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This manual is organized as follows:

Introduction

About Viz Mosart

Installation

Frame Accurate System Operations
Audio Players

Manus Administrator

Media Administrator

Overlay Graphics

Story Recorder Mode

Viz Engine as a Switcher

Viz Arc support within a Mosart show
AV Automation

AV Automation Device Properties
Device Connection Strings
Device Configuration Files

Viz Mosart Template Database
Maintenance

Trio Interface

ActiveX

General Configuration Files
Appendix
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1 Introduction

This guide takes you through the setup of Viz Mosart and is a reference guide for use during its
installation and configuration. The purpose of this document is to help new users become familiar

with the system; to illustrate the main workflow, and to show the available options. Familiarity with
XML is required.

1.1 Related Documents

Viz Mosart User Guide: Contains information on how to use Viz Mosart in live production.
For more information about all of the Vizrt products, visit:

- www.vizrt.com

- Vizrt Documentation Center
Vizrt Training Center

- Vizrt Forum

1.2 Feedback And Suggestions

We encourage suggestions and feedback about our products and documentation. To give feedback
and/or suggestions, please contact your local Vizrt customer support team at www.vizrt.com.

Copyright © 2023 Vizrt Page 15
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2 About Viz Mosart
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Viz Mosart is a broadcast solution designed for newsroom environments. Mosart allows a control
room to be fully operational with minimal effort and consistency within the production.

Viz Mosart is a collection of server and client applications, along with services, that control
equipment within your broadcast environment.

This section contains the following topics:

Naming Convention for Components
The Viz Mosart System

Viz Mosart Server

Viz Mosart Client

Other Viz Mosart Applications

2.1 Naming Convention For Components

When contacting support, please use the following standard naming convention for Viz Mosart
applications and components:
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Short
Name

AVA

Gul

KVM
Manus

Admin

Media

Admin

MMR

NCS, NRCS

oGl

RCC

RCS

Trio
Interface

URL

Viz Mosart

Long Name

AV Automation
Viz Mosart GUI

Keyboard, Video,
Mouse

Manus
Administrator

Media
Administrator

Media Router

Newsroom
Computer System

Overlay Graphics
Interface

Robotic Camera
Controller

Remote Control
Service

Uniform Resource
Locator

Viz Mosart
Newsroom
Automation
System

Viz Mosart Administrator Guide - 5.3

Description

Application controlling attached broadcast equipment.
Main user control application.

Application allowing multiple computers to share the same
monitor, keyboard and mouse.

Application controlling the Viz Mosart Rundown.

Media Administrator. Application for monitoring media objects
(clips).

Application that shares broadcast devices between control
rooms. See Media Router and Mosart Template Database.

Application that controls Overlay graphics systems.

Service used for all external PCs, like GUI and Timing Display,
to connect to Viz Mosart Server. Sometimes referred to as
RCPS.

Application that controls Vizrt overlay graphics. (Kept for
backward compatibility only - use Overlay Graphics instead).

In this context, address of web service.
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2.2 The Viz Mosart System

The Viz Mosart system is a collection of software applications that join to make your production
come together. The applications used may vary between installations and are dependent on your
broadcast environment.

The following is a general and simplified overview of the Viz Mosart system.

Viz Mosart comprises two main applications: the Viz Mosart Server and the Viz Mosart GUI. There
are also several supporting applications, such as the Timing Display and Audio Panel. You can
have more than one Viz Mosart GUI running at workstations connected to the Mosart server.
Normally there are two Mosart servers: one active (live) and one backup server.

Mewsroom
System

VIZ MOSART SERVER

Mosart
Manus Administrator % GUI

T,
Remote Audio
Control Panel
Service —
. . \\ i Y
Media Graphics AV Timing
Admin Interface Automation ™ Display
T N
Audio
Player

BROADCAST DEVICES

A Note: The shaded boxes in the diagram signify a physical device such as a workstation,
server or a piece of hardware. White rectangles represent Viz Mosart applications, white
circles represent Viz Mosart services, and rounded rectangles represent user displays.

The figure above shows a typical Viz Mosart installation with one Viz Mosart Server and four Viz
Mosart workstations to run the user control software. There is also provision for a physically
attached remote audio fader panel attached to a Viz Mosart workstation via the Audio Panel
application. Redundancy is not shown.

All Viz Mosart applications and services are connected via TCP/IP, allowing them to run on any
computer in a common logical network.
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2.2.1 Viz Mosart Applications

The Viz Mosart software package consists of the following applications:
Viz Mosart Server

- Viz Mosart Server
Manus Administrator
Media Administrator
Overlay Graphics Interface
- AV Automation
Log Service and Log Viewer
Remote Control Service

Viz Mosart Client Applications

- Viz Mosart Client
- Viz Mosart GUI
- Audio Panel (see Viz Mosart User Guide)
- Timing Display (see Viz Mosart User Guide)
- Audio Player
- ActiveX
iNews Timer

Other Viz Mosart Applications

Other Viz Mosart Applications
Media Router and Mosart Template Database
Omnibus Controller
SNMP Service
- Test Suite

Copyright © 2023 Vizrt Page 19
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2.3 Viz

Mosart Server

VIZ MOSART SERVER

Manus Administrator

Remote
Control
Service

Media
Admin

Graphics AV
Interface Automation

2.3.1 Viz Mosart Server

The Viz Mosa

rt Server comprises a suite of dedicated server applications, relevant to your

broadcast environment, running independently of one another on the same workstation.

The Viz Mosa

rt Server supports multiple GUI workstations connected to it at any time. The control

room has two Viz Mosart GUIs, one for redundancy, while others can be used for information
purposes and locked to Browse Mode for monitoring the rundown outside the control room.

The Viz Mosa

rt Server also supports multiple timing displays. Various timing information can be

seen at a glance wherever the application is installed. It may also be helpful to have a different
display for the control room and another for the studio floor. The Timing Display is connected to
the Viz Mosart rundown that is currently On Air.

2.3.2 Vi

Icon

z Mosart Server Components
Application

Mosart Manus Administrator Executables either:

- (Default) Vizrt.Mosart.ManusAdministrator.exe (A combined iINEWS/
MOS program).

- MMConsoleAdmin_2007.exe (FTP, for iINEWS).

- MMConsoleAdmin_MOS.exe (for MOS workflow Newsroom Control
Systems).

Mosart Media Administrator Executable: MMMediaAdministrator.exe
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Icon Application

K

Mosart AV Automation Executable: MMAVAutomation.exe

Mosart Overlay Graphics Executable: MMOverLayGraphicsinterface.exe

T

The Viz Mosart Server is split into four main components plus two services, each handling an
important role for the system to function. Splitting the system into components allows greater
flexibility in handling a variety of broadcast devices and productions.

A typical Viz Mosart Server installation contains the following applications and services.

Manus Administrator (console application): Handles the connection to the Newsroom Control
System (NCS).

Media Administrator (console application): Application for monitoring media objects (clips)
referenced in the current rundown. Supports the media search option used in the Viz Mosart
GUL.

Overlay Graphics Interface (Windows application): Application for controlling and monitoring
overlay graphics.

AV Automation (Windows application): Application for controlling all other external
broadcast equipment.

Log Service and Log Viewer (Windows service): Service used for generating Viz Mosart
command logs. Automatically installed with Viz Mosart Server and the Viz Mosart GUI.
Remote Control Service (Windows service): Service used for all external PCs, like GUI and
Timing Display, to connect to the Viz Mosart Server. Automatically installed with the Viz
Mosart Server.

Normally, all of the services listed above should be running at all times on the Mosart server. To
ensure this, you could start them from a convenience batch-script such as the one below:

StartMosartServicesAndGUl.cmd

1 @echo off
2
3 @REM Assume we are 1installed at the default location, otherwise fix path
4 cd "C:\Program Files (x86)\Mosart Medialab\Mosart Server"
5
6 start "Manus Admin" /MIN MMConsoleAdmin_MOS.exe
7 timeout /T 1 > nul
8 start "Media Admin" /MIN MMMediaAdministrator.exe
9 timeout /T 1 > nul
10 start "AvAutomation" /MIN MMAVAutomation.exe
11 timeout /T 2 > nul
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12
13
14
15
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start "OverlayGraphics" /MIN MMOverlLayGraphicsInterface.exe

timeout /T 1 > nul

cd "C:\Program Files (x86)\Mosart Medialab\Mosart GUI"

start

"Mosart GUI" MosartMultiGui.exe

The status of the console applications (Manus Admin and Media Admin) can easily be seen on the
Viz Mosart server console. The same applies Windows applications AvAutomation and
OverlayGraphics.

The RCS (Remote Control Service) and Log Service run as Windows services and are therefore not
available for easy visual inspection. It's recommended to make these services start automatically
when Windows starts up. One easy way to do this is to use the Windows services application (Start
button > Services): locate the required services in the services window, right-click the service and
make sure its properties are set to Automatic as shown in the screenshot below:

File Action

View Help

e |FEdE HeE » oo

., Services (Local)

Mame

‘&l MessagingService_19ebbed

Description

Service supporting text messaging and related functionality.

&l Microsoft (R) Diagnostics Hub Standard
& Microsoft Account Sign-in Assistant
£k Microsoft App-V Client

&k Microsoft iSCSI Initiator Service

&l Microsoft Office Click-to-Run Service
‘& Microsoft Passport

‘£l Microsoft Passport Container

&k Microsoft Software Shadow Copy Provide
‘&l Microsoft Storage Spaces SMP

{Ch Microsoft Windows SMS Router Service.

‘£ Mosart Logging Service

&l Mosart Media Router Service

‘& Mosart Omnibus Controller Service
&Mosar‘c Remote Control Service

‘£ Mosart SNMP Service

"L Mozilla Maintenance service
& MS-MPI Launch Service

{Ch Natural Authentication

‘ChNet.Tcp Port Sharing Service
EhNetlogon

&l Network Connected Devices Auto-Setup
&1 Network Connection Broker

Ch Network Connections

&k Network Connectivity Assistant

Gl Network List Service

Mosart Remote Control Service Properties (Local Computer)

General LogOn  Recovery Dependencies

Service name:  MosartRemoteControlService

Display name: Mosart Remote Control Service

Description: Service responsible for remote control of the Mosart
\ALtomation

Path to executable:

"C:\Program Files (x86)"Mosart Medialab‘Mosart Server'RemotePanelDispz

Startup type: Automiatic ~

h

Start Stop Pause R

Service status: Stopped

You can specify the start parameters that apply when you start the service
from here.
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If you prefer the command line, you can easily inspect and start/stop services from Powershell.
Start an elevated Powershell (Admin) session via Start > Powershell > right-click and select Run as

administrator.

In the example below, the Mosart Logging Service and RCS are running, while other Viz Mosart
services are stopped:

PS C:\Users\bva.VIZRTINT> Get-Service | grep Mosart

Running MosartLogService

MosartMediaRout...
MosartOmnibusCo...
Running MosartRemoteCon...

Stopped
Stopped

Mosart Logging Service

Mosart Media Router Service
Mosart Omnibus Controller Service
Mosart Remote Control Service
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Stopped MosartSNMPService Mosart SNMP Service

Manus Administrator

' Viz Mosart - ManusAdministrator 3.8.0.25778 IDLE - <no active rundown= — O *

strator_2887 ExSetAvConfig Loading AvConfig
aredChannelTemplat SHvideoChannel Did not find Server A/B Roll defintion for SERVERGS
not find Server A/B Roll defintion for SERVER

2 15 Did not find Server A/B Roll defintion for BACK UP SERVER
2 I 3 15 MMAVSharedChannelTemplates getHSHvideoChannel Did not find Server A/B Roll defintion for BACK UP SERVE

Newsroomsettings version OK.
88:27:54 I 3 18 NewsroomSettingsRepository Initialize MNewsroomsettings configurations succesfully loaded into th
e repository.@8:27:54 18 Newsroomsettings configurations succesfully loaded into the repository.

NEWSROOMSETTING hanneltemplates\newsroomsettings.xml

e v
e 7: 3 trator_2807 ManusDirectory Manus Directory i
e sAdministrator 2867 ExSetAvConfig Loading AvConfig@s:: 15 Loading AvConfig

15 Did not find Server A/B Roll defintion for SERVER
nel Did not find Server A/B Roll defintion for SERVER
5 UP SERVER
3 15 MMAVSharedChannelTemplates getHSHvideoChannel Did not find Server A/B Roll defintion for BACK UP SERVE

3 15 ManusAdministrator_2807 ExSetChannelTemplates ChannelTemplates loaded, current studiosetup is TVA 2817
15 ChannelTemplates loaded, current studiosetup is TVA 2

Manus is short for manuscript, the script originating from the Newsroom Control System

(NCS). Manus Administrator is the central Viz Mosart application that controls the current rundown
in the Viz Mosart GUI and receives rundowns from the attached NCS. It issues events according to
the different story items in the rundown and is dynamically updated when changes are made in the
NCS. Although Manus Administrator receives information from the NCS, it does not send updates
back - this prevents rundown control conflicts between the systems.

The Manus Administrator handles the connection to the NCS, and executes commands at the
appropriate time according to GUI input and template configuration.

The Manus Administrator runs as a live console application and responds to free text commands.
For improved execution speed, Manus Administrator should be run in the background or be
minimized.

Variants

Manus Administrator has variants with slightly different settings that suit different broadcast
environments. During installation, select the Manus Administrator appropriate to your
environment:

MMConsoleAdmin_2007 for iNews FTP Newsroom connections
MMConsoleAdmin_MOS for MOS Newsroom connections

A Note: Manus Administrator is sometimes also referred to as MMConsoleAdmin,
ManusAdmin, ManusAdministrator or just Manus.
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Media Administrator
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The Media Administrator (MMMediaAdministrator) handles the database connection to your video
servers. This application references the database to provide a current clip list within the Viz Mosart
timeline, without making changes.

Mainly used for monitoring and searching video clips on connected video servers, the Media
Administrator:

Is responsible for reporting status for all clips in the current rundown to the Manus
Administrator - typically whether a clip is present and properties like clip duration. The clip
status for video servers is displayed in the Viz Mosart GUI as horizontal bars. A light-blue bar
indicates a clip that is present on the video server, whilst a checkered bar indicates a non-
existing clip. Clip length is shown by the length of the horizontal bar in the Viz Mosart GUI.
For other media objects, Viz Mosart may present clip status in other ways.

Makes it possible to search for clips on the video server. This functionality is used by the Viz
Mosart media search window, making it possible to add clips to the rundown without the
use of an NCS. You can also search for other media objects like subtitles, graphic elements,
and audio files.

The Media Administrator runs as a live console application and responds to free-text
commands. It should be run in the background or minimized for improved execution speed.

Overlay Graphics Interface
This is used for controlling and monitoring overlay graphics for graphics engines.
The two overlay graphics interfaces are:

OverlayGraphics Interface (recommended).
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- Trio Interface (to be deprecated, kept for backward compatibility only).

& Note: An overlay graphics interface is only used for overlay graphics. Full-frame
graphics are controlled through AV Automation.

¥iz Mosart - OverlayGraphics

The Overlay Graphics is used for controlling and monitoring the overlay graphics for all Viz Mosart

approved graphics engines. Configure it using Overlay Graphics Configuration. For a list of
supported graphics devices, see Overlay Graphics Types.

Trio Interface

& Note: Trio Interface is no longer recommended for use and is kept for backward
compatibility only. Vizrt recommends using the Overlay Graphics instead.

Copyright © 2023 Vizrt Page 25



AV Automation

£

= Viz Mosart - AVAutomation: NameOfGallery (TEST)

Devices  Show  Studio setups (TEST)  Standby
H K FM L2 L2

Idle

Viz Mosart Administrator Guide - 5.3

-25 -51 0 0 0 0 -5

LIVE1 LIVE3 | LIVE4 | CLIP1 | CLIF2 | CLIF3 | CLIP4 |
transeffect

LIVE1 LIVEZ LIVEZ LIVE4 CLIF2 CLIFZ CLIF4

Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=Falze
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Requesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin failed: Attempt reconnect in 2 seconds
Regquesting reconnect to ManusAdmin: admin=False
Connection to ManusAdmin succeeded: admin=True

Build 0.0.0.23539 271016 ManusAdm Mirror MR
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—Video Ports
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AV Automation (MMAVAutomation) controls all Viz Mosart broadcast devices with the exception
of Overlay Graphics engines. Full-screen graphics is also controlled here.

Commands are issued to each device either on the fly through the Viz Mosart GUI, or as pre-
determined by the rundown submitted from the NCS.

All device commands are stored as predefined Viz Mosart templates in the Template Editor and are

saved in C:\channeltemplates or in a template database.

Log Service and Log Viewer

Log Service

This is used for generating Viz Mosart command logs and is automatically installed together with

the Viz Mosart Server and the Viz Mosart GUI.
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Log Viewer is used to decipher Viz Mosart logs. It is stored as an XML file once published, and as
a .log file while actively running.

The log entries are color-coded to allow for quick command visualization in the file. Microsoft
Excel may also be used to display log files (XML), and lets you use several layers of filtering and

plot graphs.
o CAUsers\Matt\Desktop\TVQ Logs\MMLOGS\Log.20140217-142444 xml - 0
File ~ Show ~ Search ~ Show only Reset Filter filter Out Refresh Showlast 0 AutoRefresh s
CueDelay set to 1000 ms (25 frames, min. cue delay)
Indes | Logtime Hosiname | Log module Method Logclemert | | Logten =
— | . B
-455] 201402-17T16:37:29... [ SASTVGDT | MMConsaleAdmi., | SwitchBackGrou.. | ManusAdministr | 3 | Slug=CAM BLACK, Story=1650 CLAPPER-VIZ, Templ
4562 | 201402-17T16:37:30... | SASTVQOT | MMAVAtomation | CusAccessariest.| AvAutomation [ PREVIEW ACCESSORIESRouter set matrix 0 level
[4563 | 201402-17T16:37:30... | SASTV01 | MMAVAUtomation | PrepareGraphics | Graphics 3 | Got Vizcommand from dataelement ' CLAPPER / BRIS
4564 | 2014.02-17T16:37:30... SASTVQO!  MMAVAutomation LoadGraphics  Graphics |3 | Graphics loaded ' CLAPPER / BRISBANE (TVQ) UPDAT . |
| | | ] L
4565 | 201402-17T16:37:30... SASTVRD! MMAVAutomation ScheduleElement Graphics 3 Scheduling: viz=viz_mosart_b, command=cue, show=/...
-455? 2014-0217T168:37:32... .S.P«STVQm MMAVAUtomation -DQEa'hiTakehC .Genelallrfcl . 3 . EarlyCommand DIRECTTAKE - 300(STBY ALL MICs
.45'53 20140217T16:37:32... .S.P«ST\I"QD'I MMAVALtomation .Takta"«cusw'ies .PHMUI'I'IﬁiDH E PROGRAM ACCESSORIESRouter set matrix 0 level
|4569 | 2014.02.17716:37:32.. | SASTVQO1 | MMAVAutomation | TakeGraphics | Graphics 3 Graphics taken ' CLAPPER / BRISBANE (TVQ) UPDATE
4570 | 2014-02-17T16:37:32... | SASTVGO1 | MMAVAtomation | RipleGraphicsGr. | AvAutomation |3 | Graphics ripple 2 current=2, next=2
[4571 | 20140217T16:37:32... | SASTVGOT | MMAVALtomation | MMAudio | AudioMocer ;3 ' Post onair channels: SVR D ST, READERT MAIN, SVR
. | | . | . B

Remote Control Service

The Remote Control Service (RCS, sometimes referred to as RCPS) allows all external PCs, such as
the Viz Mosart GUI and Timing Display, to connect to the Viz Mosart Server. RCS is automatically
installed together with the Viz Mosart Server.
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Viz Mosart Server
Internal communication

(.Net Remoting)

RCS Clients
(.Net Remoting) ManusAdmin Bl e AV Automation
\

RCS Clients (WCF)

Overlay
Graphics
Masart GUI
e MediaAdmin
Mosart Audio
Panel b

External client(s)
(WCF)

RCS provides a WCF interface for remote clients. This interface allows external applications or
services to connect to the Viz Mosart server.

For configuration options, see the comments in the associated standard configuration file
RemoteDispatcherServiceConfig.xml located by default at

C:\Program Files (x86)\Mosart Medialab\Mosart
Server\ConfigurationFiles\RemoteDispatcherServiceConfig.xml

See Also

Manus Administrator

AV Automation

AV Automation Device Properties
Media Administrator

2.4 Viz Mosart Client

The main components that make up Viz Mosart Client are:

Viz Mosart GUI: Fullscreen Windows application used to control and monitor the Viz Mosart
rundown.

Audio Panel: Fullscreen Windows application used to control and monitor software audio
faders.

Timing Display: Fullscreen Windows application used to display various timing information
from the Viz Mosart rundown.

Audio Player: Used to play out audio files located on the file system.

Additional Viz Mosart Client applications:
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ActiveX
iNews Timer

& Note:
= Multiple instances of the above applications may run on any workstation connected

to the same network as the Viz Mosart Server.
= All instances of Viz Mosart software must run the same Viz Mosart version with a
standard OS across all Viz Mosart client machines.

2.4.1 Viz Mosart GUI

-~
P
Mosart GUI
The Viz Mosart GUI workstation is a standalone networked PC with a single instance of the Viz

Mosart GUI application (MosartMultiGui) run in full-screen mode. More than one PC can run the
same software component, for example, you can add a backup GUI PC.

The Viz Mosart GUI is the main control interface for the Viz Mosart Server. The director can run the
production from a single key press on the workstation keyboard.

mosart

21:27:30 +27:13
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Alternate configurations may also host a fader panel and a Timing Display. Each Viz Mosart Client
application should run on a standalone networked PC.

The Viz Mosart GUI is described in detail in the Viz Mosart User Guide.

2.4.2 Audio Panel

W Mozan e Panel [ [ o]
mosart

SOUNDPLAYER

T —

BFL

STARDEY STANDEY STAMDEF ETAMDEY STANDEY

Audio Panel (Server)

The Audio Panel (AudioPanel) lets you use a Behringer BCF2000 or JL Cooper MXL with a Viz
Mosart Server. The panel controls data transmission between the physical hardware panel and AV
Automation on the Viz Mosart Server.

Audio Panel (Client)

liviberesanis Eyupefies

(Prericsl)
The Audio Panel (Client) is a software representation of the audio mixer connected to the Viz
Mosart Server, displaying current faders, on air faders, and faders in preview.

The Audio Panel is described in detail in the Viz Mosart User Guide.
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2.4.3 Timing Display

Tooks ‘Conrastiions mosa rt

MOSART 2100 BUSINESS NIGHT

+ 04:15

OO0: 09O PMTOPMARKETS # 2L-WPSTLVO OO = O A

09:27:30 PM

00:08

1613.2401.36 ASXBIZLVO =S

00:26

The T|m|ng D|splay (WPFTlmmgInfo) provides timing information to the studio control room and
the studio floor.

The Timing Display is synchronized to the current rundown in the Viz Mosart GUI. You can run as
many customized Timing Display applications as you need for the production.

The Timing Display is described in detail in the Viz Mosart User Guide.

2.4.4 Audio Player

The Audio Player is part of the Viz Mosart installation and may be used to play out audio files
located on the file system. This is useful for playing out files that are used on a regular basis, such
as openers and audio-beds.

& Note: A broadcast sound card is required for audio output. If you're running the Audio
Player on a Windows Server, you must install Windows Audio features on the machine in
order for the various audio formats to work.
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() Viz Mosart Audio Player  Settings

9 LiveSoundService AVAutomation pinged the service
io Di : CAlydvignetter\Nyhetskanale . . L " . T
] LS UM LA R EE 11 LiveSoundService AVAutomation stopped pinging
1: Qutput 1 Stopped (Pnmary Sound Driver)
2: Output 2 Stopped (Line QOut (4- Scarlett 2i4 USE]))
3: Qutput 3 Stopped (Speakers (Realtek High Definition Audio))

AVAutomation 10.211.114.132

& Note: The Audio Player replaces the discontinued Soundfile Player.

The Audio Player is described in detail in the Viz Mosart User Guide.

2.4.5 ActiveX

£
Viz Mosart
[Los -] +
iFunu::spen: j
CaERA 1 —Description T ezt
FACKAGE i name...
YOICEOWER S0T deszcription ;I
o3 S0T?
GRAFHICS FLLL
WIDEDQ EFFECT LOOF ﬂ
JINGLE — Transition
FHOMNO
FLOAT Mix =]
BREAK
WIDECWYALL
CG Mame | Yalue
SOUND clip_description
ACCESSORIES e
COMMAND clip_hirespath
Wersion 3.7.0,23436

The ActiveX is used to insert Viz Mosart template information into the Newsroom System script.
It's compatible with any newsroom system that allows ActiveX plugins.
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The ActiveX list displays the first template name result it finds under NCS tags in Newsroom
Settings. The user selects a Viz Mosart template type and variant, which can then be dragged into
an entry in the Viz Mosart rundown. When the script is saved, information is pushed to Manus
Administrator and the active rundown in the Viz Mosart GUI.

The ActiveX is installed as a standalone component and is independent of the version of Viz
Mosart Server used.

Viz Mosart has its own ActiveX NCS plugin. The plugin lets users insert Viz Mosart commands to
the scripts from a list of available Viz Mosart templates.

The templates and transition effects that are shown in the ActiveX may also depend on the value of
Studio Setup in AV Automation > Audio and Video Setup.

When a particular Studio Setup has been selected in the ActiveX (in the second dropdown box),
only effects with this studio setup (as defined in AV Automation > Audio and Video Setup) will be
available in the Transition dropdown. Effects with no studio setup defined are global effects and
always appear in the Transition dropdown.

2.4.6 iNews Timer

The iNews Timer provides accurate timing of the production in iNews, and is used to synchronize
the story currently on air in the Viz Mosart GUI to the corresponding entry in iNews.

2.5 Other Viz Mosart Applications

This section contains the following topics:

Media Router and Mosart Template Database
Omnibus Controller
SNMP Service

- Test Suite

2.5.1 Media Router and Mosart Template Database

Media Router and Template Database with a MySQL database enables two features within Viz
Mosart:

Resource sharing: video servers, graphics devices, robotics, and so on.
Viz Mosart can be configured to use shared broadcast devices between control rooms via the
dedicated Media Router (MMR). This device enables Viz Mosart to select other devices before
the next show.
The vision switcher and audio mixer are not included in Media Router control, but may in
some situations be shared, depending on the device’s capability and/or the planned use of
the device.

- Template sharing: Viz Mosart template information between multiple Viz Mosart
installations.

These features are a licensed addition to the Viz Mosart Server. Please consult your nearest sales
agent for more information.
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2.5.2 Omnibus Controller

The Omnibus Controller allows communication with Omnibus systems for Viz Mosart installations
running Omnibus equipment.

2.5.3 SNMP Service

This application allows for system monitoring of the Viz Mosart Server with SNMP agents such as
Nagios and Navigator. Any SNMP agent application with MIB support is able to use this service.

2.5.4 Test Suite

The Test Suite contains various diagnostic utilities that can be used when installing Viz Mosart for
the first time or when connected broadcast devices must be checked.

This is a list of some of the tools available in the Test Suite:

- AsRunLogTester: Test AsRun Log publishing
MediaRouterTester: Test Media Router
MVCPSimul: Test MVCP protocol
NexioTest: Test Nexio protocol
- QuantelTest: Test Corba protocol
RoboTest: Test camera robotics
- ShotokuTester: Test Shotoku camera robotics
- TestAudioMixer: Test Audio Mixer communications
- TestMIDIShowControl: Test MIDI Lighting control
- TestRouterControl: Test Router communications
- TestVDCP: Test VDCP protocol
- TestVisionMixer: Test Vision Mixer communications
- VintenTester: Test Vinten 200 protocol
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3 Installation

This section contains an overview of how to install the various Viz Mosart Applications, by running
standard Microsoft installers (.MSl files).

Prerequisites

Viz Mosart Installation Files

Viz Mosart Installation Administrator
Licensing

3.1 Prerequisites

There are several system prerequisites that must be in place before the Viz Mosart Applications are
installed.

This section contains:

System Requirements
Microsoft .NET Framework
Microsoft Visual C++ Redistributable Package
Hardware Requirements
- Viz Mosart Automation Servers
Viz Mosart GUI PCs
- Viz Mosart Audio Player
- Viz Mosart Timing Display and Audio Panel PCs
Viz Mosart Shared Template Database
Pre-Installation Tasks
Connections
Licensed and Optional Features

3.1.1 System Requirements

The following apply all machines running Viz Mosart software:

Prerequisite Target Description

Microsoft Viz Operating system. Viz Mosart has been verified working with
Windows Server Mosart Windows Server versions up to and including Windows Server 2022.
2012 R2 or Server  Viz Mosart Server will also work with Windows 10 and Windows 11.
later

Microsoft Viz Operating system.

Windows 10 or  Mosart

later Client
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Microsoft .NET
Framework

Microsoft Visual
C++
Redistributable
(both x86 and
x64)

Microsoft Edge
WebView?2
Runtime (x64)

Wibu-Systems
CodeMeter
Runtime Kit

Windows Folder
Structure

Windows
Firewall

Windows Audio

Windows Server
Type

Target

All

Viz
Mosart
Server

Viz
Mosart
Server

Viz
Mosart
Server

All

All

Viz
Mosart
Server

Viz
Mosart
Server
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Description

See the Viz Mosart Release Notes for the applicable Microsoft .Net
version. Most of the Viz Mosart installers cancel the installation
process if the correct .NET version is not detected.

See the Viz Mosart Release Notes for the applicable Microsoft Visual
C++ Redistributable Package.

Required for the Mosart Central Settings which can be opened from
the combined Manus Administrator (introduced in Viz Mosart 5.2.0)
or AV Automation driver properties (since Viz Mosart 5.3.0).

& For Windows Server 2012 and 2012R2, the last supported
version is Microsoft Edge-WebView2 109. Use the Microsoft
online installer to manually install this version if the
Windows servers mentioned above are used.

Required for licensing

The following folder must be available, containing Viz Mosart
installers, before installation: C:\mosart\installers

For some versions of Windows, it may be necessary to open ports.
Either completely disable Windows firewall, or alternatively open for
Ping and ports 8080-8099. If Mosart Template Database is used,
port 3306 also must be opened.

If MIDI devices are connected via direct conversion serial adapters,
Windows Audio feature must be enabled on the server.

& Note: If using Windows Remote Desktop, audio must be set
to play on the server, not the remote PC, as the Audio
configuration will otherwise be disturbed.

It may be favorable to configure the Windows Server running the Viz
Mosart Server software to Application Server, as this automatically
pre-configures several features and also automatically sets a
detailed .NET configuration.
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Prerequisite Target Description

Server All For more details, see below.
Specifications

& Note: All prerequisites must be completed before installing any Viz Mosart components,
both server and client applications.

Microsoft .NET Framework

Microsoft .NET must be installed on the system before installing any Viz Mosart Applications. See
the Viz Mosart Release Notes for the applicable Microsoft .NET version.

To determine which Microsoft .NET Frameworks are installed

If you do not know how to determine this, contact your IT System Administrator to learn how
to.

Installing the Microsoft .NET Framework

1. Obtain the applicable Microsoft .NET Framework Installer from the Microsoft Download
Center.

2. Run the installer and follow the prompts.

3. Restart the machine if prompted on completion.

Microsoft Visual C++ Redistributable Package

A Microsoft Visual C++ Redistributable Package must be installed on the system before installing
the Viz Mosart Server software. See the Viz Mosart Release Notes for details on the Microsoft Visual
C++ Redistributable Package.

& Note: Viz Mosart is a 32-bit program, but it also includes x64 components.
Obtain the applicable Visual C++ Redistributable Package (both x86 and x64) installers from the
Microsoft Download Center.
Installing Microsoft Visual C++ Redistributable Package:

1. When downloading, you have to download both the 32-bit (x86) version and the 64-bit (x64)
version.

2. Run the installers and follow the prompts.

3. Restart the machine if prompted on completion.
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3.1.2 Hardware Requirements

Viz Mosart Automation Servers

Two servers: one main and one backup.

Minimum Recommended Hardware Configuration

Dual Power Supply for redundancy

Redundant disk configuration

Integrated Lights Out (iLO), IPMI or similar with Keyboard-Video-Mouse (KVM) support
- Windows operating system with applicable .NET Framework

2 x Gigabit Ethernet ports

1280 x 1024 display adapter

16 GB Memory

Recommended Performance-related Components

2 Processors with performance as 2.6 GHz 6-core and with 12 MB L2 cache
Minimum 50 GB free storage space
- Windows Server 2008, 2012, 2016, 2019 or 2022 operating systems

Site-specific Requirements
Location-specified external device connections might include the following examples:

PCI multiport serial card RS-422/RS-232 (short distance connections).
www.moxa.com CP-118EL-A.htm
IP connected Terminal Servers with serial output ports RS-422/RS-232 (long distance
connections).
www.moxa.com - 2650
www.moxa.com - 5150
IP connected Terminal server with MIDI output port.
www.kissbox.nl - CM-MIDI2
- Additional Ethernet ports
IP connected GPIO control box
https://www.wut.de/e-57730-ww-daus-000.php

A Note: W&T is the only GPIO control device vendor supported by Mosart. Up to four boxes
can be controlled, giving 48 outputs. Only the first box is used for input, giving you 4
predetermined Mosart rundown functions, and 8 general inputs. Display, keyboard and
mouse should be available in the relevant gallery.

Viz Mosart GUI PCs

Two PCs: One main and one backup.
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Minimum Recommended Hardware Configuration

Local PCs physically located in the control room. Alternatively Integrated Lights Out (iLO),

IPMI or similar, optionally with Keyboard-Video-Mouse (KVM) support.
- Windows 10 or Windows 11 64 bit operating system with applicable .NET Framework
- Gigabit Ethernet port
- Approved video adapter with resolution 1920 x 1080

32 GB Memory

Displays with minimum 1920 x 1080 resolution, keyboard and mouse should be installed in

the gallery.

Recommended Performance-related Components

Processor with performance equal or better than Intel i7 2.6 GHz 6-core, 12 MB L2 cache

Minimum 50 GB free storage space

Viz Mosart Audio Player

If you will use the Viz Mosart Audio player, a single dedicated PC is normally placed in the server

room.
The degree of hardware redundancy required for this function shall be considered.
The PC running the Viz Mosart Audio Player should be equipped with:

- A broadcast quality audio card registering with Windows driver.
For example, Lynx Studio Technology AES16e PCl Express AES/EBU Interfaces,
www.lynxstudio.com.

- Windows 10 or Windows 11 operating system with applicable .NET Framework.
Ensure the audio card is supported by the selected Windows operating system.

Remaining hardware configuration and performance parameters are similar to GUI PCs

& Note: The Viz Mosart Audio Player replaces the discontinued Mosart Sound File Player.

Viz Mosart Timing Display and Audio Panel PCs

The main purpose of these two PCs is to display the output from the respective Viz Mosart
applications.

For the Audio Panel it is also possible to interact with the application via mouse and
keyboard.

The configuration and performance parameters shall be similar to the GUI PCs.

Copyright © 2023 Vizrt

Page 39


https://www.lynxstudio.com/products/aes16e/

Viz Mosart Administrator Guide - 5.3

Viz Mosart Shared Template Database

The Template Database is built on an Oracle MySQL Server. Actual database traffic will be light -
any modern PC will suffice, since Viz Mosart template features are more similar to a shared
storage function than a classic database transaction server.

Recommended MySQL Software

Refer to the Viz Mosart Release Notes.

Minimum Recommended Hardware Configuration

Keyboard-Video-Mouse (KVM) support.

- Windows operating system with applicable .NET Framework.
Gigabit Ethernet port.
1280 x 1024 display adapter.

The above hardware can be increased, for example with dual redundant PSUs, NICs, disks etc. for
redundancy.

& Note: Some of the hardware components (for example dual PSU) might necessitate an
upgrade to a server proper, running a recent version of Windows Server. It is also possible
to add another machine as a backup server.

Recommended Performance-related Components

Processor with performance equal or better than Intel 2.0 GHz Dual-core.
8 GB Memory.
Minimum 50 GB free storage space.

Pre-Installation Tasks

A computer platform as described must be installed by the customer prior to the start of
installation.

This includes:

Dual independent power feeds to Viz Mosart Servers and the GUI PCs, where one of the
inputs is from an Uninterruptible Power Supply (UPS) source.
Set-up of keyboard, video and mouse for Viz Mosart GUIs and Viz Mosart Servers in the
relevant gallery.
Cabling and connectivity-testing from the Viz Mosart servers to the gallery equipment to be
automated.

- Tested networks connection from the Viz Mosart servers to the Newsroom system and the
Viz Mosart GUIs.
For all IP connections (see Connections below), the customer must make sure relevant ports
and services are opened in any in-between firewalls.
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- Viz Mosart Support should be permitted remote access to all Viz Mosart computers for
online support.

Connections

All Viz Mosart applications and services are connected via TCP/IP. This allows them to run on any
computer in a common logical network.

Connections to external devices are a combination of TCP/IP and serial communication
protocols like RS-232, RS-422 and MIDI.
Extenders and translators, terminal servers and MIDI over IP, may also be used.

A Note: All device connections (such as link layer and application protocols) are dependent
on the device itself.

3.1.3 Licensed and Optional Features
For general Licensing guidelines, see section Licensing.

Engine Switcher: If Viz Mosart is licensed to use this optional feature, please refer to the Viz
Engine requirements in the Viz Engine Administrator Guide (version 5+).

3.2 Viz Mosart Installation Files

Viz Mosart is delivered as a software package comprising various server and client applications,
used for connecting to studio devices and managing the NRCS rundown, imported into Viz Mosart.

Viz Mosart Installer Files
- Additional Mosart Files

Manual Installation

Version Numbering

3.2.1 Viz Mosart Installer Files
Obtain the latest version of Viz Mosart at Vizrt's customer FTP:

1. Authenticate to Vizrt's FTP at https://download.vizrt.com/
2. Navigate to products/VizMosart/Latest Version/

Some of the installations files are available both as .msi and .exe.
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PC)
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Server
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Database
Server

Viz Mosart
Server

Viz Mosart
Server
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Description

Legacy installer containing the ActiveX utility, for displaying Viz
Mosart template data in the NRCS client.

Is superseded with the web application, NRCS Plugin.

See WebApplications.

Installer containing the Audio Panel, an application for controlling
audio faders, both on air and in preview.

Installer containing the Audio Player, typically installed on a
computer, or Viz Mosart Server, attached to the newsroom audio
mixer.

& Note: Audio Player is a replacement for the discontinued
Soundfile Player.

Installer containing the Viz Mosart Ul application, which is the Viz
Mosart user interface.

Installer containing the iNews Timer, an application used to create
accurate timing of the production in iNews.

Installer containing the Viz Mosart Installation Administrator, (MIA)
an installation assistant for Viz Mosart software (beta version,
feedback is welcomed).

Installer containing the Log Viewer, an application used to simplify
reading of Viz Mosart logs.

Installer containing the Media Router. For more details, see Media
Router and Mosart Template Database Administrator Guide.

Installer containing the Omnibus Controller, an application used
for Omnibus Server control.

Installer containing the various Viz Mosart Server components:
Manus Administrator, Media Administrator, AV Automation, and
Overlay Graphics Interface.
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Description

Installer containing the SNMP Service, used for monitoring the Viz
Mosart Server suite via SNMP.

Installer containing the Test Suite, test utilities used when
installing Viz Mosart.

Installer containing the Timing Display, used to provide timing
information to the studio control room and studio floor.

Is superseded with the web application, Timing Display.

See WebApplications.

3.2.2 Additional Mosart Files

Obtain the latest version of additional Viz Mosart software at Vizrt's customer FTP:

1. Authenticate to Vizrt's FTP at https://download.vizrt.com/
2. Navigate to products/VizMosart/Latest Version/

Installer Location

WebApplications

WebApplications\MosartDa
shboard

Engine Switcher Scenes

Machine Role Description

Viz Mosart Server Installer containing a Configuration
tool and all Mosart Web Applications.
Mosart Web Applications are
described here.

Viz Mosart Server + Directory containing both backend
Clients service MosartDashboardService-
n.n.n.n.msi and frontend service
MosartDashboardUIService-
n.n.n.n.msi
Details here.

Viz Engine Server Directory containing sample scenes
for Engine Switcher. Located at /
products/VizMosart/Engine Switcher
Scenes.

See also section Viz Engine as a
Switcher.

3.2.3 Manual Installation

When installing or upgrading Viz Mosart, run the Viz Mosart Installer Files manually from Windows

Explorer.
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Backing-up Viz Mosart
The locations are:
All files in the following folders:

- C:\channeltemplates

- %localappdata%\Mosart_Medialab

- %programdata%\Mosart Medialab\ConfigurationFiles

- C:\Program Files (x86)\Mosart Medialab\<Mosart application>\ConfigurationFiles

- All files with extension .exe.config in folders
C:\Program Files (x86)\Mosart Medialab\<Mosart application>\
where <Mosart application> is the relevant Viz Mosart application, e.g. Mosart Server, Mosart
GUI, etc.

Windows registry settings for

HKEY_CURRENT_USER\Software\[Wow6432Node\]Mosart Medialab
HKEY_LOCAL_MACHINE\Software\[Wow6432Node\]Mosart Medialab

Installation

@ Tip: Vizrt provides a beta software utility Viz Mosart Installation Administrator that can
speed up installation and upgrading of your Viz Mosart system. Refer to section Viz Mosart
Installation Administrator.

To Perform a Manual Installation

1. Download all relevant Viz Mosart Installation Files to the preferred location. The default
location is C:\Mosart\Installers. You are advised to make a sub-directory for the installers
for a particular version/build containing all the MSI installer-files and any other supplemental
files. This directory should be named using the Release.Version.Patch.Build nhaming
convention, for example: C:\Mosart\Installers\3.4.5.12345 for Viz Mosart 3.4.5 build
12345.

2. If you are upgrading from an earlier Viz Mosart version it is recommended to take a backup
of your current installation settings before you start the installation of the new version. See
Backing-up Viz Mosart above.

3. Double-click the installation files (msi or exe).

4. Follow the prompts to complete installation.
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5. When installing the main file VizMosartServer-n.n.n.nnnnn.exe, you can specify NRCS type.

Version 5.2.0.

The Vizrt studio automation system

Install this program for: Anyone who uses this computer #

Create shortcuts
» on the desktop:
s in the Program Menu:
o in the Startup Menu:

NCS Type: Combined

Graphics Interface: Combined
MOS
INEWS

By default, both software (Viz Mosart Manus Administrator) for both NRCS types are
installed.
6. You need to start a set of Windows services to make Viz Mosart run properly. These are
automatically started when the computer is started.
a. The safest is to reboot the computer to verify that the automatic start of the services
is working.

Copyright © 2023 Vizrt Page 45



Viz Mosart Administrator Guide - 5.3

b. Service names will be displayed as in the screenshot below:

Service status p4¢

o Services started:
” MosartMediaRouterService - Already Started

MosartOmnibusControllerService - Already Started
MosartLogService - Already Started
MosartRemoteControlService - Already Started
MosartSNMPService - Already Started

oK

3.2.4 Version Numbering

Installation folders are named with the Viz Mosart version number. All files inside that folder also
have the corresponding version number attached to the filename.

Version numbers have the following syntax:
Major.Minor.Revision.Build (for example 3.4.5.12345)

Where:

Major.Minor.Revision denotes the Viz Mosart Version Number
Build denotes a patch number

Example: Installers\3.4.5.12345\VizMosartServer-3.4.5.12345.ms1

In this example, the computer has a folder for the Viz Mosart 3.4.5.12345 release, containing
associated installers.

Every significant code change of Viz Mosart results in a change to the Viz Mosart version number.
This increases either the major, minor, or revision number.

Patches are identified by having a higher build number than the remainder of the files.

3.3 Viz Mosart Installation Administrator

Viz Mosart has its own installation utility, Viz Mosart Installation Administrator (MIA). It can save a
lot of time when installing and upgrading a Viz Mosart setup.

A Note:
The Viz Mosart Installation Administrator is beta software. Please provide any
feedback to your Vizrt Support organization.
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MIA does not currently support Mosart Web Applications.

This section contains the following topics:

Installing the Viz Mosart Installation Administrator (MIA)
- Viz Mosart Installation Administrator Interface

Semi-Automated Installation

Settings
- Take Snapshot

Start Mosart Application

Backup Files

Stop Services

Uninstall Mosart

Install Mosart

Start Services

3.3.1 Installing the Viz Mosart Installation Administrator (MIA)

i

Mosart
Installation
Administrator
You need to first download and install the Viz Mosart Installation Administrator (MIA) before
working with Viz Mosart system installations.

To Install the Viz Mosart Installation Administrator

1. Download the MosartInstallationAdministratorInstaller.<version>.msi to the
preferred location.
Default location is C:\Mosart\Installers.

2. Double-click the installation file, and follow the prompts to complete installation.
Repeat this installation process on all PCs where you plan to install any Viz Mosart
Applications.

© Warning: The directory that holds the Viz Mosart installers must be named using the
Release.Version.Patch.Build naming convention.
For example:
C:\Mosart\Installers\3.4.5.12345 for Viz Mosart 3.4.5 build 12345, or

C:\Mosart\Installers\4.0.0 for VizMosart-4.0.0 etc.
If this rule is not followed, MIA will not display the installation directory.
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3.3.2 Viz Mosart Installation Administrator Interface

m Maosart Installation Administrator (BETA) = =

Welcome to Mosart Installation Administrator |:|

What would you like to do?

4.0.30364.0

Common operations

]
Take Snapshot Start Mosart
Applications
Manual installation (follow workflow)
Backup Files Stop Services Uninstall Install Start Services
Mosart Mosart

] ,c, 6 | =

EXIT

The MIA utility assists in installation and upgrade of Viz Mosart.
The various tools are described below.

3.3.3 Semi-Automated Installation

Manual installation (follow workflow)

Backup Files Stop Services Uninstall Install

Mosart Mosart

<5 SAECIEES Pk

Start Services

The Viz Mosart Installation Administrator can run a semi-automated installation process.

The buttons above are placed in the order you would normally progress through when upgrading
an existing Viz Mosart installation.
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New Installs

If Viz Mosart has not been installed before and installer files are in the correct installation location,
begin from the Install Mosart button.

Upgrades

Follow a five-step process running from left to right when performing a semi-automated upgrade.

A Note: If Viz Mosart has previously been manually installed on the system you are using
without using the Viz Mosart Installation Administrator, the user must uninstall Viz Mosart
manually through Windows’ Uninstall or change a program before using the installation
assistant. This is due to a filename mismatch in the Windows Registry and installation
assistant that makes MIA unable to locate previous manually installed Viz Mosart
Applications.

3.3.4 Settings

Settings are accessed by clicking on the cog-wheel icon, at the top right of MIA.

The screenshot below shows default settings.
s Settings = =

Settings

Backup path ch\Mosart\Backuph

Installers path chMozarthInstallersh,

Send mail to msupport@vizrt.com

Install timeout (sec)

Correct Maosart version numbers

O O

Start Mosart applications after upgrade

K
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& Note: Any paths not found in MIA settings can be manually changed by editing the file:
C:\Program Files (x86)\Mosart Medialab\Mosart Installation

Administrator\MosartInstallationAdministrator.exe.config

Backup path: Defines the path to where the installation assistant places backup files.
Installers path: Defines the path to where the installation assistant should look for
installation files.

- Send mail to: Defines the e-mail address where error reports should be sent when
troubleshooting.
Install timeout (sec): Viz Mosart Services attempt to start/stop for the defined number of
seconds.

3.3.5 Take Snapshot

Take Snapshot

(

- A snapshot of current Viz Mosart logs and user configuration files. These are helpful for Viz
Mosart Support to assist in diagnosing any issues you encounter.
- You must specify a date and time in the past for the snapshot.
- The following files are collected:
C:\MMLogs
C:\MMLogs\MosLog
C:\MMLogs\AsRunLog
%appdata%\..\Local\Mosart_Medialab\.\user.config

Once complete, the MIA copies the files to the configured Backup path (see Settings) and
compresses the files in .ZIP format. An email interface appears with the .ZIP attached for the user
to send the file to Viz Mosart Support.

3.3.6 Start Mosart Application

Start Mosart
Application
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MIA provides an quick launch of any installed Viz Mosart application. This feature only
allows for one application to be started at a time.

s Select User = =

Please choose application type to run:

Application: | Mocart Audio Panel |

OK | | Cancel

3.3.7 Backup Files

Backup Files

O

- This tool backs up all user.config files from folders with current version numbers and all
files located in C:\channeltemplates .

- The files are copied to the specified Backup path (see Settings) with the Viz Mosart version/
username as folder name.

3.3.8 Stop Services

Stop Services

#

=

Pressing this button stops all Viz Mosart services installed, with a timeout of six seconds.

@ Tip: The timeout length can be adjusted in the installation assistant Settings.
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A dialog box appears with the current service status:
Service status

"-.I Services stopped:

¥ MosartlogService - Stopped
MosartRemoteControlService - Stopped
MosartSMMPService - Stopped

oK

Repeat as necessary.
Alternatively, perform a manual stop within Windows Services.

3.3.9 Uninstall Mosart

Uninstall
Mosart

=

Pressing this button displays all installed Viz Mosart Applications.
You can then select one or all of the applications to uninstall.
The MIA does not delete desktop shortcuts.

Existing shortcuts can be reused on completion of an upgrade.
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Installers Selection = =

Select installed Mosart applications to uninstall.

[] Check All

[] Mosart Timing Display 2

[ ] Masart Test Suite

[] Masart Remote Panel Contraller
[ Masart GUI

[] Masart SNMP Service

[ ] Masart Audio Panel

[ ] Mosart Sound File Player

[ ] Masart Log Viewer

[ ] Masart Server

oK || Cancel

3.3.10 Install Mosart

Install
Mosart

-4

I

1. Pressing this button displays all available Viz Mosart installers found in the configured
Installers path (see Settings).

The default is C:\Mosart\Installers.

s Download installers - O
Please enter version to install
(Installers are selected from c\Mosart\Installers’)
Version: 34.3.142% "
oK || Cancel
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2. Select the Viz Mosart version you want to install, and click OK.
The next screen shows applications found in the installation folder. You can select one or all
of the installers to run.
Note that if the installation folder is not named purely with the Viz Mosart version number,
like the example 3.4.3.14296 above, MIA will fail to show the below list of installers.

e Installers Selection = =

Please select applications to install:

[] Check All

[ ] MasartActiveXInstaller.2.4.2.14296.msi

[ ] MosartiudioPanelinstaller.3.4,3,14296.msi

[ ] MasariGUlInstaller.3.4.3.142%6.msi

[ ] MosartiMEWSTimerlnstaller.2.4.3.14206.msi

[ ] MosartLoglnstaller.3.4.3.14296.msi

[ ] MasartMediaRouterAdmininstaller.3.4.3.14296,msi
[ ] MasariMediaRouterinstaller.3.4.3.14296.msi

[] MasartOminibusContrallerinstaller.3.4.3.14296.msi
[ ] MasariRemotePanelControllerinstaller.3.4.3.14296.ms
[ ] MasartServerinstaller.3.4.3,14206,msi

[ ] MasariSNMPServicelnstaller.3.4.3.14296,msi

[ ] MosartSoundFilePlayerinstaller.3.4.3.14296.msi

[ ] MasariTestSuite.3.4.3.14296.msi

[ ] MosartTimingDisplay2installer.3.4.3.14296.msi

OK | | Cancel

@ Tip: For details on how to locate/change your installation folder path, see Settings.
3. MIA then performs a silent installation of the selected applications, no user interaction is

required.

The installation assistant does not create or delete desktop shortcuts. Any existing shortcuts from
a previous version can be reused on completion of the upgrade.

& Note: Viz Mosart Server components must be selected on the first installation. This is done
by creating shortcuts from C:\Program Files (x86)\Mosart Medialab\Mosart Server. Select
the components relevant to your broadcast environment.
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3.3.11 Start Services

Start Services

This button starts all installed Viz Mosart services, with a default timeout of six seconds.

@ Tip: The timeout length can be adjusted in the installation assistant Settings.

A dialog box then displays current service status:
service status

1 Services started:

¥ MosartLogService - Running
MosartRemoteControlService - Running
MosartSMMPService - Running

oK

Repeat as necessary, or perform a manual start within Windows Services.

3.4 Licensing

In version 5.2.0 a license management backend, a License Configuration menu and associated
Notifications were introduced.

In later versions, license-based feature control will be introduced. To ensure service continuity with
the correct licenses in place before upgrading, please contact your Vizrt account manager.

3.4.1 License Management
Vis Mosart uses the same Wibu-based backend licensing architecture as other Vizrt products.

For further details, please refer to the latest version of the Vizrt Licensing Administrator
Guide.
An orientation course to the Management portal is also available on Viz University.
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3.4.2 License Configuration status

The configuration status of Viz Mosart licenses can be seen in Viz Mosart Ul, using the new License
Configuration UL.

L ) License Configuration

License container

Enabled License Count Expiration Date

Refresh

In version 5.2.0 this License Configuration Ul is usually empty, and is present only for testing, and
for administrators to become acquainted with the concept. In later versions it will display the
active features that require a license, and the status of the respective licenses.

To open the License Configuration Ul from the Viz Mosart Ul menu bar, navigate to Help >
License Configuration.
pphics profiles () Standby  Tools | Help
License Configuration 3
Viz Mosart User Guide
Viz Mosart Administrator Guide

About

3.4.3 License Notifications
Important licensing notifications are presented to the user through a the Viz Mosart Ul.

A notifications icon appears at the top of all menus. A red marker indicates an unread notification.

N O
3

Info | 2 unread message(s)
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Clicking the icon opens the Notification Box menu, listing important system messages that
will usually require action.

() Notification Box

Type Source
Licensing
Licensing

Licensing

Details
Failed to refresh license list. See the log for more details.
License-based feature control is being introduced in Viz Mosart. Please refer...

License-based feature control is being introduced in Viz Mosart. Please refer...

Copyright © 2023 Vizrt
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4 Frame Accurate System Operations

To ensure reliable operational synchronization between Viz Mosart and the studio equipment that
it controls, the system can be calibrated to perform on a frame accurate level of timing precision.
This section introduces:

- Why Frame Accuracy Matters
Requirements
Enabling Frame Accuracy Operation
Calibrating the System
Genlock Logging
Frame Accuracy in Story Recorder
Limitations

4.1 Why Frame Accuracy Matters

There are two areas where frame accuracy in a Viz Mosart controlled system are significant:

Predictable Behavior of Equipment
Latency Compensation.

4.1.1 Predictable Behavior of EQuipment

Unless it is known where in the frame the Viz Mosart command is issued, the response from the
equipment will always be arbitrary.

In the figure below, the red bars represent the start of a frame. The outgoing Viz Mosart
commands (cmd 1, cmd 2) are now aligned with the start of the frame grid (frame accurate).

@ Tip: The illustrations in this section are animated. If you are viewing a PDF, we recommend
the online version.

This provides deterministic behavior from the controlled equipment, as the equipment is always
given exactly the same amount of time to respond (in the above figure, after one frame).
Without frame accuracy, cmd 1 might be fired already somewhere in the first or second frame
above, and the gear will not operate at the anticipated frame, giving unpredictable results.
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4.1.2 Latency Compensation

In non-frame accurate systems, Viz Mosart only compensates for delays in the behavior of the
playout video server.

With frame accuracy, Viz Mosart can compensate for any latency of the controlled equipment.

video switcher

audio mixer

video server

As a pay-off of Predictable Behavior of Equipment, a calibration process can reveal the latency of
each piece of gallery equipment.

Viz Mosart can then compensate for these delays, by always executing commands earlier.

In the figure above, the three devices (video switcher, audio mixer and video server) have
millisecond latencies of 1, 2 and 3 frames respectively.

After compensating by executing each command specifically earlier, Viz Mosart can now
successfully perform the TAKE command, synchronized for all three devices, from the same frame.

4.2 Requirements

On the Mosart server machines (main and backup), a Plura genlock/timecode card must be
installed.

This implies that the machine must have a free slot for this type of card.

Vizrt has only verified Plura PCI 3G, with digital genlock (SDI) and supports, for time being,
only the traditional digital VITC or ATC-VITC as timecode formats.

Calibration has been performed.

A dedicated template set.

There will be timing differences for template execution under frame accurate

operation. Latencies are automatically compensated for primary events.

& Note: Whilst frame accurate operations are being continually developed and

improved, not every feature from standard mode may be available or possible in
frame accurate mode. This is also why a dedicated template set is essential.
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4.3 Enabling Frame Accuracy Operation

For frame accurate behavior, both Viz Mosart and the equipment it controls, require setup of both
a genlock and timecode feed.

- Genlock Settings
The switcher, video server (playout and recording) and Viz Mosart Server, all require

genlock.

- Timecode Feed
Both the recorder and Viz Mosart Server require a timecode feed.

& Note: Story Recorder can be used without having proper genlock setup and a timecode
reader card installed on the Mosart Server machine, but only for testing. In this case, the
time of the day will be used.

4.3.1 Configuring Viz Mosart for Frame Accurate Operation

Once the system, including all equipment has been calibrated, frame accurate operation can be
easily switched on or off.

To activate frame accurate operations
Frame accuracy related settings and options are made in Av Automation.

1. Navigate to Devices > Properties > Genlock tab.
2. Select
a. Execution Mode: Select Genlock mode.
b. Clock Source: When checked, select which genlock / timecode card is installed, if any.
By default, this is Plura timecode reader card (and for time being, the only option).
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¢. Calibration: These are the individual latencies of the gear being controlled, as derived
when calibrating the system.

Device Properties
Audio  Camera Robotics Light Control  Fouter  Subtites GPIAQ  Video Wall  Intearated Engine | Genlock | General il
Execution Mode: (O Standard (@) Genlock
Clock Source: Plura FCle w
Timecode Format: QOVITC @ ATC-VITC
[ Statistics On
Log path: C:\MMLogsGenLock Stats
Calibration
Video Server: 7 framels)
Switcher: 1 = framels)
PGM-Recorder: 1 | frame(s)
Audio Mixer: 40 = ms
Cancel Apply Save & Close

3. Click Apply, then Save & Close.

Combinations of the configuration above for Execution Mode and Clock Source settings:

Execution mode Clock Source Logic

Standard Not selected Classic mode. No timecode in the Viz Mosart
logs. No statistics can be performed.

Standard Selected Classic mode. Timecode from the selected
clock source (by default, this is Plura PCle and
the only supported option) is written in the Viz
Mosart logs generated from AV Automation.

Genlock Selected Frame accurate behavior when executing Viz
Mosart templates during a show. A clock
source is required.

Timecode from the selected clock source
(Plura) is written in the Viz Mosart logs,
generated from AV Automation.

Viz Mosart falls back to the internal clock
source if the selected clock source is detected
as inaccurate.
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Genlock Not selected Not allowed. Viz Mosart will fall back to

Standard execution mode, with no timecode.

To deactivate frame accurate operations

Open AV Automation.

A WN—

Navigate to Devices > Properties > Genlock tab.
Execution Mode: Select Standard mode.

Clock Source: Deselect.

Click Apply, then Save & Close.

4.3.2 Genlock and Timecode Reliability

Viz Mosart contains a high resolution internal genlock clock as a built-in safety mechanism which
takes care of intermittent or lost external genlock and/or timecode signal.

- Whenever the external genlock signal drops out or becomes unreliable, Mosart will fallback

to the internal genlock clock. Mosart will return to external once the signal is reliable again.
Mosart effectively runs on the internal timecode clock, constantly synchronized to the
external clock when available, keeping Viz Mosart in phase.

4.4

Calibrating The System

For Viz Mosart to function in frame accurate mode, a calibration process has been created to
better understand the timings associated with the gear being operated.
Contact Vizrt Support for further details.

- The guide defines six tests that must be executed to detect the latencies (delays) introduced

when operating gallery gear, so that Viz Mosart can compensate for these delays and verify
equipment reliability.

4.4.1 Timecode Readers

In Av Automation, you can change properties related to the Plura timecode reader card.
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1. Open the Av Automation Settings (user.config file).
Use keyboard shortcut Ctrl+Shift+S in AV Automation.

Settings (C:\Program Files (86)\Mosart Medialab\Mosart Server)

=
v Genlock A
ClockSourceStatisticsLogPath C-\MMLogs\GenlLockStats
EnableClockSourceStatistics False
EnableGenlock True
v <TimeCodeReader Type="AlpermannVelte"><Slot>1</Slot ><Mode>0</Mode ><VitcReaderMode>1</\
EnableMidFrameGenlock False
Mode o
Slot 1
TimecodeFormat VITC
Type AlpermannVelte
VitcFirstLine 6
VitcLastline 22
VitcPriority 1
VitcReaderMode 1
terTimecodeF ormat VITC
terType Plura PCle
terlseTimeCodeReader True
v GenlocklLalencies
AudioMixerCmdLatency 40
PgmRecorderLatency 1
VideoServerCmdLatency 7
VideoSwitcherCmdLatency 1
v Misc
AdminPingDelay 00:00:02

2. If any changes have been done on the Genlock tab in AV Automation properties (see To
activate frame accurate operations above), click the Apply button or close the Properties
window and do Ctrl+Shift+P for the changes to take effect.

4.4.2 Gathering Clock Source Statistics for Vizrt Support

Once Viz Mosart is set up for frame accuracy, it is recommended to perform clock source statistics
that will verify the reliability of the genlock and timecode signals.

Follow the setup procedure below, and forward the results to Vizrt customer support, who will

perform an analysis and report results.

To start clock source statistic gathering

1. You start/stop statistics in AV Automation.

a. Navigate to Devices > Properties > Genlock tab.

b. Execution Mode: Genlock

c. Clock source checked and a clock source selected.
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d. Statistics On: Selected

Graphics Audio Camera Robotics Light Control Router Subtiles Weather Video Wall integrated Engine  Genlock G/« | »

‘ Execution Mode: O standard @ Genlock ‘
[ Clock Source: Plura PCle v
[~ statistics On

Log path C:\MMLogs\GenLock Stats\

Calibration

<

Video Server: frame(s)

Suitcher 1 frame(s)

PGM-Recorder: 1 frame(s)

Do W

Audio Mixer 40 ms

Cancel Apply Save & Close

Specify the location where you wish to save the stats in field Log path.

Click Apply, then Save & Close.

the configured external clock source, if available. The file generated

Check the indicator in the AV Automation status bar at the bottom of the screen, that
statistics are on:

om2 VIiZ VSA VSB CAMS ME1 ME2 LIVE2 DDR1 DDR2 CAaM3 CAM4 LIVE1 CAM1

DSK1 DSK2 DSK 3 DSK4 Omneon

Status Video Ports
Video Switcher: VIZRT-IPS on 10.211.112.226:5951 Omneon:OMNEON:1
Audio Mixer: MIDIMIXER -A: Omneon:MIP7600
Graphics1: VIZ localhest -B: Omneon:MIP7600)

ament MirrorBGO-MOS-SERVERT:8099 MR | ACTIVE | TDB | GENLOCK |Plura PCle - STATISTICSON | Ir
Measurements will be performed for about 8-10 minutes

You can stop the statistic measurements earlier by unselecting Statistics On, as described in

step (1) above.

. Collect the saved statistics from the location defined in Log path (above) for:

a. The configured external clock source:
ExternalClockSourceStats_<uid>.csv.

b. The Mosart frame clock, driven by the selected clock source (internal or external).

Logs are stored in FrameClockStats_<uid>.csv.

Tip: You can start/stop the clock source statistics by toggling the keyboard shortcut
Ctrl+Shift+l directly in AV Automation, without the need to open the Genlock settings
in the Properties menu.
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To analyze clock source statistics
This is a complex operation performed by Vizrt Support.

- The frame clock (FrameClock) is used internally by Viz Mosart to execute templates frame
accurately.
If the external clock source is not reliable (shown in red on the AV Automation status bar),
the frame clock is driven by the internal clock source:
Y]

Tl niror | MR | AcTive| ToB | Gentock |[METREI| Info 10/4/2021

Clock source: Internal (UTC). External genlock timeout. Switched to internal.

If the external clock source is reliable, the internal FrameClock should behave more or less
as the external clock source.

This can be seen in MS Excel by comparing the chart generated (in Excel) from
GenlockPeriodMs or JitterMs columns in FrameClockStats_<uid>.csv file,

with the chart generated from the same columns in ExternalClockSourceStats_<uid>.csv.

4.5 Genlock Logging

A new type of logging has been introduced with frame accuracy in Viz Mosart to help identifying
problems related to genlock, if this is enabled.

- To enable the genlock logging, copy the configuration file GenLogRepositoryConfig.xml
from the Viz Mosart installation folder/Mosart Server/ConfigurationFiles to your working
folder (Channeltemplates or ProgramData).

Open GenLogRepositoryConfig.xml in an editor and configure it in a similar way as the other
type of logging (refer to System Logging). These configurations also include settings about
when the logging files shall be purged.

- The genlock logging is by default generated in C:\MMLogs\Genlock every time a new show is
run in Mosart (whether Story Recorder mode is enabled or not).

- A new genlock logging file is generated when a rundown is (re)loaded in Viz Mosart or when
the show is paused whilst Story Recorder is enabled.

@ Tip: Contact Vizrt Mosart Support for assistance with
Statistics analysis
Calibration
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4.6 Frame Accuracy In Story Recorder

For Story Recorder to provide high quality final shows, frame accuracy is a requirement. SR can
also be run with Viz Mosart running in Standard mode, but only for testing.

See also the section Story Recorder of the Viz Mosart User Guide.

4.7 Limitations

Frame accuracy is only available on events driven from primary templates (clips, switcher, audio
and full screen graphics), not secondary events (like overlay graphics or accessories).
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5 Audio Players

Default Viz Mosart Audio Player

- Supported File Formats

- Third Party Audio Player Devices

Setting up a SpotOn Audio Player

- Setting up a TriCaster Audio Player

- Working with Audio Players
- Working with the Viz Mosart Audio Player
- Working with a Third Party Audio Player

A Viz Mosart user can play out audio files using an audio player. This is useful, for example for
playing regularly used audio, like openers and audio-beds.

A basic audio player is always included as standard in a Viz Mosart. You can also install third party
audio drivers (for example SpotOn) as standard player, as described below.

User actions are presented in the Viz Mosart User Guide in section Playing Audio.
Requirements

Refer to general section Prerequisites.

5.1 Default Viz Mosart Audio Player

5.1.1 Supported File Formats

The standard Viz Mosart audio player supports formats: mp3, wav, wma, aac, m4a, mp4, aiff, avi.

To set up the default Viz Mosart audio player

1. On the machine that will be used for the audio player, open the Viz Mosart installation folder
and locate the Audio Player installer file, named something like
VizMosartAudioPlayer-5.0.2.32554.msi

Install Audio Player, then start it.

. On the Viz Mosart server, open AV Automation.

4. Go to Devices > Preferences > Audio > Sound player.

w N
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5. Check Use sound player and choose from the players in the drop-down list.

Audio mixer | I Sound player | Loudness controller

Use sound player Mosart Audio Player Bt
Host

Default directory

6. Under Host write the IP address to the computer where audio player is running.
7. Under Default directory, write the folder path where the audio files are stored.

Mosart Device Properties

Wision I'H'Ii:erl Video Servers | Graphics Audio |Camera Robotics | Light Corrtmll Hm.rterl Su

Audio mixer | I Sound player | Loudness controller |

¥ Use sound player II'U'Ius.art Audio Player ﬂ

Host IIucthust

Default directory ID:‘\audiu

8. Restart AV Automation and check that the connection is green.

ca _SOUND
MIC4 Bl AYER 1

FRGA PRGB MIC3
Graphics

Sound Player

v W v v A4 W v v W v A4 W v
90 | 90 | o | -0 | 90 | 90 | 80 | -0 | 90 | | 0 [ 50 | -0 | 50l

DEK2 DSK 3 DEK 4

Log window disabled. Right click to enable

Graphics 1: VIZ bge-mnae:€ 00
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5.2 Third Party Audio Player Devices

You can connect to and enable a compatible third party audio player.

Setting up a SpotOn audio player
Setting up a TriCaster audio player

5.2.1 Setting up a SpotOn Audio Player

To set up a SpotOn audio player
This procedure prepares a SpotOn audio player.

1. Download, install and start the device software to a host machine available to the Viz Mosart
server.
2. In AV Automation, go to Devices > Preferences > Audio > Sound player.
a. Check Use sound player.
b. Choose SpotOn Audio Player from the players in the drop-down list.

Device Properties

Vision Mixer Video Servers Graphics Audio  Camera Fobotics  Light Control

Audio mixer | I Sound player | Loudness controller

Use sound player Mosart Sound File Player o
Mosart Sound File Player
e Mosart Audio Playe

SpotOn Audio Player

¢. Under Host write the IP address to the machine where the SpotOn player is running.
d. Click Save & Close.
3. Restart AV Automation and check that the connection is

green.

PRGA PRGB MIC3

v w

w W v v w b v W v v w
90 | 90 | 9 | 90 | 9 | 9 | 90 | 90 | 90| | 90 [ 90 | 90 | 0l

<

DEK 4

DK 2 DSK 3

Log window disabled. Right click to enable
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5.2.2 Setting up a TriCaster Audio Player

By adding a driver, you can control (access and play audio clips) the TriCaster onboard sound
player from a Viz Mosart template.

To set up a TriCaster audio player

1. Start the TriCaster on a host machine available to the Viz Mosart server.
2. In AV Automation, navigate to Devices > Device Properties > Audio (tab) > Sound player
(tab).
a. From the drop-down menu to the right of Use sound player, select vizrt-ips.
b. In the Host field, enter the hostname or IP address of the TriCaster host.
c. In Default directory, enter the sound clips directory on the TriCaster machine (for
example, C:\ProgramData\vizrt\Media\Sound and
Music\Sample\www.SoundTraxxMusic.com).

& Note: The current implementation enables playing of files from only a single
folder.

d. Click Save & Close.
3. Restart AV Automation and make sure you have a green connection (as in the SpotOn audio
player example above).
4. In AV Automation, navigate to Template Editor > Template > New.
5. Choose an appropriate template, right-click in the dark grey area to the left and select
Enable > Audio player.

3'.:‘;‘- Template Editor | Funcspec: PLAYSOUND + TriCaster — O b4

File + Template + Template Set ~ DB

| Enable 4 Switcher crosspoint

PLAYSOUND + TriCaster

s =

Template properties Switcher Plugin

Clear devices EMEM Recall

Apply device settings to all sets Auxiliaries 4

Keyfill ’

Videoserver

Graphics

Video wall

Audio player
Virtual Set s

Camera Control
GPI/0 Control
Light Control
Router Control
Weather

Audio Mixer

description Funcspec | DB
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6. In AUDIO FILE, enter an existing file name.

e
"

\!F.-

File = Template ~ Template Set ~ DB
Funcspec
PLAYSOUND + TriCaster

LEVEL _ AUDIOFILE  ouTPUT
S e ™ o] [

These can be browsed in the SOUND tab on the TriCaster (in this example, Inspire.mp3).

DDR 1 DDR 3 SOUND AUDIO MIXER

AL

1 News Intro 001 2 Inspire 3
1:06:23 4:33:01

Take ‘

2

& Note: The OUTPUT field is ignored, as the TriCaster has a single output.

7. On the template, click OK.

5.3 Working With Audio Players

5.3.1 Working with the Viz Mosart Audio Player

When the default Viz Mosart Audio Player is configured, the user opens the Ul from a desktop

shortcut
or file location C:\Program Files (x86)\Mosart Medialab\Mosart Audio Player\Mosart Audio

Player.exe.

& Note: User actions are described in section Playing Audio of the Viz Mosart User Guide.
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Viz Mosart Audio Player Ul

& Viz Mosart - Audio Player Settings

Audio Directory: D\audio

1: Output 1 Stopped (Speakers (Realtek(R) Audio))
2:Output 2 Stopped (C32F391 (HD Audio Driver for Display Audio))

AVAutomation 192.168.1.176

Ul Element Description

Settings button Open the Settings window for configuring the Audio
Player. See Audio Player Settings below

Audio Directory Folder path to where your audio files are. All files in this
folder are ready to be played
(This location is set in AV Automation Devices > Properties
> Audio > Sound Player)

Numbered Output list A list of all available devices. The first number is the
(left hand panel) number you use in AV Automation or the NRCS to specify
the audio file playout.

Log panel (right hand panel) All log messages that the audio player creates.

AVAutomation status Green: AV Automation is connected
Red: No AV Automation connection.

IP Address IP address of the computer Audio Player is running on.

Version Version number of the Audio Player.
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Audio Player Settings

Click the menu bar Settings to open the settings dialog.

=3 Settings

m Testing panel

If a new file is set to play on an output already playing:
© Stop the file playing, and play new file
Ignore new file

Play new file on next available output

Outputs

Name Device
Qutput1 ———  —  Speakers (Realtek(R) Audio)
Qutput2 —— (C32F391 {(HD Audio Driver for Display Audio)

New

Testing Panel
Turn On to show the panel! for testing the Audio Player. Testing panel can be used to
test the functionality of the audio player.

Testing panel

Opens a panel for testing the functionality of the selected Audio Player.

File already playing behavior

Controls what the Audio Player does if a new file is played when a file is already playing.
Outputs

The list on the left shows all the outputs, and the list on the right shows available playback devices
on the computer. The line between them shows playback device mapping.

Click an output to map to playback device.
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Click New to add an output.
Outputs

Name Device

Outputl ————  Primary Sound Driver
Line Qut (4- Scarlett 2id USB)

Qutput 2 ‘-_-._.
Speakers (Realtek High Definition Audio)

Qutput 3

MNew

- You can rename or delete an output.

Audio Player Configuration File
The Audio Player Configuration file Mosart Audio Player.exe.config is at
%ProgramFiles(x86)%\Mosart Medialab\Mosart Audio Player).

Change the baseAddvress attribute to use another port:

<add baseAddress="http://localhost:8084/LiveSoundService.svc/"/>

5.3.2 Working with a Third Party Audio Player

This example features the SpotOn audio player.

SpotOn Audio Player

Addressing an audio file that is stored in a SpotOn client is similar to the default player method
above, but the file identifier is different.

~ LeveL __ AUDIOFILE  guTPUT
] || 0452 3264 ||

| 0K Cancel

LEVEL: This value does not affect the audio fader that is taken to Program. Instead a special
command option is offered. Set LEVEL to -90 to send a STOP (playing audio) command. All

other values are ignored.
- OUTPUT: Enter the panel button number to identify the associated sound file (in this

example "2a").

@ Tip:
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Use the button number (mapped to OUTPUT) as reference (instead of the audio file
name). You can then replace the audio file assigned to a button (for example, when a
show is rebranded and new music selected) and still keep the same template
information.

This avoids having to change the file name.

AUDIO FILE: Enter the panel button name here (in this example 0452_32Bit).

0452_32Bit Eliza and the Bear Jain - Makeba -
- | Wanna Feel Bubble Edit

01:02 03:12

0452_32Bit_1 Jain - Makeba -

Bubble Edit

03:12

A Note:
- Newsroom tag available. If a newsroom tag is added, and a value is provided by the
NRCS, that value for the file name (with either AUDIO FIE or OUTPUT) is used.
When both panel button number and panel button name. are used as file identifier,
the value of panel button number takes precedence.
See also

Audio in AV Automation Devices
Playing Audio in the Viz Mosart User Guide (user actions).
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6 Manus Administrator

Manus Administrator is the intelligent element of Viz Mosart, monitoring the rundown in the
connected NRCS, parsing the content into Viz Mosart functionality that is presented in the Viz
Mosart GUI.

| &

License SDK version is 3.2.0.740
Failed to load license config: Could not find file 'C:\ProgramData\Mosart Medialab\ConfigurationFiles\licenses.json".
Failed to find containers (error: CodeMeterError, message: "CmContainer entry not found

C i MConsoleAdmin_2007.exe_Url

from

Manus Administrator is a console application and must be kept running at all times on your Mosart
server.

6.1 NRCS Software Compatibility

There are three versions of the Manus Administrator, corresponding to the flavor of newsroom
system that it connects to.
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The version choice is offered at initial Viz Mosart (server) installation:

The Vizrt studio automation system

Install this program for: Anyone who uses this computer

Create shortcuts
« on the desktop: ]
 in the Program Menu: [l
« in the Startup Menu:

NCS Type: Combined

Graphics Interface: Combined
MOSs
iINEWS

(Default) Vizrt.Mosart.ManusAdministrator.exe. A combined iINEWS/MOS program.
MMConsoleAdmin_2007.exe. Only for iNEWS (with ftp) workflow.
MMConsoleAdmin_MOS.exe. Only for newsroom systems with MOS workflow.

Use for all systems except iNEWS with ftp workflow, including iNEWS with MOS workflow.

Only one Manus Administrator can be active at any given time.

@ Tip: Type help in the Manus Administrator console window to see which commands you
can use. See Manus Administrator Commandes.

See also Avid iNews Web Service for Status Feedback in the appendix.

6.2 Configuration Utilities
6.2.1 Manus Administrator Settings

From the Manus Administrator console you can open a configuration editor in a new window:

1. Type settings in the Manus Administrator console followed by ENTER.
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2. From the first row General settings, select from NCS type.
[ settings - O x

General settings

NCS Type INEWS -

Auto preview overlays Start typing then press enter to add
3. Edit or reset values as needed.
4. Remember to click Save when ready.

For details see:

- Settings Editor iNews or
- Settings Editor MOS as appropriate.

6.2.2 Newsroom Settings

- To open the Newsroom Settings XML Editor, type ns in the console window followed by
ENTER. For details see:
Newsroom Settings Editor.

& Note: The Newsroom Settings editor opens in a new window. If you make changes to the
configuration, restart Manus Administrator for the changes to be applied.

The rest of this section covers these topics:

- Settings Editor iNews
- Settings Editor MOS
Configuring the MSE Playlist Panel
Newsroom Settings Editor
Field Mapping
Manus Administrator Commands
- Viz Mosart Settings and Configuration

6.3 Settings Editor INews

6.3.1 Working with iNEWS Settings

To simplify setting up the connection to iNEWS, the Manus Admin console includes a Settings
utility.
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1. Open the Settings utility by typing settings followed by ENTER.
DSettings

2. From the General settings section, under NCS Type, sel

3 setti

General settings
Configuration file paths
Default item durations

iNEWS configuration

MOS configuration

Viz Media Sequencer configuration
Read speed

Manus configuration

Crossover configuration

Template database configuration

ngs

General settings

NCS Type
Auto preview overlays

Auto preview overlays early ®

@ Tip:
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You can search for a specific value from the Search box.

3 settings - m] X

e

General settings ~

Auto preview overlays Start typing then press enter to ad:

Auto preview overlays early ®

Auto take offset 0

Pause Automation timing on first Break ®

Reset AutoTake on 'Clear Loop' ®

Crossover configuration

Crossover Auto Take On Switch Offset 0

The editor comprises several sections, each dedicated to a collection of settings:

General

File Paths

Default Item Durations
iNEWS

Viz Media Sequencer
Read Speed

Manus

Crossover

Template Database
Logging

Vizrt Graphics

General

NCS Type: Selecting iNEWS presents the configurable values listed here.

Auto preview overlays: List of graphic destinations that support preview of overlay graphics
(For example, DSK enables preview of all overlay graphics with handler=DSK). Default: Empty
= no preview.

Auto preview overlays early: Enable preview of overlay graphics as early as possible. When
not enabled, the preview will only be displayed when the graphic is the next item to be
taken.

Autotake offset: Sets offset for the autotake function. Default: 0 frames.

Default handler name: For all graphics that have no handler name, Mosart can default to a
specific handler for these. You can assign this handler here. Default: DSK.

Default Lower Third out behaviour: Default method for taking out a lower third. Default:
TIMECODE.

Force clip editorial time: Shows Editorial time in GUI. Default: Off.

Frame rate: Determines the frame rate of the system. Valid rates 25, 29.97, 50 and 60.
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Ignore updates if nothing changes: Ignores story update from the NRCS if the updated story
is assumed to be equal to the current version of the story when set. Default: Off (NRCS story
updates are not ignored).

Keep story status on updates from NRCS: Keeps played-out stories gray if the story is
updated in the NRCS. Default: Not enabled, do not keep story status.

Max number of dynamically inserted items: The number of story items that will be inserted
and stored dynamically on a Mosart story row. Items can, for example, be inserted with a
keyboard shortcut. Default: 0 (all items will be stored).

& Note: The greater the number of dynamic items that are kept in a story, the slower
the system will become. You will need to verify what performance is acceptable for
you, depending on your story properties.

If you experience slowness in the Viz Mosart Ul while dynamically taking items into
preview or program on a running story, you can try initially changing this value to 5
and then verifying on-air performance.
Default value for this setting is 0, which means that behavior of your system will be
unchanged, keeping all manual items.
For adlibs (floats) this solution introduces a potentially undesirable side effect.
If the adlib is removed from the list of manual items, Viz Mosart will lose the
paused position, so that when the adlib is taken again, it will start playing

from the beginning instead of from the paused position.

Metadata creator priority: Overrides priority timing information from the video file's
source. Select between:

Newsroom editorial time

MAM duration

Full video clip length.

Separate IDs with commas. Use the name of the Media Administrator entry. Special names are
NCS (for information from the NRCS) and GLOBAL (global values from media object).

If Empty, Viz Mosart inserts NCS as the first and GLOBAL as last entries.

Default: Empty.

Minimum clip length: Sets the minimum visible length of an offline clip in a story in the GUI.
When Viz Mosart receives clip information the visible length is updated. Default: 5 (ss:ff).
My port: The port used for other Viz Mosart applications to connect to the Manus
Administrator. Default: 8085.

Network exclude: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to ignore when monitoring networks. Default:
Empty (monitor all networks).

Network include: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to monitor for network failure. Default: Empty
(monitor all networks).

Offset secondary events with mix delay: Secondary events follow primary events mix delay.
For example, a lower third element is delayed with the same mix delay as the package it is
to be keyed on. Default: False
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Pause Automation timing on first Break: When enabled, any first story with a single break
template will not start the automation server rundown timing (Elapsed rundown duration).
The timing will start when the next story is taken. This does not affect the NRCS timing.
Preload Accessory Cue Delay: Defines the delay between end of cue the next item and when
a pending preload/pretake accessory shall be executed.
Time is in frames. Default = 6 frames, so the accessory preload/pretake functions take place
after the cue operation is done in AV Automation, by this number of frames.
Reset AutoTake on 'Clear Loop': Disables the autotake mode automatically when using the
clear loop function from the GUI when enabled. Default: Enabled.

- Server description: User-defined descriptive name of the server that is displayed in the
Timing Display.

- Should upgrade: For Vizrt Support use only. Do not change. Default: False

- Startup in idle mode: Determines whether or not the Manus Administrator is idle at start-up.
For normal Viz Mosart operation, this setting shall always be True, so that the Viz Mosart
server starts up in Idle mode. Switching between Idle and Active mode shall in normal
operation, be done from the GUI. Default: True

- Story compare ignore attributes: Used for debugging purposes only. Default: Empty

- Templates allowing graphic pretake: Lists template types that allow pretake of overlay
graphics elements. Available template types:

- ADLIBPIX
BREAK
CAMERA
DVE
FULLSCREENGRAPHICS
LIVE
PACKAGE
TELEPHONEINTERVIEW
VOICEOVER

Default : PACKAGE and VOICEOVER.
Only the first graphic found on the next item is taken and this is taken immediately regardless
of its start time.

A Note: For graphic pretake to work, make sure the Pretake overlay on handler setting is also
configured in the Newsroom Settings Editor.

- Transitions on Accessories: Allows transition effects on accessory templates when enabled.
If disabled, any transition effects are removed from accessory templates when translating
newsroom XML into Mosart XML. This is how it has been, historically.

Use TakeOut logic: Enables the CG takeout functionality. When two CG graphic objects with
the same graphic IDs are next to each other, the first one is not taken out, only take in on
the second object is executed.

When True, enables the takeout functionality for overlay graphics. Default: False.

Use item status to NRCS: Sends online offline CUE/PLAY/STOP status to the NRCS when
enabled. Default: False.
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Ignore Send Cue Status to NRCS for offline clips: When selected, the NRCS will not receive
CUED and READY status for offline video clips. Default: Unselected, do not ignore.
Refresh media on NRCS update: When selected, triggers a clip refresh for all clips belonging
to a story that is being updated. This usually happens through the NRCS story update
mechanism. Ensures that all clip information is synchronized. Default: Do not trigger
refresh.

- Time in ms to delay initializing devices while waiting for NRCS to add story: Set to 1200 to
avoid traffic overload (blinking whilst loading). Set to 500 to avoid the first story being set
till the end of the rundown. Default: 500 ms.

File Paths

- AV config: The path to the XML-file containing the audio and video mappings defined in the
AV Automation application. Default: c:\channeltemplates\avconfig.xml.

- Channel templates: The path to the file containing the Viz Mosart templates built in the AV
Automation Template Editor. Default: c:\channeltemplates\channeltemplates.xml.
Manus directory: The path to the folder containing copies of the internal Viz Mosart
rundown. Default: c:\manus .

Newsroom settings: The path to the XML-file containing the mappings from newsroom
system commands to Viz Mosart templates. Default: c:

\channeltemplates\newsroomsettings.xml .

Default Item Durations

Break: The minimum length given to the BREAK template type in the rundown. If no time is
given in the NRCS, then this time is given to the element.
Default: 700 (frames).
Iltem: The minimum length given to any template type in the rundown. If no time is given in
the NCS, then this time is given to the element.
Default: 700 (frames).

- Camera: The minimum length given to the CAMERA template type in the rundown. If no time
is given in the NRCS, then this time is given to the element.
Default: 125 (frames).
DVE: The minimum length given to the DVE template type in the rundown. If no time is given
in the NRCS, then this time is given to the element.
Default: 125 (frames).
Fullscreen graphic: The minimum length given to the FULLSCREEN GRAPHIC template type in
the rundown. If no time is given in the NRCS, then this time is given to the element.
Default: 125 (frames).
Live: The minimum length given to the LIVE template type in the rundown. If no time is given
in the NCS, then this time is given to the element.
Default: 125 (frames).
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Lower third: The minimum length given to the Lower-third template type in the rundown. If
no time is given in the NRCS, then this time is given to the element.
Default: 700 (frames).

- Telephone interview: The minimum length given to the PHONO template type in the
rundown. If no time is given in the NRCS, then this time is given to the element.
Default: 125 (frames).

- Video clip: The minimum length given to the CLIP template type in the rundown. If no time is
given in the NRCS, then this time is given to the element.
Default: 125 (frames).

iINEWS

Server: Hostname or IP address where the iNews FTP server is running.

User name: Username of a valid iNews FTP account. Normally the name of a valid iNews user
with access rights to the iNews FTP server.

Password: Password of a valid iNews FTP account. Normally password to a valid iNews user
with access rights to the iNews FTP server.

FTP Port: iNews FTP port.

Use FTP active mode:

Selected: Use FTP Active mode, where Manus Administrator establishes the command
channel but the iINEWS server is responsible for establishing the data channel.

Unselected: Use FTP Passive mode, where Manus Administrator establishes both channels.

A Note: In active mode, the client starts listening for incoming data connections from
the server on port M. It sends the FTP command PORT M to inform the server on
which port it is listening. The server then initiates a data channel to the client from
its port 20, the FTP server data port.

False: Passive mode where Manus Administrator establishes both channels.

& Note: Where the client is behind a firewall and unable to accept incoming TCP
connections, passive mode may be used. The client then uses the control connection
to send a PASV command to the server and then receives a server IP address and
server port number from the server, which the client then uses to open a data
connection from an arbitrary client port to the server IP address and server port
number received

FTP active port range: Ports used for Active mode. The format is '<low_port>..<high_port>',
random ports are used when left empty or the format is wrong. Useful when the current
machine has certain ports that are blocked or used for other purposes.

& Only used when active mode is selected. Similar to the iNEWS environment variable
RXDATAPORTRANGE. Because a new connection is opened for each data transfer
(listing directories, downloading stories) the port range must be sufficiently wide
(~100 wide range works in most cases).

- When the port range is left empty or the format is invalid, random ports are
used.
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When the port range is not wide enough, the rundown won't fully load.
These situations are indicated in the Manus Admin console and in the logs. For
example:
[ =R A e o c L8 UEVICES
:49:68 download of SHOW.BALAZS.CLIPS ©C5D973C:00810193:61ABDCC7 story #3
downloading No wvalid active data port available!

download of SHOW.BALAZS.CLIPS 145D9745:8001D4689:61A18812 random
downloading No valid active data port available!

download of SHOW.BALAZS.CLIPS ©35D9754:80€105C9:610D29661 clip
downloading No valid active data port available!

Prefer FTPS connection:

True: FTPS encryption is used if supported by the iNews server. Otherwise it falls back to
plaintext FTP communication.

False: Using plain text FTP communication.

& Because FTP uses a dynamic secondary port (for data channels), many firewalls were
designed to snoop FTP protocol control messages in order to determine which
secondary data connections they need to allow. However, if the FTP control
connection is encrypted using TLS/SSL, the firewall cannot determine the TCP port
number of a data connection negotiated between the client and FTP server.
Therefore, in many firewalled networks, an FTPS deployment will fail when an
unencrypted FTP deployment will work. This problem can be solved with the use of a
limited range of ports for data and configuring the firewall to open these ports.

FTP connection type and status are reported in Manus Admin:
With FTP:
146047 URMAT =2nsml .
12:87:47 15 Inews ftpserver (bgo-mos-inews using FTP) connected:
12:87:47 15 NCSStatus set iNews bgo-mos-inews True

With FTPS:
1Z2:90:10 14 5 A | =2 NS

14 Inews ftpserver (inews7x-a using FTPS) connected:

8 14 NCSStatus set iNews inews7x-a True

Working directory: Initial directory in iNews. Viz Mosart provides access to all rundowns
stored hierarchically within this directory.

Default: SHOW

Encoding: Character encoding of the iNews story items. Should match the encoding used in
iNews.

Default: Encoding for the operating system's current ANSI code page.

Other values: UTF7, UTF8, UTF32, UNICODE, BIGENDIANUNICODE, ASCII.

Web service connection: Connection string.

Example: WebServiceServer=/ocalhost; iNewsServer=10.211.112.104;
iNewsUsername=mosart; iNewsPassword=mosart; SendUpdatesStatusForAllltems=true;
ClearStatusWhenRundownReloaded=true

A Note: For complete setup and configuration of iNews Web Service, please refer to
section Avid iNews Web Service for Status Feedback.
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Viz Media Sequencer
NCS server: IP or hostname to Media Sequencer Engine (MSE).

MSE Playlist panel host: The host address of the Media Sequencer Engine (MSE)

Configure or change an existing MSE host to activate the MSE Playlist panel. The Playlist

panel users active (touch or click-sensitive) thumbnails of graphics held on an MSE.

The Viz Mosart Ul needs this MSE connection defined in order for the user to see the Playlist panel
(View > Floating windows > Playlist Panel). See Viz Mosart User Guide, section Viz Mosart user
Interface > MSE Playlist Panel.

Read Speed

Read speed: Number of words read per minute by the anchor. Applied to the prompter text
to determine the duration of an announcement, which is then the length of the green
camera bar and the green part of the voice-over bar in the Viz Mosart GUI.

Default: 745 (words per minute)

Words are usually taken to be the parts of text separated by space characters. See the
setting Use character for read speed word below.

Use character for read speed word: If True, each character counts as a word for the purpose
of calculating the spoken duration of prompter text, see Read speed above.

This option can be useful for languages like Chinese and Thai, where words are not
separated by using the space character. If False (default), words are separated by space
characters.

Manus

Default Manus: Selects the default rundown to use. If set to True, the system loads this
rundown on startup.

Manus expiration time: Number of days to keep Manus Administrator files. Older files (than
that number of days) are deleted when Manus Administrator is started.

Default: 60 (files are deleted after 60 days).

Legal values: -1 (never deleted), 1 and above (number of days until deleted from manus
folder).

Manus keep file pattern: If Manus expiration time is given, this property allows a list of file
search patterns for files to keep in the Manus Administrator directory.

Files with names satisfying any of these patterns will be kept even if they are 'too old'
according to the Manus expiration time

For example, "TEST*DEMO??.xml" keeps all files starting with “TEST” and all DEMO??.xm|
files where 2’ denotes a wild character.

Default: Empty (no files to keep).

A Note: *;’ is used to separate the file search patterns.

- Test manus: Rundown to be used for maintenance purposes.
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Use the default selection of Manus: Initializes the rundown given in the Default
Manus setting automatically when enabled. Default: True.

Crossover

Connection string: The connection string of the crossover, for example: controller=/P
address, client=crossover. Default: *”

Crossover autotake on switch offset: Offset in milliseconds to pre-take an autotake when the
next story item is after a crossover switch.

A positive value triggers the autotake before the given duration of the story item.

A negative value triggers the autotake after the given duration of the story item.

Crossover SetNext on switch delay: Delay of sending set next story from the server running
the show when taking control. Default: 500 (milliseconds).

Template Database

Use template database: When true, enables the Template DB functionality, so template type
aliases can be exported from DB to newsroomsettings.xml at startup, and exporting

newsroomsettings.xml to DB after saving newsroomsettings.xml.
Default: False.

& Note: Enter the Connection string before enabling Use template database.

Name of DB provider: The provider name for the Template DB. For example,
MySql.Data.MySqlClient for MySQL.

Default: MySql.Data.MySqlClient.

Connection string: The connection string for the Template DB. For example, for MySQL:
server=<hostname>; User Id=<user>;Password=<password>; database=mosarttemplatedb.
Default: server=localhost;User ld=root;database=mosarttemplatedb.

Default template DB inserter: The name to be used for the insertedby and updatedby
columns in the Mosart Template Database.

Default: inserter.

Logging
Log level: Sets the detail level of logging to the log file. Normal, Warnings, Errors, Info,
Detailed.
Default: 0.
Log MOS communication: Enable logging of the communication to and from the NRCS.
Default: False.
In use: Enables or disables the logging of events from the Manus Administrator to the log
file.
Default: True.
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- WTC Level: Sets the detail level of logging to the console. Error, Message, External message,
Details.
Default: Details.

- Trace internally: Enables or disables internal tracing to console, for debugging only.
Default: False.

- Use verbose logging: Enables or disables verbose logging. If In use is set, using verbose the
details sent to the log.
Default: False.
Ignore verbose events filter: Semicolon based list of events to ignore in the log when using
verbose logging.
Default: Empty (log all events)
Pass verbose events filter: Semicolon based list of events to log when using verbose logging.
Default: Empty (log all events)
MSMQ Log limit: Value to identify when the application should dump the log queue to file.
Default: 4023
Path for MMLog: The path where the Viz Mosart Log is stored.
Default: MosartLog.

Vizrt Graphics

Enable: Allow use of Vizrt graphics

MSE Host: The hostname and port number (default 8580) of the MSE used for playout.
Playlist name: The name of the MSE playlist where Vizrt content from a Mosart show will be
added and made ready for playout.

MSE Profile name: Do not change this value.

6.4 Settings Editor MOS

6.4.1 Working with MOS Settings

To simplify setting up the connection to a MOS-based NRCS, the Manus Admin console includes a
Settings utility.
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1. Open the Settings utility by typing settings followed by ENTER.
DSettings

use

General settings
Configuration file paths
Default item durations

iNEWS configuration

MOS configuration

Viz Media Sequencer configuration
Read speed

Manus configuration

Crossover configuration

Template database configuration

S.

D Settings

© Tip:

General settings

NCS Type

Auto preview overlays

Auto preview overlays early ®
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Start typing then press enter to add ite

2. From the General settings section, under NCS Type, select the flavor of MOS that the NRCS
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You can search for a specific value from the Search box.
DSettings - O X

General settings

Auto preview overlays Start typing then press enter to ad:

Auto preview overlays early ®

Auto take offset 0 a e

Pause Automation timing on first Break ®

Reset AutoTake on 'Clear Loop' ®

Crossover configuration

Crossover Auto Take On Switch Offset 0

The editor comprises several sections, each dedicated to a collection of settings:

General

File Paths

Default ltem Durations
MOS

Read Speed

Viz Media Sequencer
Manus

Crossover

Template Database
Logging

Vizrt Graphics

General

NRCS Type: Generic: No special handling of native NRCS commands. Can be: Generic,
DaletPlus, ENPS, NcPower, Octopus, Open Media and MOSInews.
Default: Generic.

5.3

Auto preview overlays: Lists graphics destinations that support preview of overlay graphics

(i.e. DSK enables preview of all overlay graphics with handler=DSK).
Default: Empty = no preview.

Auto preview overlays early: Enable preview of overlay graphics as early as possible. When

set to False, the preview will be displayed only when the graphics is the next item to be
taken.

Autotake offset: Sets offset for the autotake function.

Default: 0 (milliseconds).
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Default handler name: Defines a default handler name for all graphics that have no handler
name.

Default: DSK.

Default Lower Third out behaviour:

Default: TIMECODE.

Force clip editorial time: Shows Editorial time in GUI.

Default: False.

Frame rate: Determines the frame rate of the system. Valid rates 25, 29.97, 50 and 60.
Default: 25.

Ignore updates if nothing changes: If True, a story update from the NRCS is ignored if the
updated story is assumed to be equal to the current version of that story.

Default: False (no NRCS story updates are ignored).

Keep story status on updates from NRCS: When enabled, keeps played out stories gray if the
story is updated in the NRCS.

Default: False.

Max number of dynamically inserted items: The number of story items that will be inserted
and stored dynamically on a Mosart story row. Items can, for example, be inserted with a
keyboard shortcut. Default: 0 (all items will be stored).

A Note: The greater the number of dynamic items that are kept in a story, the slower
the system will become. You will need to verify what performance is acceptable for
you, depending on your story properties.

If you experience slowness in the Viz Mosart Ul while dynamically taking items into

preview or program on a running story, you can try initially changing this value

to 5 and then verifying onair performance.

Default value for this setting is 0, which means that behavior of your system will be

unchanged, keeping all manual items.
For adlibs (floats) this solution introduces a potentially undesirable side effect.
If the adlib is removed from the list of manual items, Viz Mosart will lose the
paused position, so that when the adlib is taken again, it will start playing
from the beginning instead of from the paused position.

Metadata creator priority: Select between
Newsroom editorial time
MAM duration
Full video clip length.

Separate IDs with commas. Use the name of the Media Administrator entry. Special names
are NCS (for information from the NRCS) and GLOBAL (global values from media object).
If Empty, Viz Mosart inserts NCS as the first and GLOBAL as last entries.

Default: Empty.

Minimum clip length: This value sets the minimum visible length of an offline clip in a story
in the GUI. When Viz Mosart receives clip information, the visible length is updated.
Default: 5 (ss:ff).

Network exclude: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to ignore when monitoring networks.

Default: Empty (monitor all networks).
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Network include: Manus Administrator automatically enters idle mode on network failure.
This property is a CSV list of network names to monitor for network failure.

Default: Empty (monitor all networks)

- Offset secondary events with mix delay: Secondary events follow primary event mix delay.
For example, a lower-third element has the same mix delay as the package on which it is to
be keyed.

Default: False.

Pause Automation timing on first Break: When enabled, any first story with a single break
template will not start the Automation server rundown timing (Elapsed rundown duration).
The timing will start when the next story is taken. This does not affect the NRCS timing.
Default: False.

Preload Accessory cue delay: Defines the delay between end of cue the next item and
execution of a pending preload/pretake accessory. The duration is displayed in frames.
Default: 6 frames, i.e. the accessory preload/pretake functions shall take place after the cue
operation is done in AV Automation with an additional and configurable delay of
PreloadAccessoryCueDelay frames.

Reset AutoTake on 'Clear Loop': Enable this to automatically disable the autotake mode
when using the clear loop function from the GUI.

Default: True.

- Server description: Used for display only, in Timing Display.

Default: ControlRoom.

- Startup in idle mode: Determines whether or not Manus Administrator is idle at start-up. For
standard Viz Mosart operation, this setting shall always be True, so that the Viz Mosart
server starts up in Idle mode. Switching between Idle and Active mode shall in normal
operation be done from the GUI.

Default: True.

- Story compare ignore attributes: Used for debugging purposes only.

Default: Empty.

- Templates allowing graphic pretake: Lists template types that allow pretake of overlay
graphics elements. Available template types: ADLIBPIX, BREAK, CAMERA, DVE,
FULLSCREENGRAPHICS, LIVE, PACKAGE, TELEPHONEINTERVIEW, VOICEOVER. Default:
PACKAGE, VOICEOVER.

Only the first graphic found on the next item is taken. This graphic is taken immediately
regardless of its start time.

A Note: To enable graphic pretake, the Pretake overlay on handler setting must be
configured in the Newsroom Settings Editor.

Use item status to NRCS: Sends online offline CUE/PLAY/STOP status to the NRCS when
enabled. Default: False.

Ignore Send Cue Status to NRCS for offline clips: When selected, the NRCS will not receive
CUED and READY status for offline video clips. Default: Unselected, do not ignore.

Refresh media on NRCS update: When selected, triggers a clip refresh for all clips belonging
to a story that is being updated. This usually happens through the NRCS story update
mechanism. Ensures that all clip information is synchronized. Default: Do not trigger
refresh.
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- Time in ms to delay initializing devices while waiting for NRCS to add story: Set to 1200 to
avoid traffic overload (blinking whilst loading). Set to 500 to avoid the first story being set
till the end of the rundown. Default: 500 ms.

File Paths

- AV config: The path to the XML-file containing the audio and video mappings defined in the
AV Automation application.
Default: c:\channeltemplates\avconfig.xml.

- Channel templates: The path to the file containing the Viz Mosart templates built in the AV
Automation Template Editor.
Default: c:\channeltemplates\channeltemplates.xml.
Manus directory: The path to the folder containing copies of the internal Viz Mosart
rundown.
Default: c:\manus
Newsroom settings: The path to the XML file containing the mappings from newsroom
system commands to Viz Mosart templates.
Default: c:\channeltemplates\newsroomsettings.xml.

Default Item Durations

Break: The minimum length given to the BREAK template type in the rundown. If no time is
given in the NRCS, then this time is given to the element.
Default: 700 (frames).
Item: The minimum length given to any template type in the rundown. If no time is given in
the NCS, then this time is given to the element.
Default: 700 (frames).

- Camera: The minimum length given to the CAMERA template type in the rundown. If no time
is given in the NRCS, then this time is given to the element.
Default: 125 (frames).
DVE: The minimum length given to the DVE template type in the rundown. If no time is given
in the NRCS, then this time is given to the element.
Default: 125 (frames).
Fullscreen graphic: The minimum length given to the FULLSCREEN GRAPHIC template type in
the rundown. If no time is given in the NRCS, then this time is given to the element.
Default: 725 (frames).
Live: The minimum length given to the LIVE template type in the rundown. If no time is given
in the NCS, then this time is given to the element.
Default: 125 (frames).
Lower third: The minimum length given to the Lower-third template type in the rundown. If
no time is given in the NRCS, then this time is given to the element.
Default: 700 (frames).

- Telephone interview: The minimum length given to the PHONO template type in the
rundown. If no time is given in the NRCS, then this time is given to the element.
Default: 125 (frames).
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- Video clip: The minimum length given to the CLIP template type in the rundown. If no time is
given in the NRCS, then this time is given to the element.
Default: 125 (frames).
m length given to the CLIP template type in the rundown. If no time is given in the NRCS,
this time is given to the element.
Default: 125 (frames).

MOS

These settings are used when sending Mosart templates as MOS objects to the NRCS. MOS objects
can then, for example be used to create items in a rundown (as an alternative to the legacy Mosart
ActiveX implementation).

You can also send a MOS object containing lower-third information.

MOS server: IP address or hostname of the main newsroom system’s MOS gateway.
See Notes below.
Default: NCSSERVER.
MOS server backup: IP address or hostname of the backup newsroom system’s MOS
gateway. See Notes below.
Default: Empty.
NRCS ID: Same form as mosID, but this value is the ID for the newsroom system.
See Notes below.
Default: NCSSERVER.
NRCS backup ID: Same form as mosID, but this value is the ID for the backup newsroom
system. See Notes below.
Default: Empty.
MOS ID: MOS identification of this instance of the Manus Administrator. Generic value
is mosart.<gallerylD>.<station|D>.mos.
Default: mosart.mos.
Use backup server: Enables an NRCS backup configuration. See Notes below.
Default: False.
Force MOS protocol version: Protocol version to use for NRCS communication. Default
(blank) setting detects the version from the NRCS, otherwise, use a discrete value, for
example, 2.8.3.
Default: Empty.
MOS lower port: The MOS protocol communicates on three ports: lower, upper and top.
MosUpperPort is MosLowerPort + 1 and MosTopPort is MosLowerPort + 2.
Default: 10540
Mos server timeout: Timeout information for MOS ports. Default: 0.0.0.0.
1. NRCS to Mosart lower port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
Value=0 means no timeout.
Default: 0 (seconds).
2. NRCS to Mosart upper port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
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Value=0 means no timeout.
Default: 0 (seconds).
3. NRCS to Mosart high port: NRCS heartbeat sent to Viz Mosart. If the time between
received heartbeats exceeds this value, the connection is displayed as lost.
Value=0 means no timeout.
Default: 0 (seconds).
- 4. Mosart to NRCS: Timeout value for an established connection between
Viz Mosart and the NRCS. If the time from heartbeat is sent to response is received
exceeds this value, the connection is displayed as /ost. Value=0 means no timeout.
Default: 0 (seconds).
MOS server time zone: Used when the time zone is not indicated by the NCS Server. Valid
values are Z (meaning UTC) and +/-hh[:mm], where hhand mm are double digit hours and
optional minutes.
Default: Z (UTC) unless another value is specified.
MOS schema: A string used to identify Viz Mosart items in the rundown. Default: http://
www.mosartmedialab.no/schema/mositem.dtd.
Default ready to air: If the value is true, all MOS active rundowns are assumed to be ready to
air.
Default: False.
- Templates to MOS objects:
- Enabled: Enables sending templates to the NRCS through MOS communication.
Default: Enabled.
- GenerateUniqueObijld: Create a unique identifying name when creating a new MOS
Object. The NRCS uses this information to search for and reference the MOS Object.
- GroupedByType: Enable to send all template types as one MOS object with the variants
embedded in the objects. Disable to send all template variants as separate MOS
objects.
MergedClips: Determines whether PACKAGE and VOICEOVER templates are merged as
CLIP templates.
- SendAllTemplateSets: Sends templates from all template sets to the NRCS when
enabled. Disable to send only the default template set.
- TemplateChangeWanted: Set to true, the NRCS will receive an update whenever
a template is changed or deleted.
. Story Scope: Displays either:
- Single = A single story uses one row in the Viz Mosart GUI.
Grouped = A single story may span over multiple rows in the Viz Mosart GUI.
Currently only supported for ENPS stories in Grouped mode that have the same story
name but different story segments; these are then treated as the same story in
Viz Mosart.
Default: Empty (Single).
MOS reply with Connection MOS ID: If set, any MOS message sent to the NRCS uses the
connection Mosld instead of the current mos object ID.
Default: False.
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Min. time between story update: If no update is received from the NRCS within the minimum
time stipulated, Viz Mosart forces a story update.

Default: 7000 (milliseconds).

Item ID generator: Default: Empty.

Mosart generates internal IDs using a combination of rundown, story and item IDs. Some
newsroom systems reuse item IDs between story updates. If a new object is inserted before
an old object, Viz Mosart will therefore generate the same ID for the new object that the old
object had, and the old object will be given a new ID.

A custom ID generator can be assigned in Item ID generator.

Value Description

(Empty) This is the default value and uses the default ID
generator

ltemAndObjectID This ID generator appends the object ID to the default ID
generator. This setting should be used for Dalet
Newswire.

Ignore initial synchronization: Ignores all roReq on startup when synchronizing with the
NRCS.
Default: False.
Ignore Send Item Status filter: Lists regular expressions used to prevent sending MOS status
back to the NRCS.
The regular expressions are matched against Moslds of MOS objects. Set to “*’ to disable the
sending status for all MOS objects.
Default: Empty (send status for all MOS objects).
Newsroom tag keep keywords: A comma (or semicolon) separated list of CAPITALIZED
words.
For example:
KEEP
KEEP,INHERIT
If a newsroom tag value is equal to any of these words, the newsroom tag will be assigned
the value of the last Newsroom tag with the same name in the same story.
Default: KEEP.
See Keep Newsroom tag (with the same name) within a story in section Newsroom Tags . If
"" (only a comma) is used all newsroomtags will be kept.
Item status unavailable values: Lists status values used to identify NRCS content as invalid.
Content as graphics or clip objects.
Default: NOT_READY, ERROR.
- Video server goto delay on retake: See Story Recorder.

Read Speed

Read speed: Number of words read per minute by the anchor. By default, words are defined
as the parts of text separated by space characters. See Use character for read speed word
below. This is applied to prompter text to determine the duration of an announcement and
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thus the length of the green camera bar and the green part of the voice-over bar in the Viz
Mosart GUI.
Default: 745 (words per minute).

A Note: This is a fallback read rate, only used when the NRCS System fails to provide a Read
speed of its own. This function can be tested by changing any Read speed="xx" to Read
speed="" on an item in a local Manus file.

Use character for read speed word: If set to True, each character counts as a word when
calculating the spoken duration of prompter text, see Read speed above. This can be useful
in languages like Chinese and Thai, where the space character is not used to separate words.
If False (default), words are separated by space characters.

Default: False.

Viz Media Sequencer

NCS server: IP or hostname to Media Sequencer Engine (MSE).

MSE Playlist panel Host: The host address of the Media Sequencer Engine (MSE)

Configure or change an existing MSE host to activate the MSE Playlist panel.

The Playlist panel users active (touch or click-sensitive) thumbnails of graphics held on an
MSE.

The Viz Mosart Ul needs this MSE connection defined in order for the user to see

the Playlist panel (View > Floating windows > Playlist Panel). See Viz Mosart User Guide,
section Viz Mosart user Interface > MSE Playlist Panel.

Manus

Default Manus: This value selects the default rundown to use. The READYTOAIR value selects
and uses all rundowns indicated by the newsroom system as ready to air.
Default: READYTOAIR
Manus expiration time: Number of days to keep Manus Administrator files. Older files (than
that number of days) are deleted when Manus Administrator is started.
Default: 60 (files are deleted after 60 days).
Legal values: -1 (never deleted), 1 and above (number of days until deleted from the manus
folder).
Manus keep file pattern: If Manus expiration time is given, this property allows a list of file
search patterns for files to keep in the Manus Administrator directory.
Files with names satisfying any of these patterns will be kept even if they are 'too old'
according to the Manus expiration time
For example, "TEST* DEMO??.xml" keeps all files starting with “TEST” and all DEMO??.xm|
files where 2’ denotes a wild character.
Default: Empty (no files to keep).

- Test manus: Rundown to be used for maintenance purposes.
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Use the default selection of Manus: Initializes the rundown given in the Settings Editor
MOS setting automatically when enabled.
Default: True

Crossover

Connection string: The connection string of the crossover. For example: controller=IP
address, client=crossover.

Default: Empty.

Crossover autotake on switch offset: Offset in milliseconds to pre-take an autotake when the
next story item follows a crossover switch. A positive value triggers the autotake before the
given duration of the story item. A negative value triggers the autotake after the given
duration of the story item.

Default: 0.

Crossover SetNext on switch delay: Delay of sending set next story from the server running
the show when taking control.

Default: 500 (milliseconds).

Template Database

Use template database: When true, enables the Template DB functionality, so template type
aliases can be exported from DB to newsroomsettings.xml at startup, and exporting

newsroomsettings.xml to DB after saving newsroomsettings.xml.
Default: False.

& Note: Enter the Connection string before enabling Use template database.

Name of DB provider: The provider name for the Template DB. For example,
MySql.Data.MySqlClient for MySQL.

Default: MySgl.Data.MySqlClient.

Connection string: The connection string for the Template DB. For example, for MySQL:
server=<hostname>; User ld=<user>;Password=<password>; database=mosarttemplatedb.
Default: server=localhost;User ld=root;database=mosarttemplatedb.

Default template DB inserter: The name to be used for the insertedby and updatedby
columns in the Mosart Template Database.

Default: inserter.

Logging
Log level: Sets the detail level of logging to the log file. Normal, Warnings, Errors, Info,
Detailed.
Default: 0.

Log MOS communication: Enable logging of the communication to and from the NRCS.
Default: False.
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In use: Enables or disables the logging of events from the Manus Administrator to the log
file.
Default: True.

- WTC Level: Sets the detail level of logging to the console. Error, Message, External message,
Details.
Default: Details.

- Trace internally: Enables or disables internal tracing to console, for debugging only.
Default: False.
Use verbose logging: Enables or disables verbose logging. If In use is set, using verbose the
details sent to the log.
Default: False.
Ignore verbose events filter: Semicolon based list of events to ignore in the log when using
verbose logging.
Default: Empty (log all events)
Pass verbose events filter: Semicolon based list of events to log when using verbose logging.
Default: Empty (log all events)
MSMQ Log limit: Value to identify when the application should dump the log queue to file.
Default: 4023
Path for MMLog: The path where the Viz Mosart Log is stored.
Default: MosartLog.

Vizrt Graphics

Enable: Allow use of Vizrt graphics

MSE Host: The hostname and port number (default 8580) of the MSE used for playout.
Playlist name: The name of the MSE playlist where Vizrt content from a Mosart show will be
added and made ready for playout.

MSE Profile name: Do not change this value.

6.4.2 Notes

If there is more than one main newsroom system, the setting parameters MOS server, MOS
server backup, NRCS ID, and NRCS backup ID should contain space-separated lists of values,
and the values must be in the same order.
If some of the newsroom systems do not have a backup system, put them last in the list and
leave the corresponding values blank for MOS server backup and NRCS backup ID.
If two newsroom systems are backup for each other, both must be listed as both main and
backup. If one system is backup for more than one main system, it must be listed as
backup for each system.
If different newsroom systems need to give Viz Mosart different MOS IDs, the settings
parameter MOS ID should also be a space-separated list of values, in the same order as for
NRCS ID.
Use only a single space between list values. All values are case sensitive.

- Story Recorder status feedback to the NRCS is supported.
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6.5 Configuring The MSE Playlist Panel

The MSE Playlist panel is presented on the Viz Mosart Ul, offering users active (touch or click-
sensitive) thumbnails of graphics held on an MSE (Media Sequencer).

6.5.1 Managing the MSE Playlist Panel

Setting User Access to MSE Playlist Panel

To configure MSE access using Manus Administrator

The Viz Mosart Ul needs a connection to MSE. You must configure or change an existing MSE host
to activate the MSE Playlist panel.

Open the Viz Mosart Manus Administrator console window.

Type settings

Navigate to the Viz Media Sequencer configuration.
Modify the value of Mse host.
Restart the console.

v hWN —

Adding the Host Address of the Media Sequencer in the Viz Mosart Ul

To configure MSE access using the Viz Mosart client

- If the MSE Playlist panel is visible in the Viz Mosart Ul, you can add the host address of the
Media Sequencer directly.
Either computer name or IP can be used.

A\ Mse Playlist Panel Host is not configured.

Floating MSE Panel

To allow floating of the MSE Playlist panel

The MSE Playlist panel can be hosted as a floating window or as a docked window in the Viz Mosart
ul.

- This is controlled with View > Floating windows > Playlist Panel.
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6.6 Newsroom Settings Editor

Edit

NCS tags

MNewsroom alias

CAMERA
PACKAGE

Mosart type

CAMERA

PACKAGE

VO

VOICEDOVER

LIVE

LIVE

GFX

FULLSCREENGRAPHICS

CVE

DVE

JINGLE

JINGLE

TELEFHONE

TELEFHOMEINTERVIEW

ADLIBPX

ADLIBPLX

BREAK

BREAK

G

LOWERTHIRDS

PLAYSOUND

PLAYSOUND

Le Lo Lo Lo Jle e Lo fle (Lo Lo fle e
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This section contains the following topics:

- Working with the Newsroom settings
Configuring NRCS Tags
Newsroom Settings Editor - Edit Menu
Story External Metadata
Graphic Destination Letters

Properties

- Viz Mosart Object Structure

- Vizrt MOS Item With Payload Data Nodes
- Vizrt MOS Item Without Payload Data Nodes

- Viz Mosart and Viz Content Pilot (VCP) MOS Item Integration

MOS ID Mapping

- Additional Newsroom Settings Examples

Defining Default Values for Lower Thirds

iINEWS: Overriding Default Field Names when Parsing Stories
iINEWS: Presenter Instructions
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6.6.1 Working with the Newsroom settings

Configuring NRCS Tags

To open the Newsroom Settings XML editor

1. Open the Manus Administrator console
2. Type ns followed by ENTER.
3. From the menu bar Edit > NCS Tags.

To save changes
Any changes made to the Newsroom Settings configuration must be saved:

1. Either

a. Go to File > Save, or,

b. Close the Newsroom Settings Editor and select Save.
2. Restart Manus Administrator for changes to apply.

Newsroom Settings Editor - Edit Menu

The Edit menu lists the configuration categories that are available.

5.3

NCS tags: Menu for assigning the NRCS command aliases from the newsroom system to the

corresponding Viz Mosart type. Each type can have multiple aliases. For example, Camera

type can have aliases CAM, CAMERA, KAM, KAMERA, and so on.

NCS omit stories: List of stories that should be ignored, and not displayed in the Viz Mosart

GUL.
NCS omit tags: (iNews only) List of iNews grommet commands that are ignored in Viz
Mosart.

NCS breakline stories: List of story names that are automatically converted to a Viz Mosart

break line story when the story is tagged as break.

NCS accessory stories: Viz Mosart interprets a story with this title as a story with accessories

only.

NCS lowerthird mapping: List for converting lower third template names from what is written

in the NRCS (origin) to the required template (translated) in the graphics system.
Transtype can be begins, exact or contains.

- Timecode character: Settings for textual analysis of timecode character, start character and

split character.
Keywords: Translation of CUT , MIX , WIPE and EFFECT transition keywords.

Lower third keep while background: Lower third variants that are kept on air for the duration

of the parent Viz Mosart template.

Lower third keep while story: Lower third variants that are kept on air for the duration of the

parent story.
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Lower third none auto out: Lower third variants that are kept on air until replaced by another
lower third of the same variant. Can be taken out with a keyboard shortcut (for example
HOME).

Lower third keep until manual taken out: Deprecated.

Pretake overlay on handler: Name of the overlay handlers that automatically take the first
lower third element in the next story on item types configured in Manus Administrator
Settings, Template allowing graphic pretake (same configurations for MOS Settings Editor
MOS or iNews).

The graphic is taken immediately regardless of its start time.

In the following example, only the graphics with destination DSK, WALL or WALL_2 are
pretaken.

Example

<pretakeoverlayhandlername>
<handlername name="DSK" />
<handlername name="WALL" />
<handlername name="WALL_2" />

</pretakeoverlayhandlername>

NCS device shortening: (iNews only) A list of aliases for clipname or clip_hirespath values
that can be used as newsroom tags in iNews grommets.

Parenthesis: Start and end parenthesis. Content within these parentheses is translated to Viz
Mosart commands. A value of (*) translates all commands in the form (** COMMAND ***) as
the * (asterisk) value is interpreted as one or more asterisks.

Story External Metadata: The NRCS can send external story values in a container

called mosExternalMetadata (MEM). These can be translated to Viz Mosart content, as
described in section Story External Metadata below.

Graphic Destination Letters: Used to identify the output and behavior of graphic elements.
See Graphic Destination Letters below.

A Note: Only applies Vizrt VCP MOS items and the use of the Viz Mosart extended data
element description.

Lower thirds type translation: (ENPS only) CG commands. Use this to translate a CG item to a
Viz Mosart primary story element
templatetype: CG template ID to translate
type: Viz Mosart primary story element
variant: Viz Mosart variant of the primary story element
transtype: begins, contains or exact. Describes the usage of the templatetype value
when searching the CG item.
Newsroom tag to lowerthird channel map: Translate the handler name of a graphic item into
the value defined by this mapping in the newsroomsettings.
For example, with the following configurations in newsroomsettings.xml:
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<inewstags>
<tags>
<tag name="CAMERA" type="CAMERA" scope="A11" />
<tag name="PACKAGE" type="PACKAGE" scope="A11" />
<tag name="VOICEOVER" type="VOICEOVER" scope="All" />
<tag name="VOICE OVER CLIPS" type="VOICEOVER" scope="All" />
<tag name="CG" type="LOWERTHIRDS" scope="A1ll" />
<tag name="FLOAT" type="ADLIBPIX" scope="A1ll" />
</tags>

<newsroomtypehandlernamemap>
<tag name="CG" value="DSK" />
</newsroomtypehandlernamemap>

</inewstags>

when a graphic MOS object is parsed in Viz Mosart and found to be a CG command as
defined in the <tag> node, Viz Mosart converts it to a Viz Mosart graphic item.

It then sets the handler_name attribute to DSK, based on the mapping defined in
<newsroomtypehandlernamemap> node

In this case, the graphic is redirected on the DSK channel of the configured graphic engine.
Omit text: (iNews only) Omit text from iNEWS presenters area.

Properties: (iNews only) iNEWS custom settings, see Overriding Default Field Names When
Parsing iNEWS Stories below.

Ignore parenthesis: (MOS-systems only) List of start and end parenthesis that encloses text
ignored in Viz Mosart.

MOS Id mapping: Enables Viz Mosart to recognize MOS elements from the NRCS and trigger
specific Viz Mosart actions when encountered. Must not be changed by the user.

See MOS ID Mapping below for a description of mapping MOS ID fields in

the newsroomsettings.xml file.

MediaObject property mapping: keywords specified during Viz Mosart installation for
installation-specific behavior of Viz Mosart. Should not be changed by the user.

Story External Metadata

The NRCS can share story values in a container called MosExternalMetadata (MEM). These values
can then be translated to Viz Mosart content. The values are:

mostagnhame: An XML element, often originating from a column name in the NRCS.
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@ You can derive this NRCS-assigned name for example in iNews, by Right-clicking >
Field Properties:

XPoint1 l)(pomt.? |XPoint3 Duration ’Custom [En‘
|SR First Story ID 03:00
Form Properties E]
Apply to:
Curmrent field Attrbutes Type
Label Label size J
Type =di size Lyt
Write Group
Text alignment Label placement Label alignment
Entries 4 K+ @
No Color
Text style Label style N |
| 7 _
In this example, the user friendly SR Base Name is stored internally in iNews as
var-007.

mos_value: This is the text that appears in the XML element mostagname (set in the NRCS).
Mosart Action:
template_type: Use a value from the NRCS to create a new Mosart item in the rundown
story. The value from the NRCS can be a newsroom tag of TEXT item scope. Newsroom
tags are configured in newsroomsettings.xml, (for example, CAM, KAM, KAMERA,
PKG).
You can also use the Viz Mosart type number, where for example, 0 is for Camera, 1
for Package. If the value from NRCS is empty, no item is created.
Example:

<mostag mostagname="var-1" mosart_action="template_type" format_type="Stri
ng" />

A new Viz Mosart item of type given in the NRCS column var-1 is created.
item_variable: Uses the value from NRCS to set a field on the first primary item found
in the story. Non-empty values overwrite any existing fields.

Example:
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<mostag mostagname="var-2" mosart_action="1dtem_variable" action_value="cli
p_hirespath" format_type="String" />
<mostag mostagname="var-3" mosart_action="ditem_variable" action_value="out
put_preview" format_type="String" />

The fields clip_hirespath and output_preview are set on the first primary item found in
the story, with the values taken from the columns var-2 and var-3 configured in NRCS.
item_duration: Use the value from the NRCS column as the duration for an item or
several items in the story.

If action_value is empty,

- the duration is applied to the first primary item in the story.

If action_value contains the template type of a Viz Mosart item (given as

a newsroomtag defined in the NRCS tags from Newsroomsettings or as a

number (for example CAM or 0) or a list of template types separated by comma,

- the duration applies to all items of that type.

For example: action_value=CAM or action_value=PKG, JINGLE or

action_value=0 or action_value=17,JINGLE.

If action_value contains pairs <type><separator><variant> or a list of such

pairs separated by a comma,

- duration applies to those specific items in the story.

For example: action_value=CAM=1 or action_value=CAM/1,PKG).

n_n ||||| n.n non

The <separator> can be "=",

n.n

N, or .
Use Format type to select if the value is given as seconds (integer), frames
(integer) or as a time code.
template_variant: Use the value from the NRCS to add or change the variant of the first
primary item found in the story.
template_transition: Use the value from the NRCS to add effect transitions to the first
primary item found in the story.
This also provides a good overview in the newsroom about which effects are used
between the stories.
For example:

<mostag mostagname="TranFromNcs" mos_value="SLIDE" format_type="String"
mosart_action="template_transition" action_value="MIX,24" />

Use the value from the NRCS to add effect transitions to the first primary item found
in the story.

The effect transition is given in the format <effect_name><separator><input>
, Where <separator> can be white space, bar (]), commag,), semicolon(;) or colon (:).
The <effect_name> can be EFFECT, MIX, WIPE or their translations as configured in

the Keywords section in Newsroomsettings.
For example, if EFFECT is mapped as EFFEKT in the Keywords section, we can add the
following effect to the Viz Mosart item: Effekt 2.
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story_variable: Use the value from the NRCS to set a field on all items (excluding
prompters and some secondaries with type > 300) found in the story. Non-empty
values do not overwrite existing fields.

story_duration: Use the value from the NRCS as the planned duration for this story.
Use Format type to select if the value is given as seconds (integer) or as a time code.
directtake_pre_story: Executes the direct take template given in the action_value at the
start of the story (in the switch from the previous to current story).
directtake_post_story: Executes the direct take template given in the action_value at
the end of the story (in the switch from the current to the next story).

guimarker_X: Translates the set of mostagname and mos_value to a marker in the GUI,
valid action_values are blank , O (green), 1 (orange) and 2 (red).

device_property: Sends a key-value pair to the device driver. For example, for

camera robots this can be used to adjust speed and camera positions.
story_endphrase: Use the value from the NRCS to override the endphrase attribute for
the last primary item in a Viz Mosart story.

segment_duration: Use the value from the NRCS to set the duration of a group of
stories.

words_per_minute : Sets the read rate for a story.

back_time: Sets the backtime attribute for a story (the exact time when a story must
start in order for the show to remain on schedule.). This is used to set a next break
time of the show. The break attribute must be set to true.

cume_time: Sets the cumetime attribute for a story - the amount of airtime required
from the beginning of the show up to a certain point in the show in order for the show
to remain on-schedule. This is used to set a next break duration of the show.

The break attribute must be set to true.

category: Sets the category attribute for a story used to identify a story category such
as sports, news, business etc.

field_value_X : Overrides the field value of a Viz Mosart item with the value stipulated
in the NRCS. This applies only to the first primary item in a story and the field must
already exist for that item. For example, if the first primary item in a story is a
Package with the following fields:

<fields>

<field name="clip_description" value="" default="" fieldtype="TEXT"
keylist="" />

<field name="clip_hirespath" value="" default="" fieldtype="TEXT"
keylist="" />

<field name="metadata_lookuppath" value="" default="" fieldtype="TEXT"

keylist="" />

</fields>

and the following mappings are given in newsroom settings:

<mostag mostagname="ClipDescrCol" mosart_action="field_value_1"
action_value="clip_description" format_type="String" />

Copyright © 2023 Vizrt Page 107



<mostag mostagname="ClipIdCol" mosart_action="field_value_2"

Viz Mosart Administrator Guide - 5.3

clip_hirespath=MyClip" mos_value="test" format_type="String" />

then the field is set to the value given in the NRCS in the column with id
ClipDescrCol and the field clip_hirespath are set to the value MyClip if the value from
column ClipldCol in the NRCS is test.

action_value="

A Note: The attribute action_value for <mostag> node in newsroom setting can
contain the field name or pairs of field name=field value separated by comma,
colon, semi-colon, dash, equal or bar.

asruninfo: Sets the attribute asruninfo for all items in a Viz Mosart story. This is used
to store specific information that is stored in the AsRunlLog.

Graphic Destination Letters

EMosart Newsroom Settings - ¢ ,channeltemplates’ newsroomsettings.xmil ;[g|5|
File  Edit Graphic destination Letters

Drestination mapping | Graphic type Templatetype field Dezcription fields Usze TC Out MOS object delimiter Mozart object delimiter TC format
_ Lawerthird il o False rarr: =5 FF
1 Super Lowerthird 0 on Falze 4

cgw whall 21 Falze

I whall_1 gl Falze

B Wwall_2 2 Falze

Arnythingroutw/ant wallM a2 Falze mim;ss:ff

F Fullscreen o Falze

T TEST true hib: rrnn: s:5: £

T2

Test

ff

T

T

TRT

TKT

Graphic destination letters identify output and behavior for graphics elements. Use them to parse
a Vizrt MOS object and obtain a Viz Mosart object.

Properties

Each row contains the following columns:

Destination mapping: The mapping defined in the Viz Mosart command from Viz super.
Graphic type: Used to identify the output for the graphics elements, either on predefined
channels:
Fullscreen: Full screen graphics for FULL output (channel)
Lowerthird: Overlays for DSK output
Wall: Overlays for WALL output
WallIN: Overlays for outputs WALL_1, WALL_2, WALL_3 etc.
Ticker: Ticker for TICKER output
or on custom channels (so any string can be set as graphic type).
Templatetypefield: Index of the description field which is set as the TemplateType. (the
value of the description field found at the specified index). The index is 0-based. Default:
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empty.
For example: If the MosAbstract is: <mosAbstract>fieldl/field2/field3/field4/
Mosart=S|00:04|00:10</mosAbstract> , and you set Templatetypefield=1

, then the templatetype attribute from the Viz Mosart object is setto field2 .

Descriptionfields: A list of indexes of the fields which should be shown in the description of
a Mosart story item. These fields are shown in the Viz Mosart GUI separated by the character
given in the outputtxtdelimiter setting. The indexes are 0-based and are separated using a
pipe ‘|’ character.

For example: descriptionfields="0/1". Default: empty.

Use TC Out: Specifies if the duration should be used as tc_out.

Inputtxtdelimiter: Vizrt MOS object delimiter. Default: ‘/’ (slash)

Outputtxtdelimiter: Viz Mosart object delimiter. Default: ‘/’ (slash)

Mask: Specifies the timecode format of the graphics starting time, end time or

duration. Default: mm:ss. Example of formats: hh:mm, hh:mm:ss, mm:ss:ff, mm:ss, ss:ff, ff.

Mapping example:

<graphicdestinationletters>

<graphicdestinationletter destinationmapping="L" type="Lowerthird"
templatetypefield="1" descriptionfields="0|1" use_tc_out="False" +inputtxtdelimiter=""
outputtxtdelimiter="" mask="mm:ss:ff"/>

<graphicdestinationletter destinationmapping="Super" type="Lowerthird"
templatetypefield="0" descriptionfields="0|1" use_tc_out="False" +inputtxtdelimiter="|
" outputtxtdelimiter="%" mask=""/>

<graphicdestinationletter destinationmapping="cgw" type="Wall" templatetypefield=""
descriptionfields="2|1" use_tc_out="False" qinputtxtdelimiter="" outputtxtdelimiter="
ll/>

<graphicdestinationletter destinationmapping="A" type="Wall_1" templatetypefield="1

" use_tc_out="False" tinputtxtdelimiter="" outputtxtdelimiter=""/>
<graphicdestinationletter destinationmapping="B" type="Wall_2" templatetypefield="2
" use_tc_out="False" tinputtxtdelimiter="" outputtxtdelimiter=""/>

<graphicdestinationletter destinationmapping="AnythingYouWant" type="WallN"
templatetypefield="" descriptionfields="0|1|2" use_tc_out="False" inputtxtdelimiter="
" outputtxtdelimiter="" mask="mm:ss:ff"/>

<graphicdestinationletter destinationmapping="F" type="Fullscreen"
templatetypefield="" descriptionfields="0|1" use_tc_out="False" qinputtxtdelimiter=""
outputtxtdelimiter=""/>

<graphicdestinationletter destinationmapping="T1" type="TEST" use_tc_out="true"
mask="hh:mm:ss:ff"/>

<graphicdestinationletter destinationmapping="T2" type="Test" mask="ff"/>

<graphicdestinationletter destinationmapping="T" type="T"/>

<graphicdestinationletter destinationmapping="TXT" type="TXT"/>
</graphicdestinationletters>

Walls
There are two ways to support a configurable number of walls:
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1. By having a general rule in the graphics destination mappings where the graphics type must
be WalIN. The destionationmapping attribute can be set to any string of alphanumeric
characters.

<graphicdestinationletter destinationmapping="Walls" type="WallN"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>

In this case, the Vizrt graphic objects must contain a Viz Mosart string command ending in a
number (this provides the wall number).
For example:

Mosart=cgwl|00:00|00:05
or
Mosart=something2|M|S
or
Mosart=wall3|00:00|B
or Mosart=W4|00:04|00:10

and so on.

Given these examples, the destination for the first graphic is WALL_1, followed
by WALL_2, WALL_3 and WALL_4, respectively.

2. By not ending the Viz Mosart string destination mapping with a number.
For example:

Mosart=B|00:00|00:05, Mosart=Z|00:00|00:05, Mosart=Wall|00:00|00:05,
Mosart=Something|00:00|00:05

and so on.

In this case, the configuration in newsroomsettings must specify the wall number in
the graphics type. For the Mosart string examples given above, the configuration can
therefore be:

<graphicdestinationletter destinationmapping="B" type="Wall_2"

templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>
<graphicdestinationletter destinationmapping="Z" type="Wall_3"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss" />
<graphicdestinationletter destinationmapping="Wall" type="Wall_4"
templatetypefield="" descriptionfields="-1" use_tc_out="False"
inputtxtdelimiter="" outputtxtdelimiter="" mask="mm:ss"/>
<graphicdestinationletter destinationmapping="Something" type="Wall_5"templatet
ypefield="" descriptionfields="-1" use_tc_out="False" inputtxtdelimiter=""
outputtxtdelimiter="" mask="mm:ss" />

Overlays with
Mosart=B|00:00|00:05
are then redirected to WALL_2, those with Mosart=Z|00:00|00:05 to WALL_3 and
so on.
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As well as redirecting graphics to predefined destinations like DSK, WALL, WALL_i, FULL, the
graphic destination letters rules can be used for any desired destination.
For example:

<graphicdestinationletter destinationmapping="T" type="TEST" templatetypefield=""
descriptionfields="-1" use_tc_out="False" inputtxtdelimiter="" outputtxtdelimiter=""
mask="mm:ss"/>

and a Vizrt graphic with Mosart string T|00:00|00:06 sends the graphic for playout on the
channel TEST.

6.6.2 Viz Mosart Object Structure

When building a graphic Viz Mosart object from a Vizrt MOS object, an XML structure is created:

<item type="100" slug="L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06" source="1"
index="100___2_5" didref="5" templatetype="TIMECODE-DSK" status="0" error="Q@" in="Q"
dur="150" pin="0" pdur="150" rdur="0" externaleffect="" intimeline="true" date_0=""
accessory="False" static="false" endfrase="" mosid="PILOT" objid="121" ismoselement="
true" use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TI
MECODE" description="(DSK) - L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06"
auto_continue="false">
<fields>

<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith|Vizrt
reporter|Mosart=L|00:00|00:06"/>

<field name="graphics_id" fieldtype="TEXT" value="121"/>

<field name="tc_dur" fieldtype="TIMECODE" -inputmask="mm:ss" default="00:00" value="
00:06"/>

<field name="continuecount" value="-1" fieldtype="TEXT"/>

<field name="payloaduri" value="http://bgoemo:8177/dataelements/121/payload"
fieldtype="TEXT"/>

<field name="thumbnailuri" value="http://bgoemo:8177/dataelements/121/thumb"
fieldtype="TEXT"/>

<field name="tc_in" fieldtype="TIMECODE" +inputmask="mm:ss" default="00:00" value="
00:00"/>

</fields>

</item>

The graphic slug is used to visualize the graphics in the Viz Mosart GUI Assets window or in the
Overlay Graphics interface, for example. The slug is taken from MosAbstract found in the Vizrt
MOS object and the fields delimited by the inputtxtdelimiter are replaced with outputtxtdelimiter.

Viz Mosart can receive several types of Vizrt MOS graphic objects from the NRCS, including a

Vizrt MOS Item With Payload Data Nodes and a
Vizrt MOS Item Without Payload Data Nodes.
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Vizrt MOS Item With Payload Data Nodes

If a Vizrt MOS item contains <mosPayload> with data entries, then the graphics_description is
built from these data nodes delimited by outputtxtdelimiter.

The property inputtxtdelimiter is used only to build the slug, not the description.

If descriptionfields is empty, then the graphics_description attribute from the Viz Mosart item
(created from the Vizrt MOS item) is set to the slug value (created from MosAbstract, see above).

If the field is populated, the slug is set to the description created from data nodes entries where
only the data nodes from the positions specified in the descriptionfields are added and separated
by outputtxtdelimiter.

Example 1:

Using a Vizrt MOS item containing the following values:

<mosExternalMetadata>
<mosScope>0BJECT</mosScope>
<mosSchema>http://www.vizrt.com/mosObj/data</mosSchema>
<mosPayload>
<data>
<entry name="data">
<entry name="">
<entry name="" type="widestring">Navn/Titel/Sted</entry>
</entry>
<entry name="1" description="Name">
<entry name="1" description="Name" type="richtext" upper="true" singleline="
true" location="2/3/1/1">L3-Anna Smith</entry>
</entry>
<entry name="2" description="Title">
<entry name="2" description="Title" type="richtext" upper="true" singleline="
true" location="2/2/2/1">Vizrt reporter</entry>
</entry>
<entry name="Mosart">
<entry name="Mosart" type="widestring">Mosart=L|00:00|00:06 </entry>
</entry>
</entry>
</data>
</mosPayload>
</mosExternalMetadata>

apply the following mapping:

<graphicdestinationletters> <graphicdestinationletter destinationmapping="L" type="Lo
werthird" templatetypefield="" descriptionfields="" [dinputtxtdelimiter=""
outputtxtdelimiter="|" /> </graphicdestinationletters>

Note that inputtxtdelimiter is empty, so the default * / ’is used.
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The result is the following Mosart item. Note the slug and description attributes and

graphics_description field:

<item type="100" slug="L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06" source="1"
index="100___2_5" ddref="5" templatetype="TIMECODE-DSK" status="0" error="0" in="0Q"
dur="150" pin="0" pdur="150" rdur="0" externaleffect="" intimeline="true" date_o=""
accessory="False" static="false" endfrase="" mosid="PILOT" objid="121" ismoselement="
true" use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TI
MECODE" description="(DSK) - L3-Anna Smith|Vizrt reporter|Mosart=L|00:00|00:06"
auto_continue="false">
<fields>

<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith|Vizrt
reporter|Mosart=L|00:00|00:06"/>

<field name="graphics_id" fieldtype="TEXT" value="121"/>

<field name="tc_dur" fieldtype="TIMECODE" -inputmask="mm:ss" default="00:00" value="
00:06"/>

<field name="continuecount" value="-1" fieldtype="TEXT"/>

<field name="payloaduri" value="http://bgoemo:8177/dataelements/121/payload"
fieldtype="TEXT"/>

<field name="thumbnailuri" value="http://bgoemo:8177/dataelements/121/thumb"
fieldtype="TEXT"/>

<field name="tc_in" fieldtype="TIMECODE" +inputmask="mm:ss" default="00:00" value="
00:00"/>

</fields>

</item>

Example 2:

Using the same Vizrt MOS item as above, but with the following mapping:

<graphicdestinationletter destinationmapping="L" type="Lowerthird" templatetypefield="
1" descriptionfields="0|1" outputtxtdelimiter="%" />

In the result below you can see that the delimiters are now ‘%’ instead of ‘|’. Note
that templatetype is set to the value found at index 1.

<item type="100" slug="L3-Anna Smith%Vizrt reporter" source="1" index="100___2_5"
idref="5" templatetype="Vizrt reporter" status="0" error="0" in="0" dur="150" pin="0"
pdur="150" rdur="0" externaleffect="" dintimeline="true" date_0="" accessory="False"
static="false" endfrase="" mosid="PILOT" objid="121" dismoselement="true"
use_graphics_id="true" graphics_id="121" handler_name="DSK" graphics_out_on="TIMECODE
" description="(DSK) - banner%Anna Smith" auto_continue="false">

<fields>

<field name="graphics_description" fieldtype="TEXT" value="L3-Anna Smith%Vizrt

reporter" />

</fields>
</item>
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Vizrt MOS Item Without Payload Data Nodes

MosAbstract

If the Vizrt MOS item does not contain data nodes, but has MosAbstract set, then the slug and the
description are built from MosAbstract.

In this case, inputtxtdelimiter is taken into consideration when building both the slug and
description.

Similarly, if descriptionfields is empty, the graphics_description attribute from the Mosart item
(created from the Vizrt MOS item) is set to the slug value (created from MosAbstract, as explained
above).

Otherwise, the slug is set to the description built as explained above from MosAbstract where only
the fields from the positions specified in descriptionfields are added and separated
by outputtxtdelimiter.

Example 3:

Using the following Vizrt MOS Item:

<mosAbstract>00:00 | Super Tema + info | 26 | 1:Tema | 2:This 1is what the item is all
about |Mosart=S|M|00:04</mosAbstract>

apply the following mapping:

<graphicdestinationletters> <graphicdestinationletter destinationmapping="S" type="Lo
werthird" templatetypefield="" descriptionfields="1|3" dinputtxtdelimiter="|"
outputtxtdelimiter="%" /> </graphicdestinationletters>"

The result is:

<item type="100" slug="Super Tema + info%l:Tema" source="1" index="100___2_2" +idref="
2" templatetype="TIMECODE-DSK" status="1" error="0" in="0" dur="100" pin="0" pdur="10
0" rdur="0" externaleffect="" 1dintimeline="true" date_0="" accessory="False" static="f
alse" endfrase="" mosid="VIZ.NPRO.MOS" ob7jid="1529718" -ismoselement="true"
use_graphics_id="true" graphics_1d="1529718" handler_name="DSK" graphics_out_on="TIME
CODE" description="(DSK) - Super Tema + 1info%l:Tema" auto_continue="false">
<fields>
<field name="graphics_description" fieldtype="TEXT" value="Super Tema +
info%l:Tema"/>
<field name="graphics_id" fieldtype="TEXT" value="1529718"/>
<field name="tc_dur" fieldtype="TIMECODE" -inputmask="mm:ss" default="00:00" value="
00:04"/>
<field name="continuecount" value="-1" fieldtype="TEXT"/>
<field name="payloaduri" value="n/a" fieldtype="TEXT"/>
<field name="thumbnailuri" value="n/a" fieldtype="TEXT"/>
</fields>
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</item>

6.6.3 Viz Mosart and Viz Content Pilot (VCP) MOS Item Integration

Vizrt MOS items do not contain any information about playout channel destination. By adding an
optional Mosart-part in the Vizrt data description, properties for channel destination, automatic or
manual play-out and timing information can be extracted from the MOS item.

This section presents the Vizrt MOS item metadata required to allow Viz Mosart to separate play-
out channel and extract timing information.

Basic requirements

Viz Mosart requires details on whether the graphics element is a lower third, a graphics played out
on a video wall engine, or a full screen graphics. Any graphic requires the following properties:

Destination: lower third, video wall or full-screen graphics
For lower thirds/video walls:
- Play-out: manual or automatic
- For automatic play-out: in time
- Duration/out time or the special durations background end, story end or open end
Mosart item (optional): Stored at the end of the description of the data element or as a
specified field in the mosExternalMetadata section of the MOS item and is formatted as
follows:
Mosart={destination}|{in behaviour}|{out behaviour}|{X}|{F}
where
- {destination} is an alphanumeric string specifying the destination of the graphic.
Suggested values are L=lower third, W=wall, F=full screen graphics
- {in behaviour} is
- either M for manual play-out
- or a time code formatted as mm:ss (minutes, seconds) as in time
- {out behaviour} is
- either a time code formatted as mm:ss (minutes, seconds) as duration
- or a single character field with values B, S or O where B=background end, S=story
end and O=open end
- Xis used only for lower thirds to ignore “Replace TakeOut Logic” meaning that when
taking and taking out the item, the replace logic is ignored if the value is set on the
item
F is used only for lower thirds to force “Replace TakeOut Logic” for graphics coming
from different templates with same layers (when used, it practically ignores the “O”
state for a layer). Not to be confused with destination letter “F” often used for full
screen graphics.

The rules which define the output and behavior for graphics elements can be configured
in Graphic Destination Letters.

Field Example:
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The following table contains examples of the Mosart= part of the Vizrt data element description in
the value cg_gordon_brown/prime minister/Mosart=L|00:02]00:05. The data element is played out
as a lower third, automatically in at two seconds with five seconds duration.

L|00:02|00:05 Lower third, automatically in at 2 seconds with 5 seconds
duration
L|00:02|S Lower third, automatically in at 2 seconds with duration equal

to the length of the story (taken out at the switch from one
story to the next)

L|00:00|O Lower third, automatically in at O seconds, never taken out
(except for when replaced by another item or manually from
the operator)

LIM|00:05 Lower third, manual play-out, duration 5 seconds

L|00:00/00:10|X Lower third, automatically in at O seconds with 10 seconds
duration and Replace TakeOut Logic is ignored

W|00:00|B Video wall, automatically in at 0 seconds, out when switching
from one story element to another

F Full screen graphics (note that this letter is usually used for
full screen graphics, but any combination of alphanumeric
characters can be used to identify a fullscreengraphic)

If no fields are given, the element defaults to a full screen graphics element.

VCP template requirements

The Mosart field is supported when embedded as a part of the VCP data element description or as
a dedicated field in the mosExternalMetadata section.

Storing the Mosart field in the VCP data element description

When saving the VCP data element, the Mosart field shall be appended to the stored database
description (the name of the data element).

Storing the Mosart field in the mosExternalMetadata section of the VCP data
element

This method is only supported if the mosExternalMetadata data section is enabled for the VCP
Template Filler ActiveX. See Appendix A for configuring the ActiveX to include this section in the
MOS object.

The scene needs a ControlObject. The Mosart field should be stored in a hidden text field in the
template, and the text field shall use Mosart in the ControlObjectName property. The Mosart field
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can either be included in the scene or added manually after importing the scene to the Viz
Template Wizard.

VB script Example

The following VB script can be used in a Vizrt Template Wizard template and returns a properly
formatted Mosart field string:

'' Method that returns a properly formatted Mosart description
Function GetMosartDescriptionPart(AType, AVariant, AOperation, ATCIn, ATCOut)
'Template variant
Dim FType, FVariant, FDefaultVariant, FDefaultOperation
Select Case AType
Case "LOWER"
FType = "L" 'LOWER (lower third, over shoulder gfx)

If AVariant = "" Then
AVariant = "AUTOOUT"
End If
Case "WALL"
FType = "W" 'LOWER (lower third, over shoulder gfx)
If AVariant = "" Then
AVariant = "OPENEND"
End If
Case Else
"FType = "F" 'FULL (fullscreen)
GetMosartDescriptionPart = "Mosart=F"
Exit Function
End Select

'Take out logic (Only applies for lower thirds)
FVariant = TranslateVariant(AVariant)

'Operation selection
Select Case AOperation
Case "MANUAL"
FOperation = "M" 'FULL
FTCIn = FOperation
If (FVariant="A") Then
FTCOut = ATCOut
Else
FTCOut = FVariant
End If
case else 'case "AUTO+"
FOperation = "A" 'AUTO+
FTCIn = ATCIn
If (FVariant="A") Then
FTCOut = ATCOut
Else
FTCOut = FVariant
End If
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end select

GetMosartDescriptionPart = ToMosartProperty(FType, FTCIn, FTCOut)
End Function

Function ToMosartProperty(AType, ATCIn, ATCOut)
splitChar = "|"
Dim vals
'vals = vbNewLine
If Not AType = "" Then
vals = vals & "Mosart="
vals = vals & AType
If Not ATCIn = "" Then
vals = vals & splitChar & ATCIn
If Not ATCOut = "" Then
vals = vals & splitChar & ATCOut
End If
End If
End If
ToMosartProperty = vals
End Function

Function TranslateVariant(AVariant)
select case AVariant
case "OPENEND"
TranslateVariant = "0" 'OPENEND
case "STORYEND"
TranslateVariant = "S" 'STORYEND
case "BACKGROUNDEND'
TranslateVariant = "B" 'BACKGROUNDEND
case else 'case "AUTOOUT"
TranslateVariant = "A" 'AUTOOUT
end select
End Function

Viz Pilot plugin Prerequisites

To enable the mosExternalMetadata section in the Viz Pilot News (Active X) plugin, the system
administrator must also enable a field in the VCP parameters list in the Viz Pilot database.

If you Viz Pilot 5.7 or later, this setting is available in the Viz Pilot Data Server settings page found
in:

http://[hostname of PDS]:8177/settings#Params

VCP parameters Search Providers Tag settings

e==l A Filter: ::4

MHame= = WValus Dh==criplion

ax_add_dbdata_to_mossxbernal Adds mxbrs information about the dats in the =lement o Bhe mos it=m

In the Value column, the checkbox should be checked (set to true).
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If you have a Viz Pilot version older than 5.7 this is easily achieved by opening the Preferences
editor in the Viz Content Pilot (Options - Preferences — Advanced), by adding or editing the field
called ax_add_dbdata_to_mosexternal setting the value toy.

=rer

?"SpeHcheck
- Resource Plugins

6.6.4 MOS ID Mapping

A MOS Id mapping can be performed in the newsroomsettings.xml file, as follows:

<mosids>

<tag name="" value="" fieldMapping="" appendContent="" embeddedMosartItem=""
keywords="" />
</mosids>

Where:
name: The MOS ID that identifies the MOS elements coming from the NRCS.
- value: The mapping ID used to identify a mapping for MOS element fields to be parsed. The
MOS element's fields to be parsed are defined using
<mosmaps> (/mmConstants/xmltemplates/mosmaps/mosmap/).
- fieldMapping: Set to true if field mapping should apply.
appendContent: Set to true if the mapping should be appended to the Viz Mosart element
item.
embeddedMosartltem: Set to true if the MOS element has a Viz Mosart command embedded.
keywords: Currently only the MOS parsing of Vizrt objects uses this column. It contains a
comma-separated list of device-specific values.
novideo : Adding this excludes video clip information from Vizrt Video MOS objects,
and only uses the lower thirds of the MOS item. The video ID can then be given from
any other MOS object, or a story field. For example the video id column in iINEWS.
nodefaultitem: Adding this excludes Vizrt full-frame graphics if no default item is
found (when missing Viz Mosart template).
IgnoreTemplateSet (or IgnoreTemplateSet=true ): When added to a MOS ID

named "MOSART" , the templateset attribute from a MOS object coming from the

NRCS is ignored.
For example:
<tag name="MOSART" value="" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet=true"/>
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6.6.5 Additional Newsroom Settings Examples

Defining Default Values for Lower Thirds

You can set default values for parsing of lower third objects. Usually these values are set from the
objects received from the NRCS. Altering these values is usually part of a customization task.

In newsroomsettings.xml add the default values to the mmConstants/inewstags/

properties element:

<mmConstants><inewstags>
<properties>

<item name = "DefaultLowerThirdDuration" value = "125"/>
<item name = "DefaultLowerThirdHandlerName" value = "DSK"/>
<item name = "DefaultLowerThirdOutBehaviour" value = "TIMECODE"/>
<item name = "DefaultLowerThirdOwnerMedia" value = "MEDIA"/>
</properties>

</inewstags></mmConstants>

Lower Third Properties

Property Description Default value

DefaultLowerThirdDuration The default duration of a TIMECODE 125
lower third, in frames

DefaultLowerThirdHandlerNam  The default graphics destination / DSK

e handler

DefaultLowerThirdOutBehaviou The default out behaviour TIMECODE
r

DefaultLowerThirdOwnerMedia The default owner attribute for MEDIA

secondary NRCS objects

iINEWS: Overriding Default Field Names when Parsing Stories

When parsing the iNEWS NSML, the system extracts various field values using default field names.
These defaults can be overridden by setting new values in Newsroom Settings > Edit > Properties.
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-

EJ * Mosart Newsroo... l = | (=] |_£h]1

File  Edit

name value

» s
FieldNameClipHiresPath | my-video4d
FieldMame Total Time my-totaltime
FieldMameVideoTime | my-videotime
FieldMame Text Time - extdime

Field name iINEWS default field Description

name

FieldNameShowld id The house ID of the show. Used for as-
run logging.

FieldNameClipHiresPath  video-id The video ID column. The field is
appended to the first primary element in
the story.

FieldNameTotalTime total-time The total planned duration for the story.

FieldNameVideoTime tape-time The video time of the story.

FieldNameTextTime text-time The iNEWS-calculated text time of the

story. If the total time is not available,
the value is calculated using this value is
added to video time.

iNEWS: Presenter Instructions

You can use Mosart commands as presenter instructions in iNEWS for item types CAMERA,
PACKAGE, VOICEOVER, ENDFRASE, ATTACHA, CLIPSTART, FULLSCREENGRAPHICS, DVE,
TELEPHONEINTERVIEW, BREAK, JINGLE, LIVE, ADLIBPIX, CLIPHIRESPATH and ACCSESORIES.

A presenter instruction (red text) command in iNews is a text command written in the story script.
The journalist designates text as a presenter instruction by selecting the text, right-clicking and
selecting Format > Presenter Instruction (or shortcut Ctrl+Alt+P). The selected text appears in red
indicating it is not standard story text.
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Package - pi clip with specia VizriTesti ONLINE
Package - p ransiion after ONLINE
Package  pl muliple cips VizriTest] ONLINE
Package - pi- absolutetime ONLINE
Package - piinvalid variant T e Tz
Package with clip mark in +
......................... cut CtrieX
Voiceover-col Copy cttec 1 Iabtest3
Voiceover - col invalid varia Paste cHisv DvPal2s
Voiceover - activex Selectll Ctri+A
Voiceover - grommet
Voiceover - grommetinvalid eamdinad D
Voiceover-pi Bt W Fon
- e L e Insert Script Template ShifteCtri+l Be oms |
PAGE  MOSACTVE DIRECTTAKE DT b e S
Hide Production Cues Lndertine cti-u
Insert Production Cue Alt+ins. Normal Text Clri+Alt+N
Audio  TAL  SLUG CAM s
1 Insert Priman Shift+Alt+ins v Presenter Instructions Clri+Alt+P
Package - pi muliple clips [
Insert Placeholder Closed Caption Ctri+Alt+C
MODIFIED: MOD BY. EDITOR  WRITER|  Titing ShifeCt1-T e
3/15/20231645:32  [|mosart Importfrom Plugin 3 = 1
Launch hyperlink into default applicatio ShifteCtri+Y
PKG 1 MIX=20 Launch hyperlink into INEWS web browser workspace Shift+Ctri+P
PKG 2 EFFEKT=1 Copy story link to clipboard Shift+Ctri+K.
|*auroraclip VizitTest1 (SOT) ° Block Time Shift+Ctri+B.
Play Low-res Vide Shift+Ciri+D
PKG 3WIPE:30 CLIFw=viznres
This is standard text
PKG FixedDur10 clipid=ViztTest3
PKG T MIX|10 clipid=AT00
PKG fixeddur20 mix5 clipid:A100

To set up presenter text

Before working with presenter text in iNEWS, so one-off setups must first be made in Viz Mosart.

1. In Template Editor make sure you have template types defined for all (except for
Cliphirespath and Endfrase which are not template types) the item types listed above.

a.
editor.

In Viz Mosart's AV Automation console, from the menu bar select Devices > Template

b. You will use presenter commands without specifying a template variant.
You need to create a template variant with the same name as the newsroom alias, as
shown below.

% o e ca - o X ||HEwe
File ~ Template - Template Set + DE - Fie  Edit NGS tags
Funcspec Newsroom aizs | Mosat e em scope
CAMERA +CAM T CAVERA CAVERA B =
PACKAGE PACKAGE ~la -
VOICEOVER VOICEOVER B =
o VOICE OVER CLIPS | VOICEQVER ~la -
FULL SOUND CLIPS | PACKAGE ~la =
os LvE ~la =
VIDEO EFFECT | DVE | A =
General Cortrl Commands  Newstoom tags orer = =
PHONO TELEPHONENTERVIEW = Al =
Name Type Variznt Description el S0UND PLAYSOUND ~la =~
== e [mcrpton esteinfebes| | OUTOUE evosse B
GRAPHICS FULLSCREENGRAPHICS | Al -
] Default NCS variant [ Usestate varianis R curoUR B &l
Sendto NCS o ca LOWERTHIRDS A -
Freload =l | o COMMAND COMMAND ~[a -
ok 51 |1 fioar soUsPx ECEE
[ Teke ot planned story in-time 2 Y ACCESSORIES | ACCESSORIES =l =
[] Fixed Duraion W00 ROLLCUE ENDFRASE B -l
[ Story Duration =2 pern FULL PACKAGE ~ln =
[JAutotake next  Ofiset Reset Site - VOICEOVER A =
y BN CAVERA ~la -
Rese Siate Afir | 2 | Stories OUTSIDE SOURCE [LIVE = N
Laststate WACRO WACRO B =
VARKER VARKER ~la =
Single State B3 FULLSCREENGRAPHICS | Al =
LOWERTHRDS | LOWERTHIRDS ~la =
an VOICEOVER B =
[ Sub Sequence Loop oo JucEOuER u
] Hide from user Cancel oK

2.
types:

If not already defined, you must first add newsroom aliases for each of the following item

Camera, Package, Voiceover, Live, Dve, Telephoneinterview, Break, Jingle, Adlibpix,
Accessories, Cliphirespath, Endfrase.
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& Note: There can be several newsroom aliases for the same item type.
You can use any of them for commands in your iNEWS story for defining a Mosart
story item in a Mosart template.

. In Viz Mosart's Manus Administrator console, type ns.
From the menu bar, select Edit > NCS tags.
c. Create mappings for any of the item types above that do not yet have an alias.

O o

To work with presenter text

The following general commands can be used for CAMERA, LIVE, FULLSCREENGRAPHICS, DVE,
TELEPHONEINTERVIEW, BREAK, JINGLE:

<ncs-alias> <varijant> <transition><sep><value>

where
<ncs-alias> is a Newsroom alias for the supported Mosart template types as defined in

Mosart Manus Administrator > Edit > NCS tags:
For example, the NcsAlias could be cam of type CAMERA.

<variant> is a template variant defined in the Template Editor (step 1 above) for the given

type.

If no variant is provided in the command, <ncs-alias> is used as template variant, which is

why you need to have a template defined in Template Editor with variant <ncs-alias>.
<transition> is the video transition when switching from one story item to the next in a
show.

5.3

Can be by default mix, wipe or effect. The value for mix and wipe is the rate of the transition

(in frames), while for the effect this is the effect number (Physical Input) configured in AV

Automation > Devices > A/V setup.

A Note: For <transition>
- Names are not case sensitive.
You can use a separator equal (=), bar(|) or colon ( :).
Default Viz Mosart naming can be overridden with preferred names by

navigating to the Mosart Manus Administrator console, typing ns followed by

ENTER. Then Edit > keywords and mapping a new value to the default name.

B *Mewsroom Settings (c\channeltemplates\newsroomsettings.xml)

File Edit kevwords

name value
EFFECT |EFFEKT

MIX MicU
~ lcut KLIPP]
WIPE WIPE

This could, for example, be a local language text.
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To work with clips

You can specify the clip id for clip types (PACKAGE, VOICEOVER or ADLIBPIX), enabling multiple
clips to be added to a single story.

The command format is:

<ncs-alias> <variant> <transition><sep><value> clipid=<clipname>

where:

- <ncs-alias> is a Newsroom alias for the supported clip Mosart template types (PACKAGE,
VOICEOVER, ADLIBPIX) in Mosart Manus Administrator > Edit > NCS tags.
For example, the NcsAlias could be pkg of type PACKAGE.

- clipid assigns a clip to the Mosart item created with this command.

& Note: For <clipname>
- This is the name of a clip residing on the MAM system controlled by Viz
Mosart.
- clip name must not contain spaces.
- This parameter is useful when defining multiple clips in the same story. The
first clip can get the clip id from the VID-ID column, the other clips using this
option on the command line.

If clipid is given for the first clip in the story, this overrides the value given in the VID-ID
column.

- <transition>: same as above.

- @ character. The absolute time field will be added to the element indicating that the element
will be prepared and taken on at absolute time from midnight.

To attach a clip to last Viz Mosart item
The type CLIPHIRESPATH can also specify a clip id that will be attached to the last Mosart item.

The full command is

<ncs-alias> <clipname>

where

- <ncs-alias> is a Newsroom alias of type CLIPHIRESPATH as defined in Mosart Manus
Administrator > Edit > NCS tags.

To work with accessories
The type ACCESSORIES can be used with manual or time-controlled takes.

The command format is
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For auto accessory with timecode in and/or timecode out relative to the start of the story
item:

<ncs-alias> <variant> tc-in=mm:ss tc-out=mm:ss

For manual accessory which can be taken manually or executed at the absolute time
specified by @:

<ncs-alias> <variant> @hh:mm:ss|@hh:mm

where;

<ncs-alias> is a Newsroom alias of type ACCESSORIES as defined in Mosart Manus
Administrator > Edit > NCS tags.
tc-in is the time when the accessory is taken in, relative to a story item start.

& Note:
If no tc_in is given, the accessory is considered manual.

Other keywords for tc-in are tcin, tc_in or simply in
tc-out is given to calculate the duration for an accessory item.

& Note:
Other keywords for tc-out are tcout, tc_out or simply out

@ character. Same as above.

To work with an end phrase
This command attaches the text given in the command to the story item preceding this command.

The command format is

<ncs-alias>=some text

The text is displayed in the Program area in Viz Mosart Ul if Show end phrase is enabled for
this template type, from the menu

Viz Mosart Ul > Tools > General settings > Preview/Program window > End phrase bar

> Show end phrase <type>.

6.7 Field Mapping

The custom MOS object mapping is a setup which extracts field values from foreign MOS objects
and translates these into Viz Mosart fields. This is done in the newsroomsettings.xml
configuration file. This simplifies integration, as no new code needs to be deployed.
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- The Tool Set
- What to Configure
- Target Fields
Mapping Source Fields to Target Fields
Examples
- Video Server Item
Graphics Item
Harris Video Objects in Octopus

6.7.1 The Tool Set

Default configurations are available as part of newsroomsettings.xml file.
- Select content from XML using simple XPath 1.0 expressions.
- Concatenate the XPath result using a separator.

Replace parts of the result using static or dynamic variables.
- Apply conversion rules for the specific field type.

6.7.2 What to Configure

Reuse or modify existing MOS field mapping in newsroomsettings.xml.
- Add MOS Id map entry using newsroom settings editor.
Newsroom alias: MOS ID of foreign item.
- value: Field mapping entry name.

5.3

- appendContent: appends the complete MOS object to the internal Viz Mosart <item />

as a _<content /> _sub child.
- embeddedMosartltem: signal if the item has a Viz Mosart item embedded.

6.7.3 Target Fields

Target fields is a list of the fields used when controlling a video server or graphics elements.
Video Server

- clip_hirespath: The name or ID of the video file.

- clip_description: A human-readable description of the video file (optional).
- clip_dur: The duration of the video file.

- clip_mark_in: The start frame of the video file (optional).

Graphics Systems

- graphics_id: The ID of the graphics item.

- graphics_description: A human-readable description of the graphics item.
- tc_in: Planned in time for the item relative to the parent item.

- tc_dur: Planned duration for the item.

- graphics_profile: The graphics concept context this item should be forced to play in. This

value is forwarded to graphics systems supporting concepts for graphics when cueing and

playing an item.
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- graphics_category: Used in CG Take Out Logic to identify graphics that should be kept at
story item transitions. If not set, graphics_id is used for identification.
- channel: The channel to play the item, i.e. DSK, WALL etc.
- take: MANUAL or AUTO. If MANUAL then tc_in is 0 and only tc_dur is used.
- outBehaviour:
- TIMECODE = the element is taken out relative to the current primary element using
tc_dur.
BACKGROUNDEND = the element is taken out when switching primary story element.
- STORYEND = the element is taken out when switching from one story to the next.
- OPENEND = the element is taken out when reloading the rundown or by manually
taking the element out.
- auto_continue: true/false (only for Orad, to send PlayWithoutPause command).

6.7.4 Mapping Source Fields to Target Fields

The following mapping <mosmap id=”VENDOR” elementtype=”CLIP”> </mosmap> contains the
attribute descriptions:

Id: Value used in the MOS map section of the newsroomsettings.xml.
Elementtype: CLIP for video servers, GRAPHICS for graphics systems.

And <fieldmapping /> contains the attribute descriptions:

- fieldname: Viz Mosart target field name.
mospath: A simple XPath 1.0 expression to the location of the source value.
separator: Value used for joining multiple returned values for the mospath.
- fieldtype:
- FIELDS - the source value is in video fields.
FRAMES - the source value is in video fields.
- TIMECODE - the source value is in time code format. Use mask attribute to identify
format.
- STATIC - the value for the fieldname has no mospaths and should be as defined in the
value attribute.
REPLACE
- ADJUST
- value: The value to use if fieldtype is STATIC.
- valuetype: TEXT, TIMECODE.
mask: Value on time code format for, i.e. hh:mm:ss or hh:mm:ss:ff.
mustexist: Set to true if the Viz Mosart field should only be added if a non-empty value
exists.
regex: Regular expression used on the value. Use this to extract parts of the value from the
MOS object.
matchindex: Group index of the result from the regex.
- overwrite: Overwrites if a field already exists if set to true. Default is false.
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6.7.5 Examples

Video Server Item

The example below is of a Quantel video item:

Source MOS XML (Quantel MOS item)

<mos>
<itemID>3</itemID>
<itemSlug>New Row 3 CVD 1-3</itemSlug>
<objID>15160::559</0objID>
<mosID>QUANTEL</mosID>
<mosAbstract>Flug Uber die Alpen fertig2 1:00</mosAbstract>
<abstract>Flug Uber die Alpen fertig2 1:00</abstract>
<objDur>1500</objDur>
<objTB>25</0objTB>
<objSlug>Flug Uber die Alpen fertig2</objSlug>

</mos>

& Note: The objID is constructed from two numbers where the first is the Quantel clip id. The
second number is the Quantel zone.

Viz Mosart MOS mapping

<mosmap id = "QUANTEL" elementtype = "CLIP" -didasindex = "false">
<fieldmapping fieldname = "clip_hirespath" mospath = "//objID" regex = "A\d+"/>
<fieldmapping fieldname = "clip_description" mospath = "//objSlug"/>
<fieldmapping fieldname = "clip_mark_in" fieldtype = "static" value =
"00:00:00:00" valuetype = "TIMECODE"/>
<fieldmapping fieldname = "clip_dur" fieldtype = "FIELDS" mospath = "//objDur"
valuetype = "TEXT"/>
</mosmap>

Target Viz Mosart XML

<fields>
<field name = "clip_hirespath" value = "15160"/>
<field name = "clip_description" value = "Flug Uber die Alpen fertig2 1:00"/>
<field name = "clip_mark_in" value = "00:00:00:00"/>
<field name = "clip_dur" value = "750"/>
</fields>
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Graphics ltem

The example below is of an XPression graphics item:

Source MOS XML (XPression MOS item (modified and stripped to fit screen))

<mos>
<itemID>11</itemID>
<objID>{01E4E214-2414-4C71-956F-6587E3FD1E4B}</0objID>
<mosID>XPRESSION</mosID>
<mosAbstract>MAIN KEY Name (B2B): This is a test | Test</mosAbstract>
<jtemChannel>1</itemChannel>
<jtemEdStart>0</itemEdStart>
<jtemEdDur>0</itemEdDur>
<itemTrigger>CHAINED</itemTrigger>
<macroOut>NONE</macroOut>
<mosExternalMetadata>
<mosPayload>
<gfxtype>CG</gfxtype>
<itcTimeIn>500</itcTimeIn>
<jitcTimeDur>250</itcTimeDur>
</mosPayload>
</mosExternalMetadata>
</mos>

Viz Mosart MOS mapping

<mosmap id = "XPRESSION" elementtype = "GRAPHICS">

<fieldmapping fieldname = "graphics_id" mospath = "(//itemID | //objID)"

separator = "-" fieldtype = "REPLACE" value = "{STORYID}-{MOSPATH}"/>

<fieldmapping fieldname = "graphics_description" mospath = "//mosAbstract"/>
<fieldmapping fieldname = "tc_in" fieldtype = "FRAMES" mospath = "//itcTimeIn"

valuetype = "TEXT"/>

<fieldmapping fieldname = "tc_dur" fieldtype = "FRAMES" mospath = "//
itcTimeDur[text()!='0"']" valuetype = "TEXT"/>

<fieldmapping fieldname = "outBehaviour" mospath = "//macroOut"/>

<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()="'CG']" value = "DSK" valuetype = "TEXT" mustexist = "true"/>
<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()="'0TS']" value = "WALL" valuetype = "TEXT" mustexist = "true"/>
<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()='FS']" value = "FULL" valuetype = "TEXT" mustexist = "true"/>
<fieldmapping fieldname = "channel" fieldtype = "STATIC" mospath = "//
gfxtype[text()="OTHER']" value = "FULL" valuetype = "TEXT" mustexist = "true"/>

</mosmap>
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Target Viz Mosart XML

<item>
<fields>
<field name = "graphics_id" value =
"VER7ENPS1;P_VANLAB\W\R_F3144D55-78F2-494B-863EDO60OAT4D92F7 ;D02D7434-58BB-43D6~-
BO3601E7B7BBC1lE7-4-{1ECA795F-101D-4301-A559-2A1392F3AA2D}" fieldtype = "TEXT"/>

<field name = "graphics_description" value = "BANNER:Chanl: | Manual |
Timed(---):TIMED" fieldtype = "TEXT"/>
<field name = "tc_in" value = "" fieldtype = "TEXT" inputmask = "ff" default
= "00:00"/>

<field name = "tc_dur" value = "125" fieldtype = "TEXT" +inputmask = "ff"
default = "00:00"/>
<field name = "outBehaviour" value = "TIMED" fieldtype = "TEXT"/>
<field name "channel" value = "DSK" fieldtype = "TEXT"/>
</fields>
</item>

Harris Video Objects in Octopus

How to configure MOS mapping of a Harris video object in Octopus:

Viz Mosart MOS mapping

<storyItem>
<jitemID>2-1</1itemID>
<itemSlug>0406 ZN MUNDE 5 WIN 3 PM NEW</1itemSlug>
<octext_elemLabel>V0O</octext_elemLabel>
<objID>0406 ZN MUNDE 5 WIN 3 PM NEW</objID>
<mosID>ZEE.HARRIS.MOS</mosID>
<itemTrigger>MANUAL</itemTrigger>
<octext_elemType>vo</octext_elemType>
</storyItem>

Update the newsroomsettings.xml file by opening it in a text editor and adding the

following XML entry in the <mosmaps /> section (as a child to the <mosmaps />
element node)

Target Viz Mosart XML

<mosmap id="HARRIS" elementtype="CLIP" -didasindex="false">
<fieldmapping fieldname="clip_hirespath" mospath="//objID" />
<fieldmapping fieldname="clip_description" mospath="//itemSlug" />
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<fieldmapping fieldname="clip_mark_in" fieldtype="static" value="00:00:00:00"
valuetype="TIMECODE" />
<l=-=
<fieldmapping fieldname="clip_dur" fieldtype="FIELDS" mospath="//itemEdDur"
valuetype="TEXT" />
-=>
</mosmap>

- Open the newsroomsettings.xml file in Mosart Server application using the ns command.
Open Edit -> MOS Id mapping from the menu and add an entry where the value in Newsroom
alias is the MOS ID of the Harris item, (in the above example ZEE.HARRIS.MOS), and the Value
column is set to HARRIS (the id of the mosmap above). If the columns appendContent and
embeddedMosartitem are shown, they should both have the value false .

6.8 Manus Administrator Commands

These console commands are only intended for advanced users, and principally for
troubleshooting. They shall never be used on a live system.

© Warning: Use of these commands may adversely affect system performance. Unauthorized
use of these commands may invalidate a contracted Vizrt Support agreement.

tmpPrint: Print the manus

pcol: Print col1

setrundown, SR, CD [name]: Set a new rundown

TESTUPDATE: Start test timer

PRINTRUNDOWNS: Print newsroom rundowns
setManusDirectory: Set the directory in which manus are stored
VERSION Prints the current version

START: Start or stop the timeline
-FILEWATCHER -FW Starts the application in file watcher Modus

R: Release background
INIFILEPATH: Set ini file

INEWSFTPSERVER [servername] [username] [pathword]: Set the ftp connection to iNEWS FTP server,
you must restart

GTS, G: Go to next story

NONEAUTOS: List none auto lower thirds

S: Skip next story

WQ: Write queue list

INEWSWORKINGDIRECTORY: Set the working directory
INEWSDEFAULTRUNDOWN: Set the default Showpath
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LOG: Collect logs for all connections

SETTINGS: Show the Settings dialog

NEWSROOMSETTINGS, NS: Show Settings dialog for newsroomsettings
LOG: Write current log to file

SHOWLOG: Show logging elements

HIDELOG: Hide logging elements

PARSENATIVESTORY, PNS - Parse a native NRCS file to Mosart XML

PS [0] [0]: Print story or story item

PST: Print states

READSPEED [0]: Set read speed in words per minute

RELOADMANUS, RL, RELOAD: Reload current manus
RELOADTEMPLATES, RT: Reload channeltemplates

RESYNC: Resync rundown with NRCS

LM, LOADMANUS [filename]: Load manus from file

LISTCLIPS: List all items in media cache

TRACE: Activate/deactivate the Trace listener

SAVE [path]: Save the rundown as a file.

STEST Y or N millisec

SS, STUDIOSETUP: Set the current studio setup

SAVEASSEQUENCE [sequencename as string]: Save the rundown as a sequence
DUMPNCSSTORY, DNS [storyname] /p[destination filepath]: Dump a story in native NSML Format

DUMPNCSRUNDOWN DNR /pl[destination filepath]: Dump the current rundown in the native NSML
Format

6.9 Viz Mosart Settings And Configuration

The Viz Mosart Settings menu provides a single point to configure all server-side parameters.

6.9.1 Working with the Settings Menu

Opening the Settings Menu

The web-based Settings menu is accessible from the the combined Manus Administrator that was
introduced with Viz Mosart 5.3.

Settings from the legacy Manus applications (MMConsoleAdmin_2007.exe and
MMConsoleAdmin_MOS.exe) are consolidated and presented in this improved Settings menu.

- Working with the Settings Menu
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Opening the Settings Menu
Vizrt Graphics

To open the Settings menu

1. Ensure that your installation is using the combined Manus, as introduced in Viz Mosart 5.3.
2. In AV Automation, navigate to Devices > Properties > [Vizrt Graphics tab].
3. In the Manus Administrator console window, type typing settings.

A Note: Configuration of the new Vizrt Graphics driver introduced can be set up from this
menu. See Vizrt Graphics below.

Settings
Q @ Hide default

General General
File paths NCS Type
Default item durations

INEWS

MOS

Viz Media Sequencer

Read speed » Auto preview overlays %
Manus i i
Crossover

Template database

Logging

Vizrt Graphics

Auto preview overlays early i3

frames
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A link from the AV Automation menu Devices > Properties >[Device type tab] is provided for

supported settini S.
Device Properties x

Audio  Camera Robotics  Light Cortrol  Router  Subtitles  GPI/O Tally  Vitual St Weather Video Wall Genlock = Vizit Graphics | General 4l

The Vizrt graphics setup and workflow will be simplified in Viz Masart by introducing @ new driver to communicate with
Media Sequencer (MSE).

For now. the new driver can only handle Viz Arc elements

To setup the connection to MSE through the nevianver and the Viz Arc specific settings. click an the link below:

Viznt Graphics

Cancel Apply Save & Close

The new settings editor enables hot-reloading, eliminating the need for restarting the
application.

The settings are stored in the Mosart Server's local file system, specifically under C:
\ProgramData\Mosart Medialab\ConfigurationFiles\manus_settings.json.

The new settings editor uses Microsoft Edge WebView?2 as the browser. Please refer to the
Prerequisites page during installation for more information.

Vizrt Graphics

For Vizrt graphics (Viz Arc AR elements and limited support for overlays, full screens and clips)
setup and workflow is simplified with a single driver that communicates with Vizrt's central media
broker, the Media Sequencer (MSE). MSE communicates with AV Automation.

Connection to the Vizrt Graphics driver is configured through the new web-based Settings menu,
as described in To open the Settings menu above.
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To configure Vizrt graphics

1. Select the Vizrt Graphics category settings and enable the connection for the Vizrt Graphics
driver:

Settings

@ Hidedefaulr

Vizrt Graphics

« M Enable i%

Default item durations
MSE Host

INEWS The host

MOS

Viz Media Sequencer

Read speed )
* Playlist name

Manus

Crossover

Template database

Logging

MSE Profile Name

Vizrt Graphics

Mosart

2. Select Enable.
3. In the MSE Host section provide:
a. Host name
b. Port number (default 8580).
4. Click Connect.
On successful connection to MSE, a page served by Media Sequencer is displayed, just below
the host and port fields.
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In the section Viz Arc Configuration:

Settings

5.

Q @ Hidedefault

General Vizrt Graphics
File paths .

. |i| Enable i§
Default item durations

INEWS
MOSs

bgo-mos-dev3
Viz Media Sequencer

Read speed
Viz Arc Configuration
s
Manus Viz Arcbackend  http://bgo-mos-dev3:9004/api/v1/Executer
Crossover Master Profile  Local

Template database

ﬁ Save IQ Revert

Logging

Vizrt Graphics

« Playlistname 5

:
MosartShowPlaylist

MSE Profile Name

Mosart

a. Enter a value for Viz Arc backend, as a URL, in the form: http://<Viz Arc REST service
hostname>:<Viz Arc REST service port>/api/v1/Executer. (default Viz Arc REST service
port is 9004. See the Viz Arc User Guide).

b. The Master profile is defined in Viz Arc. Here is an example for Viz Arc 1.8.

A profile is used to configure the different groups (channels) of either the Viz or
Unreal Engines available for user control.
6. Click Save to save to the MSE (or Revert to undo your changes).

& Note: These settings are saved on the Media Sequencer side (not Viz Mosart).

7. Enter a value for the MSE Playlist name.
This is where the Viz content playout elements added in a Viz Mosart show planned in an
NRCS will be added to be handled through the Vizrt Graphics driver.
This value is cases sensitive. Default: MosartMsePlaylist

8. Enter the MSE Profile name.
This is used for playing out elements. The selected profile must first be created and
activated, using a profile editor available in either Viz Trio, Viz Pilot (Director) or Viz
Multiplay.
This value is case sensitive. Default: MOSART.
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9. Click Save to apply the setting.
There is no need to restart the Manus Administrator.
With the settings applied, the MSE connection status that employs the Vizrt Graphics driver is
shown in Viz Mosart's AV Automation:

tion | NameOfGallery (Ful

~ ~ ~ ~ ~ A ~ ~ ~ ~ ~ ~ ~

v v v v v v v v v v v v
R B

VIZ VSA VSB CAMS ME1 ME2 LvVE2 DDR1 camz | cams | uver cAM1 CAMZ M3 M

MIX 0

[ [ o [ o | vz | vos | vss | cms | ver | ves | e | oom | oona | cmws | cmm [ over | omn [ cwe ] wo |

C T T 1 [ T T T T [ [ T [ T ]
oscr | oskz | ¢

[17:0059.24 [ inttslize Mse Platfom (bao-mos-dev3:2580). Playist name: MosartShowPlayist. |

|17:010067 | | | BREAK+BREAK Fumcspee |

|17:01:01.37 | | BREAK+BREAK Funcspec |

17:01:01.70 | C | CAMERA+2 Funcspec
17:01.01.70 Cannot cue audio. No audio interface
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7 Media Administrator

L Viz Mosart - Media Administrator 3,7.0.24523

help
MediaAdministra
[2 Outputs t

lipName | ) - Adds given clip

1

[filename ] st al i y in the cache as xml

the
pending

ingDelay, MextAdminPingDelay, NextAdminAttem

Open
Turns

The Media Administrator handles the database connection to your video servers. It is responsible
for reporting the clip status for all the video server elements in the current rundown, and for
searching the video server for clips within the Viz Mosart GUI. The Media Administrator runs as a
console application and should be kept running at all times as long as its services are required.

The Media Administrator receives the video server configuration (i.e. which servers are active) in
the following circumstances:

when the Media Administrator is started.
when the Manus Administrator is activated (i.e. from idle to active transition).
- when the Av Automation changes the current setup.

To open the Settings XML Editor, type settings in Media Administrator followed by ENTER.

A Note: The application must be restarted for any change to the settings to be applied.
This section contains the following topics:

Media Administrator Commands
Media Administrator Properties Editor

7.1 Media Administrator Commands

Media Administrator is a console application, where you can run the following commands:
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add <clipname> <index>: Adds a clip manually to the list of clips currently monitored.
Typically used to test the installation.

delete <index>: Deletes a monitored clip with the given index.

dumpclips <filename>: Outputs a list of all monitored clips in an XML format. Outputs to
console if no filename is given.

dumpprofiiler: Shows timing information. Typically used to test the installation.

exit: Exits the Media Administrator.

flushactionqueue: Flushes the internal action queue of all pending actions.

help: Outputs all available commands.

listactionqueue: Outputs the pending list of actions to be executed.

listclips: Outputs a list of all monitored clips.

listservers: Outputs a list of all configured media servers.

mmbhost <hostname>: Sets the hostname of the Manus Administrator. Default: localhost.
postroll <roll>: Sets/displays the current value of the post roll.

reconnect: Reconnects to all configured media servers. Typically only one video server is
connected.

reconnectadmin: Reconnects to the Manus Administrator.

refresh <n>: Refreshes the status for all monitored clips <n> times (by making a request io
the server for all clips). Typically used to test the installation. Default <n>= 1.

search <regex>: Issues a clip search to the video server. The regex is a regular expression
for clip names. Typically used to test the installation.
set <property>=<value>: Sets a property value. If no property is given, a list of all supported
properties is displayed. The following properties are available:
NextClipAttemptDelay: Delay in seconds when to automatically verify presence of non-
existing clips. Note that most video servers support asynchronous notifications
making this functionality not necessary.
NextServerAttemptDelay: Delay in seconds when to try to reconnect to a video server.
When the connection to a video server is not successful, this delay determines the
time to wait before a new connection attempt.
NextPingDelay: Delay in seconds when to ping the connected video servers, to detect
whether the servers are valid.
MonitorCliplnterval: Interval for monitoring clips. A clip is polled for changes as long
as any of its attributes changes.
settings: Opens the Media Administrator Properties Editor.
verbose: Toggles verbose output. In verbose mode, more information is logged to the
console.
version: Outputs Media Administrator version and some system information.

7.2 Media Administrator Properties Editor

Media Administrator is configured through the Properties XML Editor, which is opened by typing
settings in the console window.
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& Note: Once you have made any changes, you must restart the Media Administrator for
changes to apply.

Sections of the Mosart Media Administrator Properties File
Configuration
Connection
Connection Media Search Servers
Logging
Manus Admin Connection
Media Router
Dynamic Video Server Configuration
Enabling Dynamic Configuration
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Settings — O XK
IEther name of property
B=: A
v Configuration
Enable dynamic configuration False
Post roll frames 75
ShouldUpgrade False
v Connechon
Existing clip check interval 00:00:30
Load database interval (seconds) 0
Max clip duration for key frames -1
Monitoring clip interval 00:00:05
Next admin attempt delay 00:00:05
Next admin ping delay 00:00:05
Fing delay 00:01:00
Server reconnect delay 00:00:30
» Connection Media search Servers
v Logging
lgnore verbose events filter
Log exist True
Pass verbose events filter
Use logging True
Use verbose logging False
v  Manus admin connection
Host localhost
Port 8085
v  Media router
Configuration filename MediaRouterConfigVideo xml
Server index name
Use False
Host
Hostname or |P address of the computer running the ManusAdministrator application. In typical configuration the
ManusAdministrator runs on the same computer. |.e. the default value is normally sufficient. This value is also possibl.
0K Cancel

@ Tip: You can locate a specific setting from the Search box:
Settings - m} X

v Mediagouter
Server index name
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7.2.1 Sections of the Mosart Media Administrator Properties File

Configuration

Enable dynamic configuration (EnableDynamicConfiguration):
- When False ( default), Media Administrator connects to all servers configured (see
Connection Media Search Servers, Video clip Server <n> below).
- When True, it connects only to
- Servers that are part of the salvo selected in AV Automation (see Video Servers >
Virtual Server Ports > Switch between salvos)
and
- Servers which have Static=True in the connection string (see Connection Media
Search Servers, Video clip Server <n> below).

& Note: For further details, see section Dynamic Video Server Configuration below.

Post roll frames (PostRollFrames): Subtracts value from the actual clip length when sending
clip info back to the Manus Administrator. Default: 75 (frames).
- ShouldUpgrade: For Vizrt Support use only, must be set to False. Default: False.

Connection

Existing clip check interval (ExistingClipChecklInterval): Delay in seconds when to
automatically verify the presence of non-existing clips. Note that most video servers support
asynchronous notifications, making this functionality unnecessary. Default: 00:00:30.

Max clip duration for key frames (MaxClipDurationForKeyFrames): Disables showing
keyframe markers for video files greater than this value in frames. Default: -7 .

Monitoring clip interval (MonitoringCliplnterval): Default interval for monitoring clips. A clip
is polled for changes as long as any of its attributes changes. Default: 00:00:05.

Next admin attempt delay (NextAdminAttemptDelay): Interval for retrying reconnecting to
the Manus Administrator. Default: 00:00:05 (hh:mm:ss).

Next admin ping delay: Interval for sending heartbeat to the Manus Administrator. Default:
00:00:05 (hh:mm:ss).

Ping delay (PingDelay): Interval between command requests (heartbeats) that Media
Administrator sends to the video server. Pinging is used to detect whether the connected

video servers are valid. Default:

00:01:00.
For some video servers, ping can be disabled using the DisableHeartbeat property inside the
connection string. See, for example, Configuration File Properties - VDCP >
DisableHeartbeat.
- Server reconnect delay (ServerReconnectDelay): Delay in seconds when to try to reconnect to
a video server. For example, if connecting to a video server is unsuccessful, this delay
determines the time to wait before a new connection attempt is made. Default: 00:00:30.
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Connection Media Search Servers

Video clip Server <n> (VideoClipServer <n>): Connection string to a media server (a video
server or MAM system) <n>.
A maximum of five media servers may be connected. In most cases more than one server
will be connected.
These connection strings all share a common format of a semicolon-separated list of pairs
Property=Value.
Although the selection of properties and values may vary according to the type of media
server, some properties are common to all.
For example:

Name.

Any connection string may have the property (and value) Static=True.

For details, see Video Server, MAM and Database Connection Strings.

Viz Mosart in general requires two connections to each video server, one from Media
Administrator (as defined here) and one from AV Automation (see Video Servers, section Working
with Video Server Configuration).

AV Automation also has a Name property, and the two connections to the same server should have
the same, unique Name, This name cannot be used for any other connection.
By default, Media Administrator connects to all servers defined here.

However, if the setting Enable dynamic configuration is True, it connects only to

The servers (identified by the Name property) that are part of the salvo selected in AV
Automation (see Video Servers, Virtual Server Ports, Switch between salvos), and
The servers which have Static=True in the connection string.

& Note: When Media Administrator searches through all servers for information on a media
clip, the search sequence starts with the last (highest numbered) server configured. This
may impact the result of the media search if the media clip is present on more than one of
the servers, and some property of the clip is not identical on these servers. In this case, the
property is set from the last server checked (the lowest numbered server configured) from
where the clip was available.

Video clip Server <n> Backup: Deprecated.

Logging

Ignore verbose events filter (IgnoreVerboseEventsFilter): Semicolon based list of events to
ignore when using verbose logging. Default: <none>.

Log exist (LogExist): Verifies the presence of the Viz Mosart Log Service at startup.
Default: True.

Pass verbose events filter (PassVerboseEventsFilter): Semicolon based list of events to log
when using verbose logging. Default: <none> .

Use logging (UseLogging): Passes all logging to the Log Service if true. Default: True.

Use verbose logging (UseVerboselLogging): Enables verbose logging if true. Default: False.
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Manus Admin Connection

Host: Sets the hostname or IP address of the computer running the Manus Administrator
application. In a typical configuration, the Manus Administrator runs on the same computer
(i.e. the default value is normally sufficient). This value is also possible to set using the
mmbhost command. Default: localhost.

Port: Determines TCP/IP (.NET Remoting) port to establish the connection to the Manus

Administrator application. Default: 8085 .

Media Router

Configuration filename (ConfigurationFilename): Determines the configuration file to use for
Media Router. Default: MediaRouterConfigVideo.xml.

Server index name: Deprecated.

Use: Uses the Media Router if true. Default: False.

7.2.2 Dynamic Video Server Configuration

Enabling dynamic configuration ensures that only the video servers that are currently in use by AV
Automation are searched by Media Administrator.
The key setting is Enable dynamic configuration, described in Configuration Settings above.

Enabling Dynamic Configuration
The settings Enable dynamic configuration (EnableDynamicConfiguration) affects

1. The Name properties as used in connection strings in AV Automation and Media
Administrator must match. Only video servers with a name that corresponds to the video
server naming in AV Automation get used.

Any other configured connections are ignored.

The Name parameter is Media Administrator's method of distinguishing between the various
clip metadata sources. It is also Viz Mosart's means of matching clip metadata sources and
video servers.

2. Any Media Administrator connections that do not relate to a particular video server used by
AV Automation. These shall be marked with Static=True in the connection string. A typical
example is a connection to a MAM system, for clip information.

Example 1: Connection string to a video server (Quantel) in Media Administrator:

When dynamic configuration is enabled a corresponding video server (with name=Q1) has to be
configured and used by AV Automation

Name=Q1l;Type=Quantel;SerialNo=21234;I0R=http://quantel:@10.0.0.131/
ZoneManager.ior;Slave=10.0.0.132;Config=ClipServerQuantel.xml
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Example 2: Static connection with a MAM system

When dynamic configuration is enabled, this connection shall always be established, regardless of
the current AV Automation configuration.

Name=VizOne;Type=VizOne;Static=True;Server=10.0.0.136;Port=8070
;Config=ClipServerJupiter.xml

Addit
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8 Overlay Graphics

The Overlay Graphics interface provides control and monitoring of overlay graphics for all Viz
Mosart-approved graphic engines.

For a list of supported graphics devices, see Overlay Graphics Types.
Configuration is done in the Overlay Graphics Configuration menu.

Start Mosart Graphics Interface by double-clicking the application icon:

N

or by navigating to the installation directory (by default C:\Program Files
(x86)\Mosart Medialab\Mosart Server ) executable MMOverlLayGraphicsInterface.exe.

& The Overlay Graphics Interface (and application icon) is only available if Overlay Graphics
was selected when installing the Viz Mosart Server.
The Overlay Graphics interface is only used for overlay graphics. Full-frame graphics are
controlled through the AV Automation application.

A menu bar at the top offers Settings, Graphics profile, Tools and Standby.

sark - |._|'r'|..‘='|-:'1‘;'|_'|F-:]'|_Ih'll'.h.

093%29) 2 | 1] B |

09.36:44.32 | OUT | A |DSK _|L3Defaut/Auto+/AutoDut/Mosait=LID0:02(0...
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The Overlay Graphics interface consists of four main areas ([1] to [4] in the illustration).

A status bar at the foot of the Ul provides information on product version number and the total
number of graphics in Viz Mosart (rundown overlays + named overlays + button overlays. 7 in the
example above).

The main column labels are:

- Time: The time when the graphic was added in Overlay Graphics (usually at rundown
import).

- #U: The number of times this graphic has been updated.

- #T: The number of times this graphic has been taken.

- Type: The graphic type. Can be:
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Description

Auto Out (a Manual CG can also be Auto Out)
Background End

Story End

Manual (Open End)

Last Out

Stay Always

if template is STORYSTART

None of the above

If the graphic is a locator, then the type is suffixed with an "L".

A Note: Locator is a special graphics item that is linked to a video server crosspoint. When
taking the crosspoint from a Viz Mosart template, either as a switcher crosspoint or keyed
crosspoint (in a DVE box), the graphics are also (re-)taken.

[1b] Details of a Selected Graphic from the List of Overlay Graphics

Selecting an overlay graphic from the list displays further details:

L3 Default/Auto+/AutoDut/Mosart=LI00:02100:10 I DSK

Test CGs

I TIMECODE

100_SHO'W.MOSART TEST_18DABF7D_2 2

Take Take out Clear

i

Build 3.7.0.23732 151116 | 7 |
Explanation of Details

Element

[L3Defauit/Autor/AutoDut/Mosart=LI00.02100:10

DSH
TIHEEDDEi

Description

Graphic title

Handler name (the destination or the channel for this graphic)

Graphic description
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Element Description

[100_SHOWMOSART TEST_18DABF7D_2_2 Graphic ID

& This is the Viz Mosart Graphic ID, not the graphic ID from
graphic database (Graphic Hub/Oracle)

Toke | Tokeo | Oea o | Action Buttons

Take: Takes graphic on air
Take out: Takes graphic off air
Clear: Takes out all taken graphics

Info: Opens an editor window where the graphic MOS item can be
changed and updated

8.2 [2] Server Status

Viz Mosart server and configured graphic engines statuses are displayed (Green: OK, Red: Failure)

in the panel at the top riﬁht:

Time Action  Type Handler | fem

13275756  IN 5 DSK In:00:00/HEADLINE OPENER/Mail bombs ... / 19.08.2019 16:10:23

19.9T7.CTTIC AT o now T LA A T AT IR S IITRIT Y Ao d AN A0 AN ArAnnn

8.3 [3] General Log

The center right contains a log of all actions performed on the overlay graphics either triggered by
Viz Mosart or by clicking Overlay Graphics buttons.

To clear this area, double-click inside it.

8.4 [4] Event Log

The bottom right contains an event log with messages, warnings and errors from the Overlay
Graphics application.

To clear this area, double-click inside it.
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8.5 System Information

The information line at the bottom displays application version, number of graphics in the table
and whether the Mosart Media Router (MMR) is in use:

8.6 Menu Bar

B Vir Masant - OverlayGraphics = — O *

Settings
Properties: Opens Overlay Graphics Configuration.

Graphics Profile: Select the required graphics profile.
See Graphics Profiles Tab.

Tools
When things don't go as expected, there is a debugging option.

Editor: Opens a Test graphics window.

Test graphics ﬂ
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Instrumentation Panel: Displays all device commands in real time, as sent to the various connected

devices.
See Mosart Instrumentation Panel.

Standby: Toggles the graphics engines in or out of standby.

Take any controller into standby. All the engines linked to the controller are set /unset to
standby. The same action can also be performed from the Viz Mosart Ul.

Take any engine individually into standby (only in OGIl) while the other engines in the same
controller are active.

8.7 Overlay Graphics Configuration

8.7.1 Overlay Graphics Configuration Window

The Overlay Graphics Configuration (OGC) window provides options for the Overlay Graphics
interface.

Overlay Graphics Configuration Window
Controllers, Engines and Destinations
Configuration Panels
Panel 1 - Graphics Configuration
Panel 2 - Mosart Graphics Destinations
Panel 3 - Property Tabs

In the Overlay Graphics application, select Settings > Properties to open.
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Select (double-click) an object (here: the controller named HEGO).
The form displays more information.

‘& Viz Mosart - Overlay Graphics Configuration - ] X ‘

Graphics configuration Mosart graphics destinations

Gi iic handler
T e
Delay (frames) o FULL (n/a) Name DSK
Distribute status O B Link
] Description WALL_2 (n/a) Handler 1:CGA
[ Replace takeout logic
Delay (frames) 0 WALL_5 (n/a)
Enable O
WALL1 (n/a)
BRANDING (n/a)
[ TICKER (n/a)
Brand and type of graphics

Grephica Profies  Actins MMR General Obsolete Corfig
Display Hame ShowPath Defaut scene on wal

" Defaut
o
0

Controllers, Engines and Destinations

Controller

A controller defines the type of the graphics system that is to be used. For each controller,
both common and specific properties can be configured as described below.

As a rule, connection settings for the graphics system are not defined at Controller level.
However, for some graphic handlers, connection definitions to auxiliary components must
be provided (for example, when connecting to the Media Sequencer for Vizrt graphics
systems).

Engine

Engine 2 [2(2)]

For each controller, one or more engines can be added. An engine defines the connection to
the graphics system.

Destination

The destination defines the output channels where you play out the graphics.
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8.7.2 Configuration Panels

For explanation, each panel is presented in this style:

& VizMosar - Oversy Graphics Configurstion

1A

Graphics configuration

1B

- o X

Mosart graphics destinations

2A | 2B

3

Panel 1 - Graphics Configuration

Panel TA

Mew controller

Mew enging

New controller: Select to add.
New engine: Select to add.

When a controller has been clicked:

HEGO
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Hego properties
El Active signal
Delay (frames) 0
Distribute status
El Description
Hego Id 1
Mame HEGO
E Replace takeout logic
Delay (frames) 0

Enable

Hego example

- Active signal
Delay (frames): Displays an integer value indicating number of frames to be
delayed. Default: © .
Distribute status: Displays a checkbox indicating whether the selected controller is set
to distribute status. Default: Unchecked.

Description
Graphic Type: Displays the selected controller type from a dropdown list of possible
controllers.

Hego Id: Displays an integer value indicating the selected controller's ID number.
Name: Displays the written name of the selected controller.

Replace takeout logic

Delay (frames): Displays an integer indicating a number of frames to be delayed. Default: 0

Enable: Displays a checkbox indicating whether the Replace takeout logic has been enabled.
Default: Unchecked.

When an engine has been clicked:

1[CGA(T)]
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Hego engine
EI Behaviour
Always Take In
Continue Scene
E Configuration
Channel 0
Encoding
Host localhost
Port 10003
=l Description
MName 1
El Handler
Handler Id 1
Name CGA

Hego engine example

Behavior
Always Take In: Whether the selected engine is set to always taking in .
Default: Unchecked.
Continue Scene: Whether the selected engine is set to continue the scene.
Default: Unchecked.
Configuration
Channel: Shows the integer number for the channel. Default: o .
Encoding:
Host: Displays the host identification name. Default: localhost.
Port: Displays an integer value for the selected engine's port number. Default: 10003

Description

Name: Displays an integer value for the selected engine's ID number. Default: 1 .
Handler

Handler Id: Displays an integer value for the selected engine's ID number. Default: 1

Name: Displays the name of the engine handler.
Bottom of Panel (information)
Further details about the active property

Graphic Type
Brand and type of graphics
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Panel 1B

- This section contains a list of controllers:

HEGO

VIZRT M5E

- A sub-list of any engines for each controller:

HEGO

T[CGA(T)]
P VIZRT MSE

Engine 2 [2(2)]

Panel 2 - Mosart Graphics Destinations

Panel 2A

- A list of destinations:

WALL (n/a)

WALL_2 (n/a)

- The activated destination is orange.

Multiple engines can be assigned to:
- The same destination (Mirrored Graphics Playout), where you use identical graphics
concepts.
Different destinations with different names, where you use separate concepts for each
output.
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Different destinations with the same name, for example, playing out the same
graphics on multiple parallel outputs, either in a virtual set configuration or in a multi-
branding setup.

Panel 2B

MNew destination

New destination: Select to add.

Graphic handler
B Description ...
Mame DSK
B Link
Handler

Graphic handler

Description: Displays the selected, named destination.

Link: Displays a concatenation of the Handler Id and the Handler Name separated by a semi-
colon. This information indicates the graphics handler linked to this specific destination.
Bottom of Panel (information)

Handler
The graphic handler that is linked with this
destination

Further details about the active property

Panel 3 - Property Tabs

Graphics Profiles

Only available when the selected item is a controller.

Graphics Prfiles  Actions MMR  General Obsolete Corfig

Display Name ShowPath WCP concept Default scene on wall Default
» Mosart/Cverays/Green Green
Yellow Mosart/Ovedays,/ Yellow1 Yellow O
O

& tis mandatory to have an exclusive (non-null) value for ShowPath configured!
Display Name

ShowPath:
Default scene on wall:
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Default: Indicates whether the entry may be set as default.
Default: Unchecked

Actions
Only available when the selected item is an engine.
Event:
Action:
Value:
MMR
(Graphics Profiles  Actions MMR  General Cbeclete Config
[ Use Media Router Engine Destination Map
Engre 1 [#] |DSK Engine 5 []
Engne 2 [] [waLL Engine & [
Engne 3 [] - Engine 7 [
Engne 4 [] Engine 8 [

Use Media Router: Default: Unchecked.
See the Viz Mosart Media Router Guide.

Engine Destination Map
Engine 1 [to 8]: Displays a drop-down list of optional destinations to be linked to this

engine. Check the box to set the destination. Default: Unchecked.

General

Graphics Profiles  Actions MMR  General  Obwolete Config

Logging Mosart server

[ Vesbose Hostname  |localhost

[ Trace

G Control Graphics Mimonng Connectrvity

[ show local ids [] Enaiie Conmected when in standby

[] Connected when idle

Logging
Verbose: If checked, verbose actions are logged. Default: Unchecked.

Trace: If checked, trace actions are logged. Default: Checked.

GUI Control
Show local id's: If checked, local IDs are displayed. Default: Unchecked.

Mosart server
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Hostname: Shows the Mosart Server host name. Default: localhost.

Graphics Mirroring

Enable: If checked, graphics mirroring is enabled. Default: Unchecked.

Connectivity

Connected when in standby: If checked, Mosart Server remains connected in standby
mode.

Default: Unchecked.

Connected when idle: If checked, Graphics devices will remain connected in idle (when
switching from main to backup, for example).

Default: Unchecked.

Obsolete Config

© Overwrite Alert: Clicking the red CONVERT button in the Obsolete Config tab overwrites
your existing configuration. Make sure you understand the consequences before clicking
CONVERT.

Type:

Engne 1 []
Engne 2 []
Engne 3 []

Engne 4 []

Handler name Host Port Default Scene Destination Preview engine

OGA

Graphics Profiles  Actions  MMR  General Obsolete Corfig

HEGOD

A Ol static configuration
- Press the CONVERT button
ocahost 10003 DSK 1 v to convert the cument
configuration to the new

This action wil oversrite any

configuration in the new
soetup

-

Type: Displays available controller types.
Engine

Engine activation: Activates the engine by checking the checkbox.
Handler name: Sets the name of the engine handler.

Host: Sets the name of the host.

Port: Sets the port number.

Default Scene: Sets the default scene.

Destination: Sets the destination by selecting one from the dropdown list.
Preview engine: Sets the order of the preview engines.

Old static configuration: This part of the form is considered obsolete.

(@ Obsolete Configuration Notification: The red CONVERT button in the Obsolete Config tab is
only intended for use by those who have been working with the old configuration and want
to convert the old configuration and replace it with the current configuration.
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8.7.3 Managing Overlay Graphics Controllers and Engines

Overlay Graphics Controllers and Engines

- Working with Controllers

- Working with Engines
Common Graphic Controller Properties
Common Graphic Engine Properties

Working with Controllers

To Add A New Controller

1. Open the Overlay Graphics Configuration window by going to Settings > Properties.
2. Click New controller.

0] Viz Mosart - Overlay (

Graphics configuration

New mnhollerD\L MNew engine m

Graphic Controller Properties

B Active signal
Delay [frames) 0
Distribute status ]
E Description
Graphic Type *
Id 0
Mame new

E Replace takeout logic
Delay (frames) 0
Enable L]
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3. In the Graphic Type drop-down, select the type of graphics system you are using (see

Overlay Graphics Types).

MNew controller Mew engine

Graphic Controller Properties

B Active signal
Delay (frames)
Distribute status

El Description
Graphic Type
Id
Mame

E Replace takeout logic
Delay (frames)

Enable

0
L]
BIGVIZ [:
CASPAR
CHYRON
DEKO
HEGO
CRAD
PIXEL POWER CC
VIZRT
KPRESSIOMN

HEGO

4. Set additional controller properties according to the selected Graphic Type.
5. Optionally, add graphics profiles via the Graphics Profiles Tab. Only applicable for some

graphics systems.

6. To add engines to the controller, see To Add a New Engine below.

To Remove A Controller

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.

2. From the list of controllers, select the black box of the controller you want to remove.
iraphics contiguration

Mew engine
.......... Remove
Add Engine
=

El

3. Right-click and select Remove.
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Working with Engines

To Add A New Engine

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.
2. From the list of controllers, select the black box of the Controller you want to use.
3. Click New engine, or right-click the controller and select Add engine.

Graphics configuration

MNew controller Mew engine VIZRT MSE

Graphic Controller Properties Remove

B Active signal | Add Engine N |
Delay (framesz) 0 ;
Distribute status ]

1 Mazrrintinn
4. Set the engine properties according to the selected graphic type (See Overlay Graphics
Types).
5. Optionally, set actions for selected system events using the Actions Tab (Event and Action
Rules).

To Remove An Engine

1. Open the Overlay Graphics Configuration window by navigating to Settings > Properties.
2. From the list of engines, select the black box of the engine you want to remove.
3. Right-click and select Remove.

Common Graphic Controller Properties

The Graphic Controller properties that are available depend on the graphic type of the controller.
The controller properties common to most graphics types are described below.

& Note: Additional properties specific to each graphic type are described in section Overlay
Graphics Types.

- Active signal: The active status signal is sent to AV Automation containing on air status of a
graphics engine.

- Distribute status: When set to true, reports the on air/usage status of an engine to AV
Automation. This status message is sent to the AV Automation log area, the Manus
Administrator console and the Overlay Graphics log area.

Delay (frames): Sets the delay of the graphics active status changed event signal.
Using a negative value for the delay disables the functionality (Distribute status is
false).
Upon receiving the signal, AV Automation performs the following actions:
Sets the DSK if this is enabled (Control DSK from Overlaylnterface is checked on
the Switcher preferences page and the switcher can set DSK).

Copyright © 2023 Vizrt Page 162



Viz Mosart Administrator Guide - 5.3

Executes direct take templates configured on the Switcher preferences page in
Overlay DirectTake control (see section Vision Mixer).
Cuing the graphics in certain conditions (the rundown story item is in preview,
the channel template used has a graphics device setup, the engine is not in use,
the channel is not on air).
Description
Graphic Type: Selects the brand and type of graphics.
Id: Identifies the graphics controller (unique number ID ). Shall be unique among all
defined controllers.
Name: Defines the name of the server (optional).
Replace takeout logic: Reads out the transition logic context of elements to either suppress
take out or re-take items. Take outs are suppressed if another item with the same context
was taken before the scheduled for take out action. Take outs are replaced with re-takes if
the item scheduled for take out replaced an item with the same context. Only for Vizrt
graphics with transition logic.
Delay (frames): Delay when checking for duplicate ‘take in’ commands in the next
element.
Enable: Use transition logic aware take in/out commands.

& Note: See also Graphics Profiles Tab for other controller settings.

Common Graphic Engine Properties

MNew controller New engine ) m

GraphicEngineProperties ]
Engine 1 [1(1)]

E Behaviour

Always Take In ]

Continue Scene ]
B Configuration

Channel 0

Enceding

Haost

Port ]
Bl Description

Mame Engine 1
Bl Handler

Handler Id 1

Mame 1

The Graphic Engine Properties that are available depend on the graphic type of the controller. The
engine properties common to most graphics types are described below.

The additional properties for each Graphic Type are described in Overlay Graphics Types.
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Behavior
- Always Take In: Turns off the logic that does not take in a graphic element that is
already taken and no other graphic element has been taken since.
- Continue Scene: Use continue for take out of scene based graphics.
- Configuration
- Channel: Defines the output channel from the graphics system. Set to © when not
used for takes.
Encoding: Encoding to use on text. UTF-8 or UTF-16. Default: UTF-8.
Host: Defines the hostname or IP address of the graphics engine. See also descriptions
for the various graphics types.
Port: Defines the TCP port to use when connecting to the graphics system.
Description
Name: The name of the engine.
Handler: ID and name of the handler. Note that if handler ID is changed and the engine is
assigned to a destination, then the link must be removed and engine re-assigned.
Handler Id: Auto-generated ID.
Name: The name of the handle (auto-generated).

& Note: See also Actions Tab (Event and Action Rules) for other engine settings.

8.7.4 Overlay Graphics Types

Each graphic provider is stored as a Graphics Type. Several Graphics Types are currently
supported. These include:

- VIZRT
CHYRON
DEKO
ORAD
PIXEL POWER CC
- XPRESSION
BIGVIZ

All operations are managed from the Overlay Graphics Configuration menu.

- Open the Overlay Graphics Configuration menu by opening the console application Viz
Mosart Overlay Graphics Interface > Settings > Properties.

VIZRT
Graphic Type = Vizrt (Vizrt via Media Sequencer [shortname: MSE])
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Vizrt properties Vizrt engine
E Active signal E Configuration
Delay (frames) 0 Channel 0
Distribute status ] Enceding
E Description Host
Graphic Type VIZRT ~ Port 0
Id 0 Preview Engine
Mame VIZRT M5E | |E Description
E Media Sequencer Name Engine 2
Apply channel name to ne.. B Handler
Host Handler Id 2
Part 5504 Mame 2
E Media Sequencer Backup
Host
Mame Backup
Part 8504
E Playlist
MOS playlist
Use concept override ]
E Replace takeout logic
Delay (frames) ]
Enable ]

Vizrt properties: Properties in addition to Common Graphic Controller Properties:
Media Sequencer
Apply channel name to new elements: Assigns a channel name automatically to
new graphics elements.
Host: Hostname or IP address to the Media Sequencer.
Port: IP-port to the Media Sequencer. Normally 8594 (Media Sequencer TreeTalk
protocol) or 8580 (REST protocol).

Media Sequencer Backup: For an optional backup MSE. Same properties as for Media
Sequencer. Note that the Apply channel name to new elements property is common to
both main and backup Media Sequencers.
Playlist
MOS playlist: Name of playlist in MSE where graphics elements are stored.
Use concept override:If concept override is enabled, the currently selected
graphics concept will override any concept defined within the graphics element.
Use the Graphics Profile tab to define the various graphics concepts.
Vizrt engine
Configuration
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Host: Hostname or IP address of the Vizrt Engine. The input can be specified as
just a Hosthame, just an IP Address, or a combination of Hostname:Port or
IPAddress:Port. If no port value has been specified as part of the Host field, the
port from the Port field will be used. However, if no port value has been

specified in either of the Host or Port fields, the default port value will be: 6100 .

A NOTE: If a port value is specified in the Host field, this value will
override whatever port value has been specified within the Port field.

Port: TCP/IP port of the Viz Engine.

CHYRON
Graphic Type = Chyron (Chyron Lyric)
Chyron properties Chyron engine
B Active signal = Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
E Description E Configuration
Graphic Type CHYRON - Channel 0
Id 0 Enceding
Mame CHYROM LYRIC Host
= Replace takeout logic Port 0
Delay (frames) 0 & Description
Enable ] Marmne Engine 25
E Handler
Handler Id 23
Marme 25

Chyron properties: The properties are the same as described in Common Graphic Controller
Properties.

Chyron engine: The properties are the same as described in Common Graphic Engine
Properties.

DEKO
Graphic Type = Deko
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Deko properties

E Active signal
Delay (frames) 0
Distribute status ]
E Description
Graphic Type DEKO
Id 0
Marne DEKO
E Replace takeout logic
Delay (frames) ]
Enakle ]

Deko engine

E Behaviour
Always Take In
Continue Scene

E Configuration

- Channel
Encoding

E Connection
COM port
Machine ID

E Description
Mame

E Handler
Handler Id

Mame

Viz Mosart Administrator Guide - 5.3

0O

Engine 19

19
19

Deko properties: The properties are the same as described in Common Graphic Controller

Properties.

Deko engine: Contains the following properties in addition to Common Graphic Engine

Properties:
Connection:

COM port: Defines the serial port connected to the Deko engine.

Machine ID: Digit 0-9. May be used for multi-drop. Multi-drop lets you specify
different fields or layers (TypeDeko) when more than one TypeDeko is
connected to the Deko host. Set equal to 1 if there is only one.

& Note: For using a default take out scene in Deko, the setting <item name="ClearScene"
value=""/>needs to be added to the IntelligentinterfaceConfiguration.xml file instead of
the clear command. The value should be set to any scene that should be used for take

out.

ORAD

Graphic Type = Orad (Orad Maestro)
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Orad properties
E Active signal
Delay (frames)
Distribute status
E Description
Graphic Type
Id

Mame

E Replace takeout logic

Delay (frames)

Enable

Orad engine

B Behaviour

0 Always Take In
] Continue Scene
E Configuration
CRAD - Channel
0 Enceding
ORAD MAESTRO Host
Port
0 &l Description
] Mame
E Handler
Handler Id
Mame

Viz Mosart Administrator Guide - 5.3

[]
L]

Engine 24

24
24

Orad properties: The properties are the same as described in Common Graphic Controller

Properties.

Orad engine: The properties are the same as described in Common Graphic Engine

Properties.

PIXEL POWER CC

Graphic Type = Pixel Power CC (Pixel Power Control Center)

Pixel Power Control Center properties

E Active signal
Delay (frames)
Distribute status

E Description
Graphic Type
Id

Mame

E Replace takeout logic

Delay (frames)

Enable

PixelPower CC engine

B Behaviour

0 Always Take In
] Continue Scene
E Configuration
PIXEL POWER CC ~ Channels
0 Encoding
PIXEL POWER CC Host
Port
0 El Description
] Mame
= Handler
Handler Id
MName

[]
L]

Engine 23

23
23

Pixel Power Control Center properties: The properties are mostly the same as described in
Common Graphic Controller Properties.
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Pixel Power CC engine: The properties are the same as described in Common Graphic Engine
Properties.
Configuration
Channels: Specifies the Pixel Power channels associated with the Pixel Power
engine. Specify as a comma-separated list of integers.

XPRESSION
Graphic Type = Xpression (Ross Xpression)
XPression properties XPression engine
B Active signal & Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
& Description E Configuration
Graphic Type APRESSION ~ Channel 0
Id 1 Enceding
Mame ROSS XPRESSIOR Host
= Replace takeout logic Port 0
Delay (frames) 0 E Description
Enable [l Mame Engine 22
& Handler
Handler Id 22
Mame 22

XPression properties: The properties are the same as described in Common Graphic
Controller Properties.

XPression engine: The properties are the same as described in Common Graphic Engine
Properties.

BIGVIZ

Graphic Type BigViz is a BBC developed system that integrates with ENPS, Vizrt graphics, IBIS
Playout, and Autoscript.
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BigViz properties BigViz engine
E Active signal E Behaviour
Delay (frames) 0 Always Take In ]
Distribute status ] Continue Scene ]
E Connection E Configuration
Encoding UTF-8 Channel 0
Host Client 1D
Port 0 Encoding
E Connection Backup Host
Host Part 0
Mame E Description
Part 0 Mame Engine 18
E Description E Handler
Graphic Type BIGVIZ ~ Handler Id 18
Id ] Mame 18
Marne BIGVIZ
E Replace takeout logic
Delay [frames) 0
Enable ]

BigViz properties: Controller connection properties are not used. All connectivity to BigViz is
configured as part of the Engine configuration.
BigViz engine: The following properties are used only (all other properties related to Viz
Graphics configuration are not used by BigViz):
Host: Hostname or IP address of BigViz service.
Port: TCP/IP port of remote BigViz service. Default port is 8165 .
Client ID: Identifies the Mosart server. Must match the corresponding BigViz
configuration. Default: mosart.

8.7.5 Overlay Graphics Configuration Property Tabs

Graphics Profiles |Fu::tiu::ns | MME I General I Obsolete Corfig |

Please select a controller to edit Graphics profile data

The tabs functions are:

Working with Overlay Graphics Configurations
To Change a Graphics Profile
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- To set up event-action rules

- To configure the Mosart Media Router

- To configure general settings

- To convert an incompatible overlay graphics configuration

Graphics Profiles Tab

The selection of graphics profile affects the look of all graphics used for the specific show. Viz
Mosart handles which concept the graphics devices use (on Vizrt graphics systems this technique
is called concept override, on other graphics systems Viz Mosart uses its own concept override

technique).

To Change A Graphics Profile

1.
2.

3.

Mawnmtrdhf| | New engine ]

Navigate to Settings > Properties > Graphics Profiles tab.

Select the controller (black) that you want to configure.

The Graphics Profiles list changes dynamically, depending on which controller is selected.
When the graphics profile is changed in the Overlay Graphics Interface (or the Viz Mosart

GUI), all the controllers are scanned.
If a controller has the selected graphics profile, the show path, VCP concept (Viz only) and

default scene for wall values, are all changed.
Remember to restart the Overlay Graphics Interface application for any changes to take

effect.
Graphics configuration Mosart graphic

DSK (1:Engine1,2:Eng

Vizrt properti
It : 1[Engine1(1)]
B Active signal i

Delay (frames) 0 2 [Engine2(2)] FULL (n/a)

Distribute status | E - 4 m

mluun | Obsotete Config|

*

Displary Name ', ShowPath VCP concept  Default scene on wal Defaul
EBC24 BEC24 Landon 7! |
BEC WORLD BECWORLD | World A |
b BBC FOOD BBCFOOD | Kichen ]

Display Name: Name of the Graphics Profile that is displayed to the user. The Graphics
Profiles are displayed as menu options both in the Mosart GUI and in Overlay Graphics.

- ShowPath: Path to the files the graphics engine uses. Absolute path where graphics are

located within the graphics engines. Dependent upon graphics type.

- VCP concept: Name of the Viz Pilot concept that should be used when working with the

selected profile (Vizrt only).
Default scene on wall Scene name to use as default for wall graphics. Dependent upon

Graphics Type.
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Default: Selects the graphics profile to use as default. The default graphics profile is used
initially before any profile is set from the user.

Click on the Graphics Profile tab to switch between profiles. The default profile is displayed in
bold, and the active profile is marked with a check mark, and is displayed in parenthesis on the
menu itself.

iaraphics profile (BBC24)

BBC24

BBC WORLD
BEC FOOD

Actions Tab

Configurations on this tab control Event and Action rules.

To Set Up Event-Action Rules

1. Navigate to Settings > Properties > Actions tab.
In the Actions tab, any number of event-action rules can be set up.

Graphice Profiles | Actions | MMR | General | Obzolete Config

Event Action Value

3 Becomeldle v | Macro L

BecomeActive

Macra W

MirmorActive
Mirmorinactive
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2. Select the engine that you want to configure these actions on.
The rules list changes dynamically depending on which engine is selected.

Graphics configuration \f

New controller | | New engine | 'l VIZRT Sl DSK (1-Enginel
Vizrt engine ‘E WALL (3-Engine

e i _ 1 [Engine1(1)] “Engi
Use Transition Legic... [
2 [Engine2(2)] FULL (n/a)
- "l | m

B Configuration

Commrlim— |

o —
Graphics Profildg | Actions | MR | Gpeferal | Obsolete Config |

Event x Action Walue
[Eecumeﬂ.cti\re - [Mac:m - | E1
[Eiecnmeldle - [Mac:m - | E2

7 |Cear = | TakeNamed... |~ |LOGO OFF
* [ - [ -

3. Set required event-action rule by selecting parameters.
You must define three parameters to set up an event-action rule:

Event: Specifies the event that will trigger an action. The following events are available:
BecomeActive: Triggers an Action whenever the Overlay Graphics Interface state
changes from Idle to Active.

Becomeldle: Triggers an Action whenever the Overlay Graphics Interface state changes
from Active to Idle.
Clear: Triggers and Action whenever a Clear event is received to clear all overlay
graphics. A clear event is typically received when a rundown is reloaded or deleted.
MirrorActive: Triggers an Action when the mirroring graphics engine becomes active
(for mirroring). Can only be used only when using Mirrored Graphics Playout.
MirrorinActive: Triggers an Action when the mirroring graphics engine becomes
inactive (for mirroring). Can only be used only when using Mirrored Graphics Playout.
- Action: Specifies which action to trigger for the given event. Two actions are available:
Macro: Invokes a macro on the given engine. The macro to take is specified in the
Value parameter.
- TakeNamedOverlay: Invokes a named (or constant) CG on the given engine. The
named CG to take is specified in the Value parameter.
- Value: Optional value depending on selected Action. As shown above, there may be multiple
event-action rules for a controller, for example:
- Add a new event-action rule by setting values in the row at the bottom, marked with a
star ‘*’.
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Selecting the corresponding row is done by clicking in the column left of the

Event column.

Delete existing event-action rules by selecting the corresponding row, and then press
DELETE on the keyboard.

MMR Tab

Configurations on this tab affect behavior of the Mosart Media Router.

To Configure The Mosart Media Router

Navigate to Settings > Properties > MMR tab.
Graphics Profiles | Actions | MMR | General | Obsolete Config

Use Media Router Engine Destination Map

Engine 1 DsSK W Engine & ] W
Engine 2 WALL Engine & [ | W
Engine 3 [] W Engine 7 [] W
Engine 4 || W Engine & [] W

Explanation of configurable fields

Use Media Router: To use the Media Router (MMR), this must be enabled (checked). The use
of Media Router by Overlay Graphics Interface must also be enabled in General > Media
Router.

Engine Destination Map: Maps between Engine number and graphics destination. The Engine
number is part of the Media Router configuration and is given as a DeviceName property.
For more information see the Viz Mosart Media Router Guide. Use the check boxes to select
a maximum of eight engines. In the example above the MMR configuration specifies two
overlay graphics engines with numbers 7 and 2 respectively.

General Tab

On this tab are several configurations that affect Viz Mosart Overlay Graphics operation and
behavior.
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To Configure General Settings

Navigate to Settings > Properties > General tab.
Graphics Profiles  Actions MMR General  Obsolete Corfig

Logging Mosart server

Verbose Hostname  |localhost

[ Trace

GUI Cartrol Graphics Mimraring Connectivity

[ Show local id's [] Enable Connected when in standby

Connected when idle

Explanation of configurable fields

Logging
Verbose: Increases the detail level of information sent to the Viz Mosart log if enabled.
Trace: Activates internal tracing (more details are sent to the debug view) if enabled.
Used for debugging purposes only.
GUI Control
Show local id’s: Enables display of graphics ID in the OverlayGraphics GUI. Shown in
dedicated columns in both repository and log tables.
Mosart server
Hostname: Defines the hostname or IP number of the Manus Administrator. Default:
localhost.
Graphics mirroring
Enable: Allows simultaneous control of two different graphics engines driven in
mirroring by Viz Mosart. When enabled, both engines will receive “take” commands at
the same time. For more details, see Mirrored Graphics Playout
Connectivity
Connected when in standby: Maintains connection to graphics devices when in
standby or idle modes if enabled.
Connected when idle: Maintains connection to graphics devices when put on
idle, for example when switching from main to backup if enabled (Default =
disabled).

A Note: A similar parameter is available for full screen graphics, see
_GraphicsConnectedWhenldle _ in AV Automation Settings (see
Graphics).

Obsolete Config Tab

This tab is used to convert overlay graphics configuration from Viz Mosart 3.4 or earlier versions.
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To Convert An Incompatible Overlay Graphics Configuration

1. Navigate to Settings > Properties > Obsolete Config tab.

Graphics Profles  Actions MMR  General Obsolete Corfig

Type:  |HEGO "
Oid static configuration
Handler name Host Port Defauk Scene Destination Preview engine " ' '
Press the CONVERT button
Engine 1 1] |CGA localhost 10003 DSK L to convert the cument
: . . o . ) corfiguration to the new
Engine 2 [] This action will overwte any
configuration in the new
Engine 3 [] CGC scalhost 3 setup
Engine 4 [] v CONVERT

© IMPORTANT! If you have configuration based on Viz Mosart 3.5 or later, then DO
NOT use the Obsolete Config tab.
Only if you have a configuration based on Viz Mosart 3.4 or earlier, is it strongly
recommended to convert your configuration to the new standard.

This tab displays the configuration parameters as they were in Viz Mosart 3.4 and earlier,
and is used to update old configurations to the new standard.
2. Click the CONVERT button.

This overwrites any existing standard configuration.
The fields in this tab are:

- Type: The type of graphics used
Engine 1-8 (check box): Check the graphics engines to be active. When converting to new
configuration, only active engines are converted.
Handler Name: Default CGA, CGB etc.
Host: Hostname or IP-address of graphics engine.
Port: TCP/IP port number of graphics engine.
Default scene: Specifies the graphics destination to be associated with the graphics engine.
The graphics destination is assigned to graphics received from NCS.
Preview engine: The number of the engine to use as a preview engine.

8.7.6 Mosart Graphics Destinations

This section presents configuration of overlay graphics for various system setups.

- Working with Graphics Destinations
Overlay Graphics Interface
Graphic Handler Properties
Mirrored Graphics
Mirrored Graphics Playout
Mosart Media Router (MMR) and Mirrored Graphics
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Working with Graphics Destinations

Overlay Graphics Interface

The Overlay Graphics Interface provides definitions to a set of standard Mosart graphics
destinations. These include WALL handlers (WALL, WALL_2 to WALL_5), FULL, and TABLE. It is
recommended that you keep each definition as-is.

Mosart graphics destinations

DSK {-I 1] L Mew destination
Graphic handler
WALL (n/a) _
B Behaviour
FULL (n/a) Always Take In L]
Continue S5cene ]
WALL 2 (n/a) E Description
Mame WALL
WALL_3 (n/a) 2 Link
WN_L_4 {ﬂfﬂ} Handler n/a
E Replace takeout logic
WALL 5 (n/a) Enable [
WALLT1 (n/a)
WALLZ2 (n/a)

To Add A New Mosart Graphics Destination

- Click New destination, then fill in the Graphic handler properties.

Graphic Handler Properties

The properties displayed depend on the graphic handler used. For some handlers (e.g. Viz Engine)
the full set of or possible properties will be shown. For others, a simplified set of properties will
show: Description and Link.

Behavior:
- Always Take In: Turns off the logic that does not take in a graphic element that is
already taken and no other graphic element has been taken since.
- Continue Scene: Use continue for take out of scene based graphics.
- Configuration:
Preview Engine: Handler name used for preview.
Description:
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Name: Name of the graphics destination.

Link:
Handler: Shows the engine that is linked to this destination. The engine is shown as
Handler ID: Handler Name.

Replace takeout logic:
Enable: Reads out the Transition Logic context of elements and use this to either
suppress take out or re-take items. Take outs will be suppressed if another item with
the same context was taken before the scheduled for take out action. Take outs will
be replaced with re-takes if the item scheduled for take out replaced an item with the
same context.

To Link An Engine To A Destination

- To create a link from an engine to a destination, drag an engine node to the preferred
destination.
The destination label and Handler property will be updated to show the Handler ID and
Name of the engine.

" BIGVIZ L S
I ‘ WWALL

FULL

To Remove Engine Links From A Destination

1. Mark an engine.
2. Right-click to display the context menu context menu and select Remove.

Mirrored Graphics

Mirrored Graphics Playout

The feature of playing out the same graphics through multiple graphics engines is called Mirrored
Graphics Playout. This functionality is supported both for overlay graphics and full-screen graphics
(AV Automation). Here we describe the approach used in Overlay Graphics Interface.

& For using Mosart Media Router (MMR) in conjunction with Mirrored Graphics, see Mosart
Media Router (MMR) and Mirrored Graphics below.
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1. Enable Graphics Mirroring in the General tab.
Graphics Profiles | Actions | MMR | General | Obsolete Config

Logging Mosar server

[] Verbose Hostname  |localhost

[] Trace

GUI Control Graphics Mirmoring Connectivity

[] Show local id's Enable [] Connected when in standby
k [ ] Connected when idle

2. Set up multiple graphics engines with the same destination.
Example: To configure mirrored graphics for a destination, create two destinations with the
same name and assign a different engine to each destination. In the example below,
mirrored graphics is enabled for DSK and WALL destinations.

" VIZRT MSE DSK (2:2)
Engine 1[2(2)] * DSK (2:3)

Engine 2 [3(3)] WALL {2-2)

WALL (3:3)

3. (Optional): Configure actions to be triggered when changing the active mirrored graphics
engine.
Do this from the Actions tab.

Mosart Media Router (MMR) and Mirrored Graphics

If your setup employs MMR for mirrored graphics, the integration requires additional configuration
to ensure that all new graphics elements are tagged with their corresponding destinations in the
Mosart playlists.

Ensure the ApplyChannelNameToNewElements property located
in DefaultGraphicsConfiguration.xml, is set.
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5.3

This is described in detail in the Viz Mosart Media Router Guide, in the section MMR Configuration

of Vizrt Graphics.

8.7.7 Sending Lower Third Graphics MOS Object to an NRCS
You can send details to a MOS-based NRCS as MOS objects.
For all template details as MOS objects in the NRCS, see section Mosart Templates Feedback to the

NRCS.

Managing Destinations

Active Destinations

The list of channels contains the active destinations is configured in the Overlay Graphics
Interface. Active destinations are destinations linked to a graphic engine.
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Mosart graphics destinations

Engine 1 [Eng1(1]]
Engina 2 [Eng2(2])

Engine 3 Engd(3)
 Engine 4 [Eng4(4)

4
BRANDING (nia)

TICKER (n/a)
[z eceol ’

WALL3 (nfa)
S

Gasphics Profies | Actions | MMA | Genesal | Obsolete Coriig |
Showfah VTP

In the configurations above, the following engine-destination mapping is performed:

Destination Engine number
DSK 1

WALL 2

WALL_2 3

WALL_2 4

TABLE 3
MOS Format

The list of channels in the LOWERTHIRDS MOS object will be:

<keys name="channels">
<K>WALL_2</k>
<Kk>WALL</k>
<k>TABLE</k>
<k>DSK</k>

</keys>
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The active channels from Overlay Graphics are sent to the NRCS only if the Overlay Graphics
Interface is started.

This is the recommended workflow to correctly send the channels configured in Overlay Graphics
Interface to NRCS.

The steps in square brackets are optional:

Start Mosart Administrator Mos application

Start Overlay Graphics

[Do any configuration changes if necessary in OverlayGraphics Settings]

[Restart OverlayGraphics or do Ctrl+Shift+G in case any configurations have been changed]
[Verify that %localappdata%\Temp\Mosart Medialab\MOS State\ MosTemplateCache.xml
contains expected data]

Execute mosReqObijList or mosReqAll from NCS

uThWN —

o

Detailed Description of MOS Objects

See the Appendix for code-level descriptions of MOS Object with Lowerthird Information.

8.8 Take Out Logic

Introduction
Enabling Take Out Logic
Prerequisites for Take Out Logic

8.8.1 Introduction

For overlay graphics, Viz Mosart supports four different methods to take out any graphics that are
currently on air:

1. Automatic: Timed, where graphics are taken out automatically after a fixed duration,
provided in a timecode.

2. Background End: The graphic is taken out automatically, when the next story item is taken.

3. Story End: The graphic is taken out automatically when the first story item of the next story
is taken

4. Manual: Open ended, the graphic is taken out manually. Also called a non-auto out.

For the Background end and Story end cases, there is a potential issue if the graphic to be taken
out reappears in the next story item. When taking the next story item, the standard behavior of
such graphics is:

1. Take out the graphics due to the end of scope (either Background end or Story end)
2. (Re)take in the graphics since the graphics is also present in the story item to be taken.

This leads to a visual artifact on air, since the graphics will be take out and retaken within a short
time interval.

This is illustrated in the following figure:
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Story1: | Item1: ltem2:
BackgroundEnd: graphics_id="52" <any type>: graphics_id="52"
Story2: | Item1: ltem2: ltem3:;
StoryEnd: graphics_id="67"
Story3: | Item1:
<any type>: graphics_id="67"

Example 1: Background End
Story]1 consists of two story items, ltem] and Item2.

In Item] there is an overlay graphics of type BackgroundEnd
In Item?2 the same graphics is reused. The type is not relevant here.

- When the user takes ltem?2 on air, the normal behavior is to take out the graphics (out of
Item1) and then (re)take it (also part of Item2)
If Take Out Logic is enabled, the graphics will remain on air during the transition from ltem1
to Item2

Example 2: Story End

Story?2 consists of three story items, Item], Item?2 and Item3 and the next story, Story3 consists of
one story item, Iltem]

In Story2.ltem?2 there is an overlay graphic of type StoryEnd. l.e. this graphic is scheduled to
be taken out at the end of the story.
In Story3.Item1 the same graphics is reused. The type is not relevant here.

- When the user takes Story3 on air, normal behavior is to take out the graphics (out of
Story2.Item3) and then (re)take it (also part of Story3.ltem])
If take out logic is enabled the graphics will stay on air during the transition from StoryZ2 to
Story3.
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8.8.2 Enabling Take Out Logic

- Take out logic is enabled via setting Use Take Out Logic in Manus Administrator as shown in
the figure below:

B} frmSettings — O x
o 2
Should updgrade False ﬂ
Startup in idle mode True
Story Compare Ignore Aftributes
Templates allowing graphic pretake PACKAGE VOICEOVER
Transitions on Accessories False
True E I—‘
UzeltemStatusToNCS False
~ Configuration file paths
AvConfig c:\channeltemplates\avconfig.xml
Channel templates c:\channeltemplates‘«channeltemplates .xml
Manus directory c\manus
Mewsroomsettings c:\channeltemplates‘newsmoomsettings .xml
~ Crossover
Croseover fadn Take Oin Swateh Oiffz et n j
Use Take Dut Logic

Enables the CG takeout logic. When two CG graphic objects with the same graphic |Ds are next to each
other, the first one is not taken out, only “take in” on the second object will be executed. Default:False.

& Note: Enabling take out logic applies to non-Vizrt graphics only.

8.8.3 Prerequisites for Take Out Logic
For take out logic to work, there must be a unique way of identifying the graphics.

There are two ways to do this:

1. Use the graphics_id graphics property. The graphics_id property is used by most graphics
drivers to do actions on the graphics. Therefore it can normally be used as a unique
identifier for the graphics. For most graphics systems used by Viz Mosart, there is a defined
way of setting this property when receiving graphics from NRCS.

2. Use the graphics_category graphics field property. This is a special property for the take out
logic. Use this if graphics with different graphics_id shall be treated as the same graphics
and handled as part of the take out logic. This normally requires custom field mapping in
configuration file newsroomsettings.xml.
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9 Story Recorder Mode

Enabling Story Recorder mode
Prerequisites
Overview

- Activating Story Recorder Mode
Verification

- Troubleshooting
Housekeeping

9.1 Enabling Story Recorder Mode

To enable Story Recorder (SR) mode in your setup, follow the configuration procedures below.

& Note: Once SR mode is activated, you will need to establish system-wide, frame accurate
clock synchronization. This is described in section Frame Accurate System Operations.

End user (Viz Mosart operator) documentation for Story Recorder is provided in the section Story
Recorder of the Viz Mosart User Guide.

9.2 Prerequisites

- The Viz Mosart system is already fully operative in live (non-SR) mode.

- The system, including studio equipment, can be calibrated for frame-accurate operations, as
described in section Frame Accurate System Operations.

- A dedicated set of frame-accurate templates has been created for Story Recorder.
Frame-accurate operations are automatically latency-compensated for primary events,
introducing timing differences in the execution of the templates, compared to Standard
mode.

Additionally, not every feature in Standard mode is available or possible in Frame Accurate
mode.

- An operating license is obtained from Vizrt Support.

& Note: Please refer to the Viz Mosart Release Notes for details of which devices are
supported for Story Recorder mode.

9.3 Overview

Story Recorder (SR) both introduces new system components and repurposes existing
functionality. Important to note are:

Copyright © 2023 Vizrt Page 185


https://docs.vizrt.com/viz-mosart
https://docs.vizrt.com/viz-mosart

Viz Mosart Administrator Guide - 5.3

The Mosart Logging Service plays a significant role together with a new Story Recorder Log
Adapter, for capturing events for recording.

This new log adapter must be configured after installing the Mosart server.

A snippet transcoder, Vizrt's Coder, is added to the installation.

The relationships between the system elements introduced with SR are presented below. This
example has a Harmonic Spectrum video server and Vantage for EDL transcoding:

* Media Player configured in Windows for snippet
review.

e Shortcut: Pause the timeline.

e Shortcut: Set Retake Point.

® Shortcut: Broadcast the timeline for consolidation.

Configure to read the
EDL/final clip base name
from NRCS

* Copy AsRunLogRepositoryConfig.xml and
LogAdapterStoryRecorderConfig.xml into
channeltemplates.

* Enable Story Recorder Log Adapter in
AsRunlLogRepositoryConfig.xml as described in
documentation.

e Configure the settings from
LogAdapterStoryRecorderConfig.xml.

¢ 2 channel ports for A/B playout of both
the show clips and the recordings for
prerolling.

e 2 ports for clean- and dirty recording.

® Plura timecode reader card settings.

* Genlock settings.

L Access snippet cut clips.

Viz Coder
Worker

Generate snippets
around retake point

Viz Mosart
Server
Snippet

Av Automation cut clips

Generate EDLs

Harmanic
Spectrum
Video Server
_Q Vantage
) L i Transcoder |
Recorded clips Harmonic EDL
Spectrum watch
£s folder
C
Final show

clips

A Note: The folder where the final show clips reside is not controlled by Viz Mosart. This is
set on the EDL transcoder side. In the above setup, the EDL transcoder is Vantage.

9.4 Activating Story Recorder Mode

Execute each of these procedures:

Upgrading to a Version of Viz Mosart that includes Story Recorder

Enabling the Story Recorder Log Adapter

Configuring Video Server Settings for Playout and Recording
Enabling Snippet Generation at the Cut Point

Managing Naming of the Final Clip Show

Pre-Roll Duration
Automatic Pause at Show End

Copyright © 2023 Vizrt

Page 186



Failover

A Installation order

Viz Mosart Administrator Guide - 5.3

For setups where several Mosart applications are installed on the same machine and are
using their own logging service (for example, Viz Mosart Ul, Viz Mosart Audio Player and
Viz Mosart Server), please ensure that the Viz Mosart Server was the last component to be
installed and that the Mosart Logging Service points to the Viz Mosart Server installation
folder. This is relevant for Story Recorder because any supported log adapters (in this
procedure, the newly introduced Story Recorder Log Adapter) reside on the Mosart Server
side. For additional information, refer to the topic System Logging.

9.4.1 Upgrading to a Version of Viz Mosart that includes Story

Recorder

Story Recorder was introduced with Viz Mosart 5.0, so the first step will be to install the new

software bundle.

1. Stop the service Mosart Logging Service.

2. Install the new software bundle taking into account the previous note regarding the

installation order.

9.4.2 Enabling the Story Recorder Log Adapter

1. In the Manus Administrator console, type settings and verify that Logging > In use is set to

True:

@ Settings

oz 24

Full-screen-graphic

Item

Live

Lower-third

Telephoneinterview

Video clip

INews configuration

Default Rundown

Encoding

FTP Port

Ignore Send Cue Status To NCS For Offline Clips
Password

Refresh Media On NCS Update

Server

Time to delay initialie devices while waiting for NCS to add story
Username

<

Working Directory
v INews Web Service configuration
Web Service Connection
Logging
Ignore verbose events filter

<

Log level

MSMQ Log limit

Pass verbose events filter
Path for MMLog

Trace internally

Use verbose logging
Manus configuration
Default Manus

Manus expiration time

<

Inuse
Set to true to enable logging

125
100
125
125
125
125

STUDIO4 RUNDOWN
Default

21

False

False

True
0
4025

MosartLog
True
True

STUDIO4. RUNDOWN
1]

2. Check if you have the following two files in your working folder, Channeltemplates or
ProgramData\Mosart Medialab\ConfigurationFiles\.

If yes, go to the next step.
If not, copy

1. AsRunlLogRepositoryConfig.xml
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2. LogAdapterStoryRecorderConfig.xml
from C:\Program Files (x86)\Mosart Medialab\Mosart

Server\ConfigurationFiles into your working folder.

Open AsRunLogRepositoryConfig.xml in an editor and add or uncomment the following line:

<Adapter type="LogAdapterStoryRecorder" name="LogAdapterStoryRecorder" configuration="
LogAdapterStoryRecorderConfig.xml" assembly="LogAdapterStoryRecorder.dll" />

Open LogAdapterStoryRecorderConfig.xml in an editor and configure the following settings:

Setting

RemoteDispatcherHost

RemoteDispatcherPort

BackupHost

BackupPort

EdIWatchFolder

Description

The host for service Mosart Remote
Dispatcher (MosartRemoteControlService) is always local, running
on the Mosart server machine.

Default: localhost . No other value should be given.

The port where the Mosart Remote Dispatcher service
(MosartRemoteControlService) resides. This should be the same
as configured in RemoteDispatcherServiceConfig.xml.

Default: 8090 (locally on the Mosart server machine).
The hostname of the Mosart backup server.

The port for connecting to the Backup Story Recorder Adapter.
This should be the same on both the main and backup Mosart
machine.

Default: 5001.

Location of a shared folder to which Viz Mosart has access and
monitored (watched) by your EDL transcoder.

In the figure above, this folder is named EDL watch folder .

This setting can not be empty and can be any shared network
path where both Viz Mosart and the EDL transcoder have access
(for example, \\somehostname\\EDL).

The folder must have read and write permissions for the Mosart
Server Logging Service.

Viz Mosart does not clean up any files created in this folder. See
more details in section Housekeeping.
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Description

Location of a local folder where Viz Mosart drops the Story
recorder EDL files. This folder is a secure 'backup' for the
EdIWatchFolder. The EDL transcoding node does not have access
to this folder, but if ever the EDL files fail to be generated in the
EdIWatchFolder because of say, connection issues, the user can
later manually copy the files to the EDL transcode node.

The setting can not be empty and it must be a different location
than the EdIWatchFolder

(for example, C:\MMLogs\EDL or \
\mosart_server_hostname\MMLogs\EDL).

This folder must have read and write permissions for the Mosart
Server Logging Service.

Viz Mosart does not clean up any files created in this folder. See
more details in section Housekeeping.

When a retake of a story item is performed, a rendered snippet
around the cut point will be placed in this folder shortly after the
item was retaken.

If this property is not configured or left empty, no snippet of the
cut can be created.

The location should be a network shared folder where the user
running Mosart Server Logging Service has read and write access
and the user running Mosart GUI has at least read access.

(for example, \\somehostname\StoryRecorderSnippetClips)

In the figure above, this is Snippet cut clips.

To set up a shippet recorder see Enabling Snippet Generation at
the Cut Point.

Default: empty. This implies that a snippet recorder is optional.

How long in seconds after the retake process started, that
generation of the snippet clip (from around the cut) shall begin.
(The retake process is the last part from the following chain of
actions : Show is paused - Pre-roll is taken on-air - Pre-roll auto-
takes the item to be retaken). See section Story Recorder of the
Viz Mosart User Guide).

Default and minimum recommended: 15 seconds.
The amount of time (in timecode format) from each recording to

be included in the snippet clip.
Default: 00:00:05:00 (5 seconds from each recorded clip).
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Setting Description

RecordingClipNamePrefix Prefix added to the recording clips generated during a Story
Recorder session using the configured video recorder. This is
used by Viz Mosart to easily identify the recorded clips for
housekeeping. (Only clip file names prefixed with this value will
be subject to Viz Mosart housekeeping.)

Default: SRVizrt.

RecordingFolder Location of the video server's file system folder where it stores
recordings created by Story Recorder. In the figure above, this
folder is named Harmonic Spectrum FS.

(for example, \\somehost\fsO\clip.dir).
This location is defined on the video server side.

This folder must have read and write permissions for the user
running Mosart Server Logging Service which performs
housekeeping tasks.

RecordingRetentionDays Number of days to keep the recording clips (minimum 1 day) on
the video server. An empty, zero or a negative value means the
housekeeping of the intermediate recording files is disabled,
there is no deletion of the intermediate files.

If enabled, the housekeeping task is run every time Mosart Server
Log Service is (re)started and keeps running at regular intervals
defined by RecordingRetentionDays setting.

Note that the recorded clips can be very large files easily filling
the disk space. See also section Housekeeping.

Default: 0 (disabled).

PrerollTemplate The name of the variant of the pre-roll template. This will be used
to automatically create the pre-roll template in the current studio
setup.

Default: PREROLL.

& Note: If another package template with this same name
exists on your system which was manually created, delete
or rename it.

The pre-roll template for Story Recorder must retain its
default minimal characteristics and can not contain
additional control parameters.

This unique minimal template can be reused after an
upgrade.
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MinPrerollDuration

MaxPrerollDuration

- Any changes in the configurations above require a restart of the service Mosart Server Logging

Service.
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Description

The minimum and default preroll duration in seconds that the
Preroll template will insert.

& This time needs to be sufficient for the video server to
reset and be ready to record, after being paused.
Typically 10-15 seconds.

The preroll duration can be increased by the user in the Story
Recorder Ul, see Minimum Pre-Roll Duration.

Default: 70.

The maximum preroll duration in seconds that the Preroll
template will insert. (See MinPrerollDuration above.)
Default: 30.

A For further details about logging in Viz Mosart, refer to section System Logging.

9.4.3 Configuring Video Server Settings for Playout and Recording

The video server is used for both playout of clips during the show and the recording of the story.
Ports are configured for both dirty and clean recording.
These port settings on the video server depend on defined signal inputs and are not defined from
Viz Mosart. To enable Story Recorder, some small changes must be made on the Viz Mosart side.

To configure video server recorder ports for Story Recorder

1. In AV Automation, navigate to Devices > Properties > Video Servers.
2. The settings for the Video server configuration and Mosart port configuration are already OK

for a working system.

Otherwise, refer to section Video Servers.
3. Configure the recording port(s) dedicated for Story Recorder.
4. For the recording port(s) mentioned in the step above, select IsEnabled in the Story Recorder

section.

5.3
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Vision Mixer Video Servers Graphics Audio Camera Robotics Light Control Router Subtites GPI/O  Tally  Vitual Set  Weather Video Wall Int « | *

Video server configuration Mosart port configuration
Add new server | | Add new port ‘ Omneon v DE Name: |Omneon
Omneon Properties - m ® DirectTakes
‘El Connection - Omneon:MIF76004 A: (Omneon:MIP76004) Mosart Port
| — -"*50;';1’-:" | Omneon: MIP76008 8: (Omneon-MIP75008) B AvConfig ..
ExtList mxf,MX A h 1 N
e — OmneonMIFTIOOREC 3 udio Channel 1| (empty)
nitial Standby . . Audio Channel 2 | (empty) ~
Server 10211.112.134 Orneon Growing_ingest | | Fecl: OmnecntlFTINRES) |- L (empty) ~
Server Type Omneon *  « i Rec2: <no ports> 5l Description
= — -
Description STP-HDPlay1 Name Recl
Alias El Server ports
Name Omneon STP-HDPlay2 Main Cmneon:MIP
STP:REC1 Mirror n/a
STP-REC2 Bl Story Recorder
IsEnabled v
STP:HDPlay3
STP:HDPlay4
Server connechion sining: Restore

Name=0mneon; Type=Omneon; Server=10.211.112.134.Directory=/fs0/chp.dir. Config=ClipServerOmneon.xml. ExtList=_mxf MXF
Cancel Apply Save & Close

This setting reserves the selected port for Story Recorder.
5. Click Apply then Save & Close.
6. Force a reconnect to the video server with Ctrl+Shift+V.
(or restart of Av Automation).

Clip naming pattern of temporary recordings

The temporary recording files generated by Viz Mosart are automatically named.
- When only one recorder is configured, the clip name pattern

is<RecordingClipNamePrefix>_<counter_<timestamp>.<extension>, where
- The RecordingClipNamePrefix is the setting configured in step (4), when enabling the log
adapter earlier.
- The counter is reset to 1 for each Story Recorder session.
- The extension is configured in AV Automation > Devices > Properties > Video Servers >
ExtList (the first in the list will be chosen). See the previous screenshot.

For example:

SRVizrt_1_211001153956.mxf
SRVizrt_2_211001153956 .mxf
SRVizrt_3_211001153956.mxf
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When more than one recorder are configured, the clip name pattern is
<RecordingClipNamePrefix>_<recorder name>_<counter_<timestamp>.<extension>, where
- The <recorder name> is the Name setting configured in Devices/Properties/ Video Servers
on the virtual recorder port properties (see setting Name set to Rec1 in the previous
screenshot).

- The counter is reset to 1 for each Story Recorder session.

- The extension is configured in AV Automation > Devices > Properties > Video Servers >
ExtList (the first in the list will be chosen). See the previous screenshot.

For example:

SRVizrt_Rec1_1_211014172330.mxf
SRVizrt_Rec1_2_211014172330.mxf
SRVizrt_Rec1_3_211014172330.mxf
SRVizrt_Rec2_1_211014172521.mxf
SRVizrt_Rec2_2_211014172521.mxf
SRVizrt_Rec2_3_211014172521.mxf

9.4.4 Enabling Snippet Generation at the Cut Point

This setup is optional and generates a few seconds (configurable) of verification video, intended to
reveal the integrity of a fresh cut, after a story item has been paused and then retaken. This
snippet creation employs Vizrt's versatile transcoder, Coder.

1. Download the most recent .exe version of Coder from the customer FTP, by navigating to
/products/VizOne/Latest Versions/Individual Installers and Docs/Coder/Latest Version.
2. You need only install the Coder Worker .
Install Coder on the same machine as the Viz Mosart Server. Coder's default installation
location is in C:\Program Files\Vizrt\Coder.

A Note: If you install Coder anywhere but the default location, you must then update
the following configuration, to specify the new path to the Coder executable,
amlbatch.exe:

<?xml version="1.8" encoding="utf-8"?>
Sl<configuration:

<configSections>
<sectionGroup name="userSettings" type="System.Configuration.UserSettingsGroup, System, Version=4.98.8.8, Culture=
<section name="CoderTools.Properties.Settings" type="System.Configuration.ClientSettingsSection, System, Vers
</sectionGroup>
</ronfigSections>
<userSettings>
<CoderTools.Properties.Settings>
<setting name="ExecutableFilelocation” serialirefs="String">
| <value>C:\Program Files‘\wizrt\Coderibin\amlbatch.exe</value>
</setting>
| </CoderTools.Properties.Settings>
</fusersettings>
<startup><supportedRuntime version="v4.8" sku="_.NETFramework,Version=v4.8"/></startup></configuration:

This config file is C:\Program Files (x86)\Mosart Medialab\Mosart
Server\CoderTools.dll.Config.

3. On the machine that runs the Viz Mosart GUI, define a default media player for *.mxf files
(for example, VLC).
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4. On the machine that hosts the Mosart server, in your working folder (ChannelTemplates or
ProgramData), locate the file LogAdapterStoryRecorderConfig.xml.
If not already set in step (4) earlier, provide values for:
a. StoryRecorderSnippetClipsFolder
b. SnippetGenerationRequestDelay
c. SnippetLengthForEachRecording.
5. Restart both the
a. Mosart Log Service (Windows Services menu)
and
b. Viz Mosart Ul.

9.4.5 Managing Naming of the Final Clip Show

This step is optional. By default, naming of the show (and EDL files) is derived from the rundown
name.

As a convenient option, you can instead provide a flexible and predictable naming scheme through
a mapping field defined in the NRCS story.

Viz Mosart will then pick up this value and use it as the base for file naming, including the final
show clip name. This is explained in Configure the NRCS and Viz Mosart for automatic naming of
the Final Clip Show below.

@ To prevent configuring the EDL/final clip base name every time the first story is changed,
the rundown can be designed to, for example, start with a Break which will not be part of
the show.

In addition, the user can also manually enter a name for the show's final clip, in the Story Recorder
Ul. This will overwrite the value given in NRCS.

Evening Show w34

Configure the NRCS and Viz Mosart for automatic naming of the Final Clip Show

From the NRCS, you can add a name that becomes the base of the final clip name in Story
Recorder.

1. In the NRCS, open the corresponding rundown for the show.

2. Add an NRCS column (here for example, SR Base Name).
The procedure is NRCS-specific and may require administrator privileges.
The following example is from iNews.

|sLUG SR Base Name |
SHOW NAME 9AM news show-en |
Cam

Clip - Yellow

Clip - Pink

3. Under this new column, provide a name for the show, in the first story in the rundown (here,
9AM news show - en).
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& Note: Viz Mosart will only read the naming at story level, from the first story in the
NRCS rundown. If the name is placed in any other story, it will be ignored.
Tip: If your NRCS operates on rundown level, not story level (for example
OpenMedia), you can create a script that will propagate your desired final story name
(as a text field on rundown level) to all stories in your rundown. As this also
populates the first story, Viz Mosart will then successfully read the name.

This name will be mapped in Mosart to appear in the Story Recorder Ul, when SR is enabled,
as illustrated at the end of this procedure.
The NRCS-side configuration is complete, next is to arrange value-mapping on the Viz
Mosart side.
4. In the Viz Mosart console application Manus Administrator, type ns. This opens
the Newsroom Settings menu.
5. From the menu bar select Edit > Story External Metadata and add the following row if not
already present:

|E| Mewsroom Settings (chchanneltemplates\newsroomsettings.xml)

File  Edit Story External Metadata
mostagname Masart Action Fomat Type mos_value action_value
coll4 tem_variable LI String ;I lang
var-007 tem_variable n String n ar_final_clip_name
col(1 directtake_pre_story ;I String ;I pre 101
coll directtake_post_story ;I String ;I post 102
var-1 template_type LI String ;I
var-2 template_varant ;I String ;I
var-3 template_transition ;I String ;I test Effektl12

where
mostagname: the column name as specified in the NRCS (in this iNews example, var-007).

& Note: For details on how to derive this naming (here var-007) from the NRCS, refer to
section Story External Metadata in Newsroom Settings Editor .

Mosart Action : must be set to jtem_variable .
Format Type : must be set to String .
mos_value : empty.
action_value : must be sr_final_clip_name .
6. Restart the Viz Mosart Server.
7. Verify the setup:
a. Provide the Final Clip Show name as described.
b. Load the rundown in Mosart Ul.
c. Enable Story Recorder mode (see Viz Mosart User Guide, in the Story Recorder
section).
d. Check that the name entered in Managing Naming of the Final Clip Show, appears in
the Story Recorder Ul when the associated rundown is loaded and Story Recorder
mode activated.
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® Ready!

rec | 9AM news show - en | #

Recording Time: 00:03:11:00

& Any changes made in NRCS for the Final Clip Show name are not taken into consideration
during a Story Recorder session, but only when Story Recorder mode is again activated (so
in the next Story Recorder session).

Clip naming pattern for EDL files and the final show clips
The EDL and final clip recording files are automatically named by Viz Mosart.

The name pattern used to generate the EDL files at show level and the final show clips generated
by the EDL transcoder is:

<Final Clip Show name>_<timestamp>.<extension>, when the show is broadcasted first time.
<Final Clip Show name>_v<counter>_<timestamp>.<extension>, when the show is
broadcasted more than once.

where

- Final Clip Show name> is the rundown name or as given from NRCS or as given in Story
Recorder panel (see Managing Naming of the Final Clip Show ).

- extension for the EDL files is the extension for the supported EDL transcoder (for
example, tsedl for a Vantage transcoder).

For the final clip shows, this is the extension configured on the EDL transcoder itself.

For the example used in this procedure. the Show Final Clip name is 9AM news show - en:
- 9AM news show - en_211011175050.tsedl

- 9AM news show - en_211011175050.mxf

- 9AM news show - en_v2_211011175050.tsedI

- 9AM news show - en_v2_211011175050.mxf

9.4.6 Pre-Roll Duration

The pre-roll period must be long enough for the video server hardware to reset itself and be ready
to continue recording, after a pause.

To set a pre-roll duration

1. Determine the time required by your video server hardware to commence recording. This is
typically 10-15 seconds.
2. Configure this value as described in MinPrerollDuration.
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3. You may increase the value in the SR panel:

Timeline broadcasted for consolidation. | X Preroll (seconds): - 10 +

Broadcast (¢ vfe

This setting is retained between SR sessions.

9.4.7 Automatic Pause at Show End

As an option, you can automatically pause the show and recording.

To set automatic pause

1. Create a dedicated template, typically a Break.

2. Define a PAUSE_TIMELINE control command configured on the_ltemplate.

25 Template Editor | NEWS INT: BREAK + StopSho — [m}

File ~ Template - Template Set ~ DB

Take
BREAK + StopShow

Template properties

General Control Commands  Newsroom tags arder  Destination panel

|
|
NEWS INT ‘
|

Command On Take Control commands Take

Command Walue Parameter
» PAUSE_TIMELINE |~ N/A |+~

] R ~

desi
[ Continue Paints

Autotake  Command  Value  Parameter

] ~

3. Insert this template at the end of the rundown.

In the Story Recorder session, when the story before this template is taken on air, a message
warns the operator that the next story is going to pause the show and thus the recording too:
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g Morning Show 06:00
00:00:17:00 / 00:29:43

Item name
I v Countdown
I v CAMERA U1

I Countdown Recording...

9.4.8 Failover
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AU K1E = |
19:30:18  00:00 00:30 |COUNTDOWN
Q NIB USVisas 10 G
Sig)
STOP SHOW

A Next story will stop the recording

Start time Duration
Countdown 9:30:11
ANMOD LIBYA

Q NIB USVisas 10 G

This step is optional and it assumes that Viz Mosart is already set up with redundancy as described
in section Redundancy.

This means that:

Both the Viz Mosart main and backup server have same configurations for at least Mosart
Administrator, AV Automation, Media Administrator and Overlay Graphics Interface.

AV Automation is configured for mirroring on both main and backup servers (with main
pointing to backup and backup pointing to main):
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Camera Robotics  Light Control  Router  Subtitles  GPI/D Tally  Viual Set Weather  Video Wall  Integrated Engine  Genlock  General <
Standby at startup Show in Console Redundancy
[ Vision Mixer [ Autotake timing UseMirroring  Hostname  |BGO-MOS-SER
0 e v
[] Graphics Diagnostics
[ Audie Mixer Trace
Camera Robotics [] Verbose Media Router
. Uze for:
Light control [] Video Servers
[ Router [] Graphics
. Direct Tak
[ Subtitles rect janes [] Owerlay Graphics
] GFIio Directtake On Reload [] Camera Robotics
[] \weather system Directtake On Become Active l:l [] Light Control
Video wall Video \wiall
[ Video we Directtake On Become Idle l:l 0 -
[] Sound player [] Subtitling
[ Virtual set Configuration
Crossover
(] Loudness control Name |I'v'|osart1 | Port |E~ﬂ'9’9|
[ Tally Directtake On Activate l:l Connect Salvo
Directtake On Inactivate l:l Active Salvo
|dle Salve ReleaseAll
Cancel Apply Save & Close

The Viz Mosart Ul is configured to connect to the backup server:

() General settings

Remove

Connection name:
Main
Backup

Gallery 1
localhost
bgo-mos-server]

For Story Recorder, there are additional steps:

Story Recorder is configured on both main and back in the same way. For simplicity, once
main has been configured for Story Recorder mode as describe in section Enabling the Story
Recorder Log Adapter, copy AsRunLogRepositoryConfig.xml and
LogAdapterStoryRecorderConfig.xml in your working folder from the backup server
(Channeltemplates or ProgramData).

Open LogAdapterStoryRecorderConfig.xml from Mosart main server in an editor and provide
the hostname and port to the backup server (BackupHost and BackupPort) as described in
Enabling the Story Recorder Log Adapter, step 4.
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Open LogAdapterStoryRecorderConfig.xml from Mosart backup server in an editor and
provide the hostname and port to the main server (same BackupHost and BackupPort
settings) as described in Enabling the Story Recorder Log Adapter, step 4.

Both main and backup machines have Plura card installed and Viz Mosart configured to
connect to Plura as described in Frame Accurate System Operations.

(Optional) If Snippet generation around the cut point has been set up for main, this should
be set up in the same way for backup. Install Viz Coder on both main and backup server.
The snippet folder configured in LogAdapterStoryRecorderConfig.xml where the Viz Mosart
Ul has access, needs to be configured to be the same on main and backup.

Same calibration settings from AV Automation: Devices > Properties > Genlock tab should be
configured for main and backup.

9.5

Verification

- The video server is prepared for recording.
- Viz Mosart is prepared to run in Story Recorder mode.

Snippet generation around the cut point is configured (optional).

- The integration is now established between Viz Mosart and the NRCS (optional).

Failover is setup as described (optional).
Ensure you have calibrated the system to frame accuracy, as described in section Frame
Accurate System Operations.

The Viz Mosart operator instructions, for switching on and running Story Recorder are described in
the Viz Mosart User Guide, in the Story Recorder section.

a

We strongly suggest to build a new template set for Story Recorder, mainly because of the
timing differences in the execution of the templates in Frame Accurate mode (now
automatically latency-compensated for primary events), and partly because not every
feature in Standard mode is available or possible in Frame Accurate mode.

9.6 Troubleshooting

Story Recorder must always first be switched On in Viz Mosart Ul.

Failure to Enable Story Recorder Session

Recording Ports not Found

Failure to Start Recording or Story ltems not Recorded in Story Recorder Panel
Naming of Final Clip Show from NRCS not appearing in Story Recorder Ul
Unreliable genlock. See more details in AV Automation status bar

Genlock is not enabled

Retake position no longer valid. Please set retake point

- Timeline can not be paused while pre-rolling
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When the user switches on SR in the Ul, you see:

Story recorder

® On

Check these scenarios, in this order:
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Failure to Enable Story Recorder Session

Failed to enable Story Recorder: Mosart Server Log Service can not be reached.

Viz Mosart Server and Mosart Ul or Mosart Audio Player are on the same machine and the

server was not installed last.

If you installed the server before the Ul or Mosart Audio Player, Mosart Log Service will

incorrectly point to a copy of MMAsRunLogService.exe thatis located in the Mosart Ul
or Mosart Audio Player folder installation. Instead, this should point to the
MMAsRunLogService.exe located in Mosart Server installation folder:

Description

r

Status

Startup Type L

L 1

Marme
‘*-":(:' Microsoft Windows M5 Router Se
L MOM

%Mnsar‘t Logging Service
{;?;Mcusar‘t Rernote Control Service
{;?;Mcuzilla Maintenance Service

% Matural Suthentication
'!';Net.Msmq Listener Adapter
% Met.Pipe Listener Sdapter
% Net.Tcp Listener Adapter
I!‘;Net.Tu:p Part Sharing Service

EMetBalancerService

Py

8 B

Py

L Metlogon

'!';Nehnmrk Connected Devices Auto- 5
I?;Netwcurk Connection Broker
I?;Nehmcurk Connectians

'?;Nehmcurk Connectivity Sssistant

% Metwark List Service

i1 5 4o 4D

Py

i Metwork Location fwvareness
% Metwark Setup Service
I?;Nehmcurk Stare Interface Service
" MDA Display Container LS
" MWIDIA Display Driver Service
‘*-":(:' MWIDIA Stereoscopic 30 Driver Servig
'O} Office Source Engine
55(5' Office Software Protection Platform

8 6

i g5

i

Mosart Logging Service Properties (Local Computer)

General

Senvice name;

Dizplay nanme:

Descriptian:

LogOn Recovery Dependencies

MozartLogService

Mozart Logaing Service

Provides logging services for the Mozart suite

Path to executable:;

Startup twpe:

Semnvice statuz

Stark

“'ou can specify the start parameters that apply when pou start the zervice

fram here.

Automatic

Running

Stop Fauze

Cancel

Resume

Apply

To fix this, you should either stop the Mosart Log Service from Services and start it as console
from Mosart Medialab\Mosart Server\ MMAsRunLogService.exe (although you will still have
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same problem after a machine restart) or re-install the applications in this order: first the Ul/
Mosart Audio Player and then Server.

After Mosart Log Service is started, enable SR again.

Verify that the (new) Story Recorder Log Adapter, and the
config LogAdapterStoryRecorderConfig.xml are setup according to section above, Enabling
the Story Recorder Log Adapter, around step (3).

A common oversight is that someone forgot to un-comment the lines for Enabling the Story
Recorder Log Adapter for Story Replay functionality in AsRunLogRepository.xml.

type="LogAdapterStoryRecorder" name="LogAdapterStoryRecorder" configuration="LogAdapterStoryRecorderConfig.xml" assembly:
"LogAdapterStoryRecorder.dl11" /> |

For additional help, refer to the general topic Troubleshooting Log Adapters.

If the Viz Mosart Ul is connected to a Mosart server on another machine, make sure there is
no VirtualBox or similar configured on the Mosart server machine.

(")

-

A4 & > [Control Panel » Network and Internet > Network Connections »

File Edit View Tools Advanced Help

Organize « Disable this network device Diagnose this cogigection Rename this conn
- Ethernet 2 - VirtualBox Host-Only Network .
L- . l.- o
— detwork cable unplugged —_— Enabled =
% @ Intel(R) Ethernet Connection (2) | &7 VirtualBox Host-Only Ethernet Ad...

9.6.2 Recording Ports not Found

If when you switch on SR, you get errors about No recorders configured for Story Recorder, this
indicates that the connection to the video server that performs the recorder is faulty.

Mo recorders configured for Story Recorder

story name Start time Duration

Ensure you set up Viz Mosart, with correct configuration settings selected, as explained
above in To configure video server recorder ports for Story Recorder.

Even if the configured recording ports are enabled for Story Recorder as described above, you may
also get this error message dafter switching to a different video server salvo.
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MAF 1 MAP2  EXT1 KT 2 XT3 XT 5 KT6 1 ANGZ  AMGE  ANG4  ANGS

v v W v v W v v W v v v v v v W v v

90 | o0 [ %0 [ 0 | 0 | 90 | 90 | 9 [ 90 [ o0 [ o | s [ s | 90 | 90 [ 9 | 90 [ o0 | 90 | 0|

< >

oMme I oMa | KAMZ | KaMz I KA | KAMT | EXT1 I EXT2 | EXT2 | EXT4 I EXTS | EXTE | RIA I Ri18 | RIC | RID | RIP | ml | OGSE
0

OMA KAMZ KAM3 KAM4 KAMT EXT1 EXT2 EXT3 EXT4 EXTS EXT6 RIA R1B RIC RID RIP oGsa | oese | oese

10:34:0234  Performed command DIRECTTAKE - 702:
10:34:0234  Executing cmd TAKE CONTINUE POINT 600
10:34:03.56  Command DIRECTTAKE-702 performed
10:34:03.56 _|D | ACCESSORIES+702 OGSE SYN

10:34:0356  MIXon ME2OGSEin 15frames

10:34:03 56 Directtake Nr 702 702 OGSE SYN

10:34:0357  CueDelav sstto 1000 ms (25 frames, min. cue de...
10:34:04.59 |C | PACKAGE=SYN auto raus NEWS INT
10:34:0459  PREVIEW ACCESSORIESRouter NOT CONNE...
10:34:0459  CUING(StopAndCue) at frame 462 Pink-Vox-T...
10:34:05.07 CUED(StopAndCug):  Pink-Vax-TC-25fps-120s-...
10:34:0512  ServerCue  Pink-Vox-TC-25ps-120s-AVC Intra...
12:10:30.28  Executing cmd RECORD STOP AND DETACH...
12:10:58.63 - - - nitialize devicss - - - -

12.10:58.65 | | | BREAK=NEWS START NEWS INT

12:10:58.67  CueDelav setto 1000 ms (25 frames. min. cue de...
12:10:59.80 |C | CAMERA=U2 NEWS INT

12:10:59.80 | | PREVIEW ACCESSORIESRouter NOT CONNE...

After switching to a different salvo, perform the following steps:

1. Check that there are recorder port(s) configured and enabled for Story Recorder as explained
above in To configure video server recorder ports for Story Recorder.

2.

Restart AV Automation or force a reconnect to the new video server (use Ctrl+ Shift + V).

This step should be done regardless whether the previous step was necessary or not.

9.6.3 Failure to Start Recording or Story Items not Recorded in Story
Recorder Panel

Recording does not start and no story items appear in the Story Recorder panel.
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Verify in Viz Mosart Manus Administrator that logging is enabled:
Open Media Administrator and type settings.

[5] settings = O X

FH=: A
@z X

~ |News Web Service configuration
web Service Connection
v Logging
lgnore verbose events filter
[N True [~
Log level 0
MSMG Log limit 4025
Pass verbose events filter
Path for MMLog Mosart Log
Trace internally True
Ilse verbose logging True
~ Manus configuration
Default Manus STUDIO4 RUNDOWMN
Manus expiration time 1] ﬂ
Inuse
Set to true to enable logging.

On the machine hosting the Viz Mosart server, check that service Viz Mosart Logging
Service is up and running (as service or console).

If running as a service, verify that it points to MMAsRunLogService.exe from the Viz Mosart
server installation folder.

If the Viz Mosart Logging Service is restarted while other applications are running OK, then
an action in the Viz Mosart Ul (for example, reloading the rundown) must be performed to
reestablish the connection to the Viz Mosart Logging Service.

Until a Viz Mosart Ul action is made, no events are logged in the AsRunLog for the first story
item taken on-air.

This leads to Story Recorder not functioning correctly. For example, recording may appear to
start OK, but no story items show up in Story Recorder panel.

If the Viz Mosart Logging Service is restarted when the Overlay Graphic Interface is being
used for controlling the graphics systems, it must be restarted in order to re-establish the
connection.

Until the Overlay Graphic Interface is restarted, no graphic-related log events are logged in
AsRunLog for the first graphic encountered in the rundown, meaning Story Recorder will be
unable to backtrack the graphic.

& Note: After any Mosart Logging Service (re)start, as a rule of thumb, always restart
AV Automation and the Overlay Graphics interface.

Make sure Mosart Logging Service does not run both as service and console at the same
time.
To fix, stop both and then start either as a console or as a service.

Copyright © 2023 Vizrt Page 204



Viz Mosart Administrator Guide - 5.3

9.6.4 Naming of Final Clip Show from NRCS not appearing in Story
Recorder Ul

You have set up your NRCS to provide Viz Mosart with a base naming for your final clip produced
with Story Recorder, but the naming is not displayed in the Story Recorder panel.

Viz Mosart parses the MOS object corresponding to a story, and on the first primary story item
found in the rundown it will add the show final clip show given in NRCS.

Examine the underlying XML:
Do Ctrl + Shift + Alt + double click in the Viz Mosart Ul on the first story item in the rundown
to open this window and verify if the value given from NRCS is present:

12:57:19 02:00

SHOW NAME
(9

12:59:21 U item type="0" slug="SHOW NAME" sourcz="1" index="0_SHOW.LAURA.SRDEMO_OCFEFAT9_SHOWNAME_1" idref="1" templatetype="BREAK" status="0" error="0" in="0" dur="100"
Cam 4 cfields>

|_clip_name" value="9AM news show - en"/>
I <item type="320" slug="PRUMIER" source="1" index="320_SHOW.LAURA.SRDEMO_OCFEFA19_PROMTER_-1" idref="m-1" templatetype="0" status="-1" error="0" in="0" dur="0" g
I <transitions value="MIX" rate="0" enable="True" mix_delay="0" default="true">

12:59:21 01:00

13:00:21 00:00
Clip - Pink
00:00

00:00

13:00:21 00:00 Copy to ClipBoard
If this is not present, here are possible causes:

The name is read from the first story in the NRCS rundown. Check the status of the first
story.

If for example it has been set to float, and is not displayed in Viz Mosart, you will need to
add the name to whatever story in the NRCS is now the first story.

If another story is Set As Next from Mosart Ul, then you will need to add the name to this
story in the NRCS which is now the first story.

If the Show Final Clip name was changed in NRCS during a Story Recorder session, this will
be taken into consideration only at the next Story Recorder session (disable Story Recorder
mode and enable again for a new show).

9.6.5 Unreliable genlock. See more details in AV Automation status
bar

If this warning is shown in the Story Recorder panel while running a show or in pause mode, this
means that Viz Mosart detected problems in the configured clock source (refer to Frame Accurate
System Operations) and automatically fell-back to the internal clock source.

Story recorder @8 On A\ unreliable genlock. See more details in AvAutomation status bar.

(M) 9AM news show - en : Broadcast

The AV Automation status bar will also indicate that there is an issue with the selected clock
source:
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il

(CELINLGI| Mirror | MR | ACTIVE| TDE | GEMLOCE (FIMeREe Info 10/4/2021

If the warning is shown infrequently, then the message can be safely ignored and the show can
continue as planned.

Viz Mosart has a built-in safety mechanism which takes care of intermittent or lost external
genlock and/or timecode signal (refer to section Genlock and Timecode Reliability in the
topic Frame Accurate System Operations).

If the warning appears frequently or it is persistent, the genlock signal and/or timecode signal
have become unreliable and must be fixed.

9.6.6 Genlock is not enabled

In the Story Recorder panel, this warning means the genlock has not be activated for Viz Mosart.
Refer to topic Frame Accurate System Operations for details on how to activate Genlock mode.

Story recorder (@ On A\ Genlock mode is not enabled.

(W) 9AM news show - en : Sfoadeast
™, r

Story Recorder can be used without having proper genlock setup and a timecode reader card
installed on the Mosart Server machine, but only for testing. In this case, the time of the day will be
used.

However, in order for Story Recorder to generate high quality final clip shows, frame accuracy is a
requirement.

9.6.7 Retake position no longer valid. Please set retake point

- This is a user error, described in the Viz Mosart User Guide , under topic Story Recorder
Mode.

9.6.8 Timeline can not be paused while pre-rolling

- This is a user error, described in the Viz Mosart User Guide , under topic Story Recorder
Mode.

9.7 Housekeeping

Viz Mosart automatically performs regular maintenance tasks to archive or delete working folders.
For Story Recorder operations, the following are important:

No management of local EDL folder (EdILocalFolder, typically set to C:\MMLogs\EDL) and EDL
transcoder folder ( EdIWatchFolder ).
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See Enabling the Story Recorder Log Adapter.
Whilst these files are not large, they will require an occasional purging.
- Viz Mosart can perform some management of the clips generated during a Story Recorder
session.
Intermediate recording files, prefixed with the string specified in the config
RecordingClipNamePrefix (default SRVizrt) can be routinely purged from the video
server, after a time lapse defined in RecordingRetentionDays .
- When enabled, this task is run every time the service Mosart Server Log Service is
(re)started .
Default value for the number of days to keep files on the video server,
RecordingRetentionDays is 'keep forever'.

A Note: Recorded clips can be very large files, easily filling the disk space.
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10 Viz Engine As A Switcher

10.1 Engine Switcher Mode

With Viz Mosart in Engine Switcher mode, you can create an IP-based workflow which eliminates
hardware studio switcher/mixers. In this mode:

Viz Engine performs the function of a switcher/mixer, switching IP inputs and all rendering
of DVE effects (box effects, butterflies, picture in picture, etc.) and full screen/overlay
graphics.

Engine Switcher works under exclusive control of Viz Mosart, but is not an integrated single
unit. In Engine Switcher mode, Viz Engine and Viz Mosart run in their own environments.
Viz Mosart templates can then control a broad scope of traditional and unique switcher
features.

On the Viz Engine side, the solution uses Viz Engine DVE based-superchannels for live,
graphics and clip playback, instead of texture based sources.

Superchannels can automatically swap sources in an A/B mode with animated transitions,
providing further flexibility and gains in overall performance.

& Superchannels

Note: A superchannel is an abstraction on top of a Viz Engine media channel.
Superchannels support various asset types like images, graphics, clips, streams, live
content. Each superchannel has two sub-channels, so content in each channel can be
played out over an A/B workflow. One sub-channel (A) is active, while the second (B)
is inactive. New content can be prepared on the inactive sub-channel, a transition
effect can then run the transition from the active to inactive sub-channel, switching
their roles.

As standard, the Viz Engine processes the dirty feed.
Optionally, a second Viz Engine can be set up, for a clean feed.

The following topics are presented:

Engine Switcher Mode

Features of the Engine Switcher
Requirements and Limitations
Installation

Configuration

Template Design

Custom Content Transitions
Labels

NDI Clip Preview

Summary of Configuration Points
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& Note: For most recent documentation, created after this software was distributed, please
visit the most recent version of this page (for example version 5.3) here at the Vizrt
Documentation Center.

10.2 Features Of The Engine Switcher

Preview and Program: Crosspoint can be set in preview or program (For example: cameras,
external sources, clips, full screen graphics).

Auto-trans: Instructs the switcher to perform the transition from preview to program. Viz
Mosart switches to preview and sends the switcher a command to initiate the transition at a
specified rate.

This is typically achieved through a mix with rate > 0, a wipe transition, or an effect
transition (using effect scenes) specified on the Viz Mosart template, in the story item
provided by the NRCS or from the Viz Mosart Ul.

A Note: An effect scene is a scene loaded into the Viz Engine's front layer on top of the
current switcher scene. These scenes are typically used to animate on top of the
actual switcher during a switch.

Key fill crosspoint set

The number of key buses correspond to the number of superchannels (DVE box
placeholders) supported in Viz Engine.

The switcher scene available for download contains 8 superchannels by default. You can add
more superchannels, to a maximum of 16.

A Note:
- While the theoretical amount of sources/superchannels can be up to 16, a

high amount of sources loaded on air at the same time might lead to

performance issues.

A key bus is represented with a superchannel. The number of superchannels is

configured in VizEngineSwitcherConfig.xml.

Top Scene support
A top scene is a scene loaded on to the Viz Engine front layer, on top of the current
switcher scene. This type of scene is typically used for opener or closer animations for
a show.
Top scenes are called by adding a top scene attribute to the Viz Mosart template
Load (cue) and play a top scene on the Viz Engine front layer.
Cue a scene on-air (using a Viz Mosart break template).
Take a top scene on air.

Preset support
The layouts for BOX effects (split screens, picture-in-picture, etc.) are stored within the
scene in a Presets plugin. A preset contains the transformation, alpha and cropping
attributes for each Viz Engine superchannel and its sub-channels.
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- Set a preset in preview by specifying the preset name and optionally providing content
for the preset labels from a Viz Mosart template or from the NRCS.

- Cue a preset on air.

- Take a preset on air, either by hard cut or transition. This transition can be specified
in either a Viz Mosart template or from the NRCS.

- Trigger the preset style using a keyboard shortcut.

- Go to the previous preset style using a keyboard shortcut.

- Clip support

- Cue aclip in preview.

- Cue a clip on air (using a Viz Mosart break template).
Play a clip.

- Scrubbing.
Pause (where camera and adlibs are back-to-back).
Up to 4 clips can be cued. Using a 2x ripple, this enables an A to B transition for the
single box.

10.3 Requirements And Limitations

10.3.1 Requirements

- Viz Engine 5.0+
Mosart version 5.1+

10.3.2 Limitations

Viz Mosart 5.1 introduced Viz Engine as a switcher. The feature set is being continually expanded
in successive versions. Please note the current state of the product:

No M/Es (Mix/Effects) support other than PP (Program/Preset mixer section).
No support for macro recall.

No support for auxiliaries.

No enable/disable of downstream keyers.

No cueing of full screen graphics on air.

No transition logic scenes.

- Overlay graphics are not a standard part of the Engine Switcher workflow. These elements
must be loaded on a separate Viz Engine instance/hardware.

- Whilst both the clean and dirty feed can be enabled, the clean feed requires an optional,
additional dual-channel setup.

No main and backup support for Viz Engine from within Viz Mosart.

- Only one clip can be visible (playing in PGM). This can be achieved by either using a key fill
crosspoint to play the clip within a DVE box, or via a crosspoint that presents a full screen
clip. In addition,

Box effects with more than one clip playing in the box are not possible.
- These clips and GFX scenes are always bound to the main superchannel 1 (SC1I).
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- A preview setup has to run on separate hardware.
This requires separate PGM and PRV Viz Engines. However, a simple clip preview is
configurable.

- Viz Engine supports up to 16 superchannels. This is a theoretical maximum, operations may
be limited by potential performance issues.

10.4 Installation

10.4.1 Sample Scenes

In addition to a standard Viz Mosart setup, Engine Switcher builds on Viz Engine scenes for
template-driven operations in Viz Mosart.
To simplify the show design process, sample scenes are provided by Vizrt.

To obtain sample Engine Switcher scenes

Authenticate to Vizrt's FTP at https://download.vizrt.com/

Navigate to products/VizMosart/Engine Switcher Scenes

Download locally, then import the switcher scene to Viz Graphic Hub
Set the path to the Switcher Scene in VizEngineSwitcherConfig.xml

A WN—

& Note: For latest installer files and template samples, please refer to the latest version of
this documentation here at the Vizrt Documentation Center.

10.5 Configuration

For first-time configuration, all the setup steps below must be followed:

AV Setup with Cross Point Naming and Mapping.

Video Switcher Setup

Graphics

Video Server and Port Configurations

Manual Configuration of the Vizrt Media Sequencer Engine (MSE)
and then to perform

Template Design.

uIh WN —

o

10.5.1 AV Setup with Cross Point Naming and Mapping

When Viz Mosart instructs a standard video switcher to put something in preview or on air, it is
sufficient to configure AV Config file with a list of crosspoints that correspond to the video signal
input configurations defined on the switcher.

In Engine Switcher mode, employing a Viz Engine as a video switcher, these standard rules no
longer apply. There are no video signal inputs for the video server ports in a Viz Engine.

Copyright © 2023 Vizrt Page 211


https://download.vizrt.com/ThinClient/WTM/public/index.html#/login
http://docs.vizrt.com/viz-mosart-admin-guide/5.1/Viz_Engine_as_a_Switcher.html

Viz Mosart Administrator Guide - 5.3

Instead, the crosspoints on the video server ports in AV Automation must be configured to point
directly to the port names configured on the Viz Engine.

Defining Sources

Source ID from 1 - N.

CLIP X-points from 1-6 are mandatory and used for internal switching.
GFX X-points are mandatory for graphics.

(v) T|p The X-point name can either be
the source ID as defined on the Switcher side

or

a Viz Mosart user-friendly name.
In this case, then source ID (as defined on the Switcher side) should be entered in
the Mixer name column.

':(-:F A/V Setup (c\channeltemplates\avconfig.xml)

File Edit Video config
X-point name Physical input Mixer name

» [ 1
2 2 2
3 3 3
4 4 4
5 5 5
6 6 3
8 8 8
cupP 9 CLP1
CcLIP2 10 cLIP2
CLIP3 n CLIP3
CLIP4 12 CLIP4
CLIPS 13 CLIPS
CLIPs 4 CLIP6
GFX 99 GFX

.

Audiolink

MIC 1
MIC 1
MIC 1
MIC 1
EXTS

Input type

v |camera

v

v

v

v

v

v

<

<

v

camera
camera
camera
camera
camera
camera
camera
videoserver
videoserver
videoserver
videoserver
videoserver
videoserver

extemnal_source

Audiolink Ch 2

MIC 1
MIC 2
MIC 2
MIC 2

Hide From User

O0NNREERRDOOO0OOOooO

Virtual set
recall

By configuring these crosspoints on the video server ports in AV Automation or referring to them

in Viz Mosart templates, these definitions enable standard Viz Mosart clip execution.

Effects

Effects need a unique Emem Nr for calling a specific effect scene.
Scenes are always prefixed with the string effect_x in the designated Graphic Hub effect

Scene folder.

x represents the Emen Nr defined in the configuration.
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Effect IDs must not be higher than 80, since numbers 80+ are reserved for transition effects
within superchannels.

* *A/V Setup (c\channeltemplates\avconfig.xml) O
File Edit | Effects
Emem Nr Emem Nr Emem Nr . Next cue

Effect name Effect Nr Preview Program Cleanup Duration RCC delay

» TRANSITION 4 10 15
HARDCUT 5 10 15
EFFECT1 6 1 10 -1 20
EFFECT53 7 53 10 -1 20
WIPE 80 80 10 -1 20
TWIST 81 81 10 -1 20

-

Presets

@ Tip: The concept Presets, is introduced below.

In Viz Mosart, you see the preset names in the A/V Setup ( AvConfig.xm ) file.

& Viz Mosart - AV Automation | NameDfGallery (SATT)

i

ik

ik Ch 2

Input type: Hidz From User

KAME

KAM7

KAME
DACH

Preset names

g
Eﬁ%ﬁﬁi&é!‘ﬁé;
i

5|3 2|3(% 5|33

Qe feje)e|<

Clefe e«

giiiii!!ii!

Jed<lclefe]<lcfef<]«
ooooooooooo

correspond directly to the presets defined in the switcher scene:

File Edit

s A/V Setup (c\channeltemplates\avconfig....

- 0 X

Engine presets

A Preset plugin, as it appears in a switcher scene:
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A Note: F1, F2 etc. are the default full screen options for each superchannel. F1 is

mandatory.

10.5.2 Video Switcher Setup

Video switcher setup is performed in Viz Mosart.

In a Viz Engine Switcher setup, there are no MEs, just PP.

1.

N

Navigate to AV Automation > Devices > Properties > Vision Mixer tab.

Device Properties

i\ﬁs'cﬂ Mixer | Video Servers Graphics Audio Camera Robotics Light Control  Router Subttles GPI/O Tally  Vitual Set Weather Video Wall Ge ¢

Protocol
Host videoswitcher:

Port videoswitcher:

Aunillary videowall 1

Default Camera mix on vw

Mix Effect Videowall 1

Min. Cue delay

Min. Clip Mix delay

FrameRate
Virtual ME
PP
ME1
ME2
ME3
ME4

Physical ME

PP
ME1
ME2
ME3
ME4

VIZRT ENGINE v

10.211.1.145
6100

Ini-EMEM

Reset emem vw 1
DVE Forward EMEM
4 ] DVE Reverse EMEM

4
Me & v

[25] frames
10 frames

Effect Memory

DSK Nr
[ AUX Clicked preview

[[] Use DSK 1 onloff
[ Use DSK 2 onoff
| 25| frames per second [] Use DSK 3 onloff
[ Use DSK 4 onloff

[ Control DSK from Overlay Interface
Overlay DirectTake control

Acive [ |
Inactive ||

[ AsRun log cross points in stand by

Cancel Apply Save & Close

From the Protocol drop-down menu, select VIZRT ENGINE.
In addition to the default values, enter the following:
a. Host videoswitcher: Location of the Viz Engine.

b. Port videoswitcher: default 6100 .
c. Tick the box to the left of Protocol. This indicates that you want to control the vision

switcher (mixer).

Click Save & Close.

From the Mosart Installation folder > Mosart Server > Configuration Files copy

VizEngineSwitcherConfig.xml file into your Mosart working folder (C:\channeltemplates or C:

\ProgramData\Mosart Medialab\ConfigurationFiles) and configure:
a. ControlScenePat: The path to the Switcher scene located in the Viz Engine.
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b. NumberOfKeyBuses: The number of superchannels defined in the Viz Engine.

10.5.3 Graphics

1. Select the Graphics tab.

Device Properties E

Vision Mixer Video Servers Graphics Audio Camera Robotics Light Control Router Subtitles GPI/O Taly  Vitual Set  Weather Video Wall Ge ¢ | *

General  Shows

VIZRT ~
Engines
Host Port  Handler name MSE Host Encoding Clicked Preview Auto Preview Preview engine
an | Il I[ bcahost | [UTFE__| O O 5 -
02 | I I localhost |[uTFs ] O O 2 -
3 [10211.1.145:57771| [ 57777 | [viz_background_c | [localhost |[utFs | O 4 -
4 [10211.15257777 |[ 57777 | [viz_backgound | [locabhost | [UTF8 | O | 5
os | Il Il lcahost | [UTF8 | O O 5
Database Miscellaneous
[ Configure MSE database settings Mos Playlist
[Opusfullscreen l
Path Externals
Password lenemd/pilaldb/elemenls ]
Datasource Local Media Sequencer Engine [_] Start MSE if not running
Schema PILOT “er ROGRAMFILES%\vizit\Media Sequencer Engine\launcher.exe ‘

[ Use Concept Override
Translate Cue for Transition Logic elements
® Notranslate O Take (O Take out

Viz Content Pilot
[] Connect to VCP client host

localhos 6484
B Port Take out full screen graphics Apply Channel Name to Elements

Cancel Apply Save & Close

2. In the field Host, add the Viz Engine entry for PGM.

A Note: A second Viz Engine, running on separate hardware, can be added for optional
PRV.
Enable the checkbox Auto Preview option and link it to the PGM engine.
See Clean and Dirty-Feed Setup.

3. Add the designated superchannel port for each Viz Engine (defaultis 57777).

4. Tick the Auto Preview box for the PGM Viz Engine.

5. From the dropdown box under the Preview engine column, assign the identity of the PRV Viz
Engine to it.

6. Follow the other guiding values as illustrated above, then click Save & Close.

These show up in AV Automation:
Status
Video Switcher: VIZRT ENGINE on 10.211.1.145:6100
Graphics3: VIZ 10.211.1.145:57777

Graphics4: VIZ 10.211.1.52.57777
Sound Player: Mosart Audio Player on localhost
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10.5.4 Video Server and Port Configurations

Select the Video Servers tab and add four server ports to create two clip server pairs:

A/B
C/D

Device Properties

Vision Mixer Video Servers Graphics Audio Camera Robotics Light Control Router Subtiles GPI/O Tally  Vitual Set Weather Video Wall Ge < |*

Video server configuration

v

Server Port 4

{8 AvConfig VIZEngine:1
Alias VIZEngine:2
Audio Channel 1 cupP1 B

VIZEngine:3

Audio Channel 2 (empty)
CrossPoint cupP1 VIZEngine:4
Video port 1

B Description
Name VIZEngine:1

Mosart port configuration
Main “|[Z][=] Wame: [Main
. M (%) DirectTakes
A: (VIZEngine:1) Mosart Port
B: (VIZEngine:2) Sk Coatig
Audio Channel 1 [[«lL3]
.
Audio Channel 2 | (empty) ~
C: (VIZEngine:3) CrossPoint (empty) ¥
D: (VIZEngine:4) B Description
Name A

B Server ports

Main
Mirror n/a
B Story Recorder
IsEnabled O
Cancel Apply Save & Close

These show up in AV Automation:

Video Ports

VIZEngine:VIZENGINE:10.211.1.145:6100
-A: VIZEngine:1 @CLIP1

-B: VIZEngine:2 @CLIP2
-C: VIiZEngine:3 @CLIP3
-D: VIZEngine:4 @CLIP4

10.5.5 Viz Engine Configuration

The following setup is performed on the Viz Engine.

Standard Viz Engine configurations

You will need to provide basic Viz Engine configurations that include definitions of:

Graphic Hub connection

Output format
Licenses

Amount of inputs.

If these are not already in place, refer to the Viz Engine Administrator Guide.
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Additional Viz Engine configurations for an Engine Switcher setup

1. Navigate to the configuration section Communication.
2. Select Super Channel Port and set it to an available Port (for example, 57777)

Super Channel Port

3. Clip channels: Activate the following clip channels:

Channel Video System

Clip Channel 1 HD - 1080i

Clip Channel 2 - 1080i

- 1080i

- 1080i

- 1080i

HD - 1080i
Inactive
Inactive
Inactive

HD - 1080i

HD - 1080i
Inactive
Inactive
Inactive

Inactive

a
v
e
=
A
v
a
=
a
v
a
=
a
v
a
v
a
=
a
v
e
=
A
v
a
=
a
v
a
=
a
v

HD - 1080i

Clip channels 7-4 and 10-11 are for full screen and box clip playback.

Clip channels 5-6 are optional for videowall integration playback (not included in default
setup).

Clip channel 16 is for clips loaded in top scenes.

10.5.6 Switcher Scene Configuration
The Switcher scene comes with a separate configuration file.
Copy this file to C:\ProgramData\vizrt\VizEngine.

This file enables modification of switching behavior, delays and the adding of a separate Preview
engine.

10.5.7 Manual Configuration of the Vizrt Media Sequencer Engine
(MSE)

The MSE handlers that you use must be set to superchannel mode.

This is performed manually in the VDOM configuration file.
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1. Navigate to http://localhost:8580/app/vdomconfig/vdomconfig.html, node /scheduler/
<handler name>. For example, in the AV Automation screenshot above of the Graphics tab,
the handler name is viz_background_c.

2. Add the following entries to both handlers:

<entry name="superchannel"/>
<ignore_cue_operation>no</ignore_cue_operation>
<ignore_out_operation>yes</ignore_out_operation>

Example of the MSE VDOM File

<handler connected="yes" mode="enabled" status='"good: Commands processed" type="viz"
name="viz_background_c">
<entry name="encoding">UTF-8</entry>
<entry name="state'>
<entry name="last">
<entry name="element">/external/pilotdb/elements/406</entry>
</entry>
</entry>
<entry name="renderer">
<entry name="10.211.1.145:57777">
<entry name="active"/>
</entry>
</entry>
<superchannel/>
<entry name="publishing_point_uri"/>
<entry name="publishing_point_atom_id"/>
<entry name="1info"/>
<entry name="superchannel"/>
<ignore_cue_operation>no</ignore_cue_operation>
<ignore_out_operation>yes</ignore_out_operation>
<command_timeout>30.</command_timeout>
</handler>

10.6 Template Design

A show with video switching performed by Engine Switcher, is controlled exactly like any standard
video switcher-driven show, from a rundown with associated Viz Mosart templates.

@ Tip:
- For an overview of template design with examples, please refer to the section

Template Examples, section Switcher Plugin.

To download sample scenes, see To obtain sample Engine Switcher scene.
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10.6.1 Introduction to Presets, Top scenes and Effects

Viz Engine Switcher operations depend on distinct criteria, controlled from a Viz Mosart template.
All settings are made during template design, as described in the section Template Editor.

Three concepts for Engine Switcher operations are:

Presets
- Top Scenes
Effect Scenes.

Presets

(@ Info: The term preset originates from scene design in the Viz Engine. The composition of
the scene is defined by x,y positions of a collection of 'windows' (two in the illustration

below) in a Viz Engine superchannel. These definitions describe:
- The number of windows
- The position of the windows
- The size of each window.

Switcher Scene

Each composition, saved on the Viz Engine, is called a preset.

A Note: Superchannel 1 is considered the main superchannel for full screen program
switches. The preset FI is mandatory for this workflow and must not be altered.

Viz Mosart includes a sample Switcher scene with eight presets.
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Use Viz Artist to edit any preset.

Mixer Switcher Scene
ion

2022
niy!!

Add, edit and remove presets -
we provide B to get started

For more details, refer to the Viz Artist User Guide.
In Viz Mosart, you select the Preset name from the list of preset names that have been

configured in A/V Setup (AvConfig.xml) file.

APV Setup (c\channeltemplates\avconfig xmi)

File | Edit | Video confly
Video config Mixer name Sk rechink 2 - O :;Ict:abel -
Audia canfig
' Bfects £ v < [camera 5 ]
Router sources 90 MICS hd ~ | camera ~ m]
Router destinations %1 WICS ~ e — = O
Engine Prasets %2 MCs ~ = » O
Engine Top Scenes 563 MICs w v camera v ]
o — 954 WIS ~ S ™ o
KAMG %5 565 MICS < g ™ 3
w1 KAMT 966 566 MCS = = . &)
KAME el %7 WICS » o — - a]
Fﬂ!! DACH %8 o8 S o - =
w " o 69 v | osemal_source - o

Transition style

The transition style (hard-cut or animation), and several label values can be specified.

For example, in a DVE template (where Switcher plugin for the device is available), you can
select the layout and look of the DVE effect by specifying a preset style (Style), the preset
transition and the DVE window labels (Labell - Label8), as required:

Switcher plugin properties

[J Top scene
B4 Preset
M Animate

Label1: Label2: [Mary Poppins

Label7: :l Labels:
A

dd Newsroom tag
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You can also provide static values directly on the template. Additionally, newsroom tags can
be configured to enable control from the NRCS.

Top Scenes

A typical use of top scenes is as an opener. For example, the top scene is played to introduce the

Eight O’clock News show with many visual effects that fade to the following camera scene, when
the news host takes over.

3 top scene designed to only
| start fading into full

top scene started by
. jingle. Lots of visible
E drama here, fully opaque. !

s
\ 1

transparency when in cam1
item.

top scene

cami
4 A

]
/ |
;

1
\
1
autotake item. :

' hosts starts talking
| around here.

To Create a template to play a top scene

1. Select an appropriate template, for example Graphic or Jingle, corresponding to your Engine
Switcher-controlled operation.

2. Enable Switcher plugin for the device.

3. From the Switcher plugin properties menu, specify a top scene name:
a. None (Top scene unchecked)
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b. Check Top scene and select from the drop-down list of top scenes (configured in the

A/V Setup).
Template Editor | *SAT1: INGLE + OPENER Sat1 Switcher plugin properties
File » Template » Template Set = DB -
‘:‘ SAT1>Basis | Toke ‘ [ Top scene
JINGLE + OPENER Satl
Name:

O Preset

description SAT1 DB

Time-related configurations

There are two time-related aspects for top scenes (similar to handling clips):

1. The time it takes for the scene to load. This is controlled automatically by Viz Mosart when

cueing the story item.

2. The time it takes for the scene to run. This is controlled with the template configurations

Fixed Duration and Autotake next.

Template properties

General  Cortrol Commands  Newwsmom tags order  Destnation panel

Name Type Vanart Descripbon
rame GLE ] [Cpmmer ] Gwarenon
[] Default NCS variant [ Use state variants
[ Send 10 NCS
Prelcad B [N
Pfer
Pretake >
[ Take 2t planned story in-time
[ Fixed Duration ' '
.w 05:00 uwp Down
[ Sweey Duraticn
Plicttskenet  OfSet | 0| passme 2
Fleset State e 2 Stones
Last sinte
Single State
[] b Sequence b
[[] Hide from user
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Top scenes are started from within a story item and if long enough, continue to play even
when the item ends.

Top scenes ignore story items boundaries. The take out of a story item must match the
animation length of the top scene.

Top scenes can be played on top of anything else.

top scene started by top scene fading out
first item. over the first 3 items.

-

top scene

o

item 1 item 2 item 3 item 4

To create a template that plays a Viz Engine Top scene
The sample script below (code block) performs this operation:

1. Initially the scene is fully opaque, covering the switcher completely.
2. On Take, an animation starts.
3. After a pre-defined time, the openers content disappears (animates or fades out).

The Engine Switcher workflow does not need to contain a script; it is purposefully designed for
simplicity. A script can be added, to call the "clear_front_layer" routine of the switcher script which
will force-remove the top scene from the front layer after the animation is finished.

Example Script

sub OnInitParameters()
RegisterPushButton("clear_front_layer", "Opener Close", 2)
end sub

sub OnExecAction(buttonId As Integer)
if buttonid = 1 then clear_front_layer()
end Sub

sub clear_front_layer ()
dim commandStr as string = "RENDERER*MAIN_LAYER*SCRIPT INVOKE clear_front_layer"

println 5, "-—-—-—-—-—-—-—- TOP SCENE OUT ———————————————— "
System.SendRemoteCommand ("localhost", 6100, commandStr, 0)
end sub

In this case a clear_front_layer button is added to the animation in the Stage
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Dopesheet/Spline View

+ — o] & @ ig
@ Default

© Rectangle
“width

@ Alpha

Merdana-Regular ]
me ‘—Al'ha

@ Script
lIIIIlﬁﬁﬂﬁﬂ!ﬂﬁﬂllllllllllllllll

Effect Scenes

Effect scenes, similar to Top scenes, are loaded to the front layer of the Engine Switcher for an
upcoming switch between sources. These scenes are loaded automatically once a transition effect
is triggered in Viz Mosart. Scene names must be added to AV configuration and are typically
named "effect_<id>".

Example Effect

1. The scene is fully transparent at the beginning of its animation.

2. At Take, an animation starts to show content, animating to fully cover the scene underneath
it (switcher).

3. After a predefined time, the animation reaches the autotransback script routine, which
triggers the switch in the Switcher Scene.

4. The animation fades out, being fully transparent again.

Script

Two routines, one for triggering the take (auto_trans) and one for its removal when the animation ends:

sub OnInitParameters()
RegisterPushButton("autotransback", "Auto trans back", 1)
RegisterPushButton("clear_front_layer", "Effect Close", 2)
end sub

sub OnExecAction(buttonId As Integer)

if buttonid = 1 then autotransback()

if buttonid = 2 then clear_front_layer()
end sub

sub autotransback()
dim commandStr as string = "RENDERER*MAIN_LAYER" & "xSCRIPT INVOKE auto_trans"

println 5, "-=-—------—-——- TOP SCENE TRANS FROM FL SCENE ———=--—=--——-———-— "
System.SendRemoteCommand (" localhost", 6100, commandStr, 0)
end sub

sub clear_front_layer ()
dim commandStr as string = "RENDERER*MAIN_LAYER*SCRIPT INVOKE clear_front_layer"

println 5, "--—-——-—-—————- TOP SCENE OUT ———-———————————— "
System.SendRemoteCommand (" localhost", 6100, commandStr, 0)
end sub
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@ Default

SRectangle |
| “Position

e

@ Script
':autotransback
clear_front_layer

A Note: Using effects scenes on a separate/external Viz Engine.

- Edit the script to send the RemoteCommand for "autotransback" to the Engine
Switcher. In this case the IP needs to be manually changed to the correct external
one in the effect scene.

Keep in mind that using an external engine for triggering effect transition switches
might lead to timing inaccuracies due to possible network delays.

10.7 Custom Content Transitions

This section describes the actions required in Viz Artist, when working with Engine Switcher-driven
Viz Mosart templates.

& Note: Content transitions are only used for full screen content transitions. Transitions in
between Boxes / Splits are always hard cut.

10.7.1 Preset Plugin

The Preset plugin creates a default content transition for a crossfade. Additional transitions for
changing content within superchannels are created manually using Viz Artist.

Default Preset plugin crossfades

(-] Superchannel 1/A
‘ I:Alpha
PosX

e Superchannel 1/B
I:Alpha

PosX

(-] Superchannel 1/&
‘ I:Alpha
PosX

@ superchannel 1/8
a

A custom content transition is saved to a special director name, called by the Switcher from
Viz Mosart.

This director can contain the required transition animation.

Typically, a content transition director contains the keyframes related to the superchannels
sub-channels A and B.
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Content transitions are created in both directions. A separate director is used for a transition
between A to B, and B to A.

To define a director

A director has the following naming format:
content_transition:<ID>:<direction>:<transition_name> where

ID: Superchannel ID
direction: AB or BA
transition_name: Name the transition that will be called in the Ul (for example wipe).

10.7.2 Custom Effects

Custom effects scenes are manually added to the Engine Switcher's configuration file.
& Note: Custom effects IDs start at 80.

To create an Effect

1. In Viz Mosart Mosart AV Automation:

'-‘t-:';"» AV Setup (c\channeltemplates\avconfig.xml)

File Edit Effects
Effect name Effect Nr g’;i?;rr E':;;?;::r é@::ur:r Duration
HARDCUT 5 10
EFFECT61 6 61 10
EFFECT53 7 53 10
WIPE 80 80 10

2. In the Viz Engine Engine Switcher Configuration file, C:
\ProgramData\vizrt\VizEngine\switcher_config.cfg

#custom content transition effects
<content_transitions>80:wipe,81l:rotate,82:twist</content_transitions>
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3. The effect is now available for selection in Viz Mosart:

VIZEngin 00: 1AL

5 HARDCUT

6 EFFECT61

7 EFFECTS3
00:10:00 80 WIPE

Preview

1.mxf

Example - Effect 80 - Wipe:

A typical wipe is set up by animating the subchannel's X position from left to right, then having the
other subchannel follow.

'acmtﬂ'lt_tl?.!'lsilion:l:BA: il
0O Scene - —
-] Superchannel 1/A
“posX
@ Superchannel 1/B
LposX
content_transition:1:AB:

e
e

(] Superchannel 1/A
| “Posx

@ Superchannel 1/B
“posX

Values:
(1) Direction AB (content_transition:1:AB:wipe):

- Assuming sub-channel 1/A is visible and should fade out to the right
Keyframes for Pos X are set to
- Superchannel 1/A:
- Start: 0.0
End : 100.0
- Sub-channel 1/B starts on left to 1/A and animates onto the screen
- Superchannel 1/B:
- Start:-100.0
End : 0.0

(2) Direction BA (content_transition:1:BA:wipe):

The roles are now switched, this means 1/B starts on the screen, animates to the right and 1/A
now appears from the left.

Copyright © 2023 Vizrt Page 228



Viz Mosart Administrator Guide - 5.3

Keyframes for Pos X are set to
Superchannel 1/A:
Start : -100.0
End : 0.0
Sub-channel 1/B starts on left to 1/A and animates onto the screen
Superchannel 1/B:
Start : 0.0
End : 100.0

10.8 Labels

Label names (newsroom tags) and their content, defined in a Viz Mosart template and filled out in
the NCRS, are stored in shared memory when the story item containing the box template is cued.

When a new DVE box is cued, the designer dynamically reacts to any label change. These changes
can either come from a script included in the Switcher scene background or from another scene
located on another networked Viz Engine.

10.8.1 Label Format

The format of the received string comprises label names and label values. Each label pair is
separated with a "' character, giving:

<label_namel>:<label_contentl>|<label_name2>:<label_content2> |
<label_name2>:<label_content3>|<label_name4>:<label_content4>...

Example: Labels populated from a DataPool plugin

The default map name is MIXER_LABELS. This can be changed within the Engine Switcher
Configuration.

In this example you use a Vizrt Datapool plugin to access the content of the shared memory and
deliver its content to a specified text container.

An SHMTracker plugin reads the memory content.

The content is forwarded to any other Datapool plugin within the scene.

Here, ataText receives the memory content from SHMTracker and parses the values into a
readable format

The content is pasted into the geometries Text plugin.
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<+ labels

ABCm 4+ label1

Y ABCm 4+ label2

Add the SHMTracker plugin to it.
Set a unique ID for Output Field Name, in this example mixer_labels.
Data SHM Tracker

Output Field Name mixer_labels

[] use other Container

Distributed
MIXER_LABELS

To access the Switcher scenes used SHM, set Shared Memory Type to Distributed.
Assign Share Memory Key Name. Default is set to MIXER_LABELS.

Create a child container and name it labell.

Add the Data Text plugin.

Set Field Name to the same ID as used in the parent plugin. In this example, mixer_labels.

In Rebuild Now
a. Check Trim Options.
b. Check Remove Prefix Until and enter Sub String labell=
This crops the label from the incoming string.
c. Check Choose an Entry.

5.3
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i. Set Delimiter to /
This crops the string

Data Text

Field Name mixer_labels

, revealing the first label entry.

|:| Notify Only On Change

|:| Use Other Container

|:| Use Conversion Table

Prefix

Suffix

Rebuild Now

Trin

|:| No Delimiter -> Empty String

Ren

|:| Remove Suffix From (including)

Choose an Entry

Delimiter

Number
|:| Choose Characters
|:| Choose Lines
|:| Replace back slash n by EOL
|:| Replace back slash Quotation by Quotation
Convert Case None

10. Repeat these steps for all required labels, modifying the sub-strings accordingly to label2=
etc.

Example of a container script

The default map name is MIXER_LABELS. This can be changed within the Engine Switcher
Configuration.

This simple script example shows how to read in the content of a shared memory map, parsing the
content for label name and content and pasting it onto an existing text container.

The given example reacts on a mapping change that typically is triggered from cueing the next Box
item.

sub OnInit()
VizCommunication.map.Registerchangedcallback ("MIXER_LABELS")
end sub

sub OnSharedMemoryVariableChanged(map As SharedMemory, mapKey As String)
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dim labels as String = VizCommunication.map["MIXER_LABELS"]

'parsing and reacting routines
Parse_Labels(labels)
Set_Labels()

end sub

sub Parse_Labels(input as String)
Dim params as Array[String]
Dim content as Array[String]

input.Split("|",params)

For each param 1in params
param.Split(":",content)
labels[content[0]] = content[1]

Next

end sub

'setting labels (container name equals label name)
sub Set_Labels()
dim label_keys as Array[String]
labels.GetKeys(label_keys)

for each key in label_keys
This.FindSubContainer (key) .Geometry.Text = labels[key]
next
end sub

& Note: For more advanced use cases, please contact Vizrt Support.

& Note: The actual toggle event of the next story item can be accessed by registering on the
the <toggle_status> map, as defined in the Engine Switcher Configuration.
This allows the designer to trigger animations related to an upcoming change of the
layout.

10.9 NDI Clip Preview

If a simple preview of the upcoming clip layout/switch is needed and a separate Viz Engine cannot
be used, you can instead add a small nested scene to the Switcher scene. This can stream the next
cued clip via NDI (Network Device Interface, a protocol).

& Note: The Media Preview feature used in Viz Opus is no longer supported.
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10.9.1 To stream a preview with NDI
Engine Switcher is configurable to send clip cueing commands to a separate scene if needed.

1. Add the scene to a GFX channel within the Engine Switcher scene.
By default, GFX channel 14.
2. Add this channel manually to any existing Switcher scene.

Scene  Media Container Camera  Light

=fx M GFX14/TEXTURE GFX14

clip_preview

- |« > H >

I
D Controlled
D Force Key
Keep Aspect
Camera

Default Resolution

v Adaptive Scene Design Formats

Requested Format default

Active Format default

3. To activate the NDI output of GFX channel 14, activate NDI Aux Mode.

Scene  Media Container Camera Light

mx M GPX14/TEXTURE GFX14
GRX Channei =

CH <

®
1 4 SHM Aux Mode Inactive

NDI Aux Mode

GFX channel 14 will now be received as a separate NDI stream on the network.

Previewing a scene
The preview scene setup is simple.

4. Clip channel 14 and 15 are used to load the next cued full screen or box clip.
The layout of the scene itself does not matter and requires no further logic.
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5. The two clip channel

HC

are added as texture to the scene and can be placed as required.

CUED CLIP

FEEo0REEER BN

¥ (-] <« um> ¢ [T+ R LAEREES
6. Ensure that the required clip channels are added as texture within the scene.
Scene  Media Container Camera Light

/23 ! CLIP14 / TEXTURE Clip14
Clip Channel E 1:'. »

®
1 4 SHM Aux Mode Inactive

Setting up Viz Mosart

7. In Viz Mosart, select the source in the Preview window.

8. As soon as a clip is cued as next item, the GFX channel scene loads the paused clip. This
updates the NDI stream of the Mosart Ul.

Preview Program

Show next item update
VIDEOEFFECT 4BOX_2

Hide video preview types in preview

Always hide mark in/out control

Select ndi preview PTZ3UHD-560575 (Channel 1)
Z8-0OPUS (Remote Connection 1)

HA HV " Z8-OPUS (VizEngine-0 GFX-14)

CUED CLIP

10.10 Summary Of Configuration Points

Viz Engine configuration
C:\ProgramData\vizrt\VizEngine\VizEngine-0.cfg
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@ Tip: A copy of this config is included in this Administration Guide under
Device Configuration Files > Engine Switcher Configuration File.

- Switcher scene configuration
- C:\ProgramData\vizrt\VizEngine\switcher_config.cfg

- Viz Media Sequence configuration
localhost:8580/app/vdomconfig/vdomconfig.html
- Viz Mosart
C:/channeltemplates/VizEngineSwitcherConfig.xml
- C:/channeltemplates/ClipServerVizEngine.xml

A Note: VizEngineSwitcherConfig.xml and ClipServerVizEngine.xml are originally
located in the Viz Mosart installation folder C:\Program Files (x86)\Mosart
Medialab\Mosart Server\ConfigurationFiles.

See Also

- Vision Mixer

10.11 Clean And Dirty-Feed Setup

By default, Engine Switcher is set up to show only a combined dirty feed output. A clean feed
configuration must be set up manually.

& Clean and dirty feed

- Avideo signal that does not have any graphics or effects embedded, is called a clean

feed.
- A video signal that has graphics or effects enabled is called a dirty feed.

- Working with Clean and Dirty Feed
- Engine Switcher Terminology
Hardware Configuration
- Software Configuration
Output Format
- Viz Mosart Overlay Graphics Configuration
- Additional Software Configuration

Running two Viz Engine instances on the Engine Switcher server enables production of both
dirty and clean feed.

- This setup will use one program output on the clean feed and one video input on the dirty
feed.

- The clean feed signal is routed back into Engine Switcher through the Matrox video card,
using the zero-frame delay at one of the video inputs.
Zero-frame delay at the input prevents any additional delay to the final program signal.

Copyright © 2023 Vizrt Page 235



Viz Mosart Administrator Guide - 5.3

- All overlay graphics and transition effects are then added on the clean feed signal,
producing the dirty feed.
- The dirty feed is then sent out on two program-out channels.

A Note: Clean and Dirty feed are rendered by 2 instances running on the same GPU. As
resources are shared, creating a heavy load on one instance might affect the performance
of the second one.

10.11.1 Working with Clean and Dirty Feed

Engine Switcher Terminology

Clean Feed
The clean feed provides:

Full screen video live sources
Full screen clip sources

Full screen GFX elements
Butterfly effects (PiP effects)

Dirty Feed
The dirty feed adds overlay graphics on top of the clean feed output.
Clean Feed Engine Dirty Feed Engine
Front Layer Transition Effects Overlay scenes
Main Layer Full screen GFX Overlay scenes
Back Layer Not used
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Example: Output of clean and dirty feed.

Clean feed dual instance Dirty

Hardware Configuration

The current clean feed solution needs a hardware wiring using a short SDI cable from the SDI OUT
D (pin 8 on the X.mio3) to SDI IN A (Pin 1). Engine Switcher is using the "Zero Frame Delay" option
within Viz Engine 5.1. This provides a direct signal copy from Input A to Output A without
introducing an additional delay. Therefore there is no need to load a keyer scene to the dirty feed
engine.
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To configure the Matrox board

Matrox Pin Out for Engine Switcher clean and dirty feed setup (Zero Frame delay):

Routing of video signal on the Matrox board.

Viz Opus, Dell R7910, HP z840, Dual GPU
Matrox X.mio3

Engine1 (-u2) / Clean Feed Engine2 (-ud) / Dirty Feed
VideoOut B VideoOut D Videoln A VideoOut A VideoOut C
Program Program R Program  unused
AT embedded
[ 2) (®) MATROX 4 }
Program Program
out out
Clean Dirty

|64'{cha"“e‘s ‘ A ‘ Matrox AES ‘ B ‘}

[res 1z |[aessa |[ nesse |[nes7e | acs1z | [ aesaa |[ acsse |[ nes7e

ChRnulIthﬁfl + N it ™ n
ChRoutgClip 2/3 1 ChRs lip 67

YAMAHA

Blue arrows: with embedded audio
Blue text: Matrox AES output cable

Software Configuration

This sets up Viz Engine in dual channel mode.

To configure the Viz Engine in dual channel mode

1. Install Viz Artist and select Dual Channel mode.
Dual Channel installs and adds these icons to the desktop:
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. Replace the default configuration files with those provided on the Vizrt FTP.

Files are in the folder /Product/VizMosart/Engine Switcher Scenes/

. Rename them according to the computers name:

a. Engine 1 - clean feed -> <machinename>-1-0.cfg
b. Engine 2 - dirty feed -> <machinename>-3-0.cfg

. Modify the dual channel shortcuts.

For Media Preview to work in Engine Switcher the clean feed instance needs to run in console
mode (no Viz Artist).
a. Configure the desktop shortcuts properly by adding parameters:
i. -x (no Ul, mandatory)
ii. -ul or u2 depending on the graphics board used.
-ul points to the first engine on the first GPU
-u2 points to the second engine on the first GPU
iii. -n for engine mode
iv. -c config mode
- ul or -u2 for config shortcut of engine 1 or 2.

. Port Configuration.

Make sure that the ports are set correctly. This should be set when using the
a. Clean feed runs on port 6100
b. Dirty feed runs on port 6800

Output Format

Please note that the video format must be manually modified for the affected config files.

- The default is set to 1080i50.

To set the output format

Changing the format is easily done easily by loading the appropriate configuration profiles:

1.
2.
3.

Start the Configuration Tool for the clean feed Viz Engine.
Click Load and choose Installed Profile.
Navigate to C:\Program Files\vizrt\VizEngine\Configuration Profiles and choose the correct
option
- video-resolution-1080i50-audio-xmio3.cfg
- video-resolution-1080i60-audio-xmio3.cfg
- video-resolution-720p50-audio-xmio3.cfg
Save the configuration and close the Tool.

. Start the Configuration Tool for the dirty feed engine and repeat steps 2-4.

Viz Mosart Overlay Graphics Configuration

To set up Overlay Graphics configuration

The Overlay Graphics applications configuration needs modifying, to send Overlay scenes to the
dirty feed on Port 6800 (instead of the default port 6100).

1.

2.

From the Viz Mosart server machine, open the Mosart Graphics Interface application
(MMOverLayGraphicsinterface.exe).
From the menu bar, select Settings > Properties.
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3. Fill-in as illustrated:

& Viz Mosart - Overlay Graphics Configuration - [m] X
Graphics configuration Mosart graphics destinations
. DSK (2-DSK) §
Vizrt engine Vizrt handler
1 [Dummy(1)] WALL (n/a)
B Configuration E Behaviour
Channel 0 FULL (n/a) Always Take In O
Encoding UTF-8 Continue Scene O
Haost localhost:6800 WALL 2 (n/a) El Configuration
I peven g
Bl Description WALL_3 (n/a) Bl Description
2
Name WALL_4 (nia) Name DSK
E Handler O Link
Handler Id 2 WALL 5 (n/a) Handler 205K
Name DSK = Replace takeout logic
WALLT (n/a) Enable O
WALL2 (n/a)
WALL3 (n/a)
TABLE (n/a)
BRANDING (n/a)
Grephics Profiles  Actions MMR  General Obsolete Config
Please select a controller to edit Graphics profile data

4. Restart the applications to save changes.

Additional Software Configuration

Configure the Viz Engine in dual channel mode. It can initially be installed as a single engine, but
then you still need to configure the shortcuts and adjust the Viz Config.

Execute all three procedures:

1. To set dual channel mode (Viz Engine)
2. To configure clean feed
3. To configure dirty feed

To set dual channel mode (Viz Engine)

1. For default configuration of a dual channel, load the dual channel profiles for Channel 1
(Clean) and 2 (dirty). This will set the correct Ports.
C:\Program Files\vizrt\Viz3\Configuration Profiles
dualchannel -0.cfg
dualchannel -1.cfg
2. Load the correct audio profile on both channels via the configuration tool
C:\Program Files\vizrt\Viz3\Configuration Profiles
video-resolution-1080i50-audio-xmio3.cfg

To configure clean feed

The clean feed configuration should be based on the file provided in the bundle installer.
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1. Configure Program and Contains Alpha to Inactive.
See Video out documentation to configure the program output of the engine to output
program (fill) on VideoOutB and VideoOutD assigned by setting the Map to Viz channel t for
reference.
2. Configure the video inputs.
a. Start by disabling video 1 by setting VideolnA to Unused.
b. Set all other to the corresponding Video number
(VideolnB to Video?2, VideolInC to Video3 etc).

3. Changes done with the configuration tool are stored in <machinename>-1-0.cfg.

4. Video (Matrox board configuration)
a. Mapping Live Outputs:
i. Set Out B and Out D to Program
ii. Set Out A and Out C to U unused
iii. SetIn A to unused
b. Mapping Live Inputs:
i. In A set to unused
ii. InBsetto Livel
iii. In Csetto Live 2

iv. InH setto Live 7
c. Activate Live 1 to Live 7 in Input config.
5. Audio
a. Audio Mode is set to AES
b. AES audio routing for clips needs to be done directly in the config file.
Default settings for 2 separate audio channels:

ChannelRouteClip0_0 0
ChannelRouteClip1_0 2
ChannelRouteClip0_1 1
ChannelRouteClip1_1 3

To configure dirty feed

@ See the Video out documentation for reference.

Changes should be done uses the Configuration Tool.

Configure the program output of the engine to output program (fill) on VideoOutA assigned:
Set Map to Viz channel to Program

Set Contains Alpha to active.

Configure the video inputs by setting all of them to Unused.

If not already set by the preloaded dual channel profiles, set communication General
communication port on this engine to 6800.

7. Verify that the changes are stored in <machinename>-3-0.cfg.

8. Video (Matrox board configuration)
a. Mapping Live Outputs
i. Set Out A to Program

ousewN=
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ii. Set Out B, Out C and Out D to Unused
b. Mapping Live Inputs
i. Set all Inputs to Unused
9. Audio
Audio on the dirty feed is not supported by default.

Routing of the AES channels is performed manually in the Viz Engine's configuration file.
10. Additional settings

- Turn on Zero Frame Delay option.
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11T Viz Arc Support Within A Mosart Show

Viz Arc is an augmented reality control system, which enables users to drive virtual sets, AR
graphics, Viz Engine and Unreal® Engine graphics from a single interface. These elements can also
bedriven from a Viz Mosart show.

The illustration below highlights the main actors and minimum component versions required for
configuring Viz Mosart to manage Viz Arc actions within an NRCS-created rundown.

replicate Viz Arc project files

Newsroom studio

| VizArc |

i
I

i

i

i

I

i

!

I

I backend ! Viz playout content —3 |
| vaen | PDS | (ﬂ‘ ,,,,,, 5 !
* v 9.0+ 2= 1

i

I

|

|

I

I

Viz Arc actions

o R
NRCS Pilot Edge
RER Viz Arc
> ] ) .
| Viz Mosart MSE ] Viz Arc client
v.5.3.0+ vE5+ v18.1+

- 7 - e __.
|

X

Y ¥

»/ VizEngine f-————__ »

{2}
3
@
D
m
=
<
=
@

v 5.0+

MOS integration
Driver Configuration
Mosart Workflow

11.1  Configuration And Setup

11.1.1 MOS integration

To setup Viz Pilot Edge with Viz Arc

Refer to the Pilot Edge documentation.

A Note: In the diagram above
A second Viz Arc backend is set up on the Newsroom System machine for
security reasons.
Viz Arc does not currently support authentication. If this is not an issue, Viz
Pilot Edge can be set up to directly fetch data from the Viz Arc playout
backend.
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To create a Mosart show containing pre-planned or manual Viz Arc actions

1. Open Viz Pilot Edge from the NRCS.

2. From the respective drop-down menus, select Project, Profile and Tab to browse the Viz Arc

actions.

2 INEWS

File Edit View GoTe Story Format Tools Communicate  Window Project Help

[e [ ]lu]i[n]le]fcc][m]
EIEO

[allallz][e]
[e][o][c][o]

[A][C

VizPilotEdge

Viz Pilot @1
Edge

; Arc Actions

Projects Profiles Tabs Actions

= pgotest ¥ | | Local v | | Al

¥ Playout Instructions
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3. Select a Viz Arc action and enable the Playout Instructions to add timing and the trigger
(Timed or Manual).
VizPilotEdge

Viz Pilot =1 s ; Arc Actions

Cleanup

Cam 1 wall - left

i
Cam 4 - window
Y Y

Cam & - Ceilling Cam 2 - the sky Cam 6 - Wall Menu

]
Cam 5 - 6Box Wall...

A Playout Instructions
Enable In Duration Trigger

¥ o4 04 00:00 )

4. When the trigger is set to TIMED, the In field can be set to give the offset in minutes and
seconds relative to the story item start.
a. In this case, Viz Mosart will play the action when the story item is taken or with the
given offset.
b. If the Trigger is set to MANUAL, Viz Mosart will not automatically play this item, but
mark it as a Manual item in the UL

& Note: Out and Duration are not yet supported for Viz Arc actions as these
actions do not support such events. Only In time is relevant.
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5. Use the plus icon in the top-right corner in Pilot Edge to drag and drop the generated MOS

object into a story.

7 INEWS

File Edit Vien GoTo Story Format Tools Communicote Window Project Help
B | (Hm®IE |

BoaE BEo |

\ \

876 @ HElole |

BREE]

\VizPilotEdge : IN3PSWWM]SHOW.LAURA.VR_DEMO.Load VR set %]
i N Directory | project Audio | PAGE] TAL [5LUG VDD | SHOT|FORMAT [ GRAPHICS | CH| CAM[ ST
e et Ml Aceon: - T2 ] 'Manual elements
Edge {31 SETASNEXTST | |Load VR set
% [VRSet F Eiuu::us - IE ISR IViatTes0; |
552 - -G VD Hi [ [Story2 | |
H 151! orFLesTaTy || | |Story 3 ViztTestl| |
[ THEMEBOXLWI | |Story 5 |
[l asaroLLFord. |7 [ [Story 6 [
g serneall | i Istory7 VierTesti |
e W1 sty 8 veowr| |
~[Ji! PERFORM
[ PERFORMBCK
3 [ RECUEALIE ||
= > [ FLASHCLIPCUL
load Vizrt_VSS Cleanup e
| TV2FULLGRAP)
[ TVIFULLGRAP!
Cam 1 wall - left SUR
: Al >
Canch i L g PAGE  MOSACTIVE DIRECTTAKE DT Mosart Type _ Mosart Variant _ Mosar *
am 4 - window
: £ [ ]
) M g Audio  TAL  SLUG CAM  SHOT  FORMAT GRAPHICS REZ
Cam 6 - Celliing Cam 2 - the sky Cam 6 - Wall Menu - 1 ‘ Load VR set H ” ” H ‘@
g
- & MODIFIED. MOD BY. EDITOR WRITER VID-D CH  STATUS TAPE#
] Soem— e &
L E l 2/20232221:16 [ mosart [ If If 1 [ 1
g
{Ei
E "mosart BREAK o
o
g pilotload Vizrt VSS
{5
g
O
jEi
-0
g
O
&
-0
¥ Playout Instructions & wix |
[ VIZGRXLBUPC [+ |
| 2 |
Ready k) CAP. NUM OVR A

In this example, a Viz Arc action was added on a Break story to load a virtual set scene.

11.1.2 Driver Configuration

The Vizrt Graphics driver to communicate with Vizrt Media Sequencer through a REST API exposed

by Media Sequencer.

Refer to the Vizrt Graphics section of this guide.

11.1.3 Mosart Workflow

When a rundown containing Viz Arc MOS objects is loaded in Viz Mosart, Mosart will parse and

attach the asset data to a default Accessory template:
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S  —— | =
O Vi it type="220" slug="cam 5 wall - z00m out" source="1" index="220_SHOW.LAURA.VR_DEMO_058C198F_cam5wall-zoomout_3" \drel:“}ltemplats;’pe:'ACC—DEFAULT“Italus:“O"
4 <ields>

<field name="tc_in" valu: 0:06" default="00:00"/>
<field name="asset-data"
<field name="asset-type" valu
<field name="asset-statu: ="0"/>
I <iransitions value="DEFAULT" rate="0" enable="True" mix_delay="0" default="true">

Copy to ClipBoard

Because the Accessory item has attached a Viz Arc asset type, the visualization of the Accessory
item is different to the standard plus on a black background.

Please refer to the Viz Mosart User Guide (section Rundown Window > Story Elements > Secondary
Story Elements), for more on the visualization of the Accessory items.

If the template does not exist in the current studio setup (template set), this will be automatically
generated by Mosart.

& Note: Attaching Viz Arc MOS object to a custom template is not currently supported. If
modifications are made to the default Accessory template using the Template Editor and a
function is enabled within the template, that logic will be applied to all items utilizing that
template.

To execute other secondary actions in the same time with the Viz Arc action, a typical Accessory
item can be used to execute in the same time with the Viz Arc action:

15:18:17
Story 3

15:18:17 00:00 Ronoo [EEMEXO T
g +

15:18:17 2 0000 [+] ACC_FOR VIDEO VizrtTest1 00:52
00:00 AEC—DEFAULT Cam 4 - window 00:00

Story 4 - walls

The timing and behavior (whether timed or manual) of the Accessory item are inherited from the
MOS object received from the Newsroom System. Additionally, all known functionality applicable to
Accessory items can also be applied to Viz Arc elements.
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() Viz Mosart  Rundowns  View  Studio setups (Funcs Graphics profiles ) ® Standby  Tools
SHOW.LAURA.VR_DEMO

13:57:32

29
Manuals

Program
29 g

. Load VR set

]
StoryQ
13:58:29 n
Story1

Cam 4 - Stadion AGC-DEFAULT [MISSING CONTENT] K M L2 L2

HV w 3 1]
00:00 0 0:04

Preview *

358 . CAMERA 1
Story 4 - walls
- pm ]

[IManuals

Cam 3 - upside down ACC-DEFAULT [MISSING CONTENT]
Cleanup ACC-DEFAULT [MISSING CONTENT]

Cam 6 - Wall Menu ACC-DEFAULT [MISSING CONTENT]

[ Load VR set
\CC-DEFAULT [MISSING CONTENT]

cam 5 wall - zoom in ACC-DEFAULT [MISSING CONTENT]

P el L Ar, ACEATET R SECIS AR TERT

If the Viz Arc elements are not ready for playout because, for example, there is no connection to
the Media Sequencer, this is indicated in Mosart Ul by a red background:
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() Viz Mosart Rundowns  View  Studio setups (Funcspec)  Graphics profiles () Standby  Tools

SHOW.LAURA.VR_DEMO
13:57:32

14:54:30 00:00 "
[ELIETH

= Program
14:54:30 2 i

! e . Load VR set
14:54:30 0 L

aaaa

14:54:30

Story0

14:54:30

Story1 n R

14:54:30 (TR vizrtiestt
Story 2 n
% 145430 oo00 [TH
Viz Mosart - AV Automation | NameOfGallery (Funcspec)

Preview

No connection to Media _
Sequencer xpoint

v ¥ v v v v ¥ v v
0 L] o 0 0 0 L] o 0 0 0 o o

o [ o [ o [ vz [ ven [ ves [cws [ ver [ v [ e [ oomr [ som | o] oo [ e [ own | cwe [ [ e [ mem

MIX0

cam 5 wall - zoom in ACC-DEFAULT [MISSING CONTENT]

<

cam 5 wall - zoom out ACC-DEFAULT [MISSING CONTENT]
DsK1 DSK2 DSK3 DSK 4 Omneon hd Switch

14:42.0045  hnitialize Mse Platfom (bao-ms-dev3:3580). Plavistn... St Video Parls

14:42:26.97 Inttialize Mse Platform (bao-ms-dev3:8580). Plaviist n Vizrt Graphics: bgo-ms-dev3:8580
14:48:25 30

CueDelay set to 0 ms (0frames)

14:48:25.30 |C | CAMERA=1 Funcspec ‘Graphics1: VIZ bgo-mos-dev3
14:48:25 30 Cannot cue audio. No audio interface

You can create Viz Arc actions to

Initialize the Media Sequencer playlist when a show is loaded in Viz Mosart
Clean up the MSE memory after each show.

These are added as manual items in the Viz Mosart rundown and activated by the operator from
keyboard shortcuts.

Current Limitations

No loading status support: A virtual set loading on the MSE may take a considerable amount
of time. Currently, Viz Mosart does not show the progress of the loading status or when it is
ready for playout.

No redundancy support for the new driver: A Media Sequencer backup server can not
currently be configured in case of failover.

No Viz Arc actions supported as control commands on a template.
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12 AV Automation

AV Automation (MMAVAutomation) forms the bridge between Viz Mosart and the devices (for
example a vision mixer or video server) in the studio. It also controls full-screen
graphics (but not Overlay Graphics engines), which from a Mosart perspective, are treated as clips.

Overview
Menu Description
Logging and Status

12.1 Overview

¥ Viz Mosart - AV Automation | VIZRTV (SETUP 1) - m] %

HA K FM 2 L2

Mic1 mcz MIC3 MIC4 SKYPE1 SKYPE2 SKYPE3 SKYPE4  Zoom TEAMS GFX DDR1 DDR2 DDR3 DDR4 %@D

i A A a il A A - i a A A A N A A

cami | camz o | et Tt | YT | erzn P122 | arinin | Marshall | Teams | Zoom orx1 | oFx2 | DoR1 | DDR2 | DDR3 | DDR4 ME1 ME2 ME3

A
v

DSK 1 psk2 | osk3 | oske | I swich

-H: WALL2:4

1251:4539  Graphics enaine 0 changedto NOTin USE o

1251:4539  Got Vizcommand from dataelement FS dve - 2 Box - Clea... Video Switcher: vizri-ips on bgo-vizrtv-vec:5951 DDR:vizrt-ips:5951

1251:4539  Graphics loaded 'FS dve - 2 Box -Clean - "in engine 1 Audio Mixer: vizrt-ips on bgo-vizrtv-vec:5951 -A: DDR:ddr1 @DDR 1

12:51:45.41 CUE@O0 FULL1: 545 Graphics1: VIZ bgo-vizrtv-ghen:6800

1251:45.41 Scheduling element /storage/plavists/{8788aa604af4-4(6... Graphics2: VIZ bgo-vizrtv-ghen:6400

1251:5769  Graphics endine 0 changed to in USE Sound Player: bgo-vizrtv-sky -D: DDR-ddrd @DDR 4

12:51:5850  Graphics engine 0 changedto NOTin USE

12515850  Got Vizcommand from dataclement FS dve - 2 Box - Clea... WALL1:VIZENGINE:bgo-vizrtv-wall:6100:6100
1251:5850  Graphics loaded FS dve - 2 Box - Clean - "in engine 1

12515852 CUE@O FULLT: 545

1251:5852  Scheduling element /storage/plaviists/{8788aa604af4-46... :

12:53:4874  Graphics enine 0 changed to in USE WALL2:VIZENGINE:bgo-vizrtv-wall:6800:6800
12534355 Graphics enaine 0 chanaedto NOTin USE I

12534955 '

Graphics loaded FS dve -2Box-Clean- 'inenane 1
12:53:49.56 CUE@Q FULL1: 545
12:53:49.56 Scheduling element /storage/plaviists/{8788aa60{af4-46... |

v40.1.30847 |JEEMEYEN| MirrorBGO-VIZRTV-MOS2:8099 | MR | ACTIVE| TDE | TCR | Info 9/14/2020 3:06:37PM :

The principal tasks for AV Automation are:

To Cue a clip (prepare) when in preview
To Play a clip when taken on air
To manage control commands to studio devices.

All device drivers are stored in AV Automation, offering the administrator a single point of
configuration.

On the fly commands can then be issued directly to each device through the Viz Mosart GUI, or as
pre-programmed operations driven by the rundown submitted through the Newsroom System.
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All device commands are stored as predefined Viz Mosart templates. They exist in the Template
Editor, and are saved in C:\channeltemplates or in a template database.

AV Automation is the device handler of Viz Mosart. This application communicates with all
connected devices such as cameras, video servers and vision mixers.

As well as presenting tools for configuring these devices, it includes Template Editor, for defining
and customizing templates.

mixer. Allows user to set

Fader indication for audio
fader levels

Crosspoint indication for
ME1. Allows user lo sat
crosspaint

Crosspoint indication for
PGM bus. Allows user to

Fequesting reconnect bo ManusAdmin: admin=False
Cannection lo ManusAdmin succeeded. admin=True
- - - frilislice dewicee ----

Raqueeting resns from ManueAdmin
Connection status
Connection indication for Mirmored window for Wiz Connection status
Automation server, Media Router and Mosart controlled window for all video
Template Database devices, except video ports
l SEIVETS
Build 3.4.34625 110714 [IEEEEO woeee | e | ToE | Infe

The Switch button switches video server salvo. The drop-down menu to the left of Switch,
lists the available video server salvos.

12.2 Menu Description

$ Viz Mosart - AVAutomation: NameOfGallery (Funcspec)

HA K FM 12 L2
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Devices:
Preferences: Opens AV Automation Device Properties.
- Template editor: Opens Template Editor.
- A/V Setup: Opens Audio and Video Setup.
Record: See Recording.
Change password: Creates or changes the Other Template Functionality.
Show:
Show MVCP Control: Deprecated.
Instrumentation Panel: Opens the Mosart Instrumentation Panel.
Studio setups: Selects the template set to use for the current show. These template sets
are not available for selection:
those marked as Hide from user
the special template set DirectTakes.

& For more information on the concepts of template set, Directtakes, and direct take
templates, please refer to the Template Sets section in the Templates chapter in the User
guide.

Standby: Lists all configured devices and their connection status (Green: connected, Red: not

connected, Orange: standby).
Standby

A K FM L2 L2

From this menu, a device can be placed in Standby (or taken out of Standby).
(Standby means the device is not under control of Viz Mosart; no commands will be sent to
it from Mosart.)
The Viz Mosart operator can also perform this action from the main Ul. See the Viz Mosart
User Interface section of the Viz Mosart User Guide, under Main Menu, Standby for further
details.
Idle: This is an indicator that AV Automation is in idle mode, not a menu option. In this
state, the menu bar turns orange.

95 Viz Masart - AV Automation | NameOfGallery (Funcspec) — O >

Devices  Show  Studio setups (Funcspec)  Standby Idle
HA K FM L2 L2

As long as AV Automation is not in idle mode, there is no 'ldle' in the menu bar.

12.3 Logging And Status

Below the fader and switch representations are three monitoring panels.

12.3.1 Logging Panel

To the left is a Logging panel with time stamped event details. Logging is disabled by default.
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To Enable Logging
There are two options:

Right-click in the panel and select Enable
In Properties > Shortcut> Target, add the command parameter enable_logwindow.

£ Mosart AV Automation Properties *
Security Details Previous Versions
General Shortout Compatibility
F;ﬂ’ Maosart AV Astomation
Target type: Application
Target location: Mosart Server

Target: server  MMAVALtomation exe” enal:ule_lu:ugwindu:uv.”

i
Logging will then be enabled at AVAutomation start-up.

To Clear Logging

Clear the Logging panel by double-clicking in the panel.
The following AV Automation topics are presented:

Recording

Audio and Video Setup

Template Editor

Mosart Instrumentation Panel
Newsroom Tags

See Also

AV Automation Device Properties

12.4 Recording

Viz Mosart can instruct a connected video server to initiate recording.

& Note: The Story Recorder feature of Viz Mosart offers more versatile record-pause-retake
features, beyond the recording functionality described in this topic.
Please refer to section Story Recorder Mode.

Managing Recordings
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Supported Video Servers

The video server must first be configured, as explained in the procedure To add a recording port
of Video Servers.

The configured video servers are displayed in AV Automation under Devices > Record.

A Note: Recording is also presented in the Viz Mosart Ul under Tools > Record
Graphics profiles (}  Standby [Tools

General settings

Keyboard shortcuts editor

Import shortcuts from server

Edit rundowns
Arrange rundowns

00 4409 00:12

12.4.1 Managing Recordings

To Start a Recording

1. In AV Automation, select Devices > Record > Recorders > [ Name of recording port]
$ Viz Mosart - AVAutomation: MameOfGallery (Funcspec)

Devices

Preferences

Template editor

AV Setup

| Record J m Recorders  » m STP:RECISTP:RECT
Change password

& Note: If several recording ports have been configured, the Recorders menu will have
several menu items.
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2. In the dialog box, enter a file name that will make it simpler to identify your recording, as
shown in the example below:

Record STP:REC1STP:RECT n

File name
F021-02-14_ValentinesShow Teaser Create |

3. Click Create.
The appearance of the dialog box changes.
- The Create button changes to Record.

Record STP:REC1STP:RECT n

File name

|EEE1 12-14_ValentinesShow Teaser Record Stop |

- The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.
17:59:14.96 RECORD{CreateClip) failed: 2021-02-14 ValentinesShow Teaser@STF:RECT (8.
17:59:15.00 Executing cmd RECORD Prepare Rec1 2021-02-14 ValentinesShow Teaser
4. Click Record.
The appearance of the dialog box changes once again.
- The Record button is greyed-out, leaving only the Stop button active.

Record STP:REC1STP:RECT n

File name

i

2021-02-14_ValentinesShow Teaser Stop

- The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.

18:00:38.13 RECORD{RecordChannel) failed: @5TP:RECT (2 ms): 403 Unit/port STP:RECT...

18:00:38.18 Executing cmd RECORD Start Rec1 2021-02-14 ValentinesShow Teaser

Recordings are stored on the video server's system. Exactly where, is dependent on the video
server type.

To Stop a Recording

To stop an ongoing recording,
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- Click Stop.
The commands that are sent in the background to the video server, are presented in AV
Automation's Information panel.
18:04:07.02 Executing cmd RECORD Stop Rec1 2021-02-14Valentines Show Teaser

12.4.2 Supported Video Servers

Viz Mosart is continually improved to extend the range of video server drivers that are supported
for recording.

Driver Supported since
Omneon 2010-01
Harris Nexio 2011-09
VDCP 2014-07
Quantel 2016-08
MVCP 2016-08
Grass Vally K2 2016-09
AirSpeed MultiStream 2018-05

12.5 Audio And Video Setup

In the Audio and Video Setup menu, you can add the relevant audio and video channels and
configure their attributes. Viz Mosart relies on predefined video crosspoints entered into AV
Automation at initial installation and setup of Viz Mosart. A simple XML editor utility (avconfig) is
used to configure the settings in AV Automation.

- To open the configurations editor, from AV Automation, select Devices > A/V Setup.

This presents all configuration values. You can filter a specific set of configurations, for example
video configurations, as explained below.

- Video Configurations

- Audio Configurations

- Template-driven Effects
Router Source Configurations
Router Destination Configurations
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12.5.1 Video Configurations

- To work with just video crosspoint configurations, open the Audio and Video Setup XML
Editor and select Edit > Video config.

(A XML Editor file;///c;/channeltemplates/avconfigxml = =
File  Edit Video config
¥poirt name| Physical input| Audiclink Audiolink Ch 2 Input type Hide From User
3 m EXT1 ﬂ ﬂ camera ﬂ [
LIVE2 ExTz2 ~| ~| camera | r
LIVE3 j j camera j N
LIVE4 ﬂ j camera j u
CLIP1 ﬂ ﬂ videoserver ﬂ [

- As a minimum, you should enter the crosspoint details: X-point name, Physical input and
Input type (where applicable).

Settings

- X-point name: Name to use for the video crosspoint in the Viz Mosart system. This name will
be displayed in the Crosspoints drop-down menu in all Templates and in the ActiveX
application.

Physical input: Input on the video switcher. These are the physical inputs of the video
switcher.

- Audiolink: Audio fader to link to the video source when the video source is changed in the
Newsroom Control System or Viz Mosart GUI, enabling the audio faders to follow the video
crosspoints.

The drop-down menu presents Audiolink-values corresponding to the audio sources that
may be selected for a fader, alongside the selected input source, for example a camera.

- Audiolink Ch 2: Second audio fader link for the video source. The fader name that will be
used when enabling videoserver Ch2 in the Template Editor. When the video source is
changed in the Newsroom Control System or Viz Mosart GUI, the audio faders will follow
video crosspoints.

Should be used for audio mixers with mono-faders which cannot be coupled in the mixer.
Input type:
- camera: Select to assign this crosspoint as a camera type. This is used by the Audio
Panel application.
- external_source: Select to assign this crosspoint as an external source. This is used by
the Audio Panel application.
- videoserver: Select to assign this crosspoint as a server channel.
- GRAPHIC_1-5: Select to assign this crosspoint as a graphics engine.
ROUTER_RIPPLE_A: Select to use as router source A.
ROUTER_RIPPLE_B: Select to use as router source B.
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Hide from user: Do not show crosspoint in AV Automation. This prevents the crosspoint
from displaying in the Crosspoint drop-down menu in Templates and the ActiveX
application. Default: Unchecked.

Comments: Only for useful setup notes, in this menu. Not visible or used anywhere else in
the application.

12.5.2 Audio Configurations

- To work with just audio mixer configuration, open the Audio and Video Setup XML editor
and select Edit > Audio config.

(A ] XML Editor file:///c/channeltemplates/avconfigxml = =
File  Edit Audio config
Erilwannel Physical input| Mixer name | Input type Initial level |Intial standby | Delay address Lﬁudnelss
ame channe
W rct [ mic -0 »
MicC2 |2 mic | r
EXT1 |21 e:-iemal_su:uu...j [
ExT2 |23 e:-iemal_snu...ﬂ B
TLF |7 tf ~| r

- As a minimum, you should enter Channel Name and Physical input.

Settings

Channel Name: Name to use for the audio fader in the Viz Mosart system (for referencing
the audio channel in Viz Mosart templates).

Physical input: For audio mixers that use fader numbers or MIDI assigned faders, this
number must correspond with the fader number on the audio desk. (LAWO EMBER+: Leave
this value empty).

Mixer name: A unique fader identifier, for audio desks that use fader names instead of
numbers. (LAWO EMBER+: Use the value of the 'startup' label, found in the Ember+ tree/
viewer. For a stereo fader, use the left input here. Do not configure the right input.)

Input type: For the internal Viz Mosart audio logic, the input type of the fader must be set.
This can also be done in the Template Editor.

Initial level: Desired level for the audio fader to obtain after a reload of the Viz Mosart
rundown.

Initial standby: Selects the faders that should not be reset at the start-up of the AV
Automation application. Default: Unchecked.

Delay address: (Lawo non-Ember+ audio mixer boards only) Gives the signal address for the
delay function.

Loudness channel: Defines the channel number for loudness level control.
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12.5.3 Template-driven Effects

You can define effects in Viz Mosart that can then be recalled by a template. This avoids having to
recreate the effect in each template that refers to it.

Use the Effects table, which is then referenced during the execution of a template that has
specified an Effect name or Effect Nr.

- To edit vision mixer effects configurations, open the Audio and Video Setup XML editor and
select Edit > Effects.

(A XML Editor file;///c;/channeltemplates/avconfigxml = =
File  Edit Effects
Emem Emem Emem Mead ;
Effect Effect ) Fader | Audio| GPO 3
name MNr Nr ) Nr Nr Duration | RCC | cue delay | file Preview | A
Preview | Program | Cleanup delay
»  EXEM 1 10 1 |20
Bmicdela.. |2 2 10 -1 20
L
1 | 5

- An effect may perform various actions on the vision mixer, the RCC, the Audio player, the
GPO, and possibly other devices.

& Note: When using an entry in the predefined Viz Mosart Effect table, the EMEM must
include the transition between bus A and B, since transition is not performed by Viz
Mosart.

Settings

Effect name: Name or description of the effect. Mandatory.

Effect Nr: Value of the effect assigned from the newsroom system. Used in conjunction with
Studio Setup to uniquely identify effects. Mandatory.

EMEM Nr Preview: Video switcher preset to recall when the template is taken in the preview.
Mandatory.

EMEM Nr Program: Video mixer preset to recall when the template is taken on the program.
Mandatory.

EMEM Nr Cleanup: This register will be recalled when cueing the next template. Use only if
the register used for the effect demands another "cleanup” register recall to prepare the
mixer for the next events.

Duration: Duration of the effect in frames. Will hold the triggering of the template following
the effect, for this amount of time.

RCC: Recall a Robotic Camera Control shot.
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Next cue delay: Used to hold the cueing in the preview of the second template/element after
the effect. The number of frames entered will be in addition to what is already set as Min.
cue delay in the Video Switcher setup.

& Note: Next cue delay is ignored if EMEM Nr Program has a negative value!

Fader delay: Delay opening the audio effect fader (the Audio Player fader). Value is given in
frames. Ignored if this value is greater than Next cue delay.

- Audio file: Viz Mosart can play an audio file on Audio Player synchronous with the mixer
effect. Specify the filename for the audio file here.
GPO Preview: Send GPO # when entering Preview mode.
GPO Program: Send GPO # when entering Program mode.
Macro Preview: Refer to the Text field in Recall preview in the Template Device Functions -
Macro Recall section.
Directtake: Number of Direct Take template triggered when performing an effect transition.
Often used to allow control of additional devices.
For example, this could be a direct take triggering a named overlay graphic or a direct take
with additional commands required by the vision mixer for this effect.
Studio Setup: Specifies a specific studio setup for which the effect will be run. This attribute
is optional and is used in conjunction with Effect Nr to uniquely identify effects.
Macro Preview Action: Refer to the Drop-down description in Recall preview in the Template
Device Functions - Macro Recall section.
Macro Program Action: Refer to the Drop-down description in Recall program in the
Template Device Functions - Macro Recall section.

& Macro Preview Action, Macro Program Action: Load Project could affect the
performance of the switcher and should thus be used with caution during a running
show.

Macro Program: Refer to the Text field details in Recall program in the Template Device
Functions - Macro Recall section.

Effect Number and Studio Setup

Normally the effects are shared between all the studios/control rooms. But in some cases, a given
effect is required to function differently in one studio setup than another. This is achieved by
adding an extra entry for that effect, but with the Studio Setup that this effect is reserved for. The
rules for how this works are as follows:

- The combination of Effect Nr and Studio Setup must be unique within the Effects table.
Multiple effects can have the same Effect Nr, but these must have different values in Studio
Setup.

- An effect which has Studio Setup specified will only be executed for the corresponding
studio setup.

- An effect without Studio Setup specified will be executed for all studio setups that do not
have any dedicated effect specified.

Viz Mosart processes an effect in the following order:
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Search for an effect with given Effect Nr and with Studio Setup that matches the active Studio

Setup.
If no match is found, search for an effect with given Effect Nr and emptyStudio Setup.

If there are duplicate values of Effect Nr and Studio Setup the cell will be highlighted and an error
message will indicate the reason for the warning.

File  Edit Effects
Effect name Eed Studio Setup
Non Additive Fade || 33 T3
Edge LtoR{H) 1 T2
Cur 1 The pair of values "Effect Nr" and "Studio Setup" is already in use. See section "Audio and Video Setup” of the documentation.
Flash 3
Fleside A

12.5.4 Router Source Configurations

Router source crosspoints can act as an emergency switcher if the vision mixer fails to switch.
Alternatively, a router switch can change a background wall source in the studio, or anything in

your production that requires switching.
To edit Router source configurations, open the Audio and Video Setup XML editor and select Edit >
Router sources.

Bl XML Editor filey///c;/channeltemplates/avconfigxml = =

File  Edit Router sources

Source name | Physical input
] hﬁi- 0

LIVE 2
LIVE 2
LIVE 4
LIVES
ADHOC 1

En | g | | R —

Router switches are predefined as part of a Viz Mosart template. Keyboard shortcuts can also be
programmed for a router switch to take place.

Settings

Source name: Name to use for the router source in the Viz Mosart system.
Physical input: Physical or virtual input to the router.

12.5.5 Router Destination Configurations

Router destination crosspoints can act as an emergency studio output if the vision mixer fails to
switch. Alternatively, a router destination could be a monitor in the studio, a transmission output,

or anything that needs switching as part of your production.
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To edit Router destination configurations, open the Audio and Video Setup XML editor and
select Edit > Router destinations.

B XML Editor file:///c;/channeltemplates/avconfigxml = =
File  Edit Router destinations

Destination Physical
name output

DMs.oo [

 |pwe.2 1
B_WEB_03 2
B_WE_04 3
B_WB_05 4

Settings

Destination name: Name to use for the router destination in the Viz Mosart system. This
name will be displayed in the router crosspoints drop-down menu in all templates and in the
ActiveX application.

- Physical output: Physical or virtual output on the router.

- Audiolink: Linked device

12.6 Template Editor

You create templates as part of your show design. Use the Template Editor to configure the Viz
Mosart templates.

From AV Automation, select Devices > Template editor.

$ Viz Maosart - AY Automation | MameOfGallery (Funcspec)

Devices

Properties Ctrl+P
| Template editor Ctrl+T

ANV setum Crl+|
[ [] [

Record cngoing show ]

Change password
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A new application window is displayed:

n Template Editor | Funcspec: JINGLE + 3 - O
File » Ternplate + Terrplate St « [

[ | Funcspec

| | JINGLE + 3

x

Sescnption Funcspe: | 0B

See also: Template Device Functions.

Several detailed template topics are presented in this section:

Working with Templates
Template Examples
Template Device Functions
Working with Template Sets
Other Template Functionality

12.6.1 Working with Templates

This section contains the following topics:

Template Operations

Template Properties

Control Commands in Templates
Destination Panel

Mosart Templates Feedback to the NRCS

See also: Linking Device Properties and Newsroom Tags.

Template Operations

To Add a Template

Viz Mosart Administrator Guide - 5.3

You can add a new template to the currently selected template set.

1. Select File > New template.
2. Enter the new Template Properties.

To Edit a Template

Select Edit > Template properties.

A Note: Template properties can also be accessed by right-clicking in the device's Function

area. See the table Template Properties.
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To Remove a Template

1. Select File > Remove template.
2. Confirm delete in the dialog box.

To Flatten a Template

You can push a new template, created in another template set (that was created using the
hierarchical approach), back to the originating template set.

1. Select Template > Flatten.
A dialog box displays which template set the selected template will be flattened to.

Ternplate Editor

Flatten template JINGLE+3 to template set Funcspec?

Yes Ma

2. Click Yes.

& Note: For a description of Hierarchical templates, please refer to Working with Template
Sets.

To Copy a Template

You can copy a template from one template set to another template set.

1. Open the template you want to copy.

2. Select Edit > Copy template.

3. Switch to the other template set, and then apply Edit > Paste template.
4. Select Edit > Paste to all to copy the template to all template sets.

Template Properties

This section explains the configurable fields on the General tab of the Template Properties menu,
and also clarifies the function of a Sequence.
Configuration Descriptions
Sequences
Recalling a Sequence from Template
Recall a sequence from a direct take template
Controlling a Sequence
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Template properties

General lContrDI Commands ] Newsroom tags on:ler] Destination panel ]

Name

Variant Description IRD?r:::l{ t;L €l

I Default NCS variant

W Sendto NCS
-

N T

™ Take at planned story in-time

I Fixed Duration
™ Story Duration
-

[ Default TC in
I~ Default TC out

™ Sub Sequence

x| [START [

I” Use state variants

ENDE
START
START VERTICAL

[ o] [ed

’:_ Reset State 'T

00:00:00 Reset State After | 2 Stories

r [ =
=] ~
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I Hide from user

Configuration Descriptions

Item

Name

Type

Variant

Description

Description

The name of the template. This value will only show in log files. English
language is preferred, for making it easier to understand log-files.

The different primary and secondary templates types are described in the Viz
Mosart User Guide, section Viz Mosart User Interface under Rundown Window

The variant is a unique name for the selected type, and should match the

value entered in the newsroom system.

Description of the template (optional). English language is recommended, for

future maintenance purposes.
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Item

Recall Nr (Direct
take)

Disable in
Rehearsal mode

Default TC in
Default TC out

Default NCS
variant

Send to NCS

Preload

Take at planned
story in-time

Fixed Duration

Viz Mosart Administrator Guide - 5.3

Description

(Applies only for templates in the Directtakes template set). One or more
decimal digits. If this direct take template is to be recalled from the GUI
using the numeric keypad, a maximum of four digits is allowed. (If more than
four digits are used, the template may still be executed using e.g. a control
command.) The number must be unique among all direct take templates.

& Note: Avoid starting numbers with zero (). For example, use 56
instead of 0056 .

(Applies only for templates in the Directtakes template set). The direct take
will not be executed when in Rehearsal Mode

This sets the template as the default variant for the selected type.

When selected, allow this template to show in the NRCS ActiveX.

When selected, enable the preview functionality for the Accessory template.
The Accessory template must have time code

00:00

for this to function.
Only valid for Accessory templates.

If you want a story to start at a specific time of day, you can add a template
with this option checked, to a story that has a set "hit time" in the NRCS. The
"hit time" must be included in the story data sent to Viz Mosart, and the
field-name must be mapped to back_time in Newsroomsettings. See Story
External Metadata.

Make the template always have the same length (overriding the time from the
NCS) in the Viz Mosart rundown. Select this option and enter the time in

mm:ss:ff (minutes:seconds:frames). This can also be combined with

Autotake to make a frame accurate continue to the next story. Remember to
write the whole number each time, you cannot edit a single character at a
time.
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Item Description

Story duration When selected, the duration of the template will be set equal to "story
editorial duration”, coming from the NRCS. The "story editorial duration”
must be included in the story data sent to Viz Mosart, and the field-name
must be mapped to story_duration in Newsroomsettings. See Story External
Metadata.

If more templates are added to the story, their duration will be in addition to
the "Story duration” template, so calculated total duration of templates will
be greater than "story editorial duration".

Autotake next (Available for primary templates only, cf. Type above.) When selected,
automatically perform a Take Next (F12) at the end of the template's
duration, with an offset as described in Offset below

Offset Set the offset when Autotake is enabled to adjust the Viz Mosart continue
action at the end of the event. The value is in frames. A positive value will
make the continue action happen later. A negative value will make it happen

earlier.
Sub Sequence See separate explanation below this table.
Sequence See separate explanation below this table.
Loop See separate explanation below this table.

Hide from user When selected, this template is removed from the template list in the Quick

Editor.
Use state Please refer to Other Template Functionality for explanation of state variants.
variants
Control If the template should have control commands attached, configure here.

Commands (tab) Please refer to Control Commands in Templates for further instructions.

Sequences

A sequence is a saved story (including primary and secondary items with relative timing
information).

Sequences are created in Viz Mosart GUI.
This is described in the Viz Mosart User Guide, under Operation, in section Creating Sequences.

Recalling A Sequence From Template

To recall a sequence from a template

1. Select Sub Sequence
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2. Select the Sequence to recall. (The available options are the sequence names saved to the
template set).

A For a direct take template, all sequence names, regardless of template set, are
eligible, see Recall a sequence from a direct take template.

3. If required, select Loop.

When a sequence is recalled from a template, actually only the secondary items of the first primary
item are recalled (but still with the same timing information that it had in the saved story
sequence).

Recall A Sequence From A Direct Take Template

To recall a sequence from a direct take template

Sequences may be recalled from direct take templates just as from other templates. However,
when taking a direct take template, a sequence will be recalled only if the current template set (at
that time) has a sequence with the same name chosen. (And then that sequence will be recalled.)

A Any take out logic might not work as expected if the direct take is not fired at the
beginning of the current main template.
When using direct takes with sequences it is recommended to recall them from a primary
template and not use them with keyboard shortcuts.

Controlling A Sequence

When a sequence has been started it can be controlled using keyboard shortcuts with Control
Command - SEQUENCE.

See table Command Values and Parameters, COMMAND SEQUENCE, Value LOOP, STOP_LOOP,
STOP, START.

Control Commands in Templates

A Mosart control command can be triggered from a template, executed when the template is taken
(Command On Take), at continue points (Continue Points) or when the template is taken out
(Command On Take Out).

Working with Control Commands
Adding a Control Command
Commands on Cue
Command On Take
Continue Points
Command on Take Out

Command Values and Parameters
Parameters with Placeholders

& Note:
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A Mosart template can trigger multiple control commands.
A (not-templated) control command can trigger a Mosart template, often used for
a DirectTake template.

Working with Control Commands

This is done through AV Automation > Devices > Template Editor > Template > Properties >
Control Commands tab.

Template properties

General Control Commands  Newsroom tags order Destination panel

(] Commands On Cue Commands to be cued
Offset ff) Command Value Parameter A
USER_MESSAGE v |N/A |v |2
100 USER_MESSAGE |~ |N/A |~ |3
200 USER_MESSAGE v |N/A |v |4 y
Command On Take Control commands Take
Command Value Parameter s

» SWITCH_GENLOCK_MODE ~ | TOGGLE |~
SWITCH_REHEARSAL_MODE v |TOGGLE v

USER_MESSAGE ~ | N/A v|5 v
Continue Points Continue Points
Cue Next tem Index Autotake fff) Command Value Parameter Description A
» 0 USER_MESSAGE v |N/A ~|7 Imno 7
4] 200 USER_MESSAGE v |N/A v |8 Imno 8
NCS ~ |START_STATUS v No description y
[J Command On Take Out
[[] Hide from user Cancel 0OK

The figure above shows a single (video) control command to be executed when the template is
taken. Multiple control commands can be assigned here.

It is also possible to assign control commands to be executed at continue points and when the
template is taken out.

The latter has limitation since the Parameter setting is not available. In this context it may be
useful to trigger a direct take at this place.

Adding A Control Command

To Add a Control Command

Click the Control Commands tab in the Template properties window.

The three categories of control command are Commands on Cue, Command On
Take, Continue Points and Command on Take Out.

Refer to the table Command Values and Parameters for command details.
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Template properties

General Control Commands ~ Newsroom tags order  Destination panel

Commands On Cue Commands to be cued
Offset fff) Command Value Parameter [l
MARKER ~ [ N/A ~ |2
NCS START_STATUS |+

2

<

Command On Take Control commands Take
Command Value Parameter 2
SWITCH_GENLOCK_MODE ~ |DE_ACTIVATE |+
SWITCH_REHEARSAL_MODE |+~ TOGGLE w
Continue Points Continue Points
Autotake ) Command Value Parameter Description [l

Cue Next ltem Index

50 GET_PLAYER_STATUS |~ |N/A ~ Mo description

L 1 10 NCS STOP_STATUS |v console 4
b _DEVICE_PROPERTY - 4 gallerys .

Command On Take Out Control command Take Out

£

[n/a -

W frme gVEI'E_ﬂUX_CHOSSPOINT Cancel Ok

FULLSCREEN_GRAPHICS
OVERLAY_GRAPHICS
WEATHER

AUDIO

DIRECTTAKE

LIGHT

AUTOTAKE

Commands On Cue

You can recall control commands in Preview, when the template is cued. This enables triggering of
events when a story item is taken to Preview.

Template properties

General Cortrol Commands  Mewsroom tags order  Destination panel

Commands On Cue Commands to be cued
Offset ff) Command Value Parameter *
SWITCH_VIDEOSERVER_MIRRORING |~ | N/A ~
3 FULLSCREEN_GRAPHICS ~ |CONTINUE_FULLSCREEN |~ |235
100 USER_MESSAGE ~ | N/A ~ | Ready

[] Command Cn Take Control commands Take

As illustrated above, you can give the command a Value and a Parameter in the same way as
for Command On Take, Command on Take Out.

Also, in a similar way to Continue Points you can set an offset for when the command is to be
executed.

& Note: For Cue commands, all offsets are relative to the start of cueing. This differs from
Continue Points, where each offset is relative to the previous continue point.
In the illustration above, the User Message (Ready) will be sent 100 frames after cueing.
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By defining a Newsroom tag as a parameter for an On Cue command, the user can set the
parameter from the NRCS.

In the Parameter column right-click and select either Add/Remove/Change a newsroom tag.

Command On Take

When selected, the commands inserted in Control commands Take are executed when the
template is taken to Program or On Air.

By defining a Newsroom tag as a parameter for an On Take command, the user can set the
parameter from the NRCS.

In the Parameter column, right-click and select either Add/Remove/Change a newsroom tag.

@ Tip: This selection then appears in the Mosart Web App NRCS Plugin (or the legacy
ActiveX Plugin) for adding the template to a rundown.

Continue Points

When selected, the commands inserted in Continue Points will be taken when pressing TAKE NEXT
(default: F12). Viz Mosart executes this continue point from within the primary template in which it
is inserted. Each line represents a new Continue Point.

Continue Points Continue Points
Cue Next ltem Index Autotake ff) Command Value Parameter Description ~
50 GET_PLAYER_STATUS |~ |N/A ~ Mo description
I:I 110 NCS ~ |STOP_STATUS |~ console 4
v BN ccvice PROPERTY 4 gallery y

Cue Next Item Index: Enter the line number (for example, 0, 1, 2, 3) of the continue point
that executes a cue for the next/following Primary object. If empty, Viz Mosart cues when
entering the last continue point in the list.

Autotake: Insert the autotake time, in frames. The command is then automatically taken
after that time.

& Note: For Continue Points, all offsets are relative to the last Continue Point. This
differs from Commands on Cue, where each offset is relative to the start of cueing.
In the illustration above, the Device Property is fetched 20 frames after being taken
on-air, Player Status is fetched at 50 frames later and from the NRCS, the Stop Status
at 110 frames after the previous (Get Player Status) Continue Point was processed.

By defining a Newsroom tag as a parameter for a Continue Point, the user can set the parameter
from the NRCS.

In the Autotake column right-click and select either Add/Remove/Change a newsroom tag.

@ Tip: This selection then appears in the Mosart Web App NRCS Plugin (or the legacy ActiveX
Plugin) for adding the template to a rundown.
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Command On Take Out
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The commands inserted here are executed when the template is taken from the program, taken
Off Air, or at the end of the template. Only a single command can be used in Command On Take
Out, and it does accept any parameters.

Command Values and Parameters

& Note: Parameters marked with (*) do not work for templates.

& Note: It is not possible to enter a Parameter in the Control command Take Out section.

COMMA Value
ND

ACCESSO  TAKE_NEXT
RIES

AUDIO FADE_MANUAL

FADE_OUT_KEEPS

FADE_DOWN
SECONDARY_AUDI
0]

FADE_UP
SECONDARY_AUDI
0]

SET_LEVEL_2_ONAI
R

SET_LEVEL_2_PREVI
EW

FREEZE_AUDIO

Parameter

)

Fader rate

Fader rate

Fader rate

Description

Toggle fade manual.

Faders that are set as "keep level" in the
template On Air are faded out. Will also work
when new templates have been taken in
between the 'keep' action and

the FADE_OUT_KEEPS.

Viz Mosart fades down relevant audio sources
not connected to the video currently On Air.

Viz Mosart fades up relevant audio sources
not connected to the video currently On Air,
when cutting between sources.

The second level for faders in the template
which are On Air are set.

The second level for faders in the template
are set on the template which is in preview,
and be performed on next transition.

All sound faders are frozen, and do not
respond to commands from templates. This
command is a toggle function, and is thus
NOT suited for use from a template.
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COMMA
ND

AUTOTAK
E

AUTOTRA
NS

CROSSOV
ERCOMM
AND

DEVICE_P
ROPERTY

Value

N/A

PP, MET, ME2,
ME3, ME4

AUX, Default

N/A

CAMERA CONTROL

Parameter

*)

MixEffect (MIX
OR WIPE) +
Transitionrate

(*)

*)

See next
column.
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Description

For example: MIX 33, WIPE 10.

& Note: The Effect cannot be used.

& Note: This is for camera robotics.

When the DEVICE_PROPERTY control
command is used with the value 'CAMERA
CONTROL', only setting speed (Camerobot)
and presenter (Camerobot/FxMotion) are
controllable from a template.

Details for Camerobot Presenter:

ANCHOR=pos1:presenter1[,pos2:presenter2]

The position and presenter is given as a pair
divided by ‘.

Multiple position-presenter pairs are possible,
separated by ‘,’.

[V Command On Take Control commands Take

Comman: d Value Parameter
+ | DEVICE_PROPERTY | CAMERACONTROL || ANCHOR=PostionX1:SizeX(]

& Note: The position is a string and
does not have to be a number.

Details for Camerobot Time:

If Time =1 (>0), Viz Mosart sends
MATRIX_MOVE_MPOS command to
Camerobot,

while if Time = 0 Viz Mosart sends
MATRIX_CUT_MPOS command Camerobot.
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COMMA
ND

DEVICE_S
TANDBY

DEVICE_S
TANDBY

Value

AUDIO

AUDIO_MIXER, GPI,
LIGHTS,
LOUDNESS,
ROUTER,
SOUND_PLAYER,
SUBTITLING,
VIDEO_SERVER,
VIDEO_SWITCHER,
VIDEO_WALL,
VIRTUAL_SET,
WEATHER

GRAPHICS (full-
screen)

Parameter

demands
<fields>
structure as
parameter wit
h
parameter1=A
uDIO,
parmeter2=ke
Y,
parameter3=v
alue

OR
connectionstri
ng style

ON
OFF
TOGGLE

As above (ON/
OFF/TOGGLE)

OR

engineno:[ON]|
OFF|TOGGLE]
(Example:
2:TOGGLE)
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Description

& Note: This is for an audio mixer.

ON: The device chosen (in Value) is put in
Standby.

OFF: The device chosen (in Value) is taken out
of Standby.

TOGGLE: The Standby status (ON/OFF) of the
device chosen (in Value) is toggled.

(If there are several devices of the chosen
kind (e.g. video servers), all of them are
affected.)

ON/OFF/TOGGLE: As above, applied to all
graphics engines.

If an engine number is given, only the
designated engine is affected.
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COMMA Value
ND

DEVICE_S ROBOTIC_CAMERA
TANDBY

DEVICE_S OVERLAY_GRAPHIC
TANDBY S

DIRECTT
AKE

The Recall Nr (see
Template
Properties) of the
direct take
template to
execute

DVE FORWARD

REVERSE

Parameter

As above (ON/
OFF/TOGGLE)

OR

controller:
[ON|OFF|
TOGGLE]
(Example:
1:0N)

OR

controller:cam
era:[ON|OFF|
TOGGLE]
(Example:
1:2:0N)

As above (ON/
OFF/TOGGLE)

OR

Engine No:
[ON|OFF|
TOGGLE]

For example:
2:TOGGLE:
Toggles
Engine 2
Standby
status)

Recall
forward/
reverse EMEM
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Description

ON/OFF/TOGGLE: As above, applied to all
cameras on all controllers.

If a controller (but no camera) is given, only
the cameras on the designated controller are
affected.

If both a controller and a camera is given,
only the designated camera is affected.

ON/OFF/TOGGLE: Applied to all overlay
graphics (all controllers and corresponding
engines).

If an engine number is given, only the
designated engine is affected.

& Note: Only engine number is
supported.
Engine numbers are shown in the list
of active engines in Overlay Graphics
Interface and followed by '/' and
destination name of the engine.
(Engine Handler, Destinations,
Controller have no effect).

Executes the direct take template given by
Value.

n/a
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COMMA
ND

ENABLE_
GRAPHIC
S_
MIRRORI
NG

FULLSCRE
EN_GRAP
HICS

FULLSCRE
EN_GRAP
HICS

GRAPHIC
SPROFILE

HOLD_AU
DIO_
TRANSITI
ON

HOLD_VI
DEO_
TRANSITI
ON

LIGHT

MARKER

Value Parameter

n/a *)

CONTINUE_FULLSC AUTO
REEN

CONTINUE_FULLSC  Engine no
REEN

MACRO Engine no :
macro

N/A

N/A

N/A

N/A (*)

N/A (*)

Viz Mosart Administrator Guide - 5.3

Description

Continue Command Only: The AUTO
parameter will replace the continue command
with the number of continue points in the
graphics item.

The number of continue points is taken from
the graphics_continuecount field.

Examples:

AUTO+1: The number of continue counts
from the graphics + 1

AUTO-2: The number of continue counts from
the graphics - 2

The target output fullscreen engine number
to execute the action on. (e.g. 1,2,3)

The target output fullscreen engine number
to execute the action on. (e.g. 1,2,3) and
Macro name.

The engine number must be same as the
number defined in AV Automation
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COMMA
ND

NCS

NEXT_CU
E_DELAY

OVERLAY
_GRAPHI
CS

Value

START_STATUS,
STOP_STATUS

EXTEND

CLEAR

CONTINUE

TAKE_MANUAL_OU
T

MACRO

PRETAKE_NEXT_OV
ERLAY

TAKE_NEXT_OVERL
AY,

TAKE_NAMED_OVE
RLAY

Parameter

RUNDOWN
STORY
ITEM

A number of
frames

Destination or
Render
(Engine no.)

Engine no

Destination or
Empty

Engine no :
macro

Render
(engine no)

*)
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Description

Specific for Open Media

If there is a pending cue (when this control
command is executed), this cue is postponed
by the number of frames given.

Otherwise (no pending cue), the next cue
operation will be additionally delayed by the
number of frames given. (l.e., the value will
be added to the sum of the settings

Min. Cue delay in AV Automation Devices
Vision Mixer

Next cue delay in Audio and Video Setup,
Vision Mixer Effects Configurations,
Settings (if an effect is involved)).

Destination or Render (Engine no.) to clear the
graphics from.

Numerical value: Render (Engine no.)

Non-numerical value: Destination.

Destination to take out the graphics from.
Non-numerical value: Destination

Empty or Numerical value: Takes out all the
graphics

For example: 4:macrohere
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COMMA Value
ND

OVERLAY Parameter 1:
_TO_MAN ONAIR (default),

UAL PREVIEW.

PLAY_.ST N/A
ORY

RECORD  PREPARE,

START,
STOP

RELEASE_  N/A
BACKGRO
UND

RUNDOW  N/A
N_NCS_
RESYNC

Parameter

Parameter 2:
Comma-
separated list
of handler
names

Parameter 3:
AUTOMATIC
(default) /
MANUAL

Parameter

2 and Paramet
er 3 must be
separated by a
semicolon.
(E.g.
WALL,DSK;MA
NUAL.)

(*)

Split
parameters
using,

- first:
clipname,

- second:
recorder
(optional),

- third: port
name (default
Reo),

- fourth:
group name
(default Rec)

*)

*)
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Description

For more details, see Viz Mosart User
Interface > Keyboard Shortcuts > Control
Command Keys > OVERLAY_TO_MANUAL in
the Viz Mosart User Guide).

& Note : If there is no semicolon after
Parameter 2; nothing to the right of
the semicolon; or Parameter 3 has any
value other than 'MANUAL', then
Parameter 3 gets the default value
‘AUTOMATIC'.

For example: clip33,recorder1,Rec,Rec
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COMMA Value Parameter
ND
SEQUENC LOOP
E
STOP_LOOP
STOP
START
SET_AUX_ N/A (*)
CROSSPO
INT
SET_CRO PP, ME1, ME2, bus (A,B,C,D) :
SSPOINT ME3, ME4 Xpoint
AUX
Default
SET_CUR PP, ME1, ME2, *)
RENT_ME ME3, ME4
AUX
Default
SET_VIDE Select a configured
OSERVER  video server from
_ the list
SALVO
STUDIOSE #
TTUP
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Description

Sets a running sequence to start looping

Stops running a looped sequence in loop
Stops a running sequence

Restarts a previously stopped sequence

If layers are supported by the driver (e.g.
vizrt-ips) it is possible to also specify the layer
(A,B,C,D) in addition to the crosspoint.

Two arguments are supported separated by
semicolon. First parameter is crosspoint, the
second is layer.

If no semicolon is used the value is
interpreted as crosspoint only and bus A is
used.

Example: B:CAM2

These same settings are available as keyboard
shortcuts, as presented in the Viz Mosart User
Guide, under section Viz Mosart User
Interface.
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COMMA
ND

SWITCH_
GRAPHIC
S_
MIRRORI
NG

SWITCH_
GENLOCK
_MODE

SWITCH_
REHEARS
AL_MODE

SWITCH_
VIDEOSER
VER_
MIRRORI
NG

TAKE_CO
NTINUE_P
OINT

TAKE_SER
VER_TO_
PROGRA
M

TRANSITI
ON_TYPE

UNKNOW
N

Value Parameter

TOGGLE,
ACTIVATE,
DE-ACTIVATE

TOGGLE,
ACTIVATE,
DE-ACTIVATE

TOGGLE,
ACTIVATE,
DE-ACTIVATE

N/A

N/A *)

N/A transRate
(integer) -
parameter.

*)

CUT, Rate
MIX

EFFECT Effect no
TOGGLE )

N/A

Viz Mosart Administrator Guide - 5.3

Description

For standard and Story Recorder (SR) shows.

Story Recorder (SR) specific:

As long as some standard show elements are
not supported with SR, use this command to

control the use of Genlock mode.

SR can only run in Genlock mode.

Story Recorder (SR) specific:

SR can only run with Rehearsal mode

deactivated, use this command to ensure
Rehearsal mode is not accidentally active.

For standard and Story Recorder (SR) shows.

This command has no parameters, it simply

acts as a toggle.

Takes a video server port to program on a
selected ME. For example: a video clip is

running on a video wall.

The shortcut can then be used to take the last

used/active video server to program.

Default fallback. Does nothing.
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COMMA Value Parameter Description

ND

VIDEO_P N/A Must be a For example: PLAY_PAUSE,A,PLAY.
ORT comma

For more details, see Viz Mosart User
Interface > Keyboard Shortcuts > Video Port
Control Commands > OVERLAY_TO_MANUAL
command,por in the Viz Mosart User Guide).

t,parameter

separated list
in the format:

VIDEO_SE N/A (*)
RVER_GO

TO

VIDEOWA N/A (*)
LLMODE

WEATHER N/A (*)

Parameters With Placeholders

Control command parameters can include placeholders which are then populated with values
found among the fields of a currently On Air, Viz Mosart item. A placeholder is defined as a string
of characters, within curly brackets {placeholder}.

For example, a placeholder can be useful for transmitting values from the NRCS, for use as control
commands that will be executed when the template is taken On Air.

Example: Providing the clip name to be recorded from NRCS.

In the NRCS, a column can be created for giving the name of the clip to be recorded with Viz
Mosart. Then, in Viz Mosart Newsroom settings, map the column in Story External Metadata as
follows:

Story External Metadata

<mostag mostagname="NCScolumn" mosart_action="4item_variable" action_value="NCS_filena
me" format_type="String" />

In Manus file, the Mosart item will have the following fields (the value Clip] is given from the
NRCS):

Mosart Item

<fields>
<field name="NCS_filename" value="Clipl" />
</fields>
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Then, in Template Editor, the control command for the respective template is configured as
follows:

Control Command

RECORD PREPARE {NCS_filename}_Test,Recorder,RecPort

When the template is executed, a clip with name Clip1_Test is prepared for recording.

Destination Panel

In the Destination panel tab, you can create rectangles that are then available in the Viz Mosart Ul
for assigning sources to newsroom tag destinations, while the template is in preview or program.

Press Add to add the selected target area.
The target areas are displayed in the Viz Mosart Ul as drop down boxes. They become
clickable if a source or shortcut is selected by the user.

Template properties

General ] Cortrol Commands | Newsroom tags order  Destination panel l

Destination: right - Add Remove Image | Browse..

@ [Dirag the edges of the area to resize or dick and hold to move it.

I Hide from user Cancel 0K

See also section Program Window in the Viz Mosart User Guide.

Mosart Templates Feedback to the NRCS

You can send Mosart templates as MOS objects to an NRCS. The MOS object can then be used by
an NRCS operator to insert the detailed Viz Mosart item (rundown event) as a program cue into
their rundown (some users call this a “brick system”).
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This is an alternative to the Mosart ActiveX, and is the basis for the Viz Mosart web-based
application, NRCS Plugin.

In addition to MOS objects that contain Viz Mosart primary template details, a special MOS object
can be sent, containing lower third information.
- Template Properties Menu
- Working with Templates as MOS Objects
Sending Viz Mosart Template Content to the NRCS
MOS Object Containing Lower third Information
Usage Notes
Hierarchical Template Support
Detailed Description of MOS Objects

Template Properties Menu
You can view and modify the properties of a selected template.

In AV Automation, select Devices > Template Editor > Template > Properties.

Genersl | Contol Commands | Mewssoom tags order | Diestination pansd |

Hame Tope Watiork Diescripion [TJ:",Q' .ﬂ{ﬂ
K 1 |CAMERA =l [BLABLABLA |
™ Delslt HCS vanant ™ Use state varisnts
¥ Send o MCS r=Wanants .
I Eipload I" Freake _J :"- ﬂ
1RUTE 2 =
™ Take &t planned o intime . p—
I Ficed Dussion  [00.00 00 —/ —]
I™ Stony Duration ResstState  [2

I Avoiskene  OfSet [T ResstStatetfier [2 Stovies

~Sequence -

[T SubSequence =

™ Hida foom wser Cmcdl 1.4 I

Working with Templates as MOS Objects
Enabling The Template-To-MOS Object Feature

You enable the features described in this section from the Viz Mosart Administrator (MOS version)
Settings menu.
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Settings Parameters
Value Description
TemplateToMosObject Used to send templates to NCS through MOS

GenerateUniqueObjectid

Copyright © 2023 Vizrt

communication.

Enabled: Enables sending templates to NRCS through
MOS communication

Default: Enbaled

Some NRCSs (for example, OpenMedia) use objld to
identify a template.

True: The MOS object objld is sent to the NRCS as the
channel template ID , defined as GUID.

False: When GenerateUniqueObjectld is false and
- GroupedByType (see below) is false, objld is set to the
value of the TemplateSet-Type-Variant.

- GroupedByType is true, objld is set to the value of the
template type.

& Note: objld is unique among the templates from
the same gallery. If the same channeltemplates

file is used from two different galleries, MOS
objlds are no longer unique.
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Value Description

GroupedByType Use to send all template types as one MOS object, with
the variants embedded in the objects from the default
template set.

- The SendAllTemplateSets property must be set to
false.

- The default template set must first be defined in

- AV Automation: Devices > Template Editor > Template
Set > Set As Default.
If the SendAllTemplateSets property is set to true, a
MOS object for each template type (with the variants
embedded in the object) is sent for each template set.
If no default template set is set, then no template will
be sent to the NRCS.

True: objld is set to the type of the template.
False: Send all template variants as separate MOS objects.
Default: True

MergedClips Use this option to merge only the clips from the default
template set, regardless of the value of
SendAllTemplateSets.

True: Send all PACKAGE and VOICEOVER templates as a
collection of type “CLIP” to the NCS using the NEWT or
UPDT commands in the Manus Admin console.

This property has to be used together with
GroupedByType (see above).

- The default template set must first be defined in AV
Automation: Devices > Template Editor > Template
Set > Set As Default.

If no default template set is set, then no template will
be sent to the NRCS.

Default: true

See Appendix section Structure of MOS objects sent to
NRCS for details about the MOS object structure when
merging clips.

SendAllTemplateSets Use to send templates from all template sets to the NRCS.

- The default template set must first be defined in AV
Automation: Devices > Template Editor > Template
Set > Set As Default.

False: Send only the default template set.
Default: False
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Value Description
TemplateChangeWanted Use to decide whether templates changed are updated in
the NRCS.

- When a template is changed or deleted on the Viz
Mosart side, the NRCS will only receive an update if
- mosReqObijList/mosRegAll (from the NRCS) or
- NEWT or UPDT (from the Viz Mosart Manus console)
has been executed at least once since Viz Mosart
Manus console was started.

- Only a template checked in the field Send to NCS (in
the Template properties menu), is sent to the NRCS.

True: Always receive updates.

Sending Viz Mosart Template Content to the NRCS
There are two ways to send Mosart templates to the NRCS:

1. Requesting from the NRCS using commands like
a. mosReqObijList
b. mosReqAll
c. mosReqObj <objld>
2. From the Viz Mosart Manus console, using commands like:
a. NEWT: Send the Viz Mosart templates to the NRCS as MOS objects with status NEW.
b. UPDT: Send the Viz Mosart templates to the NRCS as MOS objects with status

UPDATED.
c. DELT: Send the Viz Mosart templates to the NRCS as MOS objects with status DELETED

(meaning that the templates will be deleted).

(v) - To see samples of the corresponding MOS XML code, see section Detailed
Description of MOS Objects below.

& Note: You can also use the new Viz Mosart NRCS Plugin to quickly drag and drop the
underlying MOS object details of a selected Viz Mosart template, directly into an NRCS
rundown.

Caching MOS Objects For Sending To The NRCS
All the MOS objects corresponding to the templates sent to NRCS are saved in a cache file
MosTemplateCache.xml under %localappdata%\temp\Mosart Medialab\MOS State.

This file is created or updated when Viz Mosart Administrator (MOS version) is started.

Troubleshooting
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This file is useful when troubleshooting, enabling you to verify exactly what MOS objects have
been sent to the NRCS.

You can delete it, then perform a fresh request of the templates, using a NEWT command.

Ignoring The Templateset Attribute For A Viz Mosart Item

When sending all Mosart templates to the NRCS (SendAllTemplateSets is true), an attribute
templateset is set inside the MOS object.

This attribute is used internally to identify which Viz Mosart template set the type and template
type (variant) shall be used.

When a rundown is later loaded in Viz Mosart, the NRCS returns the MOS object with
this templateset attribute set.

Example

1. You change the studio setup in the Viz Mosart Ul by selecting another Template Set (the
active template set) which contains some of the variants used in the previous template set,
but with different properties (e.g same CAMERA 1, but with different crosspoints)

2. The item from the template set referred to by the attribute templateset will be executed,
instead of the item from the new, active template set.

3. To get round this, you can instruct Viz Mosart to ignore the templateset attribute (by setting
it to an empty value) from a MOS object coming from NRCS.

Now the Viz Mosart item from the active template set will be executed.
a. Do this by adding a mosid tag with value MOSART in newsroomsettings.xml with a
keyword set to IgnoreTemplateSet:

<tag name="some.mosid" value="MOSART" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet=true"/>
or
<tag name="some.mosid" value="MOSART" appendContent="false"

fieldMapping="false" keywords="IgnoreTemplateSet"/>

MOS Object Containing Lower third Information

For graphics, please refer to section Sending Lower Third Graphics MOS Object to an NRCS.
- The corresponding MOS XML code is presented in Detailed Description of MOS Objects.

Usage Notes

Automatic Sending Of Viz Mosart Templates To The NRCS

Templates are automatically sent to the NRCS whenever Manus Admin on the Viz Mosart server is
started/restarted if Template feedback to NCS is enabled in the Manus Admin settings and
TemplateChangeWanted is set to true.

In this case, Viz Mosart will send:

- All templates from all sets if SendAllTemplates is true.

- The templates from default template set, if SendAllTemplates is false and a template set has
been defined as default.
No templates, if SendAllTemplates is false and no template has been defined as default.
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See the Settings Parameters table above.

Creating And Modifying Templates

- When a new template is created or an existing template is changed
- The template set attribute is defined in the MOS object
<objGroup> is set to the template set that the template belongs to.
On the NRCS side, the template is stored in a folder named after the template set.
- When a template is changed or deleted, the NRCS will only receive this update when either
the commands
- mosReqObjList/mosRegAll (from the NRCS) or
- NEWT or UPDT (from Viz Mosart Manus console)
are executed at least once since Viz Mosart Manus Admin was started.
- To always receive these updates, set TemplateChangeWanted to true.

& Note: When GroupedByType is set to true, deletion of templates is not handled.
Execute UPDT in the Viz Mosart Administrator console or request the
templates from the NRCS for update

Hierarchical Template Support

The template feedback to NRCS functionality partially integrates with Hierarchical Templates,
supporting the two operations

1. Requesting a single template set
2. Requesting all template sets

from a gallery with hierarchical templates.

A Note: The management of a template set (NEW, UPDATE, DELETE a template) is not
supported.

Example

Assume the following template sets:
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T1 has templates PL, P2, P3

T2 is based on T1 and

o ovemndes P1 (keeps same type and vanant, but different content)

s (2 is based on P2, but since the variant (or the type) is changed to C2, then this
becomes a new lemplate in T2 with nd relation o P2 n T1

& inhents P2 and P2

T3 is based on T2 and
& ovemdes P1 (keeps same type and vanant, but different content)

s inhernts P2 and P3 from T1 and inherits C2 from T2

If template set T1 is requested, then P1, P2 and P3 are sent.

If template set T2 is requested, then P1 and C2 from T2 and P2 and P3 from T1 are sent.
If template set T3 is requested, then P1 from T3, C2 from T2 and P2 and P3 from T1 are

sent.

Detailed Description of MOS Objects
See the Appendix for code-level descriptions of

MOS Objects with Mosart Templates Grouped by Type
MOS Object with Mosart Templates not Grouped by Type
MOS Object with Clip Templates Merged in a Mosart Template
MOS Object with Lowerthird Information
- Octopus

12.6.2 Template Examples
This section contains the following examples:

- Studio
- Video Clip with Full Sound
- Voice-over
Live External Source
DVE
Full Screen Graphics
- Accessory Templates
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Switcher Plugin

Studio

The template for a typical studio camera is based on the CAMERA type. The example below defines
a standard camera 1 variant. An entry named CAM 1 in the video setup is selected at the PP bus
cross point. Transition duration is @ frames (hard cut) and E-mem recall is disabled. There is only
one studio microphone, which fader is called "A Mic 1" in this template. Audio level is setto 0 dB,

and the input device is a microphone. The input device type is important for the handling of audio
in an ad lib sequence of full camera, DVE and full external source.

Type: CAMERA  Variant:1 E|E|E|
File = Edit = Show = Test Template
-
.
N2 FemoweFader

Fader byvpe 3
Link 3
Keep level
Fade up in preview

Inpuk device * | YWideo server

Crossfadetime 3 Yideo server ChZ

External Source

Mic
- Telephone

1] Soundplayer

Template set (Evening news)

For our standard camera 2 variant, the only difference in the above setup is the PP bus cross point
which is called CAM 2.

Video Clip with Full Sound

As crosspoint on the vision mixer, we use a source called S_RIP, which means Viz Mosart uses the
A/B roll and roll between the sources defined in the AV setup as videoserverA and videoserverB.
We chose RIP_C1 as the audio source, but as long as A/B roll is enabled, any source defined as
Video server follows the video source. The default transition is a three frame mix. The video
channel control is also enabled and controls the clip. The server channel is automatically assigned
within the automation.
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F® Type: PACKAGE Variant:SOT M=E
File = Edit = Show =  Test Template

channel

wpoirt .Eememnr _pr RemoveFader
Fader bype »
Link 3
Keep level

Fade up in preview

Input device » |[ « | Viden server ||

CrossFadetime » Yiden server Chz

Exkernal Source

Mic
- I Telephone
a Soundplayer
Template set (Evening news) 5 |

Voice-over

In this example, the variant VO is defined. Notice the difference from the two last examples and
the two fader setups. A Mic 1 is microphone input type and RIP_C1 is video server type.

Copyright © 2023 Vizrt Page 291



Viz Mosart Administrator Guide - 5.3

F® Type: VOICEOVER Variant:VO M=E

File = Edit = Show =  Test Template

channel

wpoint EMEMmnr_{r —_—

Template set (Evening news)

A second sound level can be set for each fader by using the SHIFT key over the fader to set the
second level. This second sound level for all faders is used as the start level for the voice over

sound bite type. The same special variant logic for video clip with full sound applies for the voice-
over type.

Live External Source

Live external source variants are typically defined by their corresponding vision and audio mixer
inputs. In the example below, we define variant 1 as source MW 1 on both PP bus cross point and
audio fader.
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E® Type: LIVE Variant:1 |Z||E||E|
File = Edit = Show =  Test Template

ol
1

Xpoint s ememnr_pr

RernoveFader

Fader bvpe 3
Link 3
keep level

Fade up in preview

Input dewice » | Yideo server

CrossFadetime ] Yideo server Ch2

| ¥ | External Source |I

Mic

- I Telephone

] Soundplayer

Template set (Evening news) _:EI

Additional variants 2 to 9 would typically use MW 2 to MW 9 as sources for both video and audio.

DVE

The example below describes four setup steps necessary to create a template that recalls a
predefined E-mem (emem number 10) defining a split screen DVE on M/E 1 on the vision mixer.

1. E-mem Recall Definition

The vision mixer effect uses key 1 and key 2 on M/E 1 as left and right split windows.
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ol
1

xpoint  ememnr_pr

E Recall
n E Recall

: in_pp
IF_PFEYIERW

Template set (Evening news)

The PP bus cross point is set to ME1 (program output of mixer effect). The E-mem recall control is

defined to recall emem 10 when the template is taken to preview.

2. Key bus Delegation Setup

Default crosspoints are chosen (CAM 2 and MW 1) and since a newsroom tag has been added for

both keys, the crosspoints can be set from the newsroom system.

Right click over the XPOINT window to add a newsroom tag. In addition, the template defines a

recall of a graphics background
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£® Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

Graphics

! Key 2 KPOINT  AUDIOLINK  MIXEFFECT  KEY SETDELAY [~~~ [
CAM 2 M T | Il none - MET A | | i

Al
1

wpoint EMmEmnt_pr

&dd Mewsroom bag ||

Remove Mewsroom tag

Template sefk (Evening news)

The second key bus delegation is shown. As a default we assign CAM 2 to key bus 1 and MW 1 to
key bus 2 on the MET mixer effect bus.
(This assignment can be overridden from the NRCS story element by using the newsroom tag).

3. Audio Linking
The audio link is set to 1 for both the key 2 delegation and the second fader (MW 1).
[ Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

: RemoveFader
*p oint EMEMnr_fr
Fader bype 3
Lirk, 3 | none

Keep level 1

Fade up in preview z

Input dewice 3 3

CrossFadetime 3 4
- |~ |

Template set (Evening news)

When using the newsroom tag to set key 2 to a different source (for example MW 3), both video
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and audio delegation will follow:
This leads to the key 2 source being set to MW 3 and the second audio fader being set to MW 3.

4. Graphics Engine Data Element Setup

£® Type: DVE Variant:SPLIT

File = Edit = Show = Test Template

EMGINE DATACOMMECTION COMTEMT SOURCE SCEMEMNAME
1 *  aygtemndefault *  dataconnection -
1 [ I

TEXT CONTWITHDVE USEVCP [ _—
| | r r

wpoint EMmEmnt_pr

Template sk (Evening news)

Setup of the graphics controller is described in the next section.

Full Screen Graphics

The graphics controller in the Template Editor is vendor-specific, due to the lack of a generic
control API. As a general feature, it can control multiple graphic engines. A typical controlled
cluster could for example be, one for full screen graphics, one for studio wall graphics and
additionally, an overlay CG engine. For DVE effects, this can be a fixed element, while for
telephone graphics or maps the element name and data are provided in the NCS story.

The controller's task is to cue graphics when taken to preview and run them when taken to
program.
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o Type: GRAPHIC Variant:head1fs

File = Edit = Show =  Test Template

EMGIME DATACOMMECTION COMTEMT SOURCE SCENEMAME
1 +  spsterndefault T FEWSTOom - | 00 | |_
Bl |— I

4 TEXT COMTWITHDWVE — LISE WCP
xpoint ememnr_pr | I — o o ok Fance!

Graphics

Add Mewsroom kag |

Remove Mewsroom tag

Template set (Evening news)

Accessory Templates

In this example you create an accessory template for driving content to a video wall driven by the
Template Router feature in Viz Mosart. this feature merges new template-based instructions onto
an existing one, enabling, as in this example, an asset to be diverted to the video wall. You need a
separate accessory template for each wall that will be controlled. The accessory template can
contain settings for cross points, video server port, graphics engine and aux.

Creating the Wall Accessory Template
The wall accessory template is created as a standard template.

You can create a new accessory template with a variant name of for instance "wall2".

Switcher Cross Point

To change switcher crosspoints enable Switcher crosspoint in the Template Editor.

The Switcher XPoints appear.

Here you can set the ME-step you want for the wall taken template.

When the template is set to the wall item it will use this ME step instead of the one specified
in the template.
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“Crosspoint 1

Mix Effect 1 Crosspoir
MET '+ | [none

FF Crosspoir
ME1

ME2 |

ME3

M_RIP
M OTH fold

hlise Maal=sas Il'!
The ME-step will show as a mix effect in the Template Editor.

SW Input
name SWInput
xpoint Cameral

ME4

i)

mix_delay
mix_delay_out

audiolink

delay _transitiononly
index

dsk_off

dsk_2 on
dsk_2_off_delay

Video Server Port

If a video clip is wall taken; another video server should be used.

This can be changed in the accessory.

channg
A

MIX NONE

0 A
xpoint  |ememnr_pr |3 - ‘W

Make sure the video clips are available through this port.

Copyright © 2023 Vizrt

Page 298



Viz Mosart Administrator Guide - 5.3

AUX
The AUX is controlled by the template but should be added to the accessory template.
The setting will be replaced by the wall taken template.

Graphics

To avoid conflict with other graphic elements, you may want the wall to run on its own
engine. This can be changed in the accessory.
A wall taken graphic element will then use this engine.

channd

ML

0
Xpoint ememnr_pr g Content Source
4
172
34

Switcher Plugin

These are advanced configurations to a standard switcher where functionality is extended. The
example in this section refers to extending Viz Engine functionality.
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Template Editor | SAT1: DVE + 880X

File + Template = Template Set ~ DB -

Viz Mosart Administrator Guide -

in option is available in the list of devices to be enabled on the template.

SAT1 >Basis
DVE + 8BOX (inherited)

MIX

Switcher plugin I

Template properties
Clear devices

Apply device settings to all sets

Switcher crosspoint
Switcher plugin

EMEM Recall

Macro Recall

NDI Router Output
Key/Layer
Videoserver

Graphics

»
»

8BOX

Video wall
Audio player
Virtual Set
Camera Control
GPI/O Control
Light Centrel
Router Control
Weather

Audio Mixer

The Switcher plugin view introduces two new configurable features, top scenes and presets.

Static values can be specified directly on the template. Newsroom tags can also be configured,
enabling control from within the NRCS.

Top Scenes

& Note: To work with top scenes, you must first perform the required setup, as described in
the Configuration section of Viz Engine as a Switcher.

5.3

A typical use of top scenes is as an opener. For example, the top scene is played to introduce the 8

o’clock news show with many visual effects that fade to the following camera scene, and a news
host taking over.

@ Tip: For an in-depth explanation of Top Scenes and their time-related configurations, refer

to the section Viz Engine as a Switcher (Top Scenes).

To Create A Template That Plays A Top Scene

1. Create (typically) a Jingle template.
2. Enable Switcher plugin for the device.
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3. Specify the top scene name from the list with the following options:
a. None (empty).
b. A list of top scene pre-configured in the A/V Setup.
Select the required top scene (this is the name of the scene in the associated Graphics

Hub folder).
$ Template Editor | Funcspec: JINGLE + 3 — O x
File ~ Template » Template Set ~ DB - ‘
Flm
Take
JINGLE+3

SwitcherPlugin

Switcher Plugin Properties

Top Scene

Name: | Openerl v

[ preset

[ ok ][ cancel

There are two time-related aspects when creating new templates for top scenes:

1. The time it takes for the scene to load. This is handled automatically by Viz Mosart when
cueing the story item.

2. The time it takes for the scene to run. This is controlled with the Fixed Duration and
Autotake configurations on the template.

Template properties

Genersl Control Commands  Newwoom tags order  Destnstion parel
Recall Ne

HUN_ ) Tm ) Vanart Descripbon (Direct take)
(pame | [mGLE ] [Opener Sxil | [descroeon ] Oisatie in Rehe
[] Default NCS vanant [] Use state variants
& Send s NCS .
Preload <c | [New
Pufer
Fretske >
[ Take ot plarmed story in-time
G F; ) Y
oued Durason [o0:05-00
[ Secey Duration
[ etotskeret  O#Set  | O | Reset State ;
Reset State Sher 2 Stones
Last siste
Single State
[0 Seb Sequence Loop
[[] Hide from user Cancel
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You can add an Auto Take to the template to jump to next story item automatically (switch
underneath the Top Scene)

Template properties

General Control Commands

Name Type

Newsroom tags order Destination panel

Variant

Description

Recall Nr
(Direct take)

[oPENER K1 | [GRAPHIC

~| [oPENER K1 | [oPENER K1

[] Default NCS variant
[ Send to NCS
Preload

Pretake

[ Fixed Duration
[ Story Duration

[ Sub Sequence

[] Hide from user

Presets

[] Take at planned story in-time

[] Use state variants

<<

>>

BG_GFX
CONFERENCE
FULL
GFX_SPLIT
Graphic Split
QPENER 2

~

00:05:00

[ Autotake next OffSet

up

Reset State

Down

2

Reset State After | 2 | Stories

Last state

Single State

Select Engine Presets from Edit tab.

Use one of the following options:

None (empty).

Video config

Loop

Disable in Rehearsal Mode

Cood || 0K |

Witualsst A
I

Transition Style

e Wiz name udlirk Audoink Ch 2 put type Hide From Laer 05
Audia canfig !
Effects fst = el i bt g
Router sources #0 SE= i ~ jcamen hd g
Router 961 MKCS. ~ ~ | comena ~ ]
ERpTEREE) %2 WIS - | camena - O
Engine Top Scenes %3 S [ | camers g ]

954 WIS ~ | camera v ]
%5 %5 MICS ~ ~ |camera ~ O
966 %66 WIS - | camera ~ O
367 957 MICs v v | carnera v m]
= 958 - | camera v 0
= 859 = ~ | extemal_source ~ 0

The transition style (hard-cut or animation), as well as several label values can be specified.
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For example, on the DVE template above, where Switcher plugin for the device is available, the
user can select the layout and looks of the DVE effect by specifying a preset style, the preset
transition and the DVE window labels, as required:

Switcher Plugin Properties

O Top Scene

Preset
Style:  Presetl v
Animate
Label1: <4 Label2: 24
Label3: + Labeld: +
LabelS: i Label6: =
Label7: - Label8: +

Switcher Plugin Additional Features
DVE Boxes (in a Preset)

Simple 2-Box for Live sources

Keyfill 1
Keyfill 2
No XPOINT !
Switcherplugin
%T&mplate Editor | DEMO: DVE + 2Box_1 - O X
File + Template ~ Template Set ~ DB -
DEMO
Take
DVE +2Box_1
Disabled
description | pemo | pB|

Switcher Plugin Settings

Select the required Top Scene.
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Fill in any required labels.

i
=

File = Template = Template Set = DB

EngineSwiicher
FULLSCREENGRAPHICS + OPENER2

Switcher Plugin Properties X

[#] Top Scene

Name: | Openerd v |$

‘ Take

[] Preset

| Edit/Delete n

| oK | | Cancel ‘

Labels can be linked to an NRCS with a newsroom tag.

Clicking the Edit/Delete newsroom tag icon, opens a mappings menu:

Example 1: 2-Box Template

VizMosarthCSPlugin =

[ Mosart NRCS Plugin

Template set

EngineSwitcher - C Q
« 2Box

[ 8Box

B cves B pveseox
I0] Copy MOS

B PackacE

BB yipEo EFFECT Transition:

o defauit: MIX O
B GrapHIcs

B Float

JINGLE

WIPE EFFECT

I ereac Variables:

C COMMAND siyle
Preserl

Izbal
Anna Smith
label2

John Presten
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Example 2: Jingle Template (to control a Preset)

Template set

EngineSwitcher

Il cAvera
I Copy MOS

B Packace
Static values from templates and

-
VIDEO EFFECT newsroomtags for all

B GrapHics

B rloat

JINGLE Preset2

B Breax

C COMMAND labed1

Variables:
style

animate

true
A

C
labels
3
labei?
G

label2

labelg

H

& Note: To use the animate newsroom tag, set the animate dropdown option to true.

: Full screen Graphics Template (to drive an Opener)

IC] Copy MOS

Example 3

B cvera

B Packace

™ yiDEO EFFECT Transition:

default
B crarHICS

B rioar

JINGLE

WIPE EFFECT

5 frames

W sreac Variables:

C COMMAND Top Scane Name
Opener2
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Graphics

Static values are set in the Viz Engine, so always choose GFX for the switcher crosspoint.

Template Editor | *EngineSwitcher: FULLSCREENGRAPHICS + FULL

File » Template - Template Set ~ DE -

EngineSwitcher
FULLSCREENGRAPHICS + FULL

Take

See also: Viz Engine as a Switcher, section Template Design.

12.6.3 Template Device Functions
This section lists a selection of device properties:

- Working with Device Functions
Video Switcher Crosspoint
Video Switcher Transition
Video Switcher Register/Timeline Recall
Macro Recall
Video Switcher Auxiliary Bus Delegation
Keyfill: Video Switcher Key Bus Delegation
Video Server
Graphics
Video Wall Register Recall
Audio Player
Virtual Set
Robotic Camera Control
GPO
Light Control
Router Control
Audio Settings (General)
Testing a Template

Working with Device Functions
Right-click inside the device function area to open a menu containing the following options:

Enable: These commands are described in more detail below.
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Template properties: Opens the current template's properties page, see Template Properties
in section Working with Templates.
Clear devices: Removes all devices from the device function menu, after confirming in a pop-

up message window.

Apply device settings to all sets: Applies all the device settings to all templates of same type
and variant throughout all template sets.

To Enable Device Functions

1.

Right-click in the device's Function area (black row).
2. Select the device to configure from the Enable menu.
This opens the edit box for the selected device.

File = Template ~ Ternplate 5et = DE ~

$ Template Editor | *Funcspec: JINGLE + 3

Funcspec
JINGLE+3

Take

I

4

Ke Device properties

Clear devices

Apply device settings to all sets

ey

description

Switcher crosspoint

Ernem Recall
Auxiliaries
Keyfill
Videoserver
Graphics
Video wall
Audio player
Virtual Set
Camera Control
GP1/O Control
Light Control
Router Control
Weather
Audio Mixer

| Funcspec | DB|

& Note: Depending on the protocol chosen, the caption EMEM Recall may alternatively

be:
Emem Recall
Dmem Recall
Snapshot Recall
Memory Recall

To Modify Device Functions

1.

Right-click in the device's Function area (black row).
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2. Select Device properties. See the topics below for listings of properties for each device.

oy
%K

File = Template = Template Set - DB

Funcspec
JINGLE+3

BUS XPOINT AUDIOLINK  MIXEFFECT KEY SET DELAY KEY ENABLE

CAM3 CAM4

Take

Ememnr_p

/A

& Note: Depending on the Protocol chosen, the caption Macro Recall may alternatively be:
Custom Control

To Remove Device Functions

1. Right click in the Device function area
2. De-select it from the Enable menu.

Linking Device Properties and Newsroom Tags

To Make A Device Property Editable From The NRCS

Right-click over Property and select Add newsroom tag.
The property is then reassigned to the value supplied from the newsroom system.

If several device properties are given to a newsroom tag with the same name in a template, all
devices use the value given in the NRCS.

See also: Newsroom Tags.

Video Switcher Crosspoint

The video switcher crosspoint enables switching on the video switcher. The A or B bus assignment
of the mixer effect (PP/MEXx) is automatically handled by the automation.
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Switcher XPoints >
Crosspaint 1 Diown stream keyer
Mix Effect 1 Crosspoint Audio link Off delay
PP *  |none none [ DSKOf
Crosspoint PP r
li DSK 2 On 0
[ DSK30On 0
-
[ DSK40On 0
[ Cross Point Hold
[ DSK50On 0
Mizx Delay 0 [ Transition Only
[ DSK&On 0
Mix Delay Out |0
[ DSK70On 0
[ DSKE0On 0
Cancel | Undo

Guidelines for Video Switcher Crosspoint Configuration

Item Description

Mix Effect Selects which Mix Effect (ME) bank on your vision mixer that you are currently
handling.
Note : Newsroom tag available.

Mix Effect 1
PP -

M
ME15ub2

Crosspoint  Crosspoint on the video switcher. Default value: none

Enter a text value (shall be same as in the list of available x-points for Video
configurations).

& Note: Newsroom tag available.
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Item

Audio link

Crosspoint
PP

Set ME in
PP

Cross Point
Hold

Mix Delay

Mix Delay
Out

Transition
Only

DSK Off

DSK 2
On, ...,
DSK 8 On

Off delay

Viz Mosart Administrator Guide - 5.3

Description

Default value: none

Audio link

none | -

hWNAﬁ

If another Mix Effect (ME) than PP is selected, then you can select a crosspoint for
program by writing the crosspoint name in the field.

If another Mix Effect (ME) than PP is selected, check this box to make that ME the
crosspoint for PP. (Checking this box disables XPOINT PP).

Keeps the crosspoint on the selected Mix Effect.

Offset, in frames, of when to perform the transition.

Delay, in frames, of when to perform the next transition.

Only delay the switcher transition (sub items will perform).

Turns off the Downstream Keyer (DSK) on the video switcher when the template is
active in program.

The keyer selected as DSK in the switcher device property (Devices > Properties >
Vision Mixer > selected DSKNr), will be used.

Downstream Keyer (DSK) 2-8 on. Turns on the DSK 2-8 (PP key 2-8) on the video
switcher when the template is active in program.

I~ DSK20n
I~ Dsk3on
I~ DSK40n
I~ DsKk50n
I~ DSK60n

EEEkicl

I~ Dsk70n
I~ DSK80n

Delay in frames to set the DSK 2-8 off.
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Video Switcher Transition

The transition device is only available when video Switcher crosspoint is enabled.

ol *DEMO: CAMERA + 1 — O ot

" File v Edit + Show » Test Template DB -

. | FY |
Xpaipt N =memnr_pr

A

Enable » " v | Switcher crosspoint "
Template properties EMEM Recall

Clear devices Macro Recall

Apply device settings to all sets Auxiliaries 3
Keyfill 3

Videoserver

Graphics
Video wall
. I . I Audic player
o | o0 Virtual Set

CAMI1 Camera Control
GPI/Q Contral
Light Contral

Router Control
Weather
Audio Mixcer

To Define Video Switcher Transitions

This procedure is based on the example in the screenshot.
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1. Click on MIX/WIPE/EFFECT to cycle through these three transition types.

value value
rate =
enable e cnable
mix_delay | o *DEMO: CA RGBT
File = Edit -
WIPE
0

EFFECT
rate 1
enable True
al *DEMO: AT e 0

File = Edit ~

2. Click directly on the selected value (in the screenshot above, this is either 0 or 7).

3. Enter
a. The default duration (in frames) for the Mix/Wipe transition, or
b. The effect number for the effect transition.

o' *DEMO: CAMER

File = Edit = Show

The transition is performed with the auto-transition functionality in the video switcher.

Usage and Tips

- To do a cut, use a MIX transition with © frames duration.

- To add a mix delay, right-click on the device (MIX/WIPE/EFFECT), select the number (below
Disable), and enter another number (in frames).
Adding a mix delay delays the start of the transition, compared to other device commands,

when the template goes On Air.
- To disable the transition, right-click over the device and select Disable.

Video Switcher Register/Timeline Recall

Video Switcher Register/Timeline Recall (EMEM Recall/Emem Recall/Dmem Recall/Snapshot Recall/
Memory Recall) will recall a register and/or timeline in the video switcher.

To Open the Video Switcher Register/Timeline Recall
This procedure is based on the example in the screenshot.

1. Open Template Editor.
2. Right-click over ememnr_pr
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3. Select Enable > EMEM Recall

ot *DEMO: CAMERA + 1 — O ot

* File = Edit = Show = Test Temnplate DB -

®point | =memnr_pr
Enable * Switcher crosspoint
Device properties | EMEM Recall

Clear devices Macro Recall

Apply device settings to all sets Auxiliaries r
Keyfill 3

Videoserver

Graphics
Video wall
Audio player
I Virtual 5et

0 [ 0 Camera Control
GPI/Q Control
Light Control

Router Control
Weather
Audio Mixer

4. Enter or select required values

| EReeal | e - | [ [V

& Note: If a Register recall is paired with the video switcher key bus delegation and/or
auxiliary bus delegation, the key/aux bus delegation should be disabled in the Video
Switcher Register to prevent a conflict between the stored delegation and the Viz Mosart-
assigned delegation.

Guidelines for Video Switcher Register/Timeline Recall Configuration

Item Description
NAME Name of Register/Timeline.
DESCRIPTION Description of Register/Timeline.
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Item

MIXEFFECT

EMEMNR PREVIEW

EMEMNR PROGRAM

LOAD TIME

OPEN VS FADER

Macro Recall

Viz Mosart Administrator Guide - 5.3

Description

Select the MIXEFFECT (ME) from where the Register/Timeline
should be recalled.

Drop-down menu values are PP (Program), MET, ME2, ME3,
ME4, and Master. Default value: Master.

(Depending on the Protocol chosen, there may be additional
values).

To dynamically choose MET or MEZ2, values M_RIP and M_OTH
are available.

A Note: Newsroom tag available

Register/Timeline on the video switcher that will be recalled
when the template is cued in Preview.

Register/Timeline on the video switcher that will be recalled
when the template is taken to Program.

Delay time (in frames) between when the mixer register is
recalled (in Program or Preview) and when all other template
instructions are executed.

When selected, Viz Mosart opens the fader specified in Audio
effect server, defined in the Audio tab of Device Properties in
AV Automation.

Macro Recall is available when the following vision mixer protocols (as selected in the

configuration menu Vision Mixer):

Ross Acuity

Ross Carbonite

- GV CPL

- GV KAHUNA (Kahuna/Kula)
- SONY SERIAL TALLY

- VIZRT-IPS (NewTek/Vizrt Group IP series mixers (for example, Viz Vectar Plus, TriCaster,

VMCT1).

Copyright © 2023 Vizrt Page 314



To Open a Macro Recall

1. Open Template Editor.
2. Navigate to Enable > Macro Recall

Viz Mosart Administrator Guide - 5.3

o *DEMC: CAMERA + 1

* File = Edit ~ Show = Test Template DE -

MIX
0
Y FY
EMEmnr_pr

NI

xpoint
MR

Enable

Template properties
Clear devices

Apply device settings to all sets

Switcher crosspoint

EMEN Recall

Macro Recall

Auxiliaries b
Keyfill 3
Videoserver

Graphics

Video wall

Audio player

Virtual Set

Camera Control

GPI/O Control

Light Centrol

Router Control

Weather

Audic Mixer

3. Enter or select required values.

55 Macro Recall - O x

Recall preview I I

Recall program I I

[ ok | cancel |

Undo |

A
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Guidelines for Macro Recall Configuration

Item General description Drop- Text field
down
Recall preview Action to be taken when entering preview mode. See below See below

Recall program Action to be taken when entering program mode.  See below See below

Drop-down Menu Alternatives

Drop-down option
None

Recall

Take

Recall and Take

Load project

Description

No action.

Macro is prepared (or cued).
Macro is taken.

Macro is prepared and taken.

Project is loaded (Kahuna/Kula only).

© Warning: Load Project could affect the
performance of the switcher. Use with caution
during a running show.

The format of the text fields depends on the mixer chosen:

Mixer Text field Remark
Acuity One bank character and two macro characters. Recall (and Recall and take)
Example: 102 (recall custom control 02 on bank 1) Take does nothing.
Note that Device is named C
instead of Macro Recall.
Carbonite One bank character and two macro characters. Recall (and Recall and take)
Example: 215 (recall custom control 15 on bank 2) Take does nothing.
Note that Device is named C
instead of Macro Recall.
GV CPL Macro number (integer) in the range 1-999 . Recall (and Recall and take)

Take just takes macro alreac
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Mixer Text field Remark

Kahuna/Kula The meaning and format of the text fields depend on the selected drop-down option:
Drop-down option Description
Recall Two-digit project number and three-digit macr

the format pp.mmm.

Take As for Recall above, or three-digit macro numk
Recall and Take As for Take above (if mmm only, the Recall is
Load project Project number in the range 0-100 (100 me
project).
SONY SERIAL TALLY  Macro number (integer) in the range 1-250 . Recall (and Recall and take)

Take just takes macro alreac

VIZRT-IPS Plays a macro having the name provided Take only

& Note: Some Tricaster drivers use a non-standard macro in which the argument is the macro
text itself. However, this does not apply the driver currently used by Viz Mosart.

Video Switcher Auxiliary Bus Delegation

Auxiliary bus delegation enables routing of internal video switcher signals to the auxiliary outputs
of your video switcher.

& Note: VIZRT-IPS: Video switchers supporting VIZRT-IPS use NDI outputs, not auxiliaries. So
on the template, the Auxiliaries device is instead named NDI Router Output.
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g5 *DEMO: CAMERA + 1 - O >
! File = Edit = Show = Test Template DB -
ey Keyfill E
none MIA .
MIX
0
xpoint  EMEMMT_p iy ——E—
/A FIA
Enable * | Switcher crosspoint
Template properties EMEM Recall
Clear devices Macro Recall
Apply device settings to all sets | Auxiliaries b | AUX A
Keyfill J AUXB
Videoserver AUXC
- - Graphics AUXD
0 0 Video wall AUXE
Audio player AUXF
Virtual Set AUX G
Camera Control AUXH
GPI/O Contral
Light Control
Reuter Control
Weather
Audic Mixer

Type or select relevant values.
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Guidelines for Auxiliary Bus Delegation Configuration

Item Description
BUS Selects the auxiliary to assign a new source.

BLS

1 &

2

3

4

s

&

7

g W

& Note: Newsroom tag available.

XPOINT Crosspoint on the video switcher.

& Note: Newsroom tag available.

AUDIOLINK Assigns a link group to this delegation. Please refer to Audio and
Video Setup for the use of this feature.

AUDIOLINK

none -

SET DELAY Set the delay in frames of the key delegation when taking the
template to Program. If the field is left blank, the key is set in
Preview

TRANS DUR If the vision mixer has the ability to mix on the AUX channels,

this is where the mix rate is set, 0 is a cut

Copyright © 2023 Vizrt Page 319



Viz Mosart Administrator Guide - 5.3

Configuring An NDI Router (Viz Vectar Plus Or Tricaster VMC)

A Note: For NDI output crosspoints, you must refer to actual crosspoint names recognized by
VMCI1 (and not any user-friendly names that would be mapped to the physical inputs).
These default naming on the NDI router side is typically:

- INPUTn

- DDRn

- BFRn

- MIX n.

The same naming must be used on the Viz Mosart side.

In AV Automation > Devices > A/V Setup > Video Config > Mixer name column, you must
provide the hardcoded name associated with the user-friendly name of the crosspoint.
This name is found on the switcher side.

In the example below, the value of the literal crosspoint name is the router output found in
the switcher's Macro Configuration > Macro Editor menu and added to AV Automation:

o

44 Buffer] Buffer2 Buffe

Input type Audiolik Wi e Audiclink Ch

‘extemal_source ~ |LIVET
GRAPHIC_1

DDARY
DDR2

NAA

el el el el e e e < e < <<«

~ | Mix 3

« | INPUT1
~ | INPUT2
~ [ InPuT13

There is a new setting UseOutputCrosspointNames in the IP-protocol
config VizrtlpSystemsVideoSwitcherConfig.xml set by default to expect the crosspoint
name, instead of the Viz Mosart standard of using physical input naming.

Keyfill: Video Switcher Key Bus Delegation

Video switcher key bus delegation enables routing of internal video switcher signals to the keyers
on the different mixer effects of the switcher.

A Note: VIZRT-IPS: For video switchers supporting M/E effects with 4 layers, the device is
named Key/Layer.

To Enable Keyfill by Bus Delegation
1. Open Template Editor.
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2. Navigate to Enable > Keyfill > [Keyfill index]

o=l *DEMO: CAMERA + 1 — O >

* File + Edit * Show =

MIX
0

xpoint EmMemnr_pr|

TIA TIA

Test Template OB -

’—Enahle 4 Switcher crosspoint
Template properties EMEM Recall
Clear devices Macro Recall
Apply device settings to all sets Auniliaries 3
| Keyfill Y[ ke ]
Videoserver Keyfill 2
Graphics Keyfill 3
Video wall Keyfill 4
hd I hd I Audio player Keyfill 5
0 T 0 Virtual Set Keyfill &
Camera Control Keyfill 7
GPI/O Control Keyfill 8
Light Control
Router Contral
Weather
Audio Mixer

3. Enter or select required values.

To Enable Keyfill by Bus Delegation for M/E effects with 4 layers

Devices like Viz Vectar Plus or VMC1 let you configure M/Es with effects supporting up to 4
primary sources/input layers (along with Key layers), called A, B, C and D buses.

Viz Mosart can control these buses from a template or keyboard shortcut when VIZRT-IPS is used
for a vision mixer.

1. Open Template Editor.

2. Navigate to Enable > KeyLayer > [KeyLayer index]
The Key/Layer device on a template can be used for VMC1 vision mixer to either set the
crosspoint for a Key bus or to set the crosspoint for A, B, C and D buses of a M/E effect with
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4 layers.

[<IlsIls]lI<]l<]

STP-SIMPLETEST.
= STP:HDPY

3. Right-click > Device properties.

Select from the BUS drop-down menu:
a. If the device is used for setting the crosspoint for a key bus, set the BUS drop-down

menu to a number between 7 and 8 on the Key/Layer device properties.
b. If the device is used for setting the crosspoint for a layer of a M/E effect with 4 layers,
then choose one of the letters A, B, C and D from the BUS drop-down menu.
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Guidelines for Keyfill Configuration

Item Description
BUS Selects the key bus on the selected ME.

BLIS

]

2

3

4

5

6

7

2

If the video switcher supports M/Es with 4 layers (e.g. VIZRT-
IPS), 4 more buses are available corresponding to each layer,
A, B, C and D:

BLIS

-

=3 m =

& Note: Newsroom tag available.

XPOINT Crosspoint on the video switcher. Default value: none

& Note: Newsroom tag available.
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Item Description

AUDIOLINK Assigns a link group to this delegation. Please refer to Audio
and Video Setup (previously Linking video and audio sources)
for the use of this feature.

AUDIOLINK

nong -

MIXEFFECT

& Note: Newsroom tag available.

KEY SET DELAY Set the delay in frames of the key delegation when taking the
template to a program. If the field is left blank the key is set in
preview.

KEY ENABLE Key enable drop-down menu.

KEY ENABLE

Ignore
On
Off

& Note: Newsroom tag available.

Video Server

SEFWEF{CHANNEL CLIP HIRESPATH  CLIP DESCRIPTI  TRIGGER START ~ RECUECLIP  LOOP  CUEONLY El
ab A/B -/ N » ~ ~ -

EmMemNr_p

NiA
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Guidelines for Video Server Configuration

Setting

SERVERCHANNEL

CLIP HIRESPATH

CLIP DESCRIPT

TRIGGER START

RECUE CLIP

LOOP

Description

The Mosart video port / port group where the clip is to be
played out /recorded.

For recording the corresponding video port has to be part of
the “Rec” port group.

Port groups are created as part of the video server
configuration in menu AvAutomation > Devices > Preferences.
Configurations are described in Video Servers, section Working
with Mosart Port Configurations.

Notably, the defined virtual ports are among the available
options.

In addition, the non-empty groups (groups with at least one
port) are available.

If a group has the same name as one of its ports (as may be the
case for the Rec and P groups, if defined), the group as such is
not available, but the port is.

The (default) clip ID or name.

A Note: Newsroom tag available, meaning that a value
from the NRCS will override the value specified here.

You can enter a Clip description, however a clip description
from the NRCS or video server overrides this value.

& Note: Newsroom tag available.

Enables the Trigger start function from control commands, a
shortcut or continue point could be set to PLAY the Clip.

In an A/B roll situation, when several Adlibs are played back-to-
back, this setting determines how a clip will be restarted after
it has been paused.

For example, if Clip A is paused when Clip B is taken On Air,
then next time Clip A is taken on the same channel, it can
either be played from where it was paused, or be re-cued
(played from the beginning).

This is only used for AdlibPix templates.

Sets the server port to loop the clip. Beware! Not all video
servers can loop.
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CUE ONLY Cues only the clip when the template is in Preview. The
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template will not start playing the clip when the template is

taken.

Graphics

The Graphics device enables recall of graphic elements.

o5 *DEMO: CAMERA + 1

: File  Edit + Show - Test Template DB -

NIA

ML
0
xp aint EMEMMNr_[r i I

MiA A

Enable *

Switcher crosspoint

Template properties EMEM Recall
Clear devices Macro Recall
Apply device settings to all sets Auxiliaries
Keyfill
Videoserver
| Graphics
> | ~ | Video wall
oo Audio player
Virtual Set

Camera Control
GPI/O Control
Light Control
Router Control
Weather

Audio Mixer
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Graphic elements are cued (loaded) in Preview and played (started) when taken to Program.

|1 w ‘ Engine [] Send Continue on DVE FORWARD

|dataconnection v‘ Content Source L Use VizContentPilot

Default Graphics

Scene Name Scene Text

[]Is database Index

[ Use take Qut Command Take out Delay D

[] Translate Cue for Transition Logic elements:
If enabled, this will override the global setting.

@ Motranslate (O Take () Take out

o | | o

Guidelines for Graphics Configuration

Engine Selects the engine to operate on when using this
template, based on your configuration.

b See section Graphics.

.

2

3

4

5

142

344
Content Source - dataconnection: Use content from the attached
. graphics database (only available when Vizrt
o graphics are used)

newsroom: Use content from the attached NRCS.
none: Use content written into the template.

Send Continue on DVE FORWARD If selected, a continue command is sent together
with a DVE Forward command.
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Use VizContentPilot Enable to run this element through a Viz Pilot client.
This allows for OnLiveUpdate events in Viz Pilot data
elements.

Scene Name The default scene name is used, if not overridden by
the NRCS.

& Note: Newsroom tag available.

Scene Text The default scene text will be used, if not overridden
by the NRCS.

& Note: Newsroom tag available.

Is database Index

Use take Out Command If selected, a take-out command is sent when the
template status changes from On Air to Off Air.

Take Out Delay Delay of sending takeout command after template
status changes from On Air to Off Air.

Translate Cue for Transition Logic If active, this setting overrides the global setting with

elements same name set in AV Automation > Devices >
Properties > Graphics > General > [VIZRT] >
Miscellaneous.

This setting only applies to transition logic for Vizrt
full screen graphics. The Media Sequencer ignores
standard cue command for these items.

No translate: Send cue command to the Media
Sequencer (on Media Sequencer versions below
1.20 no cue will be performed).

Take: Use a Take command when cuing.

Take out: Use a Take out command when cuing.

Video Wall Register Recall

This device is only available for Videowall template types.

Video wall NAME RECALL PREVIE EMEMNR
-1 | wwal | E I -1 || o || cem=
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Setting Description
NAME Internal name of the shot.
RECALL PREVIE For WATCHOUT, see notes below. For the other brands, this is

the number of the recall to be taken when the template is
cued in Preview.

EMEMNR For WATCHOUT, see notes below. For the other brands, this is
the number of the preset to take when the template is taken in
Program.

& Notes for WATCHOUT

- The fields RECALL PREVIE and EMEMNR should contain the command or sequence of
commands to be sent when the template comes in Preview or Program, respectively.

- The general format is: [load "show"] [resetrun "timeline"]
Both load and run are optional, however at least one of them must be present.
The show and timeline parameters may not contain double quotes.

- The reset value is optional. For more information see the connection string
property ResetAnyway, described in the section Video Wall Connection Strings.
In most cases, RECALL PREVIE contains load "show" , and EMEMNR contains run

"timeline".

Audio Player

LEVEL _ AULIUFILE  QUTPUT

N | |

LEVEL: This value does not affect the level. Instead, a value > -90 (the value must be an
integer) starts playout, whereas a value <= -90 stops the playout.

- AUDIO FILE: Optionally, enter an audio file name here. If a newsroom tag is added, and a
value is provided by the NRCS, that value is used.

- OUTPUT: (Viz Mosart Audio Player only) Choose the output on the Audio Player to be used, if
nothing is inserted, the first port is used. This value is overwritten by values coming from
the NRCS.

Outputs are displayed on the Audio Player Ul (see the Audio Player section at AV Automation

Cancel
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Devices > Audio).
% Settings

m Testing panel

If a new file is set to play on an output already playing:
0 Stop the file playing, and play new file
lgnore new file

Play new file on next available output

Outputs
MName Device
Speakers (Realtek(R) Audio)

DELL U2715H (HD Audio Driver for Display Audic

Qutputs

s, and which physical devices it maps to. Click on the

A Note: Newsroom tags available for both AUDIO FILE and OUTPUT.

For further details, including third party audio players, see section Audio Players.

Virtual Set
You can specify the camera to take in a virtual set.

WirtualSet
6Dl Virtual Set device |5l o(= e
Camera |1

Cancel | Undo |

Insert the camera number in the virtual set that is to be taken when the template is taken to
Program.

& Note: For Vizrt's virtual set manager, Viz Arc, please refer to section Viz Arc support
within a Mosart show.
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Robotic Camera Control

The camera control device allows for recalling camera shots (and pre-programmed moves) when
the template is cued in preview or aired in program. The device editor supports salvo recalls of
shots by adding multiple lines for each shot recall.

a

File

- Edit + Show =

Test Template DB

Shot Name

Camera
number

Page
Preview

Preset
Preview

Time:
preview

0
-1

Delay
preview

0
-1

Page
program

0
-1

Preset
program

0

-1

Fade time

Program

0
-1

Delay
program

0
-1

Protect
onair
source

-1

CAM 1

The Standard Robotic Camera Control Properties are described below, as well as exceptions for
specific camera types:

Guidelines for Standard Robotic Camera Control Configuration
Cambotics Properties
Camerobot Properties

Cinneo System Properties
Fx-Motion Properties

Panasonic Properties
Technodolly Properties

Shotoku TR_T Properties
Telemetrics Properties

Vinten 200 Properties

Electric Friends Robotic Camera

Guidelines for Standard Robotic Camera Control Configuration

Shot Name Not used.
-1 : Shot is sent to all cameras that are not in standby.
>=0 : Shot is sent to the camera with the same
number. The number refers to those given in the
Cameras fields in Camera Robotics.

Camera number

The exact meaning and format of the Preview fields
depend on the type of camera robotics. (See the sections
below.) These following three fields govern what happens
when the template is taken in preview.

Preview
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Page Preview This field (together with Preset Preview) determines the
shot/move.

Preset Preview This field (together with Page Preview) determines the
shot/move.

Time preview This field (together with Preset Preview and Page Preview)

determines the duration of a move.

Delay preview Not used.

Program The exact meaning and format of the Program fields
depend on the type of camera robotics. (See the sections
below.) These following three fields govern what happens
when the template is taken to air.

Page program This field (together with Preset program) together
determine the shot/move.

Preset program This field (together with Page program) together
determine the shot/move.

Fade time Program This field determines the duration of a move.
Delay program Delay of move in Program (frames).

& Note: Only available for Vinten robotics systems

Protect onair source Protected video switcher cross-point. If the video switcher
cross-point is On Air, the shot/move recall will be
ignored.

For Technodolly, this protection can be confined to
Preview and/or Program, and to Cuts and/or Moves.

Cambotics Properties

Camera Number: Set camera numberto 1.
Page Preview/ Page program: Robotic camera number.
Preset Preview/ Preset program: Shot number.
- Time preview/ Fade time Program: [Optional] Duration for move in deciseconds (10
deciseconds = 1 second).
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& Note: All parameters not defined specifically, must be setto -1.

Camerobot Properties

Page Preview/ Page program: Name of shot’s matrix in preview/program.
Preset Preview/ Preset program: Shot’s cell number in the selected matrix - the shot is
adjustable from NRCS and GUL.

- Time preview/ Fade time Program: 0 ~ cut (fastest move) to position, ?0 ~ programmed
move speed (adjustable from NRCS and GUI).

Cinneo System Properties

Page Preview/ Page program: Name of the camera to recall.
Preset Preview/ Preset program: Name of shot to recall - adjustable from NRCS/GUI.
- Time preview/ Fade time Program: Desired moving time (seconds).

Fx-Motion Properties

5.3

Page Preview/ Page program: Identifies the camera to recall (identical to Camera Number >

0), optionally followed by :category for temporary overriding any NRCS or GUI settings.
Preset Preview/ Preset program: Name of shot or move to recall.

- Time preview/ Fade time Program: =0 cut, <0 ~ default time to shot, >0 ~ wanted time
(frames).

Panasonic Properties

- Camera Number: Identifies the Controller that the command is linked to.
Page Preview/ Page program: Identifies the Camera Number to be controlled in Preview/
Program.
Preset Preview/ Preset program: Identifies the Preset Stored Move in Preview/Program.

- Time preview/ Fade time Program: Sets the Timed Delay in Preview/Program. Has no effect

for Panasonic TCP.

Technodolly Properties

Page Preview/ Page program: Identifies the camera, identical to Camera Number when >0.

Preset Preview/ Preset program: Name of the move to recall.
- Time preview/ Fade time Program: =0 ~ go to start of move, ?0 ~ move.

Shotoku TR_T Properties

Page Preview/ Page program: Page of shot to recall.
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Telemetrics Properties

Page Preview/ Page program: Preset page number to recall.

Preset Preview/ Preset program: Preset number to recall.

Time preview/ Fade time Program: =0 cut, <0 ~ default time to shot, >0 ~ wanted time
(seconds).

Vinten 200 Properties

Page Preview/ Page program: Name of the show to recall.

Preset Preview/ Preset program: Name of shot or move to recall.

Time preview: <0 ~ go to end position of a move, = 0 ~ cut to shot, >0 ~ go to start position
of a move, or move to a shot (frames).

Fade time Program: For moves, move forward or backward according to Time preview. For
shots, = 0 ~ cut to shot, 70 ~ move to shot (frames).

Electric Friends Robotic Camera
For Preview use:

Page Preview: Show and Robotic camera name separated with a colon (e.g.: ShowName:Cam
1.

Preset Preview [Optional]: Shot name. Shot attributes: prepare, prepareplay and loop.
Separated with a colon (for example, prepare:ShotName and prepareplay:ShotName).

Time Preview [Optional]: Duration for move in frames. The time is rounded up to the nearest
second.

For Program use:

Page Program: Show and Robotic camera name separated with a colon (e.g.: ShowName:Cam
1.

Preset Program [Optional]l: Shot name. Shot attributes: prepare, prepareplay and loop.
Separated with colon (for example, prepare:ShotName and prepareplay:ShotName).

Fade time Program [Optional]: Duration for move in frames. The time is rounded up to the
nearest second.

Page peogram Pt program

1 - Biotiscenislen Cam 2 PREPARE 506 EF _stat 0E 1

3 i

Camera number | [Showname : Camera| |5hot name | Not used | Showname - Camera Shot attribute - set xpoint
(As setin AVA) | |[Camers name as (PVW) Camera name as set shot name (PP) (unchanged)
T [setin EF webserver) Time (Speed) | In EF webserver Time (speed)
Ul mavement of movement
(P in frames (PP} in frames

GPO
The GPO editor is used for sending GPOs to external equipment.
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PO Program gpo_preview gpao_program
» I

The editor supports multiple GPO sends.
Add a new line in the editor for multiple GPO sends.

@ Tip: For GPO values, refer to section GPIO.
gpo_preview: GPO to send when a template is cued in Preview.

gpo_program: GPO to send when a template is taken in Program.

Light Control
Light PREVIEW COMMAND PREVIEWVALU pROGRAM COMMAND PROGRAM VAL

- | - -

AICHT
Fire

Go
GoOff
Load
MoteOff
MoteOn
Resst
Restore
Resume
Set
Stop
Custom

A Note: The commands to use are driver-dependent and may vary.

Guidelines for Light Control Configuration

Option Description

PREVIEW COMMAND Command to use for the light mixer cue to be recalled
when template is cued in Preview.

& Note: Newsroom tag available.

PREVIEW VALUE Light mixer cue to use when template is cued in Preview.

& Note: Newsroom tag available.

PROGRAM COMMAND Command to use for the light mixer cue to be recalled
when a template is taken in Program.

& Note: Newsroom tag available.
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Option Description
PROGRAM VALUE Light mixer cue to use when a template is taken in
Program.

& Note: Newsroom tag available.

Preview Command and Program Command options are available from the drop-down list:

Command Parameter count

AllOff <none>. For details, see Set below.

Fire 1.For details, see Set below.

Go cue number. For details, see Set below.

GoOff cue number. For details, see Set below.

Load cue number. For details, see Set below.

NoteOff numeric note # (Std. MIDI command). For details, see Set below.
NoteOn numeric note # (Std. MIDI command). For details, see Set below.
Reset <none>. For details, see Set below.

Restore <none>. For details, see Set below.

Resume variable. For details, see Set below.
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Set

Parameter count
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The value of SET is presented below in the context of Midi Show
Control Specifications
(RP-002-014_v1-1-1_MIDI_Show_Control_Specification_96-1-4.pdf
available at https://midi.org/specifications/midil-specifications/
midi-show-control-2)

Hex
value

00

01

02

03

04

05

06

07

08

09

0A

0B

Command

reserved for

extensions

GO

STOP

RESUME

TIMED_GO

LOAD

SET

FIRE

ALL_OFF

RESTORE

RESET

GO_OFF

Number of

data bytes

variable
variable
variable
variable
variable

40r9

0
0
0

variable

Recommende
d minimum
sets

123

123

123

23

23

23

23

23

23

23

23

A Note: You can include an optional time value (key/value[/

time]), in the form: key=value@hh:mm:ss:ff

If unexpected program conditions occur, use a (dummy)
time parameter.
For example, 511=22@00:00:00:00, meaning set key 511
to the value 22 at time (hh:mm:ss) 23:59:59, frame 24.
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Command

Stop

Custom

TimedGo

Router Control
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Parameter count

cue number. For details, see Set above.

SysEx bytesSend multiple custom SysEx bytes in the format \xnn

where nn is a numeric value ( 0-255).

The global prefix and postfix set in the device config is used in the
message

(for example, abc\x20def will send seven bytes as a SysEx

message).
For details, see Set above.

- (unsupported). For details, see Set above.

The router control device allows setting crosspoints for source/destination pairs when the
template is both cued in Preview and aired in Program.

output_program

-1

ememnr_pr

Source
preview

Source Source
program

Dest program Audiclink Dest Audiolink matrix level program_delay | salvo_preview | salvo_program
[El =l [El =l 0 0 0 - :
=l A4 B =l A4 hd| -1 1 -1 1 1

Add new lines in the router device editor to support setting multiple crosspoints.

Guidelines for Router Control Configuration

Item

Source preview

Dest preview

Source program

Dest program

matrix

Description
Source to route when a template is cued in Preview.

& Note: Newsroom tag available.

Destination of routing when a template is cued in Preview.
Source to route when a template is aired in Program.
Destination to route when a template is aired in Program.

If the router system supports multiple matrices, select the
matrix to use here.
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Item Description

level - 0: route on all levels.
1: video routing only.
2: audio routing only.
3: GPI/O routing only

program_delay Delay, in frames after the template has been taken to the
air, for ‘program’ routing to happen.

salvo_preview Salvo name to recall when a template is cued in Preview.

salvo_program Salvo name to recall when a template is aired in Program.

Audio Settings (General)

- The main level for the fader is set by dragging the notch or clicking the arrows.
The default fader level when adding a new fader is 0 dB.
- To set level 2 of the fader press SHIFT while dragging.
A tool-tip opens to signal the editing of the level 2 fader level.
- To set level 3 of the fader press SHIFT+CTRL while dragging.
A tool-tip opens to signal the editing of level 3 fader level.
Level 3 is the mute level of the audio fader.

To Add Audio Faders

1. Add audio faders to the template by right-clicking in an empty part (large grey area to the
left) of the audio fader area and selecting Add fader.

2. Set the audio mixer crosspoint from the drop-down menu by clicking the label at the top of
the fader.
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o *Testkeyenable: CAMERA + 1 = B
File - Edit ~ Show - Test Template DB -

Keyfill Key 2
T Keyfill
MIX
0
xp.uirt EMeEMmnr_pr

MR

Add Fader

| Apply audio settings to all

& Note: Clicking Apply audio settings to all applies all the changes to all templates of the
same type and variant throughout all template sets.

To Remove a Fader

Right-click over the fader and select Remove fader.

To Configure a Fader

Right-click over the fader to open the context menu and follow the Guidelines below.

Guidelines for Audio Properties Configuration

Remove Fader Removes the fader from the template.
RemoveFader ‘
Order 3
Fader type 3
Link »

Keep level

Fade up in preview
Input device 3
Cross fade time 3
Manual close

Mode 3
Delay 3

Loudness 3
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Order Re-arranging the order:

Move Left
Move Right

RemoveFader

Move Left
MoveRight

Fader type Action: When a fader control is set as an action fader, the
controls define whether the fader is enabled or disabled.

Level: For normal operation.

Action
Level

Link

oW g

Copyright © 2023 Vizrt Page 341



Viz Mosart Administrator Guide - 5.3

Keep level Keeps the fader level until manually changed.
Enabled to let the automation open the audio fader, leaving
it open until the operator closes it with the Fade audio
function in the Viz Mosart client,
or closes it from another template.

RemoveFader

Order 3
Fader type 3
Link 3
Keep level

Fade up in preview
Input device 3
Cross fade time 2
Manual close

Mode 3
Delay 3
Loudness 3
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Fade up in preview Fades up the audio in preview, when camera is in program.
To let the audio fader open when the template is cued in
program, set to enabled.

RemoveFader

Order 3
Fader type 3
Link 3

Keep level

Fade up in preview

Input device 3
Cross fade time 3
Manual close

Mode 3
Delay 3

Loudness 2

Enabling this functionality only works with specific template
combinations, as shown below:

Program Preview (with Fade up  Result
in preview enabled)

CAMERA LIVE
DVE
TELEPHONEINTERVIEW
PACKAGE
Other Templates

Other Templates  PACKAGE

DI < T > B < B < < B <

Other Templates
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Sets the type of the audio fader.

The setting is used in combination with primary template
type and On Air status to identify which fader should be
treated as secondary audio.

This special handling is applied to the types below:

none: No special treatment.

Video server: The fader controls a video server channel
audio output.

Video server Ch2: The fader controls a second video
server channel audio output.

Graphics: The fader controls audio output from the
Graphics Engine.

External source: The fader controls an external audio
source.

Mic: The fader controls a studio microphone.
Telephone: The fader controls a telephone hybrid.
Soundplayer: The fader controls the Mosart Audio Player
output.

—

RemoveFader
Order v
Fader type »
Link »
Keep level

Fade up in preview

Input device » =

Cross fade time 3 Video server

Manuzl close Video server Ch2

o e Graphics

Delay 4 External Source

Loudness 3 !Z‘ Mic

Telephone

Soundplayer

Sets the in and out crossfade time for the fader.

In
Out

RemoveFader

Order 3
Fader type >
Link 3
Keep level

Fade up in preview
Input device >

Cross fade time r In 5

Manual close Out ,T

Mode 3

Delay 3

Loudness 3
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Manual close Select to ignore sending Close-level commands to audio
mixer.
When selected, sending the Take out for the fader at the
end of the element is ignored; The fader has to be manually

taken down.
RemoveFader
Order 3
Fader type 3
Link 3
Keep level
Fade up in preview
Input device 3
Cross fade time 3
Manual close
Made 3
Delay 3
Loudness 3

Mode Only for Studer Vista and Lawo!

Sends the chosen value to the mixer board for the audio
fader.

Stereo (not for LAWO EMBER+)

Mono (not for LAWO EMBER+)

Left (LAWO EMBER+: Stereo faders only)
Right (LAWO EMBER+: Stereo faders only)

RemoveFader
Order 3

Fader type 3
Link 3
Keep level

Fade up in preview
Input device 3
Cross fade time 3

Manual close

Mode 3 Stereo

Delay 3 Mono
Loudness 3 Left

Right

Delay Only for Studer Vista and non-Ember+ Lawo!

Gives a delay value for that audio fader that will be sent to
the audio board.

Mixer delay. Default: 0

RemoveFader

Order
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Loudness Sends chosen recall value to send to the Junger audio
processor.

vi AN W N~

RemoveFader

Order >

Fader type 3
Link 3
Keep level

Fade up in preview
Input device >
Cross fade time >
Manual close

Mode >
Delay >

Loudness 3

woB W ks

Testing a Template

You can test the behavior of your template by simulating a Preview then Take.

To Test a Template

Select Test template from the main menu.

This cues the template in Preview then five seconds later take it to Program with the selected
transition.

12.6.4 Working with Template Sets
This section contains the following topics:

Template Set Types
Standalone
Hierarchical

Template Set Operations

Template Set Properties

Template Set Types

A Viz Mosart template and its variants are arranged in a set. There are two approaches to working
with template sets.
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Standalone
Hierarchical

Standalone
Traditionally, Viz Mosart template sets are treated individually, with no connection to each other.

For example, a template set is created for each show or program. This is usually combined with
automatically selecting the template set through the associated NCS rundown. In addition, startup
commands for preparing the studio (lights, sound etc) for running the show are included in the
template set.

The copy contains the same templates as the original, and each template set created in this
manner can then be changed without affecting the other. When working with the template set for
a new program, (based on a copy of an existing program's template set), you make small
adjustments according to the functionality needed by the program.

When this new template set is created (by copying an existing set), a copy of all templates and any
nested sets is made, and no references are made between the original and copied templates. Each
template set is classified as ‘standalone’.

Disadvantages With This Approach

Many duplicates are created. Normally only a few of the templates in the set need to be
adjusted for meeting the needs of a new program.

With an ever-growing bank of templates being created for each new show, the amount of
stored templates in Viz Mosart can exceed system norms. This results in long response
times when saving templates and increases the memory footprint of both the Mosart Server
and Viz Mosart client workstations.

Maintenance of templates becomes cumbersome and error prone. When a change is made in
a template that is common for all template sets, the same change has to be applied
individually to every template set. This is a time consuming task across numerous template
sets.

Hierarchical

An alternative approach to standalone is hierarchical template sets. This method also enables

a new template set to be created, based on the logic of an existing template set. However, to begin
with, no templates are copied from the existing template set.

Only when a change is made to an existing template, or when a new template created, is a new
template created and stored in the new template set.

The hierarchical approach can be adopted with all existing (standalone) template sets, to optimize
machine capacity and introduce a more efficient workflow.
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Guidelines For This Approach

You can see the relationship between a templates inherited from one set to another (created using
the hierarchic approach), by selecting properties of the template from the newer set.

5 Template Editor | Funcspec: ACCESSORIES + ME1 — | X
File - ’W\ Template Set = DB
A | Select 3 | Camera 3 S
Mew...  Ctrl+N Package ¥
Copy Ctrl+C | Voice Over 4 1 (override)
Paste  Ctrl+V B e v FULL (inherited)
Paste All Graphics 4 HEAD (override)
Delete Del mm DVE L4 LVO (inherited)
o I:‘ Jingle 3 VO )
Reset Telephone 4 WALL (inherited) C
Ad-lib Pictures  »
Undo Ctrl+Z Break v
Properties... F4 Bl video wall » E
H Sound 3
n Accessories 3 ~

Black letters without any parenthesis: Operation is defined in the current template set only
Black letters with (override): Operation is defined in the template set but also exist in the
base template set. The current template set definition is used and overrides the
implementation in the base

Blue letters with (inherited) : Operation is defined in a base template set and has no
implementation in the current template set

Red letters: An empty template, this operation is not defined.

You can break the relation (inheritance) between two template sets

You can base a new template set on a template set that was itself created using the
hierarchic approach

You can 'flatten’ an inherited template set back to its base (original) template set. This will
push any new templates back into the originating template set. After this operation, the new
(inheriting) template set is deleted

When renaming the originating template set, the relationship to any inheriting (based on)
template sets still works.

Template Set Operations

To work with a template set, from the AV Automation utility, select Devices > Template editor, to
open the editor.
From here you have several operations:

To Add a Template Set

1. Select Template Set > New.
2. In the Name field, enter the name of the new set.
3. Click OK.

File-based Template Sets
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This method can be used without the Template Database, for example at installation / show

design when trying out several solutions/designs.

You can select a ready-made template set, stored as an XML-file. This presents a convenient way of

switching between sets.

1. Select File > Open
ffi Template Editer | Funcspe

File ~| Template - Template &

Mew...

| Open... M
Save CtlFlz- 5
Save To Database

Save As,.,

Revert...

Exit Alt+F4

2. Select the preferred XML-file from the list, and click Open.

55l Open ChannelTemplates x
A » ThisPC > Windows (C) » channeltemplates v & | Search channeltemplates o
Organise v New folder =- ™ @
Name ” Date modified Type Size

# Quick access

[ AsRunLogRepositoryCenfigml XML Document 4KB

I This PC [1 aveonfigaml XML Document KB
B 30 Objects [ channeltemplatesxml XML Document 2668 KB
I Deskiop [ ChannelTemplatesLastSavexml XML Document 2331KB

[] ChannelTemplatesLastTemplateSet xml XML Document 2331kB

[ Documents

[7] keyboard_shortcutssml XML Decument 2KE

& Downioads [} LogRepositoryConfigaxml XML Document TkB
P busic [7] MosartGlobalSettings.sml XML Document ke
=] Pictures [ MosLogRepositoryConfigxml XML Decument ke
[ videos [ newsroomsettings.mi XML Document 13KB

2, Windows (C)
= FinanceBGO (\\bgo
= Installers (\\bgo-me
= common (\BGOFS

= CenterNorway (B¢

& Network

e “ -

To Open a Template Set

1. Select an existing template set with Template set > Select.
2. The name of the currently opened set is shown in the title of the Template Editor.

Fils = Templils = Termpdats S

Funcspec
JINGLE + 3
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To Rename a Template Set

1. Select Template set > Rename .
2. In the Name field, enter a new name for the set.

3. Click OK.

To Delete a Template Set

1. Select Template set > Delete .
2. In the dialog box, click Yes to confirm delete.

A Note: You cannot delete a template set that is the origin of any other (hierarchic)
template sets. In other words, if a copy of your template set has been made using
the hierarchic approach (see To Copy a Template Set below), you cannot delete the
originating (base) template set

To Copy a Template Set

Referring to the background discussion in Working with Template Sets above, when you copy a
template set, it is more efficient to use a hierarchical approach.

1. Select Template set > Copy.
2. Enter the name of the new set in the text box.
3. Hierarchic approach: Select check-box Base on original.

.“i,? Copy Template Set

| BasedOnNewsnight

>
MName OK
_ Cencel |

Cancel
[v Base upon original

& Note: If the Base on original check-box is not selected a physical copy of the entire
template set including all nested templates, is created.

4, Click OK.

To Flatten a Template Set

You can push all templates in a new template set (created using the hierarchical approach), back to
the originating template set.

1. Select Template set > Flatten .
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2. A dialog box displays which template set the selected template set will be flattened to.
Template Editor

Flatten template set BasedOnFuncspec to Funcspec?

| Yes Mo
3. Click OK.

All templates in the selected set are now inherited from the base set.

To Hide a Template Set

When a template set is hidden it is unavailable to users of the Viz Mosart GUI and any NCS
components (ActiveX) that normally provide user access to select template sets.

1. Select Template set > Properties .
2. Select check-box Hide from user.

ﬁi Template Set Properties — O ot
BasedOnFuncspec > Funcspec oK
Description;
|LU'IEJ1I'11E“-I_'"|‘~‘E- Cancel
Based On
|Takshaw =1 I Hide from user
Recall Setings
[ On select: |
| On unselect [
| On inihﬂllzanl
[ Graphics pn:]
3. Click OK.

Template Set Properties

You can manage some properties of a template set with Template Set > Properties.
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[} viz Mosart Template Editor NameOfGallery - O X

Funcspec
B JINGLE + 3
Copy

Delets

Taks

Rerame..

Hatten

Set As Default
Properties...  Shift+F4

X

descriphion Funcspec | DB

Which displays the configurable parameters:

Y% Template Set Properties — L >

11 oK

Description;
I Cancel

Based On:
“none: ;I [~ Hide from user

—HRecall Settings

[T Onselect: I
[T Onunselect: I
[T On initializaﬁc:n:l

[~ Graphics profi |E:Z|

Item Description

Descri  The name of the template set.
ption

Based Original template set, upon which this template set is a unique variant.
On
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Item Description

Hide Prevent template set from appearing in user selection menus.
from
user

On Behavior of recall under this condition.
select

On Behavior of recall under this condition.
unsele
ct

On Behavior of recall under this condition.
initiali
zation

Graphi  (When used) Profile that will be applied to the new template set.
cs
profile

12.6.5 Other Template Functionality

State Variants
Dynamic ME Allocation
- Template Editor Password

Additional Template Features

State Variants

A story sequence comprises items based on templates. With the help of state-based variants, a
single template can be used for all stories. For example, the figure below shows, after the first
story, a sequence of three stories where each story contains a single story item, and each story is
using the same Viz Mosart template (VOICEOVER+HEAD). State variance enables a different
template variant to be used depending upon the story's position in the story sequence.
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00:00:00 00:00 |

00:00:00 00:00 |HEADR

HEAD-01

00:00:00

00:00:00

HEAD-03

For example, the first story in a sequence can behave differently to the remaining stories. Another
example is when combining a sequence with music, so that each story in the sequence has a
specific length, synchronized with the music.

In both examples, is it necessary to invoke different templates depending upon the position of the
story in the sequence. You can make it simple for the user to add their stories by just referring to
the master template (HEAD in this example).

& Note: Template variance only works on Story level, meaning that only one story item /
template should be assigned per story.

Example Of Using State Variants

[+ Use state variants

Wariants
HEADZ <= | |HEAD NO BONG &
HEAD3 — |HEAD WIPE
- HEADZ

HEAD3

M 0500 MEW FRC

M CATWALK OPE ¥

up | Down

Reset State | 6
Reset State After | 6 Stories

¥ Last state HEAD WIPE -

[ Single State | J

Continuing with the headlines example presented above, the templates can be placed into a
sequence.
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1. The template called HEAD is the master template, and the first story with a HEAD variant
uses this template.

2. The second story with a HEAD variant uses the template called HEAD2,

3. HEAD3 is used for the third story.
In this way, the only command (template variant) used in the newsroom system is HEAD,
regardless of whether it is the first, second or third.

4. You can now change the order of the headlines without any modification to the script,
making it very quick to do last minute changes.
In the same way, you can also define which template to use if there is only one HEAD, or if
the last HEAD template should act in a specific way.

To Configure A Template State Variant

Configuring template state variance is done in the template editor using the Template
Properties dialog.

1. Select any template as the master template which will be used as the first template in the
sequence.

2. Add additional variants in the sequence using the << and >> arrow buttons.
For a particular template type, it is only possible to select variants of the same template
type. The same template variant may be used multiple times.

3. Use the Up and Down buttons to shuffle the variant order.

The following properties provide additional control over which template variant will be used:

Reset State: Index number of the template variant that will continue, if the number of stories
in a sequence is larger than the specified number of variants. The index O refers to

the first variant (i.e the master template itself).

Reset State After: The number of stories not belong to the sequence, that can be run before
the new sequence is started. This allows the variance sequence to be kept, even when there
are stories within the sequence that are not part of the sequence itself. See the example
below.

Last state: Special variant to be used for the /ast story in the story sequence.

Single State: To be used as the last state when there is only one story in the sequence.

A Note: When using Single State, the property Last state must be defined.

Example - Reset State After

This example continues with the story sequence presented above with the three stories all using
the HEAD template.

The HEAD template variant has a variance sequence of three item: HEAD, HEAD-2 and HEAD-3.
Executing the story sequence then invokes the template variants "HEAD", "HEAD-2" and "HEAD-3"
for the three stories respectively.

If you now add another story sequence, for example HEAD, HEAD, OTHER-STORY, HEAD, with Reset
State After defined, then executing this story sequence invokes template variants depending upon
the value of Reset State After:

Reset State After <= 1: HEAD, HEAD-2, OTHER-STORY, HEAD

The sequence is restarted since Reset State After is less than or equal to 1 (story).

Reset State After > 1: HEAD, HEAD-2, OTHER-STORY, HEAD-3

The sequence is continued since the Reset State After is larger than 1 (story).
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Dynamic ME Allocation

To be able to use dynamic allocation, the vision mixer must have at least two mix effect
banks in addition to your program/preset bank.
Viz Mosart uses ME1 and ME2 for the dynamic allocation.

A Note: Programming of the emem registers on the vision mixer vary between the various
models on the market. Contact Viz Mosart support for instructions on how to prepare your
switcher to work with Viz Mosart’s dynamic ME allocation

When ME’s are included in a template with crosspoints or an emem recall, it’s possible to do
a dynamic selection of the ME, by choosing M_RIP or M_OTH.

Dynamic allocation can be useful in situations where you want an effect to load on an ME not
in use, or to set a crosspoint on the ME currently in use.

To allocate a "new" ME in your template, then choose M_RIP (ME ripple). This loads the effect
or set crosspoint on the ME that has the status of "not in use".

When this template goes On Air, the status of the ME will change to "in use". The next
template that uses M_RIP will then load on the other ME.

Conversely, use M_OTH (ME other). Using this in a template loads the effect or set crosspoint
on the ME with the status "in use", and does not cause a change of status between the two
ME’s.

This means that if the next template also uses M_OTH, it addresses the same ME as the
previous.

Template Editor Password

Password protection can be enabled for the Template Editor. When enabled, the user is prompted
for the password when opening the Template Editor.

By default, no protection is enabled, and the user is not asked for a password before opening the
Template Editor.

To Enable Or Change A Template Editor Password

1. Set focus on AV Automation.
2. Select Devices > Change Password.
3. In the Change password dialog box, enter a new password or change an old one.

Change password I,&J

Old password: |

Mew password: ||

Retype new password: |

0K | Cancel
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To Reset A Template Editor Password
If the password is lost, it can be reset.

1. Set focus on AV Automation.
2. Opening AV Automation Settings with CTRL+SHIFT+S.

3. Find the PasswordHashed entry, and remove the value.

-
[:] CAProgram Files (x86)\Mosart Medial...L =N ihj

EH=: A
@z X

MewGalleryLoad False

port_audiomixer 3000
PasswordHashed

L L[>

12.7 Mosart Instrumentation Panel

% Mosart Instrumentation Panel = =

Time Dur Cat Event Device Descripion ReturnCode

The Mosart Instrumentation Panel displays all device commands in real time, that are being sent to
the various connected devices. Each command is time stamped, revealing when a device command
was issued, in relation to the taking of a Mosart template.

12.8 Newsroom Tags

Newsroom tags is the mechanism for configurably transferring data values from the NRCS to Viz
Mosart. For example, a template for playing a clip can have a Newsroom tag for the clip name. The
journalist specifies the clip name in their NRCS story item. This clip name is then automatically
transferred to Viz Mosart, where the correct clip is played-out when the story item is taken.

A Newsroom tag has

- A name
Optionally a value
Optionally a list of permissible values. (If a list is given, the tag value, if any, will be in the
list.) This list will be one of those defined in AV Automation, section Audio and Video Setup:
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- Video Config

- Audio Config
Effects
Router sources
Router destinations.

& Note: invalid characters in XML 1.0 are also invalid characters when used with ActiveX and

newsroom tags. For more information, see the XML 1.0 documentation:
https://web.archive.org/web/20140228010526/http://validchar.com/d/xml10/
xml10_namestart
https://en.wikipedia.org/wiki/List_of_XML_and_HTML_character_entity_references
https://en.wikipedia.org/wiki/Valid_characters_in_XML

The basic workflow for one tag is:

1.

In the Template editor, a Newsroom tag is added to a template field. (See Adding a
Newsroom tag to your Viz Mosart Template below). The tag name is specified.

If the template field has an associated list of values (as listed above), that list will be the tag
list, too. If a value is given for the template field, that value will become the tag value, too.
In the ActiveX in the NRCS, when inserting the template into a story item in a rundown, the
tag value may be changed or set (depending on whether a value was given in the previous
step).

When the rundown is loaded into Viz Mosart, the Newsroom tag value, if any,

is automatically assigned to the template field, overriding any value set in the Template
editor.

Note: Step [1] may be repeated, adding several tags to a single template. Then step [ 2 ]
may be repeated in the ActiveX, and step [ 3 ] will automatically be repeated, too.

If in step [ 11, the same tag name is specified for several template fields (in the same
template), only one newsroom tag will be added, so only one value need be supplied (for
this tag; there may be others) in step [ 2 ].

In step [ 3 1, this single value will be assigned to all template fields (in that same template)
having the newsroom tag with this name.

(Optional) If the newsroom tag shows up in the GUI Program window or Preview window (see
the explanations for Program window and Preview window (Key Select sub-sections) in the
Viz Mosart User Guide, section Main User Interface ), the value may be modified there.

The remainder of this section deals with:

- Adding a Newsroom tag to your Viz Mosart Template

- To Add a Newsroom tag
Newsroom Tags Order
- To Set newsroom tag order

- Advanced Features for Specific NRCSs

- To Use a Column in ENPS as a Newsroom Tag
Inheriting Newsroom Tags (applies to MOS-based NRCS s only)
Keep Newsroom tag (with the same name) within a story
Inherit from a Newsroom tag with another name
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12.8.1 Adding a Newsroom tag to your Viz Mosart Template

Inherit with default value

Viz Mosart Administrator Guide - 5.3

- Adding inheriting values to the lists defined in AV Automation's Audio and

Video Setup
Examples
DVE Template with inheritance
- Timeline Example

To Add a Newsroom tag

Refer to section Working with Device Functions, which lists the properties of the device
where you want to add the Newsroom tag (e.g. the 'Switcher XPoints' as shown below).

Switcher XPoints

. B

Right-click the field (e.g. Crosspoint). A pop-up menu appears:
55

Crosspoint 1
Mix Effect 1

-

Mix Delay

Diown stream keyer

Crosspoint Audio link Off delay

v |KAM DSK Off

Cross | Add Newsroom tag

,_ Remove Newsroom tag DAl IT

[ Cross Point Hold

0 I~ Transition Only

Mix Delay Out |0

0K | cancel |

(If the field already has a Newsroom tag, there will instead be a menu option Change
Newsroom tag, and the Remove option will be enabled. Please note that not all template
fields support Newsroom tags. When right-clicking a non-supporting field, a pop-up menu

may or may not appear. If it does, it will not contain an Add Newsroom tag option).

Select Add Newsroom tag.
A dialog menu appears:

Copyright © 2023 Vizrt

Page 359



Viz Mosart Administrator Guide - 5.3

Add newsroom field name >

Newsroom field oK

Cancel

Please note that a default name may be given.

- Enter or change the Newsroom tag name, and click OK.

& Note: Avoid using any special characters in Newsroom Tag naming

Close the device properties window (e.g. the 'Switcher XPoints' as shown above).
To verify, hover-over the device details. The Newsroom tag(s) are presented at the bottom of

the panel.

$ *Viz Mosart Template Editor NameQfGallery - [m] x

File ~ Template = Template Set = DB -

[ |

install
CAMERA + 1

SW Input
CKEY1

om tags -
mixeffect

xpoint

order

| instalt | DB|
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12.8.2 Newsroom Tags Order

If a template has more than one newsroom tag, the order in which the tags are shown in Viz
Mosart’s ActiveX, may be changed in the Template editor.

To Set newsroom tag order

1. In the Template Editor, open the target template
2. Open Template Properties and select the Newsroom tags order tab
3. Order the Newsroom tags if there are several. (Select a tag, and then click Up or Down).

Template propertizs

General ] Control Commands ~ Mewsroom tags order ]

Order the newsroom tags by rearranging the
elements in the list below:

right

middle Up
Down
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4. To verify, open the Activex in the NRCS, and observe that the tag order is as set in the
previous step:

BEE™™)
' )(=2)| €] C:\Program Files (86)\M 2 ~ & || & Mosart ActiveX i T 5o
Viz Mosart £
| E .
|TestTempIateSet _*J
CAM new Description
PACKAGE Double box
VO 3IBOX
LIVE SQUEEZE [ et
GRAPHICS —
Transition
TELEFHOME Default -
B-ROLL
BEREAK
CG MName Yalue
s left jcamt
COMMAND s
right EXT1
middle EXTZ2
v
£ >

12.8.3 Advanced Features for Specific NRCSs

To Use a Column in ENPS as a Newsroom Tag
You can use a column value in ENPS as a Newsroom tag in a Viz Mosart Template.
1. Add the column in ENPS, by using the TV station-specific routine to add a column in ENPS.
All the current fields are visible in System fields->ENPS fields.
A Usage Notes

The id of the field and the Newsroom tag in Viz Mosart must be named identically.
The naming is case-sensitive.

Make sure that Mos Send is checked.

Type must be Script+RO Column

2. Restart ENPS client to be able to add your new column in the layout.
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3. Add the column as a story variable in Viz Mosart config:

File  Edit Story External Metadata
mostagname Muosart Action Format Type mos_value action_value
inp1 tem_wariable j String j inp1
inp2 itern_wvariable j String ﬂ inp 2
inp3 tem_wvarable j String j inpd
inpd tem_wvarable ﬂ integer j inpd

4. In Viz Mosart External Metadata
a. Add the new ENPS field as, for example, an item_variable.
b. There is also a story_valuable available, but using this action value will affect all items
in the story (the Newsroom tag binds to all primaries in that story).
c. The target here should be the first primary item in a story.
5. Restart all Viz Mosart server applications to apply settings.
6. Add the Newsroom tag to required template, a standard operation as described in Adding a
Newsroom tag to your Viz Mosart Template.

Inheriting Newsroom Tags (applies to MOS-based NRCS s only)

For MOS-based NRCS, Viz Mosart offers a method where a Newsroom tag need only to be set once
within a story.

A Note: If, for ENPS, the Story scope is set to Grouped, a story in this context means the
contiguous collection of GUI rows with the same story name. See Settings Editor MOS,
section Story scope.

Story items that follow can be programmed to follow/inherit the given Newsroom tag (i.e.,
inheriting its value), with an optional default value.

Keep Newsroom tag (with the same name) within a story

If a Newsroom tag has the special value 'KEEP', this value will act as a placeholder in the sense that
the tag will get the value of the last Newsroom tag in the story with the same name.

A Note: The special value KEEP is configurable . See definition for Newsroomtag keep
keywords in Settings Editor MOS, section NCS Configuration.

Inherit from a Newsroom tag with another name

A Newsroom tag may inherit from another tag in the same story. Then the inheriting tag will
'inherit’ the value of the tag referred to, i.e., get the same value.

This is done in the following way: The value of one tag (the inheriting tag) may be given as
{name}', where name is the name of another tag (the tag inherited from).

Example: If there is a tag with name 'left’, another tag (with some other name) may inherit the tag
left by having this value: '{left}'.
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Inherit with default value

Optionally, a default value may be given, to be used when the tag inherited from has no value (in
the story), or does not exist at all. The general syntax (for the value of the inheriting tag) is '{name}
#default', where name is the tag inherited from (as above), and default is the default value.

Example: Continuing the example above, the inheriting tag may be given the value '{left}#0S 2'.
Then, if the tag left has no value (or does not exist at all), the value of the inheriting tag will be 'OS
2'.

Adding inheriting values to the lists defined in AV Automation's Audio and Video
Setup

As mentioned in the introduction above, a Newsroom tag may have a list being one of those
defined in AV Automation's Audio and Video Setup. Special values as defined above ('KEEP",
{name}', and '{namel#default’) may actually be added to these lists, making the available for
selection both in the template editor and in the ActiveX.

The following figures five such values added to the Video Config list, and how these values appear
in the ActiveX:

rE] XML Editor file///c:/channeltemp cnﬁg.meD (B[ B Viz Mosart
File Edit
¥-point name Physical input Audiolink Audiolink Ch 2 > = *
DVE1 64 j j uncspec ~
TEC 100 | ~| CAMERA LIVE Description
PACKAGE 2BOX name
ME30P2 125 | ~| VOREOVER —_——
ESOFs 126 | =l |los
{eft}tiCamera 5 - - GRAPHICS
left} J J VIDEO EFFECT
o j j JINGLE Transition
fight?} | ~| | PHONO Defaul
{ight}ALX12 ~| ~| EIE%OE;TK efault  ~
KEEP El =l { vibEOWALL
i | ~|—] cG Name Value
T4 | SOUND
S *| || ACCESSORIES left LIVET v
COMMAND right LIVE1
LIVE2
right LIVE3
LIVE4
CLIP1
CLIP2
CLIP3
CLIP4
STREAM1
STREAM2
INP1
INP2
INP3
INP4
KEEF
{left}#Camera 5
{left}
{right}
{right}{#AUX12
KEEF

Explanation:

{left}#Camera 5 - Use the value of the last Newsroom tag {left} or “Camera 5” if no such
Newsroom tag exists.

{left} - Use the value of the last Newsroom tag {left}. Nothing happens if no such Newsroom
tag exists
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KEEP - Special configurable word that means keep existing value of the corresponding

Newsroom tag. (In the ActiveX example "left")

Examples

DVE Template With Inheritance

A DVE 2BOX template where the left and right input may be inherited from sources within the

same story

Key

name Key

bus 1
xpoint {left’¥Camera 5 D
audiolink 1
index U
set_me_in_pp False

peint_hold False

fect M_RIP

-- Mewsroom tags --

xpoint boxleft

Key 2

{lefti#Cam {rig

ALK
1]
Xpoint ememnr_pr

|
DVE DTL 2 BOX

0

| 2406.201314:4302 |

In this template the values for Key 1 and Key 2 are:
Key 1 = {left}#Camera 5
Key 2 = {right}#AUX 12

This means that Key 1 will be either the current value of a Newsroom tag named left within the

same story or “Camera 5” if no such Newsroom tag exists.
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Timeline Example

Camera+4: LIVE+2: DVE+DTL2BOX:
left = Camera 4 right=0S 2 left = {left}
right={right}

In the figure above three templates are placed in a timeline:

1. Camera+4: Where xpoint is set to “Camera 4” with Newsroom tag = “left”

(4 “NEWSDAY: CAMERA + 4 (0] o] [ 5 e

File ~ Edit = Show = Test Template DB -

ML
0
Xpoint S ememnr_pr

SW Input
name S5W Input
xpoint Camera 4

| 2406.201315:21:04

delay
x_delay_out

k

-- Mewsroom tags --
xpoint
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2. Live+2: Where xpoint is assigned to OS 2 with Newsroom tag = “right”

SW Input

name
¥point
mixdelay

int_pp
mixeffect
set_me_in_pp
crosspoint_hold
dsk_off

mix_delay_out
audiolink

=

-- Mewsroom tags --

right

Qutside Source - Enter item timing in DURATION box belnw—righ* 24.06.2013 15:22:55 |

& Note: The Newsroom tag here is entered to make it possible for later templates in
the story to inherit the value. Adding a Newsroom tag here will also expose this
value to the ActiveX

3. DVE+DTL2BOX where left and right inputs are set to inherit Newsroom tag {left} and {right}
respectively.
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F |'1

ol *NEWSDAY: DVE + DTL 2BOX » Bl B %

© File = Edit ~ Show = Test Template DB -

Graphics

' Key 1 N

0
Xpoint  ememnr_pr

o | 0 | 0o [ o o0 o o1

DVE DTL 2 BOX | 2406.201315:42:02
L9 A
In this example, the left and right inputs are inherited from previous templates in the same
story exposing Newsroom tags with the same names.

A Note: Here, no default values are given., so nothing will happen if no values have
been assigned to the left and right Newsroom tags
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13 AV Automation Device Properties

AV Automation can send commands to all connected broadcast devices. For the commands to be
received, and interpreted according to the device's specifications, the device must be configured
within Viz Mosart.

Vision Mixer \fideo Servers Graphics fudio  Camera Fobotics  Light Control  Router  Subtiles GPL/AD  Taly  Virual Set Weather  Video Wall  Int| + |

Protocol SONY MVS v
Comport videoswitcher CoM3 v Ini - SNAPSHOT
Reset snapshot vw 1
DVE Forward SNAPSHOT
Auillary videowall 1 £ ] DVE Reverse SNAPSHOT
Diefault Camera mix on v I:I Effect Memory B »
Mix Effect Videowall 1 Me 1 - DSKMNr 1~
Min. Cue delay frames [ AUX Clicked preview |1
Min. Clip Mix delay frames [] Use DSK 1 on/off [] Control DSK from Overlay Interface
Usze DSK 2 on/off Owveray Direct Take control
FrameRate frames per second [ Use DSK 3 onloff Active |:|
Virtual ME Physical ME [] Use DSK 4 on/off Inactive |:|
FFP PP v
[] AsRun log cross peints in stand by
ME1 ME1 -
MEZ ME2 -
ME3 ME3 -
ME4 ME4 e

Cancel Apply Save & Close
To configure device properties in AV Automation, select Devices > Properties.

& Note: AV Automation must be restarted before any changes will take effect.

The Device Properties menu has three common buttons:

Cancel: Exit this menu without saving any changes.

Apply: Save all changes and reconnect the device on the active tab (only applies to
tabs Vision Mixer, Video Servers, Graphics, Audio, Camera Robotics, Light Control
and Subtitles).

Save & Close: Save all changes and close the menu.

This section presents the following device properties:
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- Vision Mixer

- Video Servers
Graphics

- Audio
Camera Robotics
Light Control
Router
Subtitles
GPIO

- Tally

- Virtual Set

- Weather

- Video Wall
General

13.1 Vision Mixer

This dialog menu is accessed from the AV Automation menu bar with Devices > Properties > Tab:
Vision Mixer.
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Vision Muer | Video Servers | Graphics | Audio | Camera Robotics | Light Control | Router | Subitles | GPI/D | Tally | Virtual Set | Weather | Video Wal | Int¢ | »

v Protocal |Carb-::ni‘te ﬂ
Hest videoswitcher: |'| 52.168.0.123
Port videoswitcher: 7788 Ini - EMEM 99
Auxillary videowall 1 4 Reset dmem vw 1 49
v Default Camera mix on vw 4 DWE Forward EMEM 57
DVE Reverse EMEM 58
Mix Effect Videowall 1 Me 4 - Effect Memory PP -
Min. Cue delay 25 frames DSKNr 1 -
[ AUX Clicked preview |1
Min. Clip Mix delay 10 frames [~ Use DSK 1 onloff ™ Control DSK from Overlay Interface
™ Use DSK 2 on/off Owerlay DirectT ake control
FrameRate 25 frames persecond [~ |Jse DSK 3 onloff Active
Wirtual ME Physical ME [ Use DSK 4 on/off Inactive
[H3 inone) - -
™ AsRun log cross points in stand by
ME1 ME1 -
MEZ ME2 -
ME3 ME2 -
ME4 ME4 -

The exact appearance of the Vision Mixer tab depends on your selection from the Protocol drop-
down menu.

Vision Mixer Settings
Description of the Video Mixer Menu
Common Video Mixer Connection Settings

13.1.1 Vision Mixer Settings

There are several settings required for Viz Mosart to effectively control a specific video mixer.

Description of the Video Mixer Menu

A Note: Most devices, especially ones controlled through IP, often have their own config
interface (for example, accessible through a web interface) where various parameters such
as host/port can be inspected and modified as needed.

Values found in this device config interface should be used for setting their corresponding
properties that are described below.
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Protocol (check box): Check the box to enable video switcher control.
Protocol: Select a protocol supported by your switcher:
- ACUITY
- CARBONITE
- GVG200: GVG/Philips/Thomson
- GVG4000: Ross Synergy
- GVG4000 V2
- GV CPL
- GV DD35
- GV KAYENNE PRIMARY
- GV KAYENNE SECONDARY
- GV ZODIAK
KAHUNA: Snell Kahuna/Kula
KAHUNA IP: Grass Valley Kahuna/Kula
MASTERPIECE
NOVA700: Echolab
- SONY: Sony compatible video switchers
- SONY BVS: Support for legacy SONY DVS/BVS 300 series
- SONY MVS: An extension to the protocol for the SONY MVS8000
- SONY SERIAL TALLY
- VIZRT-IPS
- Comport videoswitcher: Defines the serial port the video switcher is connected to.
Host videoswitcher/Port videoswitcher: Defines the IP and port the video switcher is
connected to.
- This labeling on the settings page depends on what type of mixer is selected.
Host / Port is valid for mixers that are using TCP/IP protocol, or a com-port for serial
port communication, or a host- or client-port for UDP.
- Com-port / Host-port labeling depends on the mixer model. See Common Video Mixer
Connection Settings below.
- Auxiliary videowall 1: This is the auxiliary output from the video switcher to the video wall.
Default Camera mix on vw (check box): Enables the default camera in program when
entering video wall mode.
Default Camera mix on vw: Enter the camera number you want to use as the default camera
in program when entering video wall mode.
Mix Effect Videowall 1: Select the ME to use when enabling mixing in video wall mode.
Min. Cue delay: Value in frames which sets the minimum delay before Viz Mosart cues the
next template in preview.
Min. Clip Mix delay: Value in frames which sets the minimum delay from starting the server
to starting the video switcher transition.
FrameRate: Specify the number of video frames per second for the system.
Ini-EMEM: Initial register to recall when starting the automation. Depending on the Protocol
chosen, the caption may alternatively be Ini - DMEM or Ini - SNAPSHOT.
Reset EMEM vw 1: Register to recall to normalize the ME before entering video wall mode.
(Depending on the Protocol chosen, the caption may alternatively be Reset dmem vw 1 or
Reset snapshot vw 1).
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DVE Forward EMEM: (not supported by Sony) EMEM to recall for running DVE forward.
(Depending on the Protocol chosen, the caption may alternatively be DVE Forward DMEM or
DVE Forward SNAPSHOT).

DVE Reverse EMEM: (not supported by Sony) EMEM to recall for running DVE backward.
(Depending on the Protocol chosen, the caption may alternatively be DVE Reverse DMEM or
DVE Reverse SNAPSHOT).

Effect Memory: ME to use when recalling registers for Effect use.

DSKNr: Downstream keyer to use for the DSK on/off functionality.

- AUX Clicked preview (check box and number): Check the box to enable AUX clicked preview,

and specify the AUX bus connected to the preview monitor. When activated, it is possible to
click an element in the Viz Mosart rundown, to preview the source on the monitor, via the
specified AUX bus.

Use DSK n on/off: Enable or disable the on/off functionality for DSK 1-N, where N depends
on the protocol. Most protocols have 4 DSKs, but there could be as many as 8 DSKs.

- Control DSK from Overlay Interface: Check box to enable DSK to be on only when overlay

graphics is present.

- Overlay Direct Take control:

- Active: Viz Mosart will run the direct take entered here when an overlay graphic goes
On Air.
Inactive: Viz Mosart will run the direct take entered here when an overlay graphic goes
Off Air.

- AsRun log cross points in stand by (check box): Check box to set AsRun log in stand-by.

Common Video Mixer Connection Settings

The following table presents some recommended or additional values for a range of video mixer

drivers.

Driver Settings Configuration Interface Notes

GV CPL Port video switcher: 5000 This driver uses UDP protocol
Client Port video switcher: Additional client port property used for
6004 receiving callbacks

Sony SonyVideoSwitcherConfig.xml  ReadTimeout is possible to change via
setting the SonyVideoSwitcherConfig.xml

. " . " configuration file. Default set to 200
<item name="ReadTimeout -
" " milliseconds

value="100" />

VIZRT ENGINE When working with a Viz Engine in a

switcherless, or Engine Switcher
configuration, refer to the specific
settings in section Viz Engine as a
Switcher.
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& Note: Configuration files can be used to configure some settings. See section Vision Mixer
Configuration Files for examples.

13.2 Video Servers

Viz Mosart is capable of controlling video servers from many different manufacturers. Although
the end result is the same, each video server type operates in a slightly different way.

Working with Video Server Configurations
Video Server Properties
Video Server Port Properties

Working with Servers and Ports

Mosart Port Configurations
Virtual Server Ports
Working with Mosart Port Configurations
Working with Salvos

Video Server Recording Setup Example
Configuring Viz Mosart

It is essential that the correct settings are defined in AV Automation for Viz Mosart to effectively
and correctly control your video server. You reach these settings with

- AVAutomation > Devices > Properties> Video Servers tab.

Video server configuration Mosart port configuration
Quantel Properties Maosart Port Group
B Connection = Description
Config File ClipSenerQua MName A7B
Initial Standiby [ Qrder 0
IOR httpfquantel: E Misc
SarialNs 20154 IsDefault O
sevarTipe
Slave
Timegut
El Description
Alias
MName sQ1
| Mame=s01Type=Cuantel. Server=192.168.1.1.Por=5258. Mode=Player.Config=ClipServerQuentel xoml I0R=htip iquanizl @132 168 1.1ZoneManager ior. Senzl
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- The left side presents details of the physical video servers, and any port configurations.
The example above presents a Quantel server, sQ1 (as selected from the Server Type drop-
down menu), and one other server (sQ2), which could also be a Quantel server.

Server sQ1 has 2 ports defined, sQ1:1 + sQ1:2.
Server sQ2 has 2 ports defined, sQ2:1 + sQ2:2.

- The right side presents details of the virtual connection within Viz Mosart, with salvo
definitions.

This is described in Working with Mosart Port Configuration.

This rest of this section contains the following topics, presented according to the configuration
menu illustrated above, from left to right:

- Working with Video Server Configurations
- Video Server Properties
- Video Server Port Properties
- Working with Servers and Ports
Mosart Port Configurations
- Virtual Server Ports
- Working with Mosart Port Configurations
- Working with Salvos
- Video Server Recording Setup Example
Configuring Viz Mosart

13.2.1 Working with Video Server Configurations

You can add or remove video servers to your Viz Mosart system, and modify the configuration of
existing hardware.

Viz Mosart supports a wide range of video servers. These can be viewed from the Server
Type drop-down menu.
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Server Type

Add new server Add new port |
Quantel Properties
Config File ClipServerQua
Initial Standby J
IOR, http:/fquantel:
Serialbo 20154
Server Type Quantel
Slave
Timeout
El Description
Allias
WName s0O1

Viz Mosart Administrator Guide -

Quantel

AirSpace

AirSpeed
AirSpeedMultiStream
EVS LinX

EvsXedio

GVG K2

MVCP

Mexio

Omneon

Orad OCIP

Quantel

VDCP [:}
VDCPtcp

VizEngine

vizrt-ips

A Note: Only compatible combinations of Media Administrator and AV Automation drivers
can be defined. Please contact Vizrt Support for further details.

5.3

The Name property links the selected video server to a Media Administrator properties line.
For an explanation of the various configuration properties, please refer to the specific video
server model, as presented in Video Server Properties below.
After configuration, restart Media Administrator and AV Automation, and ensure that the GUI
is connected to the required server.
Verify that all indicator lights for the selected video server go green.

@ Tip: If you do not get green lights, and you see a message similar to this in the Mosart log:

Failed connecting to video server K2:

The source was not found, but some or all event logs could not be

searched.

Inaccessible logs:

Security.

you can try to start AVAutomation as Administrator. This is a known issue with Grass
Valley servers. More info here: http://www.gvgdevelopers.com/concrete/apis/
appserver_api/windows/

Video Server Properties

Here are some guidelines for common video servers that Viz Mosart can work with.

Common Settings

Several of the settings are always required, as listed here
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Initial Standby: If selected, the server is forced to start in Standby mode.
Server: Defines the hostname or IP address of the video server.

& Note: For EVSXedio, a value for Server is not required.

Server Type: Name of supported video server. For example, AirSpace, AirSpeed, EVS LinX,
Orad OCIP.

- Alias: Defines the name of the server to display in the Viz Mosart GUI and Timing Display.
Name: Internal name of the server, displayed in AV Automation.

The above settings are typical for
AirSpace, AirSpeed, EVS LinX, EVS Xedio, OradOcip video servers.

AirSpace Properties

B Connection

Initial Standby ]
Server

E Description
Alias Alias
Marne Marne

Some common video server properties are summarized below:

- AirSpeed MultiStream
Grass Valley K2
Nexio
MVCP
Omneon
Quantel

- TriCaster

- VDCP

- Viz Engine
Vizrt-ips
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AirSpeed MultiStream

AirSpeed MultiStream Properties

£ Connection

BasePort

Initial Standby ]

Server

Server Type AirSpeedh
El Description

Alias Alias

Mame Mame

BasePort: The first port Viz Mosart uses to communicate with the AirSpeed
MultiStream server.
Default: 59451.

Grass Valley K2

Connection to K2 is initialized with a ping (ICMP) from Mosart to the server to confirm the
connection. Then it uses port 3811 to communicate with the K2 server. Both must be open for
Mosart to be able to connect.

Manus Admin uses a separate port when it connects: 49171 (a range is OK. Use 49168-49172)

Grass Valley K2 Properties

E Connection
Clip Bin
Domain
Initial Standby ]

Pazz

Server
Server Type GrassValle ~
Suite
User
Wolume
E Description
Alias Alias

Mame Mame

Clip Bin: This value, together with that of Volume (see below), defines the default server
location of clips to be played. This default location is used only when the location is not
provided by other means. (In particular, it is not used when the setting IgnoreBin (in Media
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Administrator) is true for this server.) The value of Clip Bin should designate a bin in the
volume designated by the value of the Volume setting.
Domain: The domain as part of the user credentials.
Pass: The password as part of the user credentials.
Suite: Arbitrary value. However, follow these guidelines:
For each K2 server, two or even three unique Suite values must be used:
First, the values for Media Administrator and AV Automation must be different.
Second, in a redundancy setup with Main and Backup Mosart server, the
two values for Media Administrator must be different.

& Note: In this constellation, both Main and Backup AV Automation should
use the same value, different from the two Media Administrator values.

User: The username as part of the user credentials.

Volume: This value, together with that of Clip Bin (see above), defines the default server
location of clips to be played. This default location is used only when the location is not
provided by other means. (In particular, it is not used when the setting IgnoreBin (in Media
Administrator) is true for this server.) The value of Volume should designate a server
volume.

Nexio

HarrisMexio Properties

B Connection

Initial Standby L]

Port 1

Server

HarrisMex *
E Description

Alias Alias

Mame Mame

Port: TCP/IP communication port to the Nexio server.
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MVCP Properties

E Connection
Initial Standby L]
Port 5558
Server

E Description
Alias Alias
Mame Mame

Port: TCP/IP communication port to the MVCP server.

Omneon

Omneon Properties

E Connection
Directory
ExtList
Initial Standby ]
Server
E Description
Alias Alias

Mame Mame

Directory: Defines the directory where the clips are stored.

Viz Mosart Administrator Guide - 5.3

ExtList: The list of valid file extensions used when listing and querying files on the server.
The list is period separated and case sensitive.
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Quantel

Quantel Properties

E Connection
Config File
Initial Standby ]
IOR

SerialMo

Slave
Timeout
El Description
Alias Alias

Marme Mame

Config File: The path to the XML configuration file used to define the Viz Mosart - Quantel
communication.

IOR: The HTTP link including hostname or IP address to the IOR resource on the Quantel ISA
manager. Example: http://192.168.100.50:2096/ZoneManager.ior

SerialNo: The serial number of the Quantel playout server.

Slave: The hostname or IP address of the slave/backup IOR.

- Timeout: Timeout value for requests from Viz Mosart to ISA manager. If the request exceeds
this timeout the server connection is reinitialized. Setting a value here should only be
needed for sites experiencing issues with the Quantel connections. Leaving a blank value
uses the default timeout.

Recording with Quantel Devices

Quantel requires a duration when preparing a recording. This duration can be set the following
ways:

As part of a template: Specified using markin and markout properties.
As part of a keyboard shortcut: Specified by trailing the ClipName

property with [,duration]. Similar to the examples under the general section Controlling
Video Servers from Mosart above.

As part of template control command: Specified as part of the Parameter property. Again,
see the general section above.

TriCaster
The Vizrt TriCaster uses the Vizrt-ips protocol.

Please refer to the procedure below in Video Server Recording Setup Example.
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VDCP
VDCP Properties
{E Connection
COM Port 1
Initial Standby ]
Server Type VDCP -
E Description
Alias Alias
MName MName

COM Port: The COM port co

VDCP(tcp) Properties

E Connection

Port 1

Initial Standby L]

Server

oo
E Description

Alias Alias

Marme Marne
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nnected to the VDCP video server.

Port: The TCP/IP communication port connected to the VDCP video server.

Viz Engine
VizEngine Properties
E Connection
Port 1
Initial Standby ]
Server
VizEngine *
El Description
Alias Alias
Mame Mame

Port: The TCP/IP communication port connected to the Viz Engine video server.
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Vizrt-ips
vizrt-ips Properties

B Connection

Directory Di\Sessionsh\De
Initial Standby ]
Fort 5951
Server 192.168.1.1
E Description
Alias
Mame vizrt-ips

Directory: Defines the directory where the clips are stored. The following format can be
used: {volume}:/Sessions/{session_name}/Clips/Import
Port: The TCP/IP communication port connected to the vizrt-ips video server.

Video Server Port Properties

Server Port =

B AvConfig Quantel-1
Alias Quantel:2
Audio Channel 1 SVR A e

4 e
Audio Channel 2 [empty) ~
CrossPoint SVRA ¥ 2
Video port 1

El Description
Mame Cuantel:1

Alias

Audio Channel 1: The audio channel 1 for the selected video port.

Audio Channel 2: The audio channel 2 for the selected video port.

CrossPoint: The video crosspoint for the selected video port.

Video port: The actual port name/number on the video server. Please refer to the
documentation of your video server for information on how to find these.

& For the Server Type vizrt-ips, any recording port must have a 'Video port' of the form
recN, where N is a number.

Name

Copyright © 2023 Vizrt Page 383



Viz Mosart Administrator Guide -

13.2.2 Working with Servers and Ports

To Add a Server

1. Click the Add new server button
2. In the Properties pane on the left, select from Server Type and add additional

information such as Port and Server host.

To Remove a Server

In the Video Server Configuration tree, right-click a server node and select Remove.

To Add a Port

1. In the Video Server Configuration tree, select a server node
2. Click the Add new port button, or right-click the server node and select Add new port
3. In the property editor on the left, enter the port information.

To Remove a Port

In the Video Server Configuration tree, right-click a port node and select Remove.
13.2.3 Mosart Port Configurations

Virtual Server Ports

Mosart port configuration

Main L IZII Mame: | Main
5 m @Direcﬂakes

On swatch to:
A (Quantel:1
( ) On switch from
E: (Quantel-2) On mirror switch to backup

On mirrer switch from backup:

Mosart Port Group

El Name
Marme AB
B Misc
IsDefault B
Order 0

- Add new salvo: Use the + icon to add another empty virtual video server salvo.

5.3
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Remove a salvo: Use the - icon to remove/delete a virtual video server salvo.
Switch between salvos: Use the drop-down menu to select another virtual video server salvo.
If the Media Administrator setting Enable dynamic configuration (see Media Administrator
Properties Editor, Configuration) is True, selecting a salvo will also have the effect that Media
Administrator connects only to
those servers that are part of the salvo selected, and
those servers which have Static=True in the Media Administrator connection
string. (See Media Administrator Properties Editor, Connection Media Search Servers,
Video clip Server <n>.)
Name: Defines the name of the virtual video server salvo.

Direct Takes

On switch to: The Recall Nr (see Template Properties) of the direct take template that should
be taken when switching to this virtual server salvo.

On switch from: The Recall Nr of the direct take template that should be taken when
switching from this virtual server salvo.

On mirror switch to backup: The Recall Nr of the direct take template that should be taken
when switching to a backup server using this virtual server salvo.

On mirror switch from backup: The Recall Nr of the direct take template that should be
taken when switching from a backup server using this virtual server salvo.

Mosart Port Group

Name: The name of the virtual server group. This name is displayed in the server part of the
templates.

IsDefault: Enable to set the default and preferred video port group for assets residing on
multiple systems.

Order: See the documentation of the Media Router. If a Media Router is not used, this value
can be left to the default 0.

Mosart Port

B AvConfig :
Audio Channel 1 (empty) *~
Audio Channel 2 (empty) *~

CrossPoint (empty) *~
B Description
Mame A
B Server ports
Main Cuantel:1
Mirror n/a

Mosart Port
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- Audio Channel 1: The virtual audio fader 1 for the selected video port. If nothing is selected
here, the audio fader from the physical part is used. Default: Empty

- Audio Channel 2: The virtual audio fader 2 for the selected video port. If nothing is selected
here, the audio fader from the physical part is used. Default: Empty
CrossPoint: The virtual video crosspoint for the selected video port. If nothing is selected
here, the video crosspoint from the physical part is used. Default: Empty
Name: The name of the virtual server port, this name is displayed in the server part of the
templates.
Main: Auto-generated display name of the main video port.
Mirror: Auto-generated display name of the mirror video port.

Working with Mosart Port Configurations

The panel on the right-side of the details presented in the Video Servers tab lists any configured
ports. This represents a virtual configuration, presented as Viz Mosart port groupings, or salvos. A
salvo is a configured constellation of virtual ports (see Working with Salvos below).

Mosart port configuration

Main v |:|Z| Mame: |Main

4 Maszart Part Group
G, Enﬂcnptlnn ..
B: (sG21) ame E
Order +]
= & Misc
C: (sQ1:3) lsDefault L |
e (s02=2)

To Add a Virtual Port Group

Right-click in the Mosart Port Configuration tree (not on a node) and select either:

- Add virtual ripple group to add a new virtual ripple group. The default ripple group
names are A/B, C/D, E/F etc.

- Add virtual preview group to add a new green virtual preview group node to be used
for preview ports. The default preview group name is P.

- Add virtual recording group to add a new red virtual recording group node to be used
for recording ports. The default recording group name is Rec .

You can edit or rename the selected group using the Properties Editor on the right.

To Remove a Virtual Port Group

You can remove a virtual ripple group, preview group or recording group.
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1. In the Mosart Port Configuration tree, right-click any ripple/preview/recording group node
and select Remove group <name>.
Alternatively, select a node and press the Delete key.

2. When prompted, select Yes to confirm that you want to remove the group from all salvos.

To Add a Virtual Port
1. In the Mosart Port Configuration tree, right-click any group node and select Add virtual port.

If the port was added to a preview group, the added port will be a preview port with default name
P. If the port was added to a recording group, the added port will be a recording port with default
name Rec.

& Note: Do not change the name Rec!

To Remove a Virtual Port

1. In the Mosart Port Configuration tree, right-click any virtual port node and select Remove
<name>. Alternatively, select a node and press the Delete key.
2. When prompted, select Yes to confirm that you want to remove the group from all salvos.

Working with Salvos

Salvos are used to switch between server setups. They are used when the operator needs to switch
between server parks, for example, when switching to a backup salvo.

Salvos can also be used if different video servers are used in different parts of the show, for
instance, sports and news, but you still want to use the same ports.

& Note: It is recommended that the default Main and Backup salvos are not renamed.

To Connect a Server Port to a Virtual Port
You can connect a server port to a virtual port:

Select the server port (in the left-hand, Video server configuration part) you want to connect,
and drag it to the virtual port (in the right-hand Mosart port configuration part) that you use
to represent the port in the selected salvo.

& Note: If the virtual port is a recording port (in the recording group), the server port to
connect must also be a recording port: The physical server must have recording
capabilities (and the chosen Server Type must allow for recording).

To connect two server ports to one virtual port, causing mirroring:

1. Select a server port and drag it to the virtual port that you use to represent the port in the
selected salvo.
2. Select another server port and drag it to the same virtual port.

& Note: Only two ports can be mirrored.
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To Clear Server Links in a Virtual Port Node

Right-click the virtual port node and select Clear links.

To Add a Salvo
Click the Add =] button.

To Remove a Salvo

Click the Delete E| button.

To Modify a Salvo

- Click the drop down box above the Mosart Port Configuration tree and select the salvo you
want to edit.
Rename the selected salvo in the Name textbox.

13.2.4 Video Server Recording Setup Example

As an example of a typical video server workflow, this scenario describes how Viz Mosart can
control recording of the output from a TriCaster video mixer to a specified video server.

Configuring Viz Mosart

Follow all steps in this section.

To configure AV Automation

1. Navigate to AV Automation > Devices > Properties > Video Servers.
2. Under Video server configuration on the left side, click Add new server
3. If notin focus, click on the newly created black box, New server.
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4. From the Server Type drop-down menu, select vizrt-ips.
Device Properties

Vision Mixer Video Servers Graphics Audio Camera Robotics  Light Control  Router

Video server configuration

vizrt-ips Properties
B Connection
Directory
Initial Standby [

Orad OCIP
Quantel
SimpleTest
vDCP

Copyright © 2023 Vizrt Page 389



Viz Mosart Administrator Guide - 5.3

5. Name the server appropriately by filling in Name.

Video server config

Add new server Add new port

vizrt-ips Properties
v Bl Connection
Directory
Initial Standby ]
Port

Server

12 Hl o

Server Type vizrt-ips ~
El Description
Alias

TS TriCaster T |

6. Right-click the black box and add a port:

Fl asie
[ : Add port
TriCz i
: Remaove
< > £

7. Click the Plus sign on the right under Mosart port configuration.
Device Properties n

Vision Mixer Video Servers Graphics Audio Camera Robotics Light Control Router Subtitles GPI/O Taly  Vitual Set Weather Video Wall Ge ¢ *

Video server configuration Mosart port configuration
Addnswmrver| ‘ Add new port ‘ Backup v [] Name: |ESSkip
s —— 4+ Bid 4 @ DireciTakes
B AvConfig STP:HDPlay1 A (STP:Hmrt Port Group
Alias STP-HDPlay2 B (STPHDPlay2): <nopos (=) Name i
Audio Channel 1 (empty) ~ STP-REC v N;ame A/B
Audio Channel 2 (empty) ~ Rect: (STP-REC) B Misc
¥ : x : <no pc
CrossPoint (empty) * SRR IsDefault O
Video port a Rec2: (STP.REC2): <nop¢ |  Order 0
D= TriCaster-1

8. In Name, give this new virtual server an appropriate identity, like TriCaster.
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9. Right-click on the black box to add a virtual port.

nfiguration Mosart port configuration
TriCaster v DE Name: | TriCaster
a m @ DirectTakes
Add virtual port w
S : A3 A: (STP:HDPIay1): <no por Mosart Port Group
Clear all server links
Remove group'A/B' Del B: (STP:HDPlay2): <no poi H Name
Name A/B
STP-REC1 <
Recl: (STP:REC1) & Misc
u - . L€
SRR o | isDefault ]
4 Rec2: (STP:REC2): <no pc Order 0
TnCaster:1

10. Click on the first Video server configuration (physical) port on the left half and drag-and-
drop it to the first virtual one on the right under Mosart port configuration.

Video server configuration Mosart port configuration
| Add new server | | Add new port | TriCaster v E| Name: |TriCaster
Server Port El STP 2 I @ DirectTakes
El AvConfig STP:HDPlay1 A (STP-HDPlay1): <nopo Mosart Port Group
Alas STP:HDPlay2 B: (STP-HDPiay2): <nopoy = Name
Audio Channel 1 em| = mME
— {empty) STP-REC1 “
Audio Channel 2 (empty) v Recl: (STP-RECT) E Misc
¥ . : - <no pc
CrossPoint (empty) “ S IsDefault O
Video port 4 Rec2: (STP:REC2): <no pc Order 0
El Description Tii 1
b

11. Repeat with the second port, by repeating steps (9) to (12).
12. On the TriCaster black box on the left half, add two more ports
a. Fill out the first one with recl then press Enter.
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15.
16.
17.

b. Fill out the second one with rec2 then press Enter.

Device Properties

Vigion Mer  Video Servers  Graphice  Audio

[

Add new server | | Add new port

Server Port

‘B AvConfig

Alias
Audio Channel 1
Audio Channel 2
CrossPoint
Video port

= Description

Mame

[empty) ~
[empty) “ |
[empty) ~
recl

TriCasterrec]

Camera Robotics  Light Control

Video server configuration

Cmneon:MIFT100REC

Omneon:Growing_lnge

P STP
STP:HDPlay1
STP:HDPlay2
STP:REC1
STP-REC2
STP:HDPlay3
STP:HDPlay4

y
TriCaster-ddrl

TriCasterddr2

TnCasterrecl

. TnCasterrec?

Similarly, fill out the second one with rec?2.

Now set

a. Crosspoint: DDR] for first port and DDR2 for the second port.
b. Video port: ddr1 for first port and ddr2 for the second port.

¢. Name: Any meaningful name.
This adds a virtual ripple group with 2 virtual ports.
Click Apply, then Save & Close.

Navigate to AV Automation > Devices > AV Setup > Edit > Video config.
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18. Add the crosspoint mapping video server ports as configured on the TriCaster.
crosspoints must be mapped:

The following

File  Edit

X-point name

Physical input Mixer name buttonnr Audiolink Ch 2 Input type

151

74T

~ I NAA ~

152

745

~ | NAA ~

153

751

~ | NAA w

154

753

~ | NAA ~

755
—

 Lha v

DDR1

~ videosemer\ w

DDR2

[ ~ | videoserver

DDR3

DDR4

\
\ ~ | videoserver ‘ ~
/

videoserver

—

® Tip:

All (physical) inputs are found by accessing the TriCaster over its REST API:
http://<TriCaster_host>/v1/dictionary?key=switcher

<« [ [ 61/

button_label="Suffer)
spe

“Taput1” o_label-"MIPT600B" putton.label="MIP76008">
pus2” i5_Label="MIPT600A" batton_label="MIPT600A">
1pu” iso_label="CAMS" button_label="CAN">
putd” iso_label="CAM" button_label="CAM:">
Inputs" iso_label="CAMI" button_label="CAMI">
physical_input_number="Taputs" iso_label="CAMY" button._label="CAN2">
positon="07>
er="TnputT" iso_label="CAM 1 button_label="CAM ">
sput_mumber="Tngus” iso_label="CAM 2" button_label="CAM 2>
position="0">
" so_label="CAM 3" button_label="CAM 3'>
putl0” io_label="CAM 4" button_label="CAM 4°>
er="Inputl1” iso_label="CAM 5" button label="CAM 5"
physical_input_number="Toput12" iso_label="LIVE3" button_label="LIVES">
posit
er="Tnput13" iso_label="LIVE{" button_label="LIVEA">
sput_sumber="Topurl 1" iso_label="TNPUT 14" bution_labelINPUT 14°>
07

er="Tnputl 5" iso_label="INPUT 15" button_label="INPUT 15>

number="Input]6" iso_label="TNPUT 16" button_label="INPUT 16°>

-
11" fast_speed="0.5"/>

O

Slowe
<oz

o

o
o
o
o
o
o
o
o

< [wercan

< [uercanz

s

<ot
e

< meurt
ez
<meuria

S s

R oL | 108 | STaNDARD [oC | o

- http://<TriCaster_host>/v1/dictionary?key=tally
- Alternatively, you can access the Physical number by:
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RECORD / REPLAY

0206 GRAB 05:12:11:15

File  Edit Video config
Xpontname  Physcalnput  Inputype Audiink Miername Audoink Ch2 e
ovs o [e—— - <[ cupt <
oma 2 e - -
5 s - 5 -
vsA “ videosenver - < -
vsB 55 videosenver - < -
cans 5 GRAPHIC_1 - < -
VET ® v ~ ~
Button HD1 Use External ez | = S S
LvE2 o - |uve2 ~ ~
DOR1 5 v ~ | ooR1 ~
DOR2 6 v ~ | ooR2 ~
cAu3 2 v ~ ~
A4 3 v ~ ~
LIVET 5 /A v ~ ~
Al 4 v ~ | mxeRcAMI ~
canz 5 v ~ | mxeRcAM2 ~
nix3 100 v ~ 3 ~
nixs 101 v ~ s ~
Buffert 102 v MEGT ~
M wves PPROODRODOR DR vp me M mes MM Buffer2 103 i | BFR2 2
HD1 104 v ~ | meuTi ~
) - HD2 105 v ~ | npPuT2 ~
BRNS  ECResS LVE4 i) - | nputrs -
DUPLICATEINP |5 - - -
<
[ ==
v5.4.0.33665 Development Miror | MR | IDLE| TOB | STANDARD |NoTC Info

ii. Check the number attached to the Input#n text in the Comment.
iii. Set the value in Mosart to n-1.

19. Click on the black box (see below) and configure the following properties for the server:
Video server configuration

Add new server ‘ ‘ Add new port ‘ E
vizrt-ips Properties 4 Bls 4
O Connection | STP-HDPlay1

Directory STP-HDPlay2

Initial Standby J

STP:REC1 4

Port

Sener STP-REC2

Server Type vizrt-ips v | 4 IRE
) ipti o>

e TriCaster:1

Alias

Name TriCaster TriCaster:2

a. Server: http://<TriCaster_host> as IP number.
b. Directory: {volume}:/Sessions/{session name}/Clips/Import

& Note: To find session name:
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Navigate to the TriCaster DataLink menu:

= Datalink

DW_1080i25fps

The session name is also displayed on the TriCaster home page (hidden
menu at the top left corner):

c. Extension: let it empty (when Media Service is used, no extension is needed)
& Note: The clips id can be given from NRCS without any extension.
d. Name: Any meaningful name.

A Make sure Name in the connection string is the same as the one configured in
Media Administrator (see To configure Media Administrator below).

20. Click Save & Close.
21. Restart AV Automation if needed.

13.3 Graphics

Viz Mosart is capable of connecting to a variety of Graphic Engines available from many different
manufacturers. AV Automation handles full frame graphics playout, from a primary template type
in the rundown.

The properties available depend on the system to be used:

Vizrt Settings
General Tab
Show Tab

Deko Settings
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XPression Settings
Orad Settings

Pixel Power Settings
Chyron Settings

13.3.1 Vizrt Settings

Vision Mixer | Video Servers Graphics | Aucio | Camers Robotics | Light Cortrol | Router | Subtttes | GPLO | Tally | Vitual Set | w

IGeneqal | Shows |

[vizRT =l ™ Use MSE Backup
IEngines |
Host Port  Handler name MSE Host Encoding Clicked Preview Auto Preview Preview engine

W 1 [10211.1145:6100 |6100 |viz_background_a [10.211.1145 [UTF-8 v r [l
rz| | 6100 |viz_background_b [localhost [UTF-8 v r =]
r 3| | 6100 |viz_background_c [localhost [UTF-8 v r E
r 4| | 6100 |viz_background_d [localhost [UTF-8 v r [+ =]
rs| | 6100 |viz_background_e [localhost [UTF-8 v r =]
—Databaze — Mizcellaneous

I~ Configure MSE database settings Mos Playlist

[NEWS.ON-AIR-NEWS
zer It
Path Externals

Password  |piet [extemal/pilctdb./lemets

Datasource fvizrtdb Local Media Sequencer Engine [~ Start MSE if not running

Schema IF‘ILOT I‘JELF‘ ROGRAMFILES % wizrt"Media Sequencer Engine’launcher exe

Use Co Override
iz Content Pilot I Use Concept VEFFI. ] )
_ Translate Cue for Transition Logic elements:
I Connect to VCP client host ' Notranslate ¢ Take ¢ Take out
II::u:thu::st Port IMM [~ Take out full screen graphics W Apply Channel Name to Elements
General Tab

Use MSE Backup: Uses Media Sequencer backup engine when starting the system when
checked.

Engines: Enables connection to each Viz Engine. Viz Mosart supports five graphics engine
connections when checked.
Host: Hostname or IP address to Viz Engine.
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& Note: A port other than the default (6100) should be added as an appendix to
the host. For example: 127.0.0.1:6101 and not to the Port field.

Mirroring
You can add multiple Vizrt Viz Engines to any of the five graphics connections.

- Separate the engine name with a comma (,).
For example: enginel:portl, engine2:port2, engine3:port3

- All mirrored engines will share the same MSE.
- You can add up to 9 engines.

Port: PDB only: Port to communicate with the Viz Engine. Default: 6100 .

Handler name: Media Sequencer only: Internal Media Sequencer handler name.
MSE Host: Media Sequencer only: Hostname or IP address to the machine running the
Media Sequencer.

& Note: For Media Sequencer, both Handler name and MSE Host must be
specified.

& Creating a backup MSE
You can define a backup MSE here by adding a second IP aftera ;"

Encoding: Font encoding for the Viz Engine. Default: UTF-8.
- Clicked Preview: Enables the “click on full screen graphic element” to be taken on the
preview engine.
- Auto Preview: Enable to automatically take all full screen graphic elements in the
preview engine.
Preview engine: The number of the Viz Engine that is selected to be the preview
engine.
Database
- Configure MSE database settings: Enable to update the database settings in the Media
Sequencer with the details below.
User: Username on the Oracle database. Default: pilot.
Password: Password on the Oracle database. Default: pilot.
Datasource: TNS name or connection string of the Oracle database. Default: vizrtdb.
- Schema: Oracle database schema for the Viz Pilot connection. Default: PILOT.
- Viz Content Pilot
- Connect to VCP client host (check-box):
When checked, enables playout of Viz Pilot elements directly through a Viz Pilot
client .
Use of Viz Pilot must be assigned for each template, and the special Viz Pilot
macros mosart_load, mosart_start and mosart_continue must existin Viz
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Pilot.
Please refer to the ‘Shows’ fields in the Engines Setup Tab.

& Note: The "Display name" of both configurations must be exactly the same

Host: Hostname or IP address to the Viz Pilot client.
Port: Port to connect to the Viz Pilot macro port.
Miscellaneous
Mos Playlist: Playlist in VCP that is populated through the Vizrt MOS gateway. Default:
NEWS.ON-AIR-NEWS

(@ Info: The playlist name used here cannot be the same as that used in Trio
Interface > Engines Setup Tab > Playlist > Playlist name.

Path Externals: Internal Media Sequencer path to the location for handling database
elements. Default: external/pilotdb/elements

Local Media Sequencer Engine: Path to the launcher.exe in the Media Sequencer
program files folder (only if Media Sequencer is running as a console application on
the same machine).

Start MSE if not running: If checked and the Media Sequencer is not running, then AV
Automation will try to execute it from the location given below.

Use Concept Override: If the full screen graphics concept should change when a new
Graphics Profile is selected, this is configured here. Check to enable the Vizrt Concept
Override if your scenes are prepared for this. Requires Viz Pilot 5.2 or later.

- Translate Cue for Transition Logic elements: Only applicable when using Transition
Logic full screen graphics as the Media Sequnecer ignores a normal cue command for
these items.

No translate: Send cue command to the Media Sequencer (on Media Sequencer
versions below 1.20 no cue will be performed).

- Take: Use a take command when cuing.

- Take out: Use a take out command when cuing.

- Take out full screen graphics: Check to take out full screen graphics. By default, Viz
Mosart will not do a takeout for full screen graphics.

- Apply Channel Name to Elements: This will send the Channel name to be displayed
with the graphic elements in the GUI.
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Show Tab

% Viz Mosart - AV Automation | PCR1 (Funcspec)

HA K FM L2 L2

JINGLE

Mic2 Mic 3 Whlic 1 WMic2  WMic3 LIVE1 VEZ2 VEA VEE TEL1 TEL2Z ELAYER

Device Properties

Vision Mier | Video Servers Graphics | Aucio | Camera Robotics | Liht Control | Router | Subteles | GPIIO | Tally | vVitual Set | Westher | video wal | e« » |

General | Im |
—Shows
Digplay name | Show path YCP concept It
)4_ Masart/Overdays/ Yellow Yellow [
I Green Masart/Overays/Green Green

[

-I-ITI-l?:E‘

A It is mandatory to have an exclusive (non-null) value for Show path configured!

13.3.2 Deko Settings

|DEKO = I™ Enable Mirroring

I Engines |

COMPort  Mach.ld  Default directory Clicked Preview Auto Preview Preview engine
1| ~|| 8100 |Di\news ¥ r [ =]
r2 [ few | g rE
rs [ [ew | v r F
re [ few | v TF
rs [ ][ ew | v r F =

Engines: Enables the connections to the Deko engines. Viz Mosart supports five graphics
engine connections when checked.

COM port: Serial ports connected to the Deko engines.

Mach. Id: Machine IDs of the Deko engines. Valid range is © to 9 . Leave blank to send

global commands.
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Default Directory: The folder on the Deko engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.
Auto Preview: Automatically send full-screen graphic element to the Preview engine.
Preview engine: Defines the Deko engine number.

13.3.3 XPression Settings

|XPRE

SSION |

Engines

I Enable Mirroring

Host Channel Channe list Default directory Clicked Preview Auto Preview Preview engine
1| | 6100 [viz_backgound_a [D:\news v r ]
2| | 6100 |viz_background b | v r 2 ]
3| | 6100 [viz_background ¢ | v ~ B ]
4| | 6100 |viz_background_d | v r 4 <]
5| | 6100 [viz_backgound e | v ~ B ~]

Engines: Check to enable the connections to the XPression engines. Viz Mosart supports five
graphics engine connections.

Host: Hostname or IP address to the XPression engine.

Channel: Output channel from the XPression engine. Use 0 for default channel.

Channel list: Output channel(s) to be cleared when Channel is set to 0.

Default directory: The folder on the XPression engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

Auto Preview: Automatically send full-screen graphic element to the Preview engine.

Preview engine: Defines the XPression engine number.
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13.3.4 Orad Settings

|ORAD E1 [ Enable Mirroring
Host  Channel Channel list Default directory Clicked Preview Auto Preview Preview engine
1] | 6100 |viz_background_a |D:\news v r o~
2| | 6100 |viz_background_b | ™ r 2~
3 | 6100 |viz_background_c | v r -]
4 | 6100 |viz_background d | ™ r 4~
[ 5| | 6100 |viz_background_e | v r -]

Engines: Check to enable the connections to the Orad engines. Viz Mosart supports five
graphics engine connections.
Host: Hostname or IP address to the Orad engine. Include the IP port number, for
example 172.20.51.55:10001.
Channel: Output channel from the Orad engine. Use 0 for default channel.
Channel list: Output channel(s) to be cleared when Channel is set to 0.
Default directory: The folder on the Orad engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.

- Auto Preview: Automatically send full-screen graphic element to the Preview engine.
Preview engine: Defines the Orad engine number.

13.3.5 Pixel Power Settings

|PIXELPOWER |

Engines

Host Port System (roChannel) Default directory Clicked Preview Auto Preview Preview engine
1] [6100 [viz_backgound_a  |D:\news v r ]
2| |6100 |viz_background b | v r I
3 [6100 [viz_backgound_c | v |— B ]
4 |6100 |viz_background_d | v r 4 ]
5 [6100 |viz_backgound_e | v |— b+

Engines: Check to enable the connections to the Pixel Power engines. Viz Mosart supports
five graphics engine connections.
Host: Hostname or IP address to the Pixel Power engine.
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Port: Port to communicate with the Pixel Power engine.
Default directory: The folder on the Pixel Power engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.
Auto Preview: Automatically send full-screen graphic element to the Preview engine.

Preview engine: Defines the Pixel Power engine number.

13.3.6 Chyron Settings

CHYRON -

Engines

[ Ensable Mirroring

Default directory  Clicked Preview Auto Preview Preview engine

Hest Channel Channel list
1 | 6100 |viz_background_a [D:\news
2| | 6100 |viz_background b |
3 | 6100 |viz_background_c |
4] | 6100 |viz_background d |
5 | 6100 |viz_background_= |

1 < < % A

=

1 1 O O

i e
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Engines: Check to enable the connections to the Chyron engines. Viz Mosart supports five
graphics engine connections.

Host: Hostname or IP address to the Chyron engine.

Channel: Output channel from the Chyron engine.
Channel list: Output channel(s) to be cleared when Channel is set to 0.
Default directory: The folder on the Chyron engine that contains the graphics templates.
Clicked Preview: Click on full-screen graphic element to send to the Preview engine.
Auto Preview: Automatically send full-screen graphic element to the Preview engine.

Preview engine: Defines the Chyron engine number.

13.4 Audio

Viz Mosart connects to a variety of audio devices, from various manufacturers.

Select the required audio device from AV Automation > Devices > Preferences > Audio.

Audio Mixer
Audio Player
Loudness Control

13.4.1 Audio Mixer

This tab enables setting-up of the main mixer and optionally, a backup.
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Audio mixer | Sound player | Loudness controller
Use Audio mixer | MIDIMIXER w MigiCh |1 v
Midi Input port w

Midi Output port

[] Set user labels on console

Default fade time Default snapshot I:I
Audio effect server VSN

Midi type MidiCh  Midiport

[[] Use Backup Audio Mixer 1

Send reset command en connect

Maximum visible audio faders

Use Audio mixer: Enables the audio mixer functionality.
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Audio Protoco Supported hardware / Comments Interfa
mixer | ce
Ardour OSC Harrison Mixbus VBM uDP
/Harris Ensure OSC is enabled in the Control Surface Protocol selector
on and that in the OSC Setup tab, Viz Mosart Audio mixer
Mixbu properties match:
s VBM
In the example above, where the port number (here 3879)
match correctly.
The input field Port Mode must be: Manual - Specify Below.
The input field Reply Manual Port can be any value, including
empty.
The Mixer name must match the input name, Physical Input is
blank:
File  Edit Audio config
ﬁl:nnenel Physical input Mixer name Input type Initial level Initial standby
MIC1 MIC1 mic
MIC2 MIC2 S
MIC3 3 mic
MIC4 4 mic MIC1L MIC2
MICE 5 mic
IcE . = NDI Input NDI Input
Fs1 7 MNAR Fader Fader
F52 H N/A
I IWF1 a9 evtamal enr
& Note: Harrison MixBus 32C is not supported.
CALCR RAP RS-422
EC , TCP/
IP
(Artemi
s)
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Audio
mixer

DHD

EUPHO
NIX

LAWO
RMNO
PL

LAWO
ZIRKO

LAWO
EMBER

MIDIMI
XER

SSL

Protoco
|

DHD
RM4200
-D v2.02

RAP

Remote
MNOPL

RAS,
Lawo
Zirkon
subset

Ember+

Sanford.
Multime
dia

Light
Broadca
st
Automat
ion
protocol
, SSL
Broadca
st
Automat
ion
Control
Specifica
tion -
v1.0

Viz Mosart Administrator Guide - 5.3

Supported hardware / Comments

Lawo mc?

Lawo audio mixers with A__UHD Core. This requires that the Lawo
audio mixer has correct firmware and settings to allow Ember+
control (contact Lawo for details about which specific audio mixer
models support this functionality).

Copyright © 2023 Vizrt

Interfa
ce

TCP/IP

COM

TCP/IP

RS-422
or
TCP/IP

TCP/IP

MIDI

RS-422
or
TCP/IP
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Audio
mixer

STAGE
TEC

STUDE
R_300

STUDE
R_VIST

VIZEN
GINE

WHEA
TSTON

YAMA
HA_O2

vizrt-
ips

Protoco
|

Stagetec
Diamon
d RAS

protocol

Monitor
a RAS

Monitor
a+
Ember,
Ember
1.0

Ember

n/a

Wheatst
one
Mixer

Automat

ion
Protocol
v.1.4

MIDI

NewTek
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Supported hardware / Comments Interfa
ce
COM
Studer OnAir 3000 RS-232
or
TCP/IP
Studer Vista TCP/IP
Viz Opus only TCP/IP
TCP/IP
Yamaha 01V96, DM1000, DM2000, DME64N, 0O2V96, LS9, CL5 MIDI
Vizrt Group/NewTek IPseries mixers. TriCaster, VMC, Viz Verdi, TCP/IP
Viz Vectar

- Serial (Calrec, Lawo, Studer, etc.): Serial port connected to the audio mixer, when Serial radio
button is selected.

- TCP/IP: Hostname or IP address and port to communicate with the audio mixer, when TCP/IP
radio button is selected. Note that for Calrec it is possible to configure a main and backup
audio mixer by specifying two comma separated hostname values and port values.

Hostname: Hostname or IP address of the audio mixer.

Port: Port on the audio mixer.
Local port: (Ardour only) The mixer will send messages to this port on the Mosart server.
Use 8000 unless there is a good reason for choosing another port.
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Backup hostname and port (LAWO RMNOPL): Hostname (or IP address) and port to the
backup audio mixer console.

- Set user labels on console: When selected, user labels on the (non-EMBER+) Lawo or Vista

console are overwritten.

MidiCh (MIDIMIXER and YAMAHA_O2): MIDI channel assigned to the audio mixer. Depending
on mixer model, this setting may have to correspond to settings on the mixer.

Midi Input port (MIDIMIXER and YAMAHA_O2): System MIDI input port to communicate with
the audio mixer.

Midi Output port (MIDIMIXER and YAMAHA_02): System MIDI output port to communicate
with the audio mixer.

Default fade time: Time in frames for fading open faders with the manual fade function
(CTRL+F).

Default snapshot: Snapshot to recall when starting the automation (MIDI parameter change).

- Audio effect server: Name for the Audio effect fader. This fader will open if effect transitions

are used.

- Send reset command on connect: Used for STUDER3000 SW 2.2, or lower. Recalls a default

setup for the Mixer panel.

- Visible audio faders: Maximum visible faders in AV Automation.

AV Automation Audio Mixer Availability Table

Ser TCP Midi Midip Hostn Po Back Back Faderi Usee Compo

ial /IP Ch ort ame rr up up nput mber rt
host Port offset protoc audio
nam ol mixer

Ardour X X

CALRE x X X X X

C

DHD

EUPHO x X

NIX

LAWO X X X X X
RMNO

PL

LAWO X X X X X
ZIRKO
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Ser TCP Midi Midip Hostn Po Back Back Faderi Usee Compo

ial /IP Ch ort ame n up up nput mber rt
host Port offset protoc audio
nam ol mixer
e

LAWO X X
EMBER

MIDI X X
MIXER

SSL X X X

STAGE x X X X X
TEC

STUDE x X X X X X

3000

STUDE X X X

VISTA

ViZ X X X
ENGIN

WHEAT X X X
STONE

YAMA X X
HA
02

Vizrt X X X
ips

13.4.2 Audio Player

A basic audio player is always included as standard in a Viz Mosart.
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Audio mixer Sound player Loudness controller

Use sound player Mosart Audio Player ~
Host localhost
Default directory [C:\Lydvignetter\Nyhetskanalen

Requirements

Refer to general section Prerequisites (section Viz Mosart Audio Player).

Setting Up an Audio Player

Refer to section Audio Players.

Operating an Audio Player

Refer to section Playing Audio in the Viz Mosart User Guide.

13.4.3 Loudness Control

A loudness control from Junger.

Audio mixer Sound player | Loudness controller

v Use loudness controller

Channels Hostport

WONGERT-AP =] 14 |
Tnggers/levels -8 |
1 312 |
2
3 1316 |
: 1720 |
21-24 |

Use loudness controller: Check the box to enable loudness control.

Loudness controller type: JUNGER T*AP.

Triggers/levels: Name of triggers or loudness levels, one for each line. These will appear in a
tool-tip menu in the Template editor, and must correspond to the configuration in the
loudness controller(s).

Channels: Fixed values. For Junger T*AP there are four stereo channels per host.
Connections to the audio faders are configured in A/V Setup/Edit/Audio config/Loudness
channel.
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Host:port: Hostname or IP address and optional port number for each controller.

& Note: If the root node name is different than T*AP the name must be set in the AVA
configuration property JungerRoot .

See Also

- Audio Player
- Stagetec Driver Configuration
- Audio Mixer Configuration Files

5.3

13.5 Camera Robotics

13.5.1 Configuring a Robotic Camera

From AV Automation > Devices > Properties > Camera Robotics tab, you can configure up to 4
robotic camera controllers.

[v lUse Robotic Cameras

Host Port Cameras
¥ Robotic Camera |VINTEN 200 ~| |10.209.101.102 5000 |15

Haost Paort Cameras

[~ Robotic Camera |[TELEMETRICS — »| | | |

Use Robotic Cameras: Check to enable the robotic camera control functionality.
Robotic Camera: CAMBOTICS, CAMEROBOT, CINNEO, ELECTRIC FRIENDS, FX-MOTION,
PANASONIC, PANASONICNEW, PANASONIC TCP, SHOTOKU TR-T, SHOTOKU TR-T IP,
TECHNODOLLY, TELEMETRICS, VINTEN 200, .

Host: Hostname or IP address of the RCC (Robotic Camera Controller) server.

Hosts (FX-Motion and Technodolly): A comma separated list of names or IP addresses for the

camera robots starting from Camera 1. Missing robots are indicated by extra commas.
Port: Port to communicate with the RCC server.

A Note: When using PANASONIC TCP, you may or may not specify a port here. If no
port is specified, the default port 80 is used.

- Com port: For serial communication with the RCC server.

& Note: When using PANASONIC or PANASONICNEW you must select the Com port to
use. Only one controller can be connected to each Com port.
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- Cameras: List of robotic cameras for individual stand-by control and for matching against

the Camera Number in Robotic Camera Control in Template Device Functions. List members
are separated by commas, or by hyphens indicating ranges.

& Note: When using PANASONIC, PANASONICNEW, or PANASONIC TCP, the connection
goes through a controller. The Cameras value is used to set the controller, so only
enter one number here.

Camerobot Camera Systems

Viz Mosart can control anchor dependent shots for the Camerobot camera system. For details,
please refer to Control Commands in Templates, section Command Values and
Parameters, DEVICE_PROPERTY, using the value CAMERA CONTROL.

Robotic Camera Configuration Files

For both general and device-specific settings, see section Robotic Camera Configuration Files.

13.6 Light Control

13.6.1 MIDI Show Control

rg

Light Control
Diriver ||"-"||D| Show Control j

Midipart | =]
Midi Show Control (MSCID) 0

Custom command Frefix w00 =00

Custom command Suffix 00

Light Control: Enables the Light control through MIDI Show Control.

Midiport: System MIDI port to communicate with the Light board.

Midi Show Control (MSCID): The MIDI Show Control ID that is used for communicating with
the Light board. Default: 0.

- Custom command Prefix: This is the prefix test sent with the MIDI Show Control command.

Characters can be escaped using the x00 where 00 is replaced by the numeric value of the
character. Default: \x00CY\x00 .
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- Custom command Suffix: This is the suffix sent with the MIDI Show Control command.
Characters can be escaped using the x00 where 00 is replaced by the numeric value of the
character. Default: \x00 .

13.7 Router

W Use Router |SW-P-08 TCF/IP |

Host Paort
Main | |

Backup | |

Additional parameters |

- Use Router: Check to enable router control and select protocol from the list.
Router type: EVERTZ QUARTZ, GVG G-SMS7000, SW-P-08 TCP/IP, SW-P-08 SERIAL, VENUS,
VIKINX SERIAL or VIKINX TCP/IP.
Port: Serial port (GVG G-SMS7000, Venus, SW-P-08 serial, and Vikinx serial).
Bit rate: Selectable serial bit rate (GVG G-SMS7000).
Parity: Parity bit, default None (GVG G-SMS7000).
Main Host: Hostname or IP address of the main router (EVERTZ QUARTZ, SW-P-08 TCP/IP and
Vikinx TCP/IP).
Main Port: IP port of the main router (EVERTZ QUARTZ, SW-P-08 TCP/IP and Vikinx TCP/IP).
Backup Host: Hostname or IP address of the backup router (SW-P-08 TCP/IP).
Backup Port: IP port of the backup router (SW-P-08 TCP/IP).
- Additional parameters: For future use.

13.8 Subtitles

Host Part
W Use Subtitle |SCREEN ~| |10.208.101.102 1043

Back to back play delay | 0  frames

- Use Subtitle: Check to enable Screen Polystream subtitling.
- Subtitling type: SCREEN, SVT
Host: Hostname or IP address of the subtitling system.
Port: Defines the IP communication port.
Back to back play delay: Delay in frames on the play command to the subtitling system when
playing subtitle files back to back.
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13.9 GPIO

GPI functionality supports triggering any template from the currently active template set and
including a selection of control commands.
Adding GPI/O control to a device is performed in Viz Mosart AvAutomation.

Direct takes via GPI

- Syntax

- Configuring

- Verifying

- To Trigger Direct Take Templates via a GPI
- Syntax for GPI 5-11

- Sample Configuration (W&T Web-10)

- GPI 0-4

- GPI 5-11
Hardware Configuration

Host Port Password
I~ GPO(1-12) [10.209.101.102 [49153 |
™ GPO(13-24) [10.209.101.102 |49153 |
GPO (25-36) | |49153 |

GPO (37 - 48) | [49153 [

GPI 0 (Reload rundown)
GPI 1 (Start/continue rundown)
GPI 2 (Start rundown from top)
GPI 3 (Rehearsal mode OFF)
GPI 4 (Rehearsal mode ON)
GPI 5 (Fire Template) |
GPI & (Fire Template) |
GPI 7 (Fire Template) |
GPI & (Fire Template) |
|
|
|

GPI 9 (Fire Template)
GPI 10 (Fire Template)
GPI 11 (Fire Template)

EEEEEEEEEREE B E

Min Time Between GPls (ms) I.'EI-'D[I'

- GPO (1-12): Enables a WeblO box for the first 12 GPO when checked. Note that this has to be
configured for GPI 0-11 to be enabled.
- GPO (13-24): Enables a WeblO box for the second 12 GPO when checked.
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- GPO (25-36): Enables a WeblO box for the third 12 GPO when checked.
- GPO (37-48): Enables a WeblO box for the fourth 12 GPO when checked.

Host: Hostname or IP address to the WeblO GPI/O box.

Port: Port to communicate with the WeblO GPI/O box.

If configured as 80, Mosart will use the HTTP WeblO protocol, while for other Port values
Mosart will use the Binary WeblO protocol.

Password: Defines the password, if needed.

- GPI 0 (check box): Enables initialize Viz Mosart rundown when the external pulse is received.
- GPI 1 (check box): Enables start/continue the Viz Mosart timeline from an external pulse.

- GPI 2 (check box): Enables starting Viz Mosart rundown on the first story on the external
pulse.

- GPI 3 (check box): Enables rehearsal mode off.
- GPI 4 (check box): Enables rehearsal mode on.

- GPI 5-11 (check boxes/custom): Enables firing of the template or command given in the text
box.

13.9.1 Direct takes via GPI

As taking a template using one of GPIs 5 to 11 (Fire Template) would add the corresponding
template to the timeline, which is not always wanted, you can instead use a DIRECTTAKE control
command, as explained below.

Syntax

DIRECTTAKE|<the Recall Nr of the direct take>
Example: DIRECTTAKE[99
Triggers direct take 99
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The figure below connected GPI 9 to firing direct take 999

Mosart Device Properties

Vision I'u'Iixerl Video Servers l Graphics ] Audio l Camera Robotics ] Light Control ] Routerl Subtitles  GPI/O ITthr l Virtual Set l Weathe

<l

GPO (1-12)

GPO (13-24)
GPO (25-36)
GPO (37 - 48)

= A

GPI 0 (Reload rundown)

GPI 1 (Start/continue rundown)
GPI 2 (Start rundown from top)
GPI 3 (Rehearsal mode OFF)
GPl 4 (Rehearsal mode ON)
GPI 5 (Fire Template)

GPI & (Fire Template)

GPI 7 (Fire Template)

GPI & (Fire Template)

Y I Y (R I

<1 =

Hast Part Password

[17227.33.138 |30 |

| | |
| | |
| 49153

INVOKE DIRECTAKE 999 FROM
GPI9

|PLAYCUEDVIDEOSERVER
|STOPFLAYINGVIDEOSERVER
|PAUSEFLAYINGVIDEOSERVER
|RECUECUEDVIDEOSERVER

<l

GPI 9 (Fire Template)

|DIRECTTAKEIS93

GPI 10 (Fire Template)
GPI 11 (Fire Template)

1 7

Verifying

Assign a direct take to a GPI between 5 and 11

Restart AvA

Trigger this GPI from the external device connected to this GPI.

For testing this can also be done for GPIs 0 to 9 from within AvAutomation by pressing
SHIFT+CTRL+<no> where <no> is the GPl number + 1 (modulo 10).

For example, SHIFT+CTRL+0 will invoke GPI 9

Verify on the Mosart server that the corresponding GPI is executed. One way to do this is in
Av Automation, since Direct takes are shown in the Av Automation Log window (lower left)

when taken.

To Trigger Direct Take Templates via a GPI

To trigger a direct take from a GPI (which can then further trigger multiple control
commands) use the GPI/O tab in Av Automation > Devices > Properties as shown in the
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figure below.

<l

GPO (1-12)
GPO (13-24)
GPO (25-36)
GPO (37 - 48)

. .

GPI 0 (Reload rundown)

GPl 1 (Start'continue rundown)
GPI 2 (Start rundown from top)
GFl 3 (Rehearsal mode OFF)
GPl 4 [Rehearsal mode ON)
GPI 5 (Fire Template)

GFI & (Fire Template)

GPI 7 (Fire Template)

[ R B R

< =
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Mosart Device Properties ﬂ
Vision Mixer | Video Servers | Graphics | Audio | Camera Robotics | Light Cortrol | Router | Subtiles GPIO | Taly | Vitual Set | Weather | Video Wl | int ¢ |
Host Part Password
[10.55.199.153 30 mosart
[10.55.199.154 30 |mosart
[10.55.199.155 30 mosart
| [49153 -
|Direct TaksI810
|Direct Takelg 11
|Direct Takelg12
|Direct Takeld 13

<l

GFI 8 (Fire Template)
GPI 3 (Fire Template)
GFI 10/ (Fire Template)
GFI 11 (Fire Template)

1717

Min Time Between GPls (ms)

300

Syntax for GPI 5-11

DIRECTTAKE|<the Recall Nr of the direct take>

Close

& Note: A GPI/GPO device must first be configured. The configuration of GPI/GPO devices is
done in AV Automation Devices - GPIO.

o

Testing GPI signals without the use of GPI

If a GPI/GPO device is configured, as shown in the figure above, any GPI signals 0-9 may be
simulated using the keyboard sequence CTRL+SHIFT+<number> inside AvAutomation to

trigger a corresponding GPI.
This is an easy way to test the GPI configuration.

For example: CTRL+SHIFT+6 will trigger GPI 5
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13.9.2 Sample Configuration (W&T Web-I0O)

W&T's Web-I0 products enable TCP/IP Ethernet-based switching signals for control, acquisition and
monitoring. Their products are accessed using APl queries from, for example, a standard web
browser, or in our case, Viz Mosart.

From the Web-10 side, GPI is enabled by attaching a device capable of sending GPI signals to Viz
Mosart. The configuration below shows configuration of a W&T Web-IO device capable of 24 GPI/
GPO connections.

This configuration uses at a maximum 24 GPO signals. A maximum of 12 GPI signals can be used
to control Viz Mosart.

GPI1 0-4

The first 5 GPI signals are connected to fixed Viz Mosart commands for backward compatibility.

The signals are as follows:

GPI O - Reload rundown, Will trigger a rundown reload event. l.e. the timeline will be stopped and
the current rundown will be reloaded from the NCS cache.

GPI 1 - Start/continue rundown. Will trigger the TAKE-NEXT event and with that start the timeline or
advance to the next timeline element

GPI 2 - Start rundown from top. Will start the rundown from the first story

GPI 3 - Disable rehearsal mode

GPI 4 - Enable rehearsal mode

GPI 5-11

Each of the GPI signals 5-11 may be assigned to either trigger a Viz Mosart control command,
trigger an arbitrary template from the active template set or trigger a direct take, as follows.

Triggering Mosart Control Commands

To trigger a Mosart Control Command enter a valid command in the text field associated with the
GPI signal.
Supported commands:

ClearForegroundGraphics - Removes all CGs

SkipNextStory - Skips next story item

UnskipNextStory - Unskips next story item

TakelLastGraphicsOut - Removes last CG

TakeManualGraphicsOut - Removes manual CGs

PlayCuedVideoServer - Plays out the last cued clip on a video server
PausePlayingVideoServer - Pauses the currently playing clip on a video server
StopPlayingVideoServer - Stops the currently playing clip on a video server
RecueCuedVideoServer - Recues the last cued clip on a video server

Triggering a Mosart Template

This can be used to trigger a Mosart template from the active template set:

Syntax: [TemplateType]|[Variant]
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Example: Camerall

Triggering a Direct Take
This can be used to trigger a direct take:

Syntax: DIRECTTAKE|<the Recall Nr of the direct take>

Example: DIRECTTAKE[99
triggers direct take 99.

Hardware Configuration

For this example, you configure the in and out ports as required for the GPIO system, by following
their own specifications.
The Web-10 physical device can be configured via a browser pointed to the box’ IP address.

To get into the configuration menus select
Config > Login > Administrator login
from the Start page.

& Note: Configuration changes are only saved after clicking the Logout button.

Mosart IAT/SAT

For testing from Mosart, the new configuration is either directly loaded, or inspected and
used for setting the inport 0 manually.
Inspection and comparison may be necessary should the load fail. If necessary reset the box
to factory settings before using the configuration below.
Under the inport nodes in the menu tree

Set the port minimum pulse filter to 100ms

Set the input type to positive pulse (three separate settings).
If you use port 0O it is easier to test Viz Mosart, as this port is hardwired to the Reload
Rundown function.

Preparation of Test Circuit

This requires two pieces of wire, ~20cm, stripped (and preferably tinned) at the end.

To set up the box for generating an input test pulse, interconnect the terminal strip ground
connector for power supply ground (the outermost VCC connector) with the outermost GND
connector, across the box. This establishes a common ground between power supply side
and the input logic circuits.

A Note:

- It is not possible to simply take the output of one output port and feed it
directly back to the input side, as the outputs are intended to drive relay
circuits (these are also known as current drivers, they operate at a very low
voltage)
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- The 12 in 12 out version requires an external relay.
- The inputs requires 8V referred to GND to detect a pulse.

Testing GPI O

- To generate the input pulse, connect a piece of wire from the other VCC connector and
briefly touch the connector for Inport 0 (the pulse must be >100ms).

- A green light beside the connector will briefly light up if successfully triggered. Given that
AV Automation has GPIO enabled and is also enabled for Input 0, any loaded rundown will
reload, clearly visible on the Mosart GUI.

- Configure GPIO with the file containing the working configuration.

@ A sample xml file is listed in the Appendix section here.

If the GPIO will not import the configuration file directly, a workaround is to save the current
configuration and using Notepad++ (or similar) to compare the difference between the new
configuration and the existing configuration. Amend the configuration on the existing
configuration to match the new settings.

13.10 Tally

W Enable Protocol  |GVG200 |

Arguments |C|:|m Port=COM1

Enable: Check to enable tally functionality.
Protocol: GVG200 or SONY MVS
- Arguments: ComPort=COMx

13.11 Virtual Set

¥ Virtual Set |BRAINSTORM =/

Connection string

- Virtual Set: Check to enable virtual set control.
- Virtual Set: BRAINSTORM, Viz Virtual Studio.
- Connection string: Server=hostname; [port=portnumber;] [mode=mixmode;].
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13.11.1 Connection String Parameters for Viz Virtual Studio

- Server: IP address or network name of machine where Viz Tracking Hub is running.
Required.
Port: TCP/IP port Viz Tracking Hub accepts connections. Optional.
Default value is 20000.
LocallP: IP address of local network interface. Optional. Default value is first Ethernet
interface.
Router: Router name configured in Viz Tracking Hub. Optional.
Default value is first router in Viz Tracking Hub.

Sample Connection string: Server=10.45.0.15;Port=20000

Camera set index enumeration starts from 1. This means that if a router has two camera sets
configured, their indices will be 1 and 2.

5.3

& Known Issue: Driver cannot detect when hub server is going offline. For example, if you kill

the server, the driver keeps sending messages to server without an error being raised.

13.12 Weather

W  |VIZWEATHER ~|

MSE Hostname MSE Port  Host Viz[\Weather Default concept
localhost |a594 1127.0.0.1 1

Use Weather: Check to enable control of a weather control.
- Weather controls: VIZ WEATHER or WEATHER ONE

MSE Hostname (Viz Weather): Hostname or IP address to the Media Sequencer controlling the

Weather Control engine.

Hostname (Weather One): Hostname or IP address of the Borealis Weather One engine.
MSE Port (Viz Weather): Port to communicate with the Media Sequencer.

Port (Weather One): Port to communicate with the Borealis Weather One engine.

Host Viz Weather (Viz Weather): Hostname or IP address to the Viz Weather engine.
Default concept: The weather concept to be used as default.
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13.13 Video Wall

W \Video wall type |SPYDER -

Server address: |I|:u:th|:|st

- Video wall type: Check to enable video wall control.

- Video wall controls: ENCORE, PANDORA, SPYDER, WATCHOUT (Version 5.2, DISPLAY
CLUSTER PROTOCOL).

Port (Encore): Serial port.
Bit rate (Encore): Serial bit rate.

- Server address (Pandora, Spyder, Watchout): Hostname or IP address of the video wall server.
For Pandora, the server is the PB Widget Designer.

For WATCHOUT, full connection string. For details see Watchout Connection String.
Backup (Pandora): Hostname or IP address of the backup PB Widget Designer.

See also

- Jupiter Systems PixelNet Video Wall Control
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13.14 General

Mosart Device Properties

Graphics l Audio l Camera Robotics l Light Control l Router] Subtitles l GPI/O l Talky l Virtual Set l Weatherl Video Wall l Integrated Engine

Standby at startup Show in Console Redundancy
™ Vision Mixer ™ Autotake timing ™ UseMirroring  Hostname
[ Video Server Port 8099
™ Graphics Diagnostics
™ Audio Mixer [ Trace
: Media Router
I~ Camera Robotics ™ Verbose .
™ Light contral [ Video Servers
™ Router o . [~ Graphics
. irecttakes
™ Subtitles [ Overlay Graphics
™ GPIO Directtzke On Reload [ Camera Robotics
™ Weather system ER e e e e ™ Light Control
A ™ Video \wiall
Llidechal Directtake On Become Idle ’— ! eo ) @
[ Sound player [ Subtitling
™ Virtual set Configuration
M Loud o Crossover
oudness contra Name Mosart 1 Port [8099
LIiTally Directtake On Activate Connect Salve [Cument
Directtake On Inactivate Active Salvo Slave

Idle Salvo ReleaseAl

Standby at startup: Selector for drivers that will start in standby mode. These selections
must then be manually reset from standby mode, either using the Viz Mosart GUI or from AV
Automation.

& Note: Whenever a Viz Mosart GUI is operational or if a backup Viz Mosart server is
operational, they will override any standby settings made here. Standby settings
applied in this menu only take affect at complete restart of all Viz Mosart
applications. See the Standby description under Main Menu of the Viz Mosart User
Guide for further details..

Show in Console
Autotake timing: Adds timing to the log window. Used for debugging purposes.
Diagnostics
Trace: Adds logging information to console used for dbugview.
Verbose: Increases logging information from AV Automation to the log file.
Directtakes
Directtake On Reload: The Recall Nr (see Template Properties) of the direct take
template to be fired upon re-loading the rundown.
Directtake On Become Active: The Recall Nr of the direct take template to be fired
when the server becomes active from idle, when switching between main and backup
Viz Mosart servers.
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Directtake On Become Idle: The Recall Nr of the direct take template to be fired when
the server becomes idle from active, when switching between main and backup Viz
Mosart servers.

Crossover
Directtake on Activate: The Recall Nr of the direct take template to be taken when this
server goes active in crossover switch.
Directtake on Inactivate: The Recall Nr of the direct take template to be taken when
this server goes inactive in crossover switch.

Redundancy
UseMirroring: Check to enable mirroring. Upon enabling mirroring on both main and
backup server, the settings are synchronized.
Hostname: Hostname or IP address of the Backup Server if using Main Server, and vice
versa.
Port: IP port number of the Backup Server if using Main Server, and vice versa. NB: For
redundancy to work, the same port number must be configured as Media Router Port.
Recommended value: 8099.

Media Router
Use for: Select which controls should be used by the Media Router. (Also see the MMR
Tab for Overlay Graphics Interface configuration).
Name: Media router’s hostname or IP address.
Port: Media router’s connection port number. Must be the same as Redundancy Port.
Recommended value: 8099.
Connect Salvo: The salvo name to be taken when this server connects after restart.
Default: Current.
Active Salvo: The salvo name to be taken when this server becomes the active server
from being idle. Default: Slave.
Idle Salvo: The salvo name to be taken when this server becomes idle after being
active. Default: ReleaseAll.

& f Redundancy is to be used, the Media Router Port has to also be set, and then to the same
value as the Redundancy Port.
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14 Device Connection Strings

This section contains an overview of Device Configuration Strings for connection to equipment in
your broadcast environment.

A device in this context is a physical unit, such as an Viz Engine or a video server. The device
driver is the code that provides Viz Mosart the ability to handle and control the actual device. The
Device Connection string is a textual description that identify the type, name and various other
parameters required for Viz Mosart control the device. In some cases, you need to provide
additional parameters for the device, typically specified in an XML file, in addition to the
Connection String.

This section contains the following topics:

- Video Server, MAM and Database Connection Strings
Video Wall Connection Strings

14.1 Video Server, MAM And Database Connection Strings

A connection string contains parameters needed for connecting a studio device to Viz Mosart. The
string always comprises two parts:

Standard Connection String Properties
For example Name, Type, Server, Config (Config is the name of the associated file that
contains custom settings).

Device-specific Connection String Parameters
Driver-specific configurations. For example, what to log in error situations, manipulation of
standard commands, or timeout behavior.

Connection strings are used both in the Media Administrator configuration and, in some cases, AV
Automation.

In AV Automation:

Connection strings get autogenerated when configured in the video server GUI.
- You can enter additional device parameters to match specific control room parameters.

This section describes the following connection string types:

System-level Location of Device Configuration Files
Standard Connection String Properties
Viz Mosart Video Server Connection String
General Configuration File Properties
General Search Configuration File Properties
Device-specific Connection String Parameters
- AirSpeed Classic Connection String
- AirSpeed Multi Stream / AirSpeed 5000 Connection Strings
- AirSpeed Multi Stream Search
- Amadeus Connection String
EVS LinX Connection String
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EVS Xedio Connection String
Grass Valley K2 Connection String
Harris Nexio Connection String

- JupiterWebService Connection String
MVCP Connection String
Omneon Connection String
Omnibus OPUS Connection String
Orad OCIP Connection String
Quantel Connection String
ScreenLL Connection String
SimpleTestPlayer Connection String
SQL Database Connection String
VDCP Connection String
Viz Engine Connection String
Viz One and Media Service Connection String

14.1.1 System-level Location of Device Configuration Files

In a connection string where no path is provided as a value to the Config parameter, Viz
Mosart searches for the file in the following order of folders:

$ALLUSERSPROFILE%\Mosart Medialab\ConfigurationFiles\
C:\ChannelTemplates\

{Application path}\

{Application path}\ConfigurationFiles

{Current folder}\ConfigurationFiles

14.1.2 Standard Connection String Properties
Irrespective of device type, several values are standard parameters:

Viz Mosart Video Server Connection String
General Configuration File Properties
General Search Configuration File Properties.

Viz Mosart Video Server Connection String

Parameters not recognized by the driver in question will simply be ignored.

Name=myServerName; Type=myServerType; Server=myServerAddress; Config=myConfigFile.xml

Name: A logical name consistently associated with the device, allowing the device to be
uniquely recognized throughout the system setup.

All Media Administrator connection strings contain a name, which forms a distinction for
Media Administrator, when handling multiple clip metadata sources and video servers.
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If the same video server also is to be controlled by AV Automation, Name in AV Automation
must be the same as Name used here.

& Note: Naming plays a critical role in the powerful feature Dynamic Video Server
Configuration. Please see the topic Dynamic Video Server Configuration.

- Type: Specifies a driver to be used for connecting to the server. Potential values are:
- AirSpace: AirSpace driver.
- AirSpeed: AirSpeed driver.
- AirSpeed Search: As AirSpeed driver, but contains search functionality only.
- AirSpeedMultiStream: AirSpeed Multi Stream driver, also Airspeed 5000.
- AirSpeedMultiStreamSearch: As AirSpeed Multi Stream driver, but only search
functionality.
- Amadeus: Amadeus MAM driver.
EVS LinX: EVS LinX driver.
EVSXedio: EVS Xedio driver, used by AV Automation.
EVSXedioSearch: EVS Xedio driver for search functionality, used by Media
Administration.
GrassValleyK2: Grass Valley K2 driver.
HarrisNexio: Harris Nexio driver.
- Jupiter Web Service: Jupiter web service driver.
MVCP: MVCP driver.
OPUS: Omnibus MAM driver using OPUS interchange.
Omneon: Omneon (Harmonic) driver.
OmneonSearch: As Omneon driver, but contains search functionality only. Used by
Media Administrator to obtain clip status from an Omneon (Harmonic) video server.
Orad OCIP: Orad OCIP and Avid FastServe driver.
Quantel: Quantel driver.
- ScreenlLL: Screen LingualLib search driver.
- SimpleTestPlayer: SimpleTestPlayer driver
- SqglMediaSearch: SQL database driver.
- VDCP: VDCP driver over serial port.
- VDCPtcp: VDCP driver over TCP/IP port.
- VizEngine: Viz Engine driver.
- VizOne:Viz One and Media Service connection string.

- Server: Specifies the server name or the IP address of the video server.

- Config: Specifies a configuration file containing custom configuration for a particular video
server driver. Editing these files is typically done during installation.

- Static: (Effective for Media Administrator only) If True, Media Administrator always connects
to the MAM system (or video server), also when Enable dynamic configuration (see the topic
Dynamic Video Server Configuration) is True, and this MAM system (or video server) is not
part of the salvo selected in AV Automation. (see also section Virtual Server Ports
in Automation Devices Video Servers).

Copyright © 2023 Vizrt Page 426



Viz Mosart Administrator Guide - 5.3

& Normally, a MAM system will not be part of any salvo. This setting is mostly intended
for MAM systems which should always be connected, regardless of the selected
salvo. Default: False.

General Configuration File Properties

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server.
KeepCache (boolean): When set to true, the internal Media Administrator clip cache is kept
on reconnect (Default: false).

RefreshOnUpdate (boolean): If set to true, any clip update message received from the video
server results in a clip refresh operation (Default: false).

ReleasePortOnDispose (boolean): If true, the assigned video port is released when server
connection is closed (Default: true).

- SupportSearchUsingObjSlug (boolean): Activates searching using objS/ug. ObjSlug is the clip
slug as shown in the GUI Media pool Search tab. (Default: true).

- SupportSearchUsingRefID (boolean): Activates searching using RefID. ReflD is a specific clip
property that has been defined as a reference (Default: false).

- VerifyModifiedClips (boolean): If true, clip modified/update events for all clips trigger a
complete verification (for example treated as the clip was created). If false, only clips
currently in the cache are verified. (Default: false).

CueTimeout (integer): Specifies the maximum time in milliseconds for AV Automation to
wait for a cue operation to complete. (Default: 7000 msec).

PlayTimeout (integer): Specifies the maximum time in milliseconds for AV Automation to
wait for a play operation to complete. (Default: 0).

- SetLoopDelay (integer): Specifies the time when to set the clip to play in loop after a
successful cue operation, in milliseconds. (Default: 1000 msec).

NextPingDelay (integer): Specifies the interval (in milliseconds) at which AV Automation
issues a 'Ping' operation (verifying that the connection is still OK) against the server. The
nature of the 'Ping' operation depends on the driver chosen. (To modify the ping interval for
Media Administrator see Media Administrator Properties Editor > Ping Delay.)
NextServerAttemptDelay (integer): In case of failure, specifies the time between trying to
reconnecting to the video server, in milliseconds. (Default: 5000 msec).
MirrorActivePortTimeout (integer): For mirroring setups. Specifies the time to wait for the
active port to complete before waiting for any of the ports, in milliseconds. (Default: 7100
msecs).

IgnoreCase (boolean): If true, searching for clips is done case insensitive. Must be used in
combination with <MatchExpression ignoreCase="true" /> from General Search
Configuration File Properties.

- AssetToMediaMap: Choose from two ways of mapping Asset to MediaObject. UseTitleAsSlug
or UseMamlIdAsSlug.

MaxClipNameLength: Naming standard for recordings.

- ClipNamePattern: When recording a file, the system can be configured to use a predefined
pattern for filenames. The pattern shall be defined in the associated config file for the video
server. The following variables are available for injecting into the clip name:
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Variable name Description

clipname The value given in the recording dialogues, or from
custom template commands.

gallery The name of the gallery.
templateset The name of the currently selected template set.
timestamp The current time. This value can be formatted using the

patterns from MSDN.

() Example

Gallery = MyGallery

Current template set = MyTemplateSet
Clipname = MyClipName

Current Time = 21 September 2016 12:00:00

Config File for Video Server

<DeviceConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="
http://www.w3.0rg/2001/XMLSchema'">
<Properties>
<item name="ClipNamePattern" value="{gallery}_{templateset}_{clipname}
_{timestamp:yymmdd}" />
</Properties>
</DeviceConfig>

The file name sent to recording is MyGallery_MyTemplateSet_MyClipName_160921.

General Search Configuration File Properties

HitSortOrder (enum): Specifies how to sort a list of multiple hits for a single search. Used in
combination with the BestMatchMethod property.
Options:
- Ascending: The list of hits are sorted ascending alphabetically.

Descending: The list of hits are sorted descending alphabetically.

Unspecified (Default): No sorting is applied to the resulting hits.

Example: <HitSortOrder>Descending</HitSortOrder>
BestMatchMethod (enum): Method used to determine single search result if a search results
in multiple hits. Options:

First: The hits are sorted alphabetically and the first hit is returned.

Last: The hits are sorted alphabetically and the last hit is returned.

Filter (Default): Returns the first hit evaluated true from a MatchExpression filter.
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MatchExpressions (list): List of filters to be used for narrowing searches that may result in
multiple hits.
Each MatchExpression filter is constructed from three attributes:
ignoreCase: (boolean) True if the filter is case insensitive. Must be used in
combination with property "IgnoreCase" from General Configuration File Properties.
expression: (string, regex) Expression used to create a regular expression to be
applied to the given clip name. Use the pattern attribute to extract parts of the
original clip name to search for. (Default: Empty = exact search).
pattern: (string) Regular expression used to extract information from the clip name.
(Default: The original clip name).
An empty MatchExpressions list results in an exact case sensitive search.

The following example sets up a regular expression filter searching:

MatchExpressions

<MatchExpressions>
<!-- Returns true for all hits with clip names starting with the given clip name

-=>
<MatchExpression expression="A$1.%x$"/>

<!-- Returns true for all hits with identical clip name but case insensitive -->
<MatchExpression ignoreCase=true/>

<!-- Returns true for all hits with clip names containing leading or trailing
spaces -->

<MatchExpression pattern = "A\sx(.*x)\s*x$" expression = "$1"/>
</MatchExpressions>

14.1.3 Device-specific Connection String Parameters

AirSpeed Classic Connection String

Applies to Models

AirSpeed
AirSpace

Connection String Properties

Type: AirSpeed and AirSpace.
Name: See Name above. Defines the ID of this connection (Default: AirSpeed).

Server: Defines the hostname or IP-address of the server.
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- Config: Defines the name of the configuration file.

Examples
AV Automation:

Name=HAR; Type=AirSpeed; Server=192.168.1.1; Config=ClipServerAirspeed.xml

Configuration File Properties
Configuration file properties can be overridden by connection string properties.

KeepCache (boolean): How often (in seconds) to look for clip changes. value=17 is the default
value if not configured here (Default: false).
RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server.
ReceiveTimeout (integer): Time in seconds to wait for response from AirSpeed (Default: 10).

- ChangeChecklinterval (integer): Time in seconds how often to poll AirSpeed for clip changes
(Default: 2).
Heartbeatinterval (integer): Time in seconds to send out a heartbeat in case of no
communication detected from AirSpeed (Default: 30).

- GetMinimumlList (boolean): Set to true to retrieve only clip names when initializing database
(Default: false).
DelayGetClipData (boolean): Delay getting detailed clip information. Information is retrieved
for clips in rundown only (Default: true).
DelayEventsOnDatabaselnitialization (boolean): If true, all clip handling during database load
is postponed until last clip is received (Default: false).

- SignalDatabaseReady (boolean): Refreshes all clips after database has been built instead of
refreshing for every item in the database (Default: true).

- VerifyModifiedClips (boolean): If true, all modified clip events for clip not in cache are
verified, as if they were created (Default: true).
ReceiveBufferSize (integer): Set buffer size used for receiving date from AMS. Default 16384

= two times default buffer size of Net.Socket (Default: 16384).

Encoding (string): Set to encoding used for send/receive from AMS (Default: UTF-8).
- SupportSearchUsingObjSlug: Ignores search for objSlug if set to false (Default: true).
- SupportSearchUsingRefID: Ignores search for reflD if set to false (Default: false).

Use for debugging purposes only:

- VerboselLogging (boolean): Set to true to enable logging of received messages from AMS
(Default: false).
DatabaseCache (boolean): If set to a valid filename, initial load database stores the content
in this file (Default: false).
DatabaseCacheUpdate (boolean): Determines when the debug database cache is updated
(either [Never,Always,Initial]).
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LoadDatabase: Specifies whether the AirSpeed clip database should be initially loaded and
maintained by the Media Administrator. Setting this attribute to true is required if any search
should be possible using an AirSpeed video server.

AirSpeed Multi Stream / AirSpeed 5000 Connection Strings

The AirSpeed Multi Stream drivers supports up to six multiple player ports per connection.

Applies to Models

- AirSpeed Multi Stream 1.8
- AirSpeed 5000

Connection String Properties

- Type:

- AV Automation: AirSpeedMultiStream
Media Administrator: AirSpeedMultiStreamSearch
Name: See Name in Standard Connection String Properties above.
- Server: See Standard Connection String Properties above.
- Config: See Standard Connection String Properties above. The installed xml config file is
ClipServerMultiStream.xml. Unless changed, the value of Config should be
ClipServerMultiStream.xml. See Examples below.

Optional

BasePort*: Specifies the number of the lowest-numbered port on the server.

(Default: 59451). For AV Automation, six consecutive player ports, starting at this one, are

available for playout. (They should be referred to by numbers 1 to 6 in AV Automation.)

For Media Administrator, refer to Player and the note below for how the actual port number

is calculated.

- AV Automation only
LoopPostRoll: (only used when Newlooping is true) No. of frames before clip-end to
restart loop. Should probably be set to a positive value to obtain smooth looping.
(Default: 4).

NewLooping: Whether to use an alternative looping mechanism. Must be true if
MPEG-2 HD clips are involved. (Default: false).

- OpenSomePlayerAfterConnect: By default, server connection is considered successful
('green’) without connecting to any players. If this setting is enabled, also connection
to some configured player will be necessary. (Default: false).

Set to true if connection problems are experienced, e.g.

i. Green server line

ii. Unsuccessful port connect (red port line)

iii. Reconnect

iv. ...andsoon ...
OpenPlayerAfterConnectTimeout: (only used when OpenSomePlayerAfterConnect is
true) Timeout (in milliseconds) for the above OpenSomePlayerAfterConnect
functionality (Default: 2000).
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RecordEjectFirst: If true, initiating a recording on a channel/port will first eject any
existing clips (Default: false).

RecordOverwrite: If true, any recording initiated on an existing clip will delete the
existing clip before creating the new (Default: true).

RecordUseNameAsClipld: If true, the clip name is also used as clip id when preparing a
recording. Otherwise the airspeed will automatically assign clip ids (Default: true).

& Note: The asterisk (*) above denotes the TCP port to connect to becomes BasePort + Player
- 1.

Examples

AV Automation:

Name=AMS; Type=AirSpeedMultiStream; Server=192.168.1.1;
Config=ClipServerMultiStream.xml

Configuration File Properties

With a few exceptions (Type, Name, Config), the connection string properties described above may
alternatively be specified in the configuration file. (A connection string setting overrides a
corresponding file setting.)

In addition the following properties may be specified in the configuration file:

Media Administrator only
DelayEventsOnDatabaselnitialization (boolean): If true, all clip handling during
database load is postponed until last clip is received (Default: false).
DelayGetClipData (boolean): Delay getting detailed clip information. Information is
retrieved for clips in rundown only (Default: true).
Encoding (string): Set to encoding used for send/receive from AMS (Default: UTF-8).
- GetMinimumlList (boolean): Set to true to retrieve only clip names when initializing
database (Default: false).
IgnoreCase: Whether clip search is case-insensitive (Default: false).
NumClips (integer):Number of clips to receive for each server query (Default: 50).
ReceiveBufferSize (integer): Set buffer size used for receiving date from AMS. Default
16384 = two times default buffer size of Net.Socket (Default: 16384 ).
- SignalDatabaseReady (boolean): Refreshes all clips after database has been built
instead of refreshing for every item in the database (Default: true).
Use for troubleshooting only:
DatabaseCache (boolean): If set to a valid filename, initial load database stores
the content in this file (Default: false).
DatabaseCacheUpdate : Determines when the debug database cache is updated
(either [Never,Always,Initiall).
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VerboselLogging (boolean): Set to true to enable logging of received messages
from AMS (Default: false).
Effective only if Verbose logging is turned on in Media Administrator.
AV Automation only
ReadTimeout: Time in seconds to wait for response from AirSpeed (Default: 5).

AirSpeed Multi Stream Search

This driver is similar to the AirSpeed Multi Stream driver, but contains search functionality only.
It is used by Media Administrator for obtaining clip status from an AirSpeed Multi Stream or 5000
video server.
BasePort*: The lowest port number to connect to (Default: 59457).
Player*: The player number (1-6). Used for setting the TCP port (Default: 7).
LoadDatabase (boolean): Set to true to build internal database of clips present on server and
enable clip monitoring (Default: false).
ChangeChecklinterval: Time in seconds how often to poll AirSpeed for clip changes
(Default: 7).
ReceiveTimeout: Time in seconds to wait for response from AirSpeed (Default: 70).
Heartbeatinterval: Time in seconds to send out a heartbeat in case of no communication
detected from AirSpeed (Default: 30).

& Note: The asterisk (*) above denotes the TCP port to connect to becomes BasePort +
Player - 1.

Example

Name=AMS; Type=AirSpeedMultiStreamSearch; Server=192.168.1.1; BasePort=59451; Player=2;
ChangeCheckInterval=5; ReceiveTimeout=5; HeartbeatInterval=20;
Config=ClipServerMultiStream.xml

Amadeus Connection String

Name=HTC-DB; Type=Amadeus; Port=[port]; Config=ClipServerAmadeus.xml

Connection String Properties

Name: Amadeus ID for database. See Name in Standard Connection String Properties above.
Type: Defines the Amadeus driver for clip handling.
Port: Set to port to listen for an Amadeus connection.

Optional
Port: Defines the connection port (Default: 2202).
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ResponseReadTimeout: Defines the wait time until timeout (default: 5000).
PollintervalClips: Defines the time between polling (Default: 15). Set to 0 to disable.
RundownPrefix: Defines the prefix to add for the rundown name (Default: ””).

- GetAlICGs: If true, METAREQ_ALLCGS message type is used when getting clip info (Default:
"). For more details, see the Amadeus documentation.
LowerCaseRundowns: If true, then the rundown name is always generated with lower case
(Default: false).
IgnoreSTEG: If true, all messages from Amadeus starting with STEG are ignored
(Default: true). For more details, see the Amadeus documentation.

- StegCommandIfSubtitled: Sends the specified STEG command if clip is subtitled (Default:
KLOCKA INVOKEOFF). For more details, see the Amadeus documentation.

- SubtitleStegOutOn: Sets the graphics_out_on xml value in the STEG command set to
Amadeus (Default: BACKGROUNDEND).
PurgeCachelnterval: Use hh:mm:ss format (Default: 00:00:00).
PurgeCacheAge: Use hh:mm:ss format (Default: 00:05:00).

EVS LinX Connection String

This connection string is used for EVS video servers controlled by the LinX protocol (as opposed to
EVS Xedio systems, see EVS Xedio Connection String).

Type=EVS LinX; Name=[name]; Server=[IPaddress]; LoadDatabase=true;
Config=ClipServerEvsLinX.xml

Example

Type=EVS LinX; Name=EvsLinXName; Server=192.168.62.6; LoadDatabase=true;
Config=ClipServerEvsLinX.xml

Connection String Parameters

- Type: EVS LinX or EVS (EVS is retained purely for backward compatibility).
Name: See Name in Standard Connection String Properties above.

- Server: Defines the IP address of the server.
LoadDatabase: If true, loads all clip metadata into local cache (Default: false). Use true for
Media Administrator.

- Config: Configuration file containing further configuration settings.

Optional

LogOutput: The LinX log file created for the LogFlag option 0x00000003. The files for the
other options are in the same folder, and with names derived from LogOutput (see LogFlag
below for details.) The folder should exist in advance, and the Viz Mosart user should have
permission to create and write files.

AV Automation and Media Administrator should log to different files, so LogOutput should
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be specified (with different folders) in the respective connection strings rather than in this
file.

- VeryVerbose: If true (and the Viz Mosart application issues verbose logging), then some
extra log messages are issued (Default: false).

Config File Parameters

- SupportSearchUsingObjSlug: Search by ‘slug’ (clip name) is supported (Default: true).

- SupportSearchUsingRefID: Search by a configurable clip property (given by the
SearchPropertyName parameter; see below) is supported (Default: false).
HeartbeatTimeout: The time (in milliseconds) after which the server connection may close if
there is no activity (Default: 72000).
KeepAlivelntervalDivisor: In case of connection problems, multiply both HeartbeatTimeout
and KeepAlivelntervalDivisor by the same factor (for example, two) (Default: 8).
LocalMtpclpAddress: Necessary only if the Viz Mosart server has several network adapters,
e.g. a virtual adapter (or several virtual adapters) in addition to the physical adapter, e.g.
when VMWare (or similar) is installed on a demo PC, or when connecting through VPN. In
this case, use the IP address (in the usual format of four dot(.)-separated groups of one to
three decimal digits) of the network adapter connected to the EVS servers.
LogFlag: Bitmask specifying LinX log level. Available options are listed in the table below. (In
addition, linxFunctions.log is produced.) The options may be combined. For example,
OXFFFFFFFF produces all log files.

Bitmask Description Log file, given
LogOutput=...\linx.log

0x00000003 Function entry and exit points, linx.log
with parameters and return code

0x00000010 Connections linxConnect.log
0x00000200 Keeping alive linxKeepAlive.log
0x00000400 Databases linx_Archive.log
0x00008000 Debug linxDebug.log
0x01000000 Tools linxTool.log

MaxTries: Obsolete. Instead, use SharedNbMaxConnectRetry and SharedConnectTimeout,
described below. (The maximum number of times to try to synchronize the database
(Default: 70).
NbMaxLinxConnection: The maximum number of connections. The default is 18, to
accommodate two EVS servers. Add 9 for each additional server.

- OsdDefine00 - OsdDefinel1: Defines the 12 OSD lines.

- OsdShowHideError: Defines whether or not to show OSD.
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OsdShowHideErrorSignals: Defines whether or not to show OSD. (For further details of these
and other OSD settings, please see the default configuration file.)

SearchPropertyName: Clip property that may be used for clip search. The default is Varid (a
LinX specific clip ID that may be used to identify clips in the NRCS). If some other property is
needed, please ask Viz Mosart personnel for a list of available values.
SharedNbMaxConnectRetry: Maximum number of retries in case of connect error on a
shared connection. Increase if the error code "Too many retries' is encountered, e.g. when
synchronizing the database. (Default: 76).

SharedConnectTimeout: Maximum time in milliseconds to execute connection request on a
shared connection. Consider increasing if the error code 'Too many retries' is encountered,
e.g. when synchronizing the database. (Default: 500).

Applies to Models

- XS family (6U, 4U)
- XT family (XT2+, XT3, not nano)

Device Prerequisites

Multicam 10.03, or later
LinX license code
Channels to be controlled by Viz Mosart must have Main CTRL LinX.
- The network, including any firewalls, connecting the Viz Mosart server(s) and the EVS

server(s) must support and allow TCP (ports 50000 - 50002 ) and UDP (unicast and
multicast, ports 50100 - 50108 ).

EVS Xedio Connection String

These connection strings are used for EVS Xedio video servers (as opposed to EVS video servers
controlled by the LinX protocol, see EVS LinX Connection String).

From a Viz Mosart perspective, a Xedio system has three parts:

One or more playout servers
- A control center
- A DB connected to through ODBC.

AV Automation controls the playout servers, whereas Media Administrator connects to the control
center and the database. Consequently, the connection strings for AV Automation and Media
Administrator are somewhat different.

AV Automation Connection String

Type=EvsXedio; Name=[name]; Config=ClipServerEvsXedio.xml

Example:
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Type=EvsXedio; Name=EvsXedioName; Config=ClipServerEvsXedio.xml

AV Automation Connection String Parameters

- Type: EvsXedio.
Name: See Name in Standard Connection String Properties above.
Config: Defines the configuration file containing further details.

& Note: The parameters mentioned so far are insufficient to connect to a playout server. The
IP address and port number are also required.
These are specified (separated with : ) in the Video port field(s) in AV Automation Device
Properties, for example 192.168.76.11:4021.

Media Administrator Connection String

Type=EvsXedioSearch; Name=[name]; Server=[IPaddress]; Config=ClipServerEvsXedio.xml

Example:

Type=EvsXedioSearch; Name=EvsXedioSearchName; Server=192.168.76.10;
Config=ClipServerEvsXedio.xml

Media Administrator Connection String Parameters

- Type: EvsXedioSearch.
Name: See Name in Standard Connection String Properties above.
Server: Defines the IP address for the Control center.
Config: Defines the configuration file containing further details.

& Parameters mentioned so far are insufficient to connect to the database. Additional
parameters DataSourceName, User, and Password are required.
The defaults are probably sufficient. If not, these are more conveniently set as
configuration file parameters, described below.

Configuration File Parameters

PrefixTypeEdit: MOS objlDs with this prefix are treated as 'edits' (Default: EVSE).
PrefixTypeMedia: MOS objlDs with this prefix are treated as 'media' (Default: EVSM).

Relevant for AV Automation Only

- TimeOut: Defines the timeout in milliseconds (Default: 7).
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Relevant for Media Administrator Only

- AcceptHighResolutionOnly: Whether only high resolution clips are accepted (Default: false).
DataSourceName: ODBC System DSN entry for the CleanEdit DB (Default: CleanEditDB).
MonitorClipinterval: The interval (in seconds) at which found clips are monitored (Default:
60). Used only if MonitorFoundClips is true, see below.

MonitorFoundClips: Whether found clips are monitored (Default: false).

Password: Password for the CleanEdit DB.

PrefixCheckltemReturnAllltemHiResPresent: The prefix added to the Description of a hi-res
clip (Default: HIRES-).

PrefixCheckltemReturnError: The prefix added to the Description of an error clip (Default:
ERROR-).

PrefixCheckltemReturnNotPlayable: The prefix added to the Description of non-playable clip
(Default: NOTPLAYABLE-).

PrefixCheckltemReturnOnlyltemLowResPresent: The prefix added to the Description of a lo-
res clip (Default: LORES-).

- SkipGetDuration: Whether to skip getting clip duration. Note that this operation may be slow
and MAY be rendered unnecessary by future Media Administrator dev (Default: false).

- User: User for the CleanEdit DB.

Debug Parameters, Relevant for Media Administrator Only
LogFile: CleanEditOcx log file (Default=C:\EvsLogs\CleanEditOcx\CleanEditOcx.log).

Grass Valley K2 Connection String

Applies to Models

K2
- Summit

Connection String Properties

- Type: GrassValleyK2 (selects the Grass Valley K2 driver for clip handling).
Name: See Name in Standard Connection String Properties above.

- Config: See Standard Connection String Properties above. The installed xml config file is
ClipServerGrassValleyK2.xml. Unless changed, the value of Config should be
ClipServerGrassValleyK2.xml, cp. the examples below.

Bin: When LoadDatabase (see below) is true, a 'cache'/'database' of server clips is built and
maintained. Unless IgnoreBin (see below) is true, this 'cache'/'database' comprises the clips
in the bin designated by the two settings Volume (see below) and Bin. (The Bin setting must
designate a bin in the volume designated by the Volume setting.) (The default value is the
string default. Yes, there is normally a bin named default.)

Domain: The domain as part of the user credentials.
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DontUsePath: (Media Administrator only) For each clip and server, Media Administrator
keeps track of the 'id" of that clip on that server. By default (DontUsePath false), that id is the
full path and name of the clip on the server. When DontUsePath is true , the id is the clip
name only. The default false may be used in most cases. For a Stratus system, changing to
true may be considered. (However, this should not be combined with setting IgnoreBin (see
below) to true.)

EnsureUniqueObjSlug: (default false) This may be left at the default false in most
circumstances. However, if the clip_hirespath from NCS is the full clip path, e.qg. edl/cmf//
BGO-LAB-K2SUMMI/C:/default/Clip, this should be set to true. (But if IgnoreBin (see below) is
true, it is not necessary to also set EnsureUniqueObjSlug.)

FilterGetXmlIChanges: (Media Administrator only) If true, only clip changes involving the bin
selected by the properties Volume and Bin will be handled. Otherwise (false), all changes are
handled. The default false may be used in most cases. For a Stratus system, changing to
true may be considered. (However, this should not be combined with setting IgnoreBin (see
below) to true.)

IgnoreBin: (default false) If true, the Bin setting (see above) is ignored, and the
‘cache'/'database' of server clips (see LoadDatabase above) will comprise all clips in the
server volume designated by the Volume setting. (See below.) In this case, the clip_hirespath
from NCS must be the full clip path, e.g. edl/cmf//BGO-LAB-K2SUMMI/C:./default/Clip. (Clips
in different bins may have the same name, so the path is necessary to select a particular
clip.)

LoadDatabase: Whether to maintain a 'cache'/'database' of server clips. Default false. For AV
Automation, keep the default false. For Media Administrator, use true. By default,

this 'cache'/'database’ comprises the clips in the bin designated by the two settings Volume
(see below) and Bin (see above). However, if the setting IgnoreBin (see below) is true, the
‘cache'/'database' will comprise all clips in the server volume designated by the Volume
setting.

Modificationsinterval : (Media Administrator only; valid only when LoadDatabase is true)
Interval (in ms) for checking for server change.

Pass: The password as part of the user credentials.

- Server: The IP address/hostname of the Grass Valley K2 server.

- Suite: This value may be chosen arbitrarily. However, these guidelines should be followed:
For each K2 server, two, or even three, different Suite values should be used: First, the
values for Media Administrator and AV Automation should be different.

- Second, in a redundancy setup with Main and Backup Mosart server the two values for
Media Administrator should be different.
(Whereas both Main and Backup AV Automation should use the same value, different
from the two Media Administrator values.)
For further info wrt. the redundancy setup, refer to Failover with K2 Servers.

User: The username as part of the user credentials.

- Volume: When LoadDatabase (see above) is true, a 'cache'/'database' of server clips is built

and maintained. This 'cache'/'database’ is limited to clips in the volume designated by the

Volume setting. If IgnoreBin (see above) is true, this 'cache'/'database' comprises all clips in

that volume. If IgnoreBin is false, the 'cache'/'database’ comprises the clips in the bin

Copyright © 2023 Vizrt Page 439



Viz Mosart Administrator Guide - 5.3

designated by the Bin setting (see above) only. (The Bin setting must designate a bin in the
volume designated by the Volume setting.) (The default value is V)

Examples
AV Automation:

Name=Summit; Type=GrassValleyK2; Server=K2SERVER1;
Config=ClipServerGrassValleyK2.xml; Bin=default; User=GVAdmin; Pass=GVPass;
Volume=V:; Suite=AVA; Domain=K2SERVER1

Media Administrator:

You also need to add the connection string in Mosart Media Administrator. This is the same
connection string as in AVAutomation, except that you need to

add LoadDatabase=true at the end
use another value for the Suite property.

Name=Summit; Type=GrassValleyK2; Server=K2SERVER1;
Config=ClipServerGrassValleyK2.xml; Bin=default; User=GVAdmin; Pass=GVPass;
Volume=V:; Suite=GVAdmin; Domain=K2SERVER1;LoadDatabase=true;

Configuration File Properties

KeepCache: See General Configuration File Properties above.

RefreshOnUpdate: See General Configuration File Properties above.

VerifyClipDelay: See General Configuration File Properties above.

VerifyModifiedClips: See General Configuration File Properties above.
BypassRetrieveServerConfig (Boolean, default: false): (AV Automation only) Whether to
bypass retrieval of channel configuration from the server. Set to true if there are problems
connecting to one or more channels (red line).

CloseChannels (Boolean, default true): (AV Automation only) Whether channels are closed at
disconnect. Use false in a redundancy setup with Main and Backup Mosart servers to prevent
clip ejection on failover. Otherwise, use true. (See Failover with K2 Servers below.)
MaxCueRetries: Maximum number of cue/load attempts. Default: 7.

RecordingBin (string): (AV Automation only) The server bin where clips are to be recorded.
(This bin must be in the volume specified by RecordingVolume.) Both RecordingBin and
RecordingVolume must be specified if clips are to be recorded in a specific bin. Otherwise,
the recording location is undefined.

RecordingVolume (string): (AV Automation only) The server volume where clips are to be
recorded. Both RecordingBin and RecordingVolume must be specified if clips are to be
recorded in a specific bin. Otherwise, the recording location is undefined.
SuspendConnection (Boolean, default false): (AV Automation only) See Failover with K2
Servers below. Use true in a redundancy setup with Main and Backup Mosart servers to
prevent clip ejection on failover. Otherwise, use false.
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UseExtendedLogging (Boolean, default false): Adds some more logging. Valid only if Verbose
logging is turned on. Should normally be kept at the default false.

UseMovieAddedNotice (Boolean, default false): Whether to utilize the MovieAddedNotice
element when processing a MovieAdded notice.

& Note: This setting was introduced to handle added clips at an installation with rather
old GV firmware. In the default ClipServerGrassValleyK2.xml, this setting is true. (But
if the setting is removed altogether, the actual default value is false.) Change to false
(or remove setting) if added clips are not handled correctly (for example, if a clip
added on the GV server does not turn solid blue in the Viz Mosart GUI).

UseVideoFormatFromServer (Boolean, default true): Set to false if clip durations (for
example, as shown in GUI) are incorrect.

Failover with K2 Servers

When GVG K2 servers are connected to both main and backup Mosart servers, any cued or playing
clips would be ejected from the K2 ports during failover.

This is not desirable, so a further layer of configuration file properties have been provided for
avoiding this:

CloseChannels: (Default: true)
SuspendConnection: (Default: false).

For a redundancy setup with Main and Backup Mosart servers, use instead these settings:

<item name="CloseChannels" value="false" />
<item name="SuspendConnection" value="true" />

With these settings, the outgoing Mosart server (e.g. main) will disconnect in a way that allows the
incoming Mosart server (e.g. backup) to retake the same connections and channels.
This ensures that no clips are ejected in the process.

The prerequisite for this to work is that the Connection String Properties on main and backup are
set up with identical Suite names (for AV Automation).

Stratus
The two connection string properties

DontUsePath
FilterGetXmlIChanges

were introduced at installations with a Stratus system to ensure that deleted clips appeared
chequered in the Mosart GUI.

The default value of both settings is false, and that has, as far as we know, worked for all other
installations. We recommend the following:

1. Start using the default value false for both settings.
2. If problems of the type indicated (deleted clips stay solid blue in GUI) are encountered,
change both settings to true.
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Other combinations (than both false and both true) have not been tested.

Harris Nexio Connection String

The Harris Nexio driver supports Binary-Coded Decimal TCP/IP transport. The driver can be
configured to be case sensitive on searches and use Unicode encoding. The Harris Nexio driver
supports recording.

Control via RS-422 can be done through VDCP.
Maximum five video server units.

Connection String Properties

Type: Harris Nexio

Name*: See Name in Standard Connection String Properties above. Defines the ID of this
connection.

Server*: Defines the hostname or IP-address of the server.

Config: Defines the name of the configuration file.

Optional

Port*: TCP port to connect to (Default: 557).

Encoding:* Set to U or Unicode if it should be Unicode.

Case*: Set to B to be case sensitive on clip name searches.

ClipNames:* Property for using exact clip names. If set to EXACT, clip names are case-
sensitive (Default: EXACT).

ChangeChecklinterval: Defines the number of seconds between checks for clip changes.
LoadDatabase (boolean):* Set to true to build internal database of clips present on server
and enable clip monitoring (Default: false).

& Note: The asterisk (*) above denotes the configuration file set property can be
overridden by a connection string parameter.

Examples
AV Automation:

Name=Harrisl; Type=HarrisNexio; Server=192.168.1.1; Port=557;
Config=ClipServerHarris.xml

Media Administrator:

Name=Harrisl; Type=HarrisNexio; Server=192.168.1.1; Port=557; LoadDatabase=true;
Encoding=UTF-8; ClipNames=UNEXACT; ChangeCheckInterval=15;
Config=ClipServerHarris.xml
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Configuration File Properties

- ChangeCheckinterval (integer): Time in seconds how often to poll HarrisNexio for clip
changes (Default: 5).
Port (integer): Defines the default connection port (Default: 557).

- Encoding (string): (Default: ANSI).

- Case (string): (Default: UPPER).

- ClipNames (string): Property for using exact clip names. If set to EXACT, clip names are case-
sensitive (Default: EXACT).
KeepCache (boolean): When set to false, the cache is cleared on reconnects (Default: false).
RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server
(Default: 0).

- SupportSearchUsingObjSlug: Ignores search for objSlug if set to false (Default: true).

- SupportSearchUsingRefID: Ignores search for refID if set to false (Default: false).
MaxCueTime (integer): Maximum milliseconds to wait for cue (Default: 5000).

- ClipNamePattern: See General Configuration File Properties.

JupiterWebService Connection String

JupiterWebService is an asset management system.

Name=myServerName; Type=Jupiter; Url=myConfigFile

Example:

Name=Jupiter; Type=Jupiter; Url=ClipServerJupiter.xml

This server type does not support any additional parameters in the connection string. The
following settings must be added in the configuration file.

Configuration File Properties

- Server (string): Defines the hostname or IP-address of the server (Default=localhost).
Port (integer): Defines the TCP port to connect to (Default= 8102 ).

- ServiceName (string): Default=JupiterService.svc.

- Service (string): Default=http://\{Server}:{Port}/{ServiceName}.

- GetStatusCommand (string): Default={Service}/clipstatus/{0}.

- GetKeyFramesCommand (string): Default={Service}/keyframes/{0}.
PollintervalStatus (string): Default={Service}/keyframes/{0}.
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MVCP Connection String

MVCP (Multiport Video Computer Protocol) is a simple request/response protocol, which is
implemented over a TCP byte-stream connection (for example, a stream socket).

Applies to Models

- Vizrt Xlator.
- SVT F2C file name conversion service.

Connection String Properties

- Type: MVCP
Name: See Name in Standard Connection String Properties above. Defines the ID of this
connection (Default: MVCP).

- Server: Defines the hostname or IP-address of the server (Default: localhost).
Port: Defines the TCP port to connect to (Default: 5250).

Configuration File Properties

- CustomSearch*: (Example) Set to a unique string like SVT to enable a custom search named
SVT on objSlug.

- SetNameAsRefld*: Set clip name as ref ID in the media object (Default: false)for re-use in
other clip servers (Default: false).

- WriteTimeOut: Sets the amount of time in milliseconds that a write operation blocks waiting
for data from the server (Default: 5000).
ReadTimeOut: Sets the amount of time in milliseconds that a read operation blocks waiting
for data to the server (Default: 5000).

- AppendExtension*: A file extension used when sending messages to the MVCP interface

(Default: ™).
RemoveExtension*: Used to strip the extension of a clip name from the MVCP interface
(Default: ™).

- ClipNamePattern: See General Configuration File Properties.
& Note: The asterisk (*) above denotes a custom search called SVT, where in this
example SVT is set up to process file names with 36 characters. As Nexio only

supports 32 characters, SVT will expose a mapping proxy with an MVCP interface
and a custom command F2C which translates a long name to a shorter one.

Examples
AV Automation:

Name=MVCP2; Type=MVCP; Server=192.165.4.1; Port=5250
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Media Administrator:

Name=MVCP2; Type=MVCPSearch; Server=192.165.4.1; Port=5251

Omneon Connection String

Applies to Models

Models with Omneon Spectrum

A Note: Viz Mosart is incompatible with Omneon Spectrum versions earlier than 4.6.

Additionally, in some cases, clip length is not updated when using Omneon
Spectrum 6.4.3 or earlier.
It is recommended to upgrade to Omneon firmware version 7.9.x or later.

Connection String Properties

Type: Connection type: Omneon or OmneonSearch.
Name: See Name in Standard Connection String Properties above. ID of this connection.
Server: Hostname or IP-address of the server.

5.3

Player: Performs searches associated with directory for the given player if set. If not set, the

Directory option should be used to identify the search directory (optional).
Directory: Specifies the search directory (optional).

ExtList: File extensions to be used. List of case sensitive extensions separated by periods.

ClipDir: Clip directory to monitor for files.

LoadDatabase (boolean): Set to true to build internal database of clips present on server and

enable clip monitoring (Default: false).
Config: Name of the configuration file (ClipServerOmneon.xml).

UseFullPath: If true, the Media Administrator returns full clip paths. The clip ID contains both

the Omneon server directory, as well as the clip name. Setting this property to true is
mandatory if multiple directories are used on a single Omneon server. (Default: false).

Examples
AV Automation:

Type=Omneon; Name=Omneon; Server=10.211.114.104; ExtList=.mov.MOV.mxf.MXF;
UseFullPath=true; Config=ClipServerOmneon.xml

Media Administrator:

Type=OmneonSearch; Name=Omneon; Server=10.211.114.104; Player=Playl; clipdir=/fs0/
media; ExtList=.mov.mxf; LoadDatabase=True; Config=ClipServerOmneon.xml
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Configuration File Properties

KeepCache (boolean): When set to false, the cache is cleared on reconnects (Default: false).
RefreshOnUpdate (boolean): When set to true, the cache is updated on each update clip
message from the server (Default: true).

- VerifyClipDelay (integer): Delay in frames to wait before verifying new clips from server
(Default: 0).

DescriptionPattern (string): Makes it possible to extract a description from the object slug
(objSlug) based on this Regex pattern (Default: [A_]*_(.*)).

DescriptionReplacement (string): Regex expression referring to first matched group. Used
when replacing object slug (objSlug). (Default: $7)

InvokeServerOnGetClipinfo (boolean): If true (non-zero), a request is sent to the video server
when doing clip search. If true, all modified clip events for clip not in cache are verified (as if
they were created) (Default: false).

- VerifyModifiedClips (boolean): If true, all modified clip events for clip not in cache are
verified (as if they were created) (Default: false).

IgnoreCase: If true, searching for clips is done case insensitive. Must be used in combination
with <MatchExpression ignoreCase=true /> from General Search Configuration File
Properties .

- GoToTimeCodeTimeOQut (integer): Maximum time to wait (in milliseconds) for successful
execution of command to play clip from a given time code (Default: 6000).
UseNativeGoToTimeCode (boolean): If true, it uses GoToTimeCode method available in
Omneon API. This may take a longer time to cue a clip at a specified position (Default: false).
UseStopOnCue: If true, the timeline is stopped, not paused (play with speed 0) when cueing
a new clip. This causes cueing to take longer than usual.

- ClipNamePattern: see General Configuration File Properties.

Search Properties: See General Search Configuration File Properties.

Omnibus OPUS Connection String

Name=myServerName; Type=0PUS; Url=myUrl; Config=myConfigFile.xml

Url: Specifies the URL of the OPUS Interchange web service.

Orad OCIP Connection String

This connection string is used for video servers controlled by OCIP (Open Control Interface
Protocol). This includes Orad V) (obsolete) and Avid FastServe video servers.

Type=Orad OCIP; Name=[Name]; Server=[hostname/IP address]; Port=[Port];
LoadDatabase=true; Config=ClipServerOradOcip.xml

Example:
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Type=Orad OCIP; Name=0OradVJ; Server=192.168.15.1; Port=10001; LoadDatabase=true;
Config=ClipServerOradOcip.xml

Connection String Parameters

- Type: Orad OCIP.
Server: Defines the server hostname.
Name: See Name in Standard Connection String Properties above.
Port: Defines the server port. By default, the four ports

10001
10002

10003
, and
10004

are configured on an OCIP-controlled Orad server. We recommend using different
ports for AV Automation and Media Administrator.

(® Example: 710002 for AV Automation and 10003 for Media Administrator.

LoadDatabase: If true, the server database is loaded at start-up (Default: false). Use true for
Media Administrator.

Config: Configuration file containing further configuration settings.

Configuration File Parameters

- AllowSetPosition: Whether to enable 'scrubbing'/'scrolling’ the in-point of a cued clip in the
GUI. Default: false. Effective only for servers supporting OCIP 3.0.0 or higher. (Only tested
with OCIP 4.0.0.)

- CopyObjSlug: Whether the value of the clip 'slug’ (the slug is the value of the OCIP item
parameter set in ObjSlugParameter) shall be copied 'upwards' (to Media Admin). Default:
false.

& The value for CopyObjSlug in the installed ClipServerOradOcip.xml file, is initially set
to true. This will be the value for new installations.

If problems are experienced when a clip is first deleted and then re-created with the same
Sourceld (assuming that is the value of the ObjSlugParameter setting), but a different Id,
make sure this setting is true.

IgnoreGrowingltems: Whether clips with growing parameter set to true will be ignored.
When set, this implies that growing clips are processed as non-existent and are unavailable.
Available for Avid FastServe running FSP 2018.8 or higher. The RequestGrowing setting must
be true for this to have effect.
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LoopPostRoll: Number of frames before clip-end to restart loop. Set to a positive value to
obtain smooth looping.
ObjSlugParameter: The OCIP item parameter to use for clip 'slug'. The values of this
parameter should match the values of the 'clip_hirespath' newsroom tag.
Default 'Name'. This default value has worked for the video server Orad VJ. Other workflows,
especially using Avid FastServe, require using the value 'Sourceld'. Other values are not
verified as supported.
RequestGrowing: Whether to request the Growing parameter from the server. Default: false.
Set to true if the IgnoreGrowingltems feature is to be used.
SetInAndOutPoint: How a clip's in-point and out-point are set. Available values:
FromServer: (Default) From the item's In and Out parameters. This may yield incorrect
results if the In parameter is different from 0.
ZeroAndDuration: (Value in the installed ClipServerOradOcip.xml file, so this will be
the value for new installations.) As 0 and the item's Duration parameter.
Dont: For future/internal Vizrt Support use. Do not use this value.
SkipAbortinLoadClip: If true, skip the ChannelAbort command at cue (Default: false).
- TimeoutDefault: Timeout in milliseconds for commands with no specific timeout set
(Default: 1000 which is 1 second).
- TimeoutChannelAbort: Timeout in milliseconds for the ChannelAbort command performed
at cue.
- TimeoutChannelJog: Timeout in milliseconds for the Jog command performed at
'scrubbing'/'scrolling' (See AllowSetPosition).

- TimeoutChannelPause: Timeout in milliseconds for the ChannelPause command.

- TimeoutChannelPlay: Timeout in milliseconds for the ChannelPlay command performed at
cue.

- TimeoutChannelPlaylnit: Timeout in milliseconds for the ChannelPlaylnit command
performed at cue (Default: 4000 (4 seconds)).

- TimeoutChannelSetSpeed: Timeout in milliseconds for the ChannelSetSpeed command
performed at play.

- TimeoutChannelStatus: Timeout in milliseconds for the ChannelStatus command.
- TimeoutCreateCallbackltem: Timeout in milliseconds for the CreateCallbackltem command

at start-up (Default: 2000 (2 seconds)).

- TimeoutltemCheck: Timeout in milliseconds for the temCheck command occasionally
performed at cue.

- TimeoutltemGet: Timeout in milliseconds for the ItemGet command occasionally performed
at cue, and also for getting status.

- TimeoutListChannel: Timeout in milliseconds for the ListChannel command at start-up.

- TimeoutListltem: Timeout in milliseconds for the Listitem command at start-up

(Default: 2000 (2 seconds)).

UpdatelnAndOutPoint: Whether clip in-point and out-point should be copied 'upwards' (to
MediaAdmin) for clips with growing duration.

Default: false. Change to true if such clips are not shown with correct duration in GUI.
UseHashKey: If true, the item Id will be used as clip 'id". If false, clip 'slug' will be used. (See
settings ObjSlugParameter and CopyObjSlug above.)

Default: false. However, the value in the installed ClipServerOradOcip.xml file is true, so this
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will be the value for new installations.

If problems are experienced when a clip is first deleted and then re-created with the same
Sourceld (assuming that is the value of the ObjSlugParameter setting), but a different Id,
make sure this setting is true.

UsePingOcipOperation (boolean): If true, use an OCIP operation for Ping instead of the
default TcplpClient ping (Default: false).

Debug Parameters

KeepSpeed: For Vizrt Support use. Default: false.
Do not change!
- WSACancelBlockingCallExceptionTraceEventType: The TraceEventType for the
WSACancelBlockingCall exception.
Options: Critical, Error, Warning, Information, Verbose (Default: Error).

Applies to Models

Orad V]
- Avid FastServe

Device Prerequisites

OCIP 1.0.4. Some features require OCIP 3.0.0.
- Avid FastServe. Some features require FSP 2018.8.

Quantel Connection String

Applies to Models

Connects to Quantel using Quantel CORBA interface.

Device Prerequisites

Requires Quantel CORBA services to run.
Serial numbers of playout servers, normally obtained via Quantel Web interface.

Quantel Video Server Connection String

Name=myServerName; Type=Quantel; Mode=Player; SerialNo=mySerialNo; IOR=myQuantelIOR;
Slave=mySlaveAddress; Timeout=10; Config=myConfigFile.xml
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Connection String Properties

Name: See Name in Standard Connection String Properties above. A logical name to be
associated with the video server. This is used to identify the server across AV Automation
and Media Administrator configurations.
Type: Specifies which driver to be used for connecting to the server. This should be set to
Quantel for both AV Automation and Media Administrator.
Mode: Specifies whether the Quantel connection is used for playing clips or searching
(Default: Search):

Mode=Player: The Quantel connection is used for playing clips (AV Automation).

Mode=Search: The Quantel connection is used for searching (Media Administrator).
SerialNo: Specifies the serial number of the Quantel video server. This number is used to
recognize the particular video server within a Quantel zone portal. Serial numbers may be
obtained via the Quantel Web interface.
IOR: Specifies the Corba IOR used to establish connection with a Quantel server. This IOR is
normally obtained from the system administrator.
Slave: Specifies an optional slave address. Used when Quantel is configured in a redundancy
setup.
Timeout: Specifies the timeout in seconds when initially connecting to the Quantel zone
portal (ISA manager). Default is 70 seconds.
Config: Specifies a configuration file containing custom configuration for the Quantel server
driver. Normally set to ClipServerQuantel.xml, which contains the default configuration.

Examples

AV Automation:

Name=sQ7; Type=Quantel; SerialNo=19343; Mode=Player; IOR=http://
quantel:@192.168.60.33/ZoneManager.ior; Config=ClipServerQuantel.xml

Media Administrator:

Name=sQ7; Type=Quantel; SerialNo=19343; Mode=Search; IOR=http://
quantel:@192.168.60.33/ZoneManager.ior; Config=ClipServerQuantel.xm

Quantel Configuration File Properties

DefaultTakenPortAction (enum): Action when not able to take a port when owned by
someone else (Default: Steal).
Options:

Steal: Takes control over the port even if in use by someone else.

Share: Shares control with the other user. Not recommended.

Cancel: Cancels the operation. Port is still in control by other user.
IssueRequestForTakenPorts (boolean): If true, the user is prompted to confirm taking a port
in use by someone else (Default: true). A dialog box appears in AV Automation, warning

Copyright © 2023 Vizrt Page 450


http://quantel:@192.168.60.33/ZoneManager.ior
http://quantel:@192.168.60.33/ZoneManager.ior

Viz Mosart Administrator Guide - 5.3

about taking a port that is currently in use. Only applicable when
DefaultTakenPortAction=Steal.

ReleasePortsWithNoAssignedChannels (boolean): If true, any unassigned ports (with no
assigned channels) are released on player initiation (Default: true).

ServerPollFrequency (integer): Polling frequency for server, in seconds. This is used as
heartbeat between Viz Mosart and Quantel. Note that heartbeats are not issued if data has
been received from Quantel since last heartbeat. (Default: 30).

ClipNamelsValidNumber (boolean): If true then it is possible to search from Viz Mosart GUI
using valid Quantel ClipIDs directly (Default: false).

QuantelSlugColumn (string): Specifies the Quantel database column that is used for the clip
slug (Default: Title).

QuantelClipIDColumn (string): Specifies the Quantel database column that is used for the
clip ID (Default: CliplD).

QuantelSearchColumn (string): Specifies the Quantel database column that is used for the
clip searches (Default: Title).

MaxPingAttempts (integer): Maximum ping attempts before a lost connection is detected
(Default: 7). When Viz Mosart detects a lost connection, the current connection is closed
followed by attempts to reconnect. For playout servers only (AV Automation).
QuantelRefIDColumn (string): Specifies the Quantel database column that is used for the clip
RefID. Used if SupportSearchUsingReflID is set to true. (Default: Title).
SearchUsingServerldOnly (boolean): Forces AV Automation to only search for clips using
Quantel Clipld’s obtained from Media Administrator if true.

ClipNamePattern: see General Configuration File Properties.

Quantel Failure Handling Properties

QuantelStatusinterval (integer): Interval in seconds for the Quantel server to send regular
status messages. These messages are only sent when the Quantel server is idle. (Default: 2
seconds).

QuantelCommErrorNumRetries (integer): The number of retries in case of a Quantel CORBA
operation results in a CORBA_COMM_FAILURE. (Default: 7).

QuantelCommeErrorTimeout (integer): The timeout in milliseconds between retries in case of
a Quantel CORBA operation results in a CORBA_COMM_FAILURE. (Default: 700 msec).

Quantel Search Filters

It is possible to define a set of dedicated filters used to either exclude or include hits returned
from the Quantel ISA manager. Note that the Quantel ISA manager returns hits for all attached
pools. It is necessary to filter out the clips not available on the pools used by the corresponding
video servers.

The Quantel search filters are defined in the Quantel configuration file as a list of Filter elements
within a SearchFilter element. The following XML structure defines the default filters:

<SearchFilters>
<Filter property="Category" pattern="TEMPORARY CLONE" qinclude="false" />
<Filter property="PoolID" pattern="[PoolID]" include="true" />
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<Filter property="IgnoreCase" pattern="true" />
</SearchFilters>

Each filter has the following attributes:

property (string): Name of a Quantel database column. A special property= IgnoreCase
available to specify case insensitive or case sensitive searches.
pattern (string): Regular expression applied on the resulting property.
include (boolean): Action to take if the regular expression results in a match:
include=false, the hit is excluded from the search.
include=true, the hit is returned as part of the search.
The default example given above shall be interpreted as follows:

All clips stored in the Quantel database with Category=TEMPORARY CLONE are ignored.
Only clips in the Quantel database with a PoolID that matches the pool identity of the
corresponding video servers are returned.

All searches are case insensitive.

ScreenLL Connection String

Screen Lingualib Connection String, used by Media Administrator.

Name=myServerName; Type=ScreenlLL; Server=myMainServerlLocator;
BackupServer=myBackupServerLocator; ServerUsage=myServerUsageMode;
Config=myConfigFile.xml

Name: See Name in Standard Connection String Properties above.
Type=ScreenLL: Defines the Screen Lingua Lib search driver for clip handling.
Server=path: Defines where subtitle clips are located on the main subtitle server.

5.3

BackupServer=path: Defines where subtitle clips are located on the backup subtitle server, if

applicable.

ServerUsage=mode: Specifies how availability status is updated based on (main) server and

backup server clip status:
0: available if clip is present on main server.
1: available if clip is present on backup server.
2: available if clip is present on either main or backup server.
3: available if clip is present on both main and backup server.
Config=ClipServerScreenLL.xml

SimpleTestPlayer Connection String

The Simple Test Player can be used in Media Administrator for Viz Engine, see the example in
section Viz Engine connection string, below.

A Note: With the exception of testing purposes, this string provides no functionality with AV

Automation.
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The Clip File can contain Clip Element Attributes, often used for development of Viz Mosart
features.

The SimpleTestPlayer may be used in either of two modes:

File mode: A specified file contains clip metadata. The file is read at start-up and is
monitored for changes.

Folder mode: A specified folder contains actual clip files. The folder is read at start-up and is
monitored for changes.

File mode example:

Name=STP;Type=SimpleTestPlayer;File=D:
\DemoClip\DemoClip.xml;Config=ClipServerVizEngine.xml

Folder mode example:

Name=STP;Type=SimpleTestPlayer;Folder=D:\;Config=ClipServerVizEngine.xml

Connection String Properties

Type: SimpleTestPlayer
File: The clip metadata file (used in File mode). See below.
Folder: The clip folder (used in Folder mode)

Clip File

The file must be in this format:

<ClipDB>
<clips>
<clip slug="..." status="0" dur="..."/>
</clips>
</ClipDB>

Clip Element Attributes

Attribute Mandatory Value Comment
slug Yes String
status Yes 0 If missing or other value, the clip

is considered missing
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Attribute Mandatory Value Comment

dur Yes Positive integer Duration in frames. Should be
greater than the value of the
MinimumClipLength setting.

objid No String
description No String
mark_in No String
mark_out No String
pdur No String
statusdescription No String
rights No String
refid No String
timestamp No String
type No String
Mamld No String

Additionally, the ClipDB element may have a serverDown attribute. This is for testing purposes
only, and should not be used.

Configuration File Properties (Folder mode only)

InternalBufferSize: The size (in bytes) of the internal buffer. For details, see Microsoft's
article: InternalBufferSize.
IncludeSubdirectories: Whether subdirectories should be monitored
MedialnfoMethod: May have one of these two values:
Medialnfo (default): Use Medialnfo to retrieve clip file data
VDCPProxy: In this case, the 'clip files' are regarded as VDCP proxy files. For further
details, contact Viz Mosart Support, quoting MOSART-6143.
- SkipExtension: Whether the file extension is not to be part of the clip slug
- AlwaysGetDuration: Whether the actual clip duration is retrieved from the clip file
UseObjSlugAsServerld: Whether to use the slug as the server ID. (Otherwise, the path is
used.)
UseDurationAsMarkOut: Whether to set InPoint (=0) and OutPoint (=Duration) from Duration
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SQL Database Connection String

This connection string (in Media Administrator) is for the SqlMediaSearch driver, for reading clip
metadata from an RDBMS (Relational DataBase Management System) using SQL, and then
computing clip properties based on:

- SQL query results.
Existing clip properties (referred to as properties of 'the clip sent down to the
SqlMediaSearch driver').

It is assumed that

- All metadata resides in a single database table (the clip table).
- The metadata of a single clip is found in a single row (the clip row) in this table.

The driver is designed to be used in conjunction with one or more video servers, to provide
additional metadata about clips residing on the server(s). The presence of clip metadata in the
database is not considered proof of clip existence. Only clips that exist on a video server appear as
blue in the viz Mosart GUI.

Place this connection string above (for example, in Video clip Server 1) that/those of the video
server(s).

Applicable Models

The driver has been designed to interact with any RDBMS (Relational Database Management
System) using SQL. However, it has only been verified with following versions of Microsoft SQL
Server:

Microsoft SQL Server 2012 (SP1) - 11.0.3000.0 (X64)
Microsoft SQL Server Express (64-bit) - 11.0.2218.0

Device Prerequisites
Create a DB user with:

Read access to the table containing clip data.
No write or admin access. (As no attempts to prevent SQL injection have been done, this is
necessary to prevent unauthorized changes to the DB).

General Format

Name=DB; Type=SqlMediaSearch;ProviderName=System.Data.SglClient;Config=ClipServerSqgl.xml;D
bConnectionString="..."

Connection String Parameters

Name: See Name in Standard Connection String Properties above.

- Type: SqlMediaSearch.

- Config: See Viz Mosart Video Server Connection String above. A configuration file
ClipServerSql.xml is installed. Use the name of this file (ClipServerSql.xml unless changed).
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ProviderName: The 'invariant name' of a .NET Framework data provider. At least the
following providers are installed with the .NET Framework:

System.Data.SqlClient

System.Data.Odbc

System.Data.OleDb

System.Data.OracleClient.

Others may have been installed. Only System.Data.SqlClient has been verified.

DbConnectionString: The connection string (containing connection settings) sent to the
chosen provider. The format depends on the chosen ProviderName.

For System.Data.SqlClient (the only verified provider) the format is documented in https://
msdn.microsoft.com/en-us/library/
system.data.sqlclient.sglconnection.connectionstring(v=vs.110).aspx.

Quotes in the value have not been tested and may not work as expected.
FileClipProperties: Same as the ClipServerSql.xml parameter. As this is set

in ClipServerSql.xml, see below.

FileSelectStatements: Same as the ClipServerSqgl.xml parameter. As this is set

in ClipServerSql.xml, see below.

LogResult: Same as the ClipServerSqgl.xml parameter. As this is set

in ClipServerSql.xml, see below.

DefaultTableName: Same as the ClipServerSql.xml parameter. As this is set

in ClipServerSql.xml, see below.

MonitorFoundClips: Same as the ClipServerSql.xml parameter. As this is set in
ClipServerSql.xml, see below.

MonitorCliplinterval: Same as the ClipServerSql.xml parameter. As this is set

in ClipServerSql.xml, see below.

Example

Name=DB;Type=SqlMediaSearch;ProviderName=System.Data.SqlClient;Config=ClipServerSql.x
ml;DbConnectionString="Persist Security Info=True;Initial Catalog=HarrisDBTest;Data
Source=BGO-OFRENGINE\SQLEXPRESS;Failover Partner=aut-db-srv03.fs-
pn.vizrtnet.int\harris;User ID=test;Password=test;"

Configuration Files
There are three configuration files:

ClipServerSql.xml
SelectStatements.xml
ClipProperties.xml

When the Mosart Server is installed, these files are placed in the ConfigurationFiles sub-folder
of the installation folder. If any file shall be be changed, follow the standard procedure:
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Copy the file to c:\channeltemplates, and change the copy .

If you choose to change the name, you must also change (accordingly):
If the name of ClipServerSql.xml is changed: The Config connection string parameter.
If the name of SelectStatements.xml is changed: The FileSelectStatements parameter in
ClipServerSql.xml (below).
If the name of ClipProperties.xml is changed: The FileClipProperties parameter in
ClipServerSql.xml (below).

ClipServerSql.xml
This is the main configuration file for the driver. These configuration parameters are available:

FileClipProperties: The name of the file containing clip properties to be pulled from DB.
Default: ClipProperties.xml, as described below.

FileSelectStatements: The name of the file containing the SELECT statements to be used.
Default: SelectStatements.xml, as described below.

LogResult: Whether query results should be logged (in Media Administrator console and in
Viz Mosart log). Default true. Set to false if everything works fine, and the messages are
superfluous.

DefaultTableName: The name of the outer XML element shown when using LogResult. The
default (dummy) is usually OK.

MonitorFoundClips: Whether found clips should be monitored. Default true. If set to false,
missing or changed clips are not detected.

MonitorCliplInterval: If the value is X (and if MonitorFoundClips is true), each found clip is re-
queried every X seconds. Increase if DB traffic is too high.

DbConnectionString: Same as the connection string parameter; As this is set in the
connection string parameters, see above.

ProviderName: Same as the connection string parameter; see above. Should be set in the
connection string.

In addition, these 'common'/'standard' parameters are available:

SupportSearchUsingObjSlug: See General Configuration File Properties above.
SupportSearchUsingReflD: See General Configuration File Properties above.

SelectStatements.xml

If the name of this file is changed, the configuration parameter FileSelectStatements in
ClipServerSqgl.xml must be changed accordingly.

To further understand this configuration, please study the examples provided in the installed file.
This file defines the SQL SELECT statements that are executed when:

- The DB is queried for data on a single clip.
- The DB is searched for clips satisfying a given search criterion.

Each of these two SQL SELECT statements is defined by a SelectStatement element. For technical
reasons, the two SelectStatement elements are enclosed in a Statements element, which in turn is
enclosed in a SelectStatements element.

A SelectStatement element has these attributes:
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Attribute Value(s) Description

type Single/Multiple Distinguishing between the two types of
SQL SELECT statements.

database The DB name.
schema The schema name.
table The table name.

A SelectStatement element has these sub-elements:

Sub-element Description

SelectColumns The columns in the SELECT clause of the SQL
statement.

WhereColumn The WHERE clause column to be searched for the

(variable) search criterion.

AdditionalWhereColumns Additional WHERE clause columns being searched for
constant values.

The SelectColumns element has one or more SelectColumn sub-elements, each with these
attributes (and no sub-elements):

Attribute Value(s) Description

name The DB column name

type String/Int The DB column data type. For Microsoft SQL
Server,

String is used for char and varchar columns.
Int is used for int columns.
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Attribute Value(s) Description
format Default/ How a column value is to be interpreted:
HhMmSsFfPackedBCD

Default: The value is passed as is. (And this
is default, so it is used if no format attribute
is present.)

HhMmSsFfPackedBCD: The (four-byte) int
value is interpreted as the packed BCD
representation of a time code hh:mm:ss:ff.
This is converted to the total number of
frames. E.g., the int (decimal) 404310278 is
hex 18194906, corresponding to the time
code 18:19:49:06, in total 1649731 frames.

The AdditionalWhereColumns element has one or more WhereColumn sub-elements.

A WhereColumn element (either as a direct sub-element of SelectStatement, or as a sub-element of
AdditionalWhereColumns) has these attributes:

Attribute Value(s) Description Comment
name The DB column name
type String/Int The DB column data type. Only String has been

For Microsoft SQL Server, tested.

- String is used for char
and varchar columns.
Int is used for int

columns.
value The value to search for Used only for WhereColumn
elements which are sub-
elements of

AdditionalWhereColumns.

For the WhereColumn sub-
element of SelectStatement,
the value to search for is
given by context.
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Attribute Value(s) Description Comment

searchMethod BeginsWith/ How the column value Only IsEqualTo makes
IsEqualTo/EndsWith/  (c) is compared to the sense for Int.
Contains value to search for (s ):

EndsWith and Contains
IskqualTo: ¢ must be have not been tested.

exactly equal to s IsEqualTo has not been
BeginsWith: ¢ must tested for Int.

begin with s

EndsWith: ¢ must end

with s

Contains: ¢ must

contain s

ClipProperties.xml

If the name of this file is changed, the configuration parameter FileClipProperties in
ClipServerSql.xml must be changed accordingly.

To further understand this configuration, please study the examples provided in the installed file.

This file defines the clip properties computed by the driver. Each of these properties is defined by
a Property element. For technical reasons, the Property elements are enclosed in a Properties
element, which in turn is enclosed in a ClipProperties element.

A Property element has one attribute:

Attribute Description Comment

name The property name Only these have been implemented:

Description (the clip description as shown
in the GUI (if selected by the setting Video
clips should be presented with there))
InPoint (the clip in point as shown in the
GUI Preview window)

ObjSlug (the clip slug as shown in the GUI
Media pool Search tab)

OutPoint (the clip out point as shown in
the GUI Preview window)

A Property element has one sub-element, an expression. The principal feature of an expression is

that it may be evaluated to yield a value. There are four kinds of expression elements (so a
Property element has one of these as a sub-element):
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ClipExpressi
on

DbExpressio
n

ConstantEx
pression

OperationEx
pression

Description

The value of a ClipExpression depends only
on a property of the clip as sent down to
the SglMediaSearch driver.

The value of a DbExpression depends only
on the value of a column in the clip row (the
DB row pertaining to the clip).

The value of a ConstantExpression is (as
strongly indicated by the name) constant , it
depends neither on the clip as sent down to
the SglMediaSearch driver, nor on the DB.

An OperationExpression is used to combine
other (simpler) expressions by performing
an operation, which means applying an
operator to the values of its operands (sub-
expressions). Each operand/sub-expression
may be of any of the four kinds of
expression listed in this table. In particular,
OperationExpressions may be nested to any
depth.

A ConstantExpression element has one attribute:

Attribute

value

Both a ClipExpression and a DbExpression has two attributes:

Attribute

name

default

Description

Viz Mosart Administrator Guide - 5.3

Comment

The clip properties available
depend on the video server
driver(s) used together with
SqlMediaSearch. Only the BasePoint
property (start timecode in frames,
available for the HarrisNexio
driver) has been tested.

The column has to be defined by a
SelectColumn element as
described in the
SelectStatements.xml section
above.

ConstantExpressions were
introduced for internal purposes,
and have not been real-life tested.

The (constant) value of the ConstantExpression

Description

See table below

The value to be used if evaluating the expression as described in
the table below doesn’t make sense in the given context
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The name attribute and expression evaluation is described in more detail for each of the two kinds

of expressions:

Expression Description of the Expression value

kind name attribute

ClipExpression  The name of a clip The value of the
property property for the given

clip

DbExpression The name of a The value of the
column in the DB clip  column for the clip
table row

An OperationExpression element has one attribute:

Attribute Value(s) Description

operator Minus/Plus The operator to be applied to
the values of the operands.
Details are given in the table
below.

An OperationExpression element has one sub-element: Operands.

attributes, but any number of expression sub-elements, meaning

Comment

Only the BasePoint property
(start timecode in frames,
available for the HarrisNexio
driver) has been tested.

The column has to be
defined by a SelectColumn
element as described in the
SelectStatements.xml section
above.

Comment

Both operators make sense for
numerical arguments only, and
have been implemented for
integer arguments only.

An Operands element has no
any number of ClipExpression,

DbExpression, ConstantExpression, and OperationExpression sub-elements.

These sub-elements are the operands / sub-expressions of the OperationExpression.

Some further details on each operator:

Operator Expression value

Minus If there is one operand, the negation

of the value of that operand. If

there are two (or more) operands, the difference between the values
of the first operand (minuend) and the second operand (subtrahend).

Plus For any number of operands, the sum of the values of the operands.
(As a special case, the ‘sum’ of no operands is zero. However, the
Operands sub-element itself must be present.

so <ConstantExpression value=0 />
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VDCP Connection String

The VDCP driver supports both serial and TCP as transport. Video Disk Communications Protocol
(VDCP) is also known as Louth protocol. The driver can be configured to run in eight character or
variable character mode. (See the UseLongClipNames setting below.)

& Note: Standard VDCP does not support looping of clips. For a very limited number of
servers, a customized solution has been introduced to support looping over VDCP, if
described in the server model's configurations.

Applies to Models

Dalet BRIO
Dayang VIPS-2H-4XHD
EVS XT-VIA
Ross Blackstorm
- Vector MultiPlay VServer

Device Prerequisites - VDCP

Dalet BRIO
- Single VDCP connection configuration per port - does not support multiple control
ports per connection.
- Only clips in folders added to the BRIO VDCP configuration are visible for Viz Mosart
to monitor and play-out.
Duration of video files is only available if the VDCP connection is configured to use a
physical play-out port.
Dayang VIPS-2H-4XHD
For Media Administrator to function correctly, the Dayang server must be configured
so that a dedicated signal port is available for media search. Viz Mosart Support does
not have details about this procedure and recommends consulting Dayang.

Connection String Properties - VDCP

- Type: VDCP (serial) or VDCPtcp (Ethernet).
For Dayang, only VDCP (serial) has been tested.
Name: See Name in Standard Connection String Properties above.
- Server: Hosthame or IP-address of the server (for Type=VDCPtcp only).
Port:
- Serial port (Type=VDCP, Default: COMT)
- Server side TCP port to connect to (Type=VDCPtcp, Default: 5205).
LoadDatabase: If true, builds internal database of clips present on server and enables clip
monitoring (Default: false).
- Config: Name of the configuration file. At installation the file ClipServerVDCP.xml is
copied to the ConfigurationFiles subfolder of the installation folder. Unless you rename this
file, use Config=ClipServerVDCP.xml. (You may need to copy and rename if you have several
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VDCP servers which should be configured differently.) This file may be taken as a starting
point for custom configuration, See Configuration File Properties - VDCP below.

DisableHeartbeat (boolean): Whether the 'Ping' operation (see NextPingDelay above) is just a

simple connection check. If false, the Ping operation sends a command to the server. For
some servers, this is necessary to prevent the server from closing the connection. This
applies to at least the Ross Blackstorm server.

NoOfPlayers: The number of signal ports on the server to be made available to the program

(AV Automation or Media Administrator). (The ports are numbered consecutively from 1
upwards.) Default 5. (So then ports 1-5 are available.) Use a larger value if you need to
control a signal port with a number greater than 5.

(MediaAdministrator and Dayang only) PlayerToOpen: The number of the dedicated signal
port available for media search. If this number is greater than 5, the NoOfPlayers must be
set to at least this number.

& Note: There have been known issues with this vendor's implementation of the VDCP

protocol. Vizrt recommends that you consult Dayang if there are issues where the
video server seems to require an open port to respond to ID List command.

Examples
AV Automation: VDCP (serial)

Type=VDCP; Name=Serverl; Port=COM1l; Config=ClipServerVDCP.xml

AV Automation: VDCPtcp (Ethernet)

Type=VDCPtcp; Name=Serverl; Server=192.168.42.42; Port=10001;
Config=ClipServerVDCP.xml

AV Automation: Dayang

Name=DY1;Type=VDCP;Port=COM4

Please see the Note below.
Media Administrator: VDCP (serial)

Type=VDCP; Name=Serverl; Port=COM2; LoadDatabase=true; Config=ClipServerVDCP.xml

Media Administrator: VDCPtcp (Ethernet)

Type=VDCPtcp; Name=Serverl; Server=192.168.42.42; Port=10002; LoadDatabase=true;
Config=ClipServerVDCP.xml
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Media Administrator: Dayang

Name=DY1;Type=VDCP;Port=COM3;Config=ClipServerVDCP.xml;LoadDatabase=True;NoOfPlayers=
101;PlayerToOpen=101

& Note: For Dayang, different COM ports should be used for AV Automation and Media
Administrator

Configuration File Properties - VDCP

DefaultRecordingLength (integer): Default duration of recorded video files in frames
(Default: 1000).

DelayGetClipDuration (Boolean): Enable to build the initial playlist without getting the file
duration (Default: false).

IgnoreClipExistence (Boolean): Enable to ignore requesting clip presence on the server. This
should be set to false in the configuration file used by AV Automation (Default: true).
LogMessages (Boolean): If true, log any messages that are sent and received. Verbose
logging must be activated for this to have effect (Default: false).

MaxClipList (integer): The maximum amount of clips to hold in cache. When this limit is
reached, there are no more clips added to the cache. Setting this to a low value reduces load
time, but might cause invalid clip status if non-cached clips are in the rundown.

- ClipListChangeslinterval: The interval, in seconds, to poll for clip list changes (added/deleted
clips) on the Media Admin server (Default=30). See also UseAddedClipsCommand.

Requires LoadDatabase=true (set in connection string) and UseAddedClipsCommand=true.
DelayUpdateClipsMsec: Delay, in milliseconds when to trigger a clip update after retrieval of
clips. Used when obtaining multiple clips when loading and updating the database
(Default=5000).

Requires LoadDatabase=true (set in connection string) and DelayGetClipDuration=false.
DelayLoadDatabaseMsec: Delay in milliseconds for delaying loading the database after
connecting to the server (Default=5000).

Requires LoadDatabase=true (set in connection string).

RequestPortStatus123 (Boolean): Whether to request more status from the VDCP server. May
safely be left at false for normal production. Change to true for debugging purposes if
advised to by Vizrt Support.

- SendStillWhenCueDone (Boolean): When the server has cued a clip, whether to send a
command making sure that the first frame is shown on the server output. Change to true if
supposedly cued clips are not shown on the server output.

- SendStopBeforeCueing: Whether a Stop command is always sent before cueing a clip.
Change to true if cueing problems are encountered, in particular when cueing/playing adlibs
back-to-back (Default=false).

- StopShouldCheckForldle (Boolean): Whether stopping a clip should make sure that the port is
idle. Change to true if cueing problems are encountered.
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- TimeoutPlay (integer): The time (in ms) for the server to acknowledge that it is playing the
cued clip. Used only if VerifyPlay is true (or if EnableLoopingDaletBrio is true, and the cued
clip should loop).

UseAddedClipsCommand (Boolean): Enable to retrieve a list of new files added to the video
server.

UseFixedPortStatusBitMap (Boolean): Whether to force Mosart to use a fixed bit map when
requesting port status. Change to true for new installations. In general, CHANGE the value if
problems are encountered, in particular problems related to cueing.

UselnternalPlayerState (Boolean): Enable to ignore requesting presence of the clip on the
play-out device using the ID REQUEST message.

UseLongClipNames (Boolean): If true, use messages supporting variable length file names
(maximum length 80 characters). If false, use fixed eight character files names padded with
spaces if less than eight characters.

- VerifyPlay (Boolean): Whether to verify that the server is actually playing.

- WaitTimeoutPlay (Boolean): The time (in ms) to wait between each server playing status
polling. Used only if VerifyPlay is true (or if EnableLoopingDaletBrio is true, and the cued clip
should loop).

Configuration File Properties - Dalet BRIO only
The following properties are used for the looping functionality of the Dalet BRIO:

EnableLoopingDaletBrio (Boolean): Whether to enable the looping mechanism for Dalet
Brio. Set to true only if this file is for a Dalet BRIO, and you want looping (Default: false).

- TimeoutDaletBrioLoop (Boolean): The time (in ms) to wait for the server to acknowledge that
looping has been turned on/off.

- WaitTimeoutDaletBrioLoop (Boolean): The time (in ms) to wait between each server looping
status polling.

Viz Engine Connection String

Viz Engine Connection String, used by Media Administrator and AV Automation.

Connection String Properties

- Type:
For AV Automation: VizEngine.
For Media Administrator: SimpleTestPlayer.
Name: See Name in Standard Connection String Properties above. Defines the ID of this
connection.

- Server: Defines the hostname or IP-address of the server (for Type=VizEngine only).
Port: Defines the port.

- Config: Defines the name of the configuration file.

Folder: Location of the Viz Mosart configuration files. Either in %ProgramFiles (x86)%
\Mosart Medialab\Mosart Server\ConfigurationFiles or with the video
configurations in C:\channeltemplates .
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Examples

Connection string for Integrated Engine (Viz Engine connection in AV Automation):
Type=VizEngine;Server=localhost;Config=VizEngineSwitcherConfig.xml (Port=6100
is optional)

Connection string for Video Server (Viz Engine connection in AV Automation):
Name=Vizrt;Type=VizEngine;Server=1localhost;Port=6100;Config=
ClipServerVizEngine.xml

Connection string for Media Administrator:
Name=VizEngine;Type=SimpleTestPlayer;Folder=D:

\ ;SkipExtension=true;Config=ClipServerVizEngine.xml

Configuration File Properties

- AlwaysGetDuration (Default: false):
- When false, only files in the active Viz Mosart rundown get the actual video duration.
- When true, get the video duration from all files in the monitored folder. Note that
setting this value to true impacts the startup time of the SimpleTestPlayer driver in
Media Administrator for folders with a large number of video files.

Viz One and Media Service Connection String
This connection string is used by Media Administrator for Viz One and Media Service.

Viz Mosart can search for clips in Viz One and initiate transfer of Viz One clips to a specified
playout storage. The driver uses the REST-based Viz One Third party API to execute tasks.

Device Prerequisites (Viz One)
For further details, please consult the Viz One Administrator Guide.

At least one Viz One user at least one publishing point must be configured.

Connection String Properties

Naming Examples Description

Name VizOne Name of connection. Must be same as
VizEngine Name of the video server in AV
MediaSearch Automation.

See Name in Standard Connection String
Properties above.
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Naming

Type

UserName

Password

Server

PublishingPoints

ValidDuration

AutoTransfer

Examples

VizOne

vizmse

vizmse

10.211.112.213
bgogavizone

vve2-1
vizengine-1
MediaService

26

true
false
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Description

Type of connection. Must be VizOne to use
the Viz One Clip Administrators.

Viz One only

Username for user that connects to third
party API.

Please look at separate section in this
document on how to create a dedicated
user for Viz Mosart to access Viz One.

admin as username and password may be
used for testing, but should not be set in
production.

Viz One only
Password for user that connects to third
party API

IP address or host name of Viz One server

A publishing point is a playout storage
defined in Viz One. This can be accessed
through Administration menu on the Web
interface.

Comma separated list of publishing point
identifiers where the clip administrator
should ensure assets are present.

If MediaService is specified for
PublishingPoints, Media Service and not
Viz One is used to search for clips.

Viz One only

Duration for which an asset should be
present on the publishing point from time
of transfer. Value is in hours.

Default: 24

Viz One only

true: Any assets in the playlist that is
present in Viz One, but not on the
publishing points will be transferred.
false: Assets are marked as not present.
true is default value.
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Naming Examples Description
PublishingPointAsObjld  true true: An Objectld will be set for each
false publishing point as well as Name from

connection string (an additional server ID
is set for each publishing point).

false: Use Name from connection string as
Objld (only one server ID is set: for Name).
false is default and most common.

Port 21099 Media Service only
MediaService requires port to be specified.
Default port is 271099 for MediaService.
See also Configure Media Service section
in the Media Service guide.
(Viz One does not require this field).

Config ClipServerVizOne.xml Name of configuration file located in
ChannelTemplates folder.
See also Standard Video Server Connection
String.

Example (Media Service)

Name=VizEngine; Type=VizOne; Server=localhost;Port=21099;PublishingPoints=MEDIASERVICE; Conf
ig=ClipServerVizOne.xml

Example (Viz One)

Name=VizOne;Type=VizOne;UserName=username;Password=password;Server=10.211.112.21
3;PublishingPoints=vizengine-1;ValidDuration=26;AutoTransfer=true;PublishingPoin

tAsObjId=false;Config=ClipServerVizOne.xml

& Note: The differences between ClipServerVizEngine.xml and ClipServerVizOne.xml is that
the first one handles video server in configuration Av Automation and second is only for
establishing clip searches in Media Administrator.

14.2 Video Wall Connection Strings

Video wall connection strings are used by AV Automation. This section contains Connection String
types.
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& Note: For general information on connection strings, see Video Server, MAM and Database
Connection Strings.

14.2.1 Watchout Connection String
This connection string is used for WATCHOUT video walls.

Modes of Operation

The driver may operate in any of three different modes. (For the sake of simplicity, assume that at
least two commands are to be performed in one operation).

default: A driver operation sends the commands one after the other. It waits for WATCHOUT
to respond finally (or time-out) before sending the next command. If a command fails, the
rest is skipped. The advantage is that when the driver operation finishes, the entire
operation is complete (or has failed). However, as driver calls may arrive in different threads,
and therefore simultaneously or overlapping, problems may occur. (The driver is made for
performing (sending and feedback-waiting) one command at a time.)
SequenceRecallAndMixes: A driver operation queues the commands to be performed as a
unit (without interference from other such units), possibly at a later time. The problem
mentioned above is solved, however at the cost of the driver operation possibly finishing
before the commands are complete.

SequencelndividualCommands: A driver operation queues the first command (to be
performed without interference from other commands). If successful, the next command is
queued, and so on. This may be useful if WATCHOUT is able to keep several shows loaded at
the same time (and is able to use the run timeline argument to choose between them).

Examples

AV Automation Connection String:

AuthenticateTimeout=[authenticateTimeout] ;BufferSize=[bufferSize] ;BusyNonCommandTimeo
ut=[busyNonCommandTimeout] ;BusyTimeout=[busyTimeout];GetStatusThreshold=[getStatusThr
eshold] ;LoadTimeout=[loadTimeout];PingInterval=[pingInterval];PingTimeout=[pingTimeou
t];Port=[port];ReconnectInterval=[reconnectInterval];ResetAnyway=[resetAnyway] ;ResetT
imeout=[resetTimeout] ;RunTimeout=[runTimeout] ;SequencelndividualCommands=[sequenceInd
ividualCommands] ;SequenceRecallAndMixes=[sequenceRecallAndMixes] ;Server=[server];UseG
etStatus=[useGetStatus]

Example:

Server=192.168.97.129;AuthenticateTimeout=200;RunTimeout=40
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Connection String Properties — Watchout

String

AuthenticateTimeout

BufferSize

BusyNonCommandTim
eout

BusyTimeout

GetStatusThreshold

LoadTimeout

PingInterval

Type

integer>0

integer>0

integer>0

integer>0

integer

integer>0

integer>0

Description Default

The time (in ms) allowed for 2000
WATCHOUT to process an

authenticate command and

respond with Ready.

The maximum number of bytes 1024
to receive from WATCHOUT at a

time.

Should be set at least as large as

the longest conceivable

WATCHOUT response.

The time (in ms) allowed for 10000
WATCHOUT to return to normal

operation after a non-command

Busy.

The time (in ms) allowed for 60000
WATCHOUT to increase the % of
otherwise equivalent Busy

responses.

The highest acceptable value of 1 (Suboptimal)

the third parameter of the Reply
feedback to the getStatus
command

General health status of the
cluster:

0: OK

1: Suboptimal
2: Problems
3: Dead

The time (in ms) allowed for 10000
WATCHOUT to process a load

command and respond with

Ready.

The time (in ms) between ping 10000
commands sent to WATCHOUT.
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String Type Description Default

PingTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a ping
command and respond with

Ready.
Port integer>0 The port to connect to. 3039
ResetAnyway true/false Whether reset commands are false

always sent before run
commands even if not present in
the RecallAndMix argument.

ResetTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a reset
command and respond with
Ready.

RunTimeout integer>0 The time (in ms) allowed for 10000
WATCHOUT to process a run
command and respond with
Ready.

Reconnectinterval integer>0 The amount of time (in ms) to 10000
wait to reconnect after a failed
connect or authenticate.

SequencelndividualCo true/false Whether the driver should false
mmands operate in that mode. Has no
effect when
SequenceRecallAndMixes=true.

SequenceRecallAndMix  true/false Whether the driver should false

es operate in that mode.

Server string The DNS name of WATCHOUT. localhost
UseGetStatus true/false Whether the Ping operation false

should use the getStatus
command instead of the ping
command.
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15 Device Configuration Files

The device configuration files are located in the following directory: %ProgramfFiles(x86)%\Mosart
Medialab\Mosart Server\ConfigurationFiles.

A Note: Do not modify any files at this location, as they are overwritten by the next
installation. Copy any files that must be modified to the " %ProgramData%\Mosart

Medialab\ConfigurationFiles" directory, and modify them there. This ensures that
configurations remain valid after system upgrades or downgrades. Note that historically,
C:\channeltemplates has been the folder to copy to, but with a few exceptions, Viz

Mosart applications will look in %ProgramData% before checking C:\channeltemplates
for configuration files.

(® Name of the configuration file(s)

In the following sections, the configuration files are shown with their default names. For
some device types it is possible to specify a different configuration file name in the device
connection string.

This makes it possible to use different configurations for various devices of the same type,
for example when you have two slightly different settings for two video servers of the
same type and brand.

There must be a 1:1 match between the name of the configuration file and the name
referred to in the device connection string.

This section contains the following topics:

Robotic Camera Configuration Files
Graphics Configuration Files
Subtitling Configuration Files

- Video Router Configuration Files

- Audio Mixer Configuration Files

- Vision Mixer Configuration Files
Engine Switcher Configuration

Information about Video Server Configuration Files is in section, Video Server, MAM and Database
Connection Strings.

15.1 Robotic Camera Configuration Files
This section contains the Robotic Camera types:

Shotoku

FxMotion

Vinten 200 Radamec
Cambotics Configuration File
Cinneo Configuration File
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- Technodolly Configuration File
Panasonic (serial) Configuration File
Panasonic TCP Configuration File
Electric Friends Configuration File

All configuration files are by default stored at C:\Program Files (x86)\Mosart

Medialab\Mosart Server\ConfigurationFiles)\ . Please refer to the Note in Device
Configuration Files for information on copying the files before changing.

15.1.1 Shotoku

Specific Shotoku parameters are found in RoboticCameraConfiguration.xml.

You can control behavior of the connection to Shotoku when switching Viz Mosart from main to
backup, or at an AVA restart. Ensure the following properties are managed in the configuration
file:
ShotokuForwardStandbyCommands (boolean) - If set to true, standby state will be forwared
to Shotoku controller. Default false.
ShotokuDisableHeartbeat (boolean) - If set to true, the heartbeat mechanism is disabled.
Default true.
ShotokuDisconnectinStandby (boolean) - If set to true, disconnect controller when in
standby. Default false.

The above settings govern the two situations:

1. Whether the sending of a disable command (when AVA restarts or when the active Mosart
server is switched) to the Shotoku controller will block all automation commands until an
enable command is received.

2. Whether instead of timing-out, Mosart shall stay connect to the Shotoku controller when in
standby/idle.

In addition, the HeartbeatInterval property also applies to Shotoku. Refer to the configuration
for file for information.

15.1.2 FxMotion

Specific FxMotion parameters are found in RoboticCameraConfiguration.xml . Refer to the
configuration for file for information.

Heartbeatlnterval
FxMotionReceiveTimeout

15.1.3 Vinten 200 Radamec

Specific Vinten 200 Radamec parameters are found in RoboticCameraConfiguration.xml.
Refer to the configuration for file for information.

Heartbeatlnterval
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Vinten200ShowfFilterValue
Vinten200DisconnectInStandby
Vinten200MinSendInterval

15.1.4 Cambotics Configuration File

The integration between Viz Mosart and Cambotics Camera Robotics Control Systems supports
moving to a stored position. Camera Robotics control is handled by AV Automation.

For details on the Cambotics (Ross CamBot) Protocol, refer to the product documentation written
by Ross Video (www.rossvideo.com).

The Cambotics configuration file is located in the program-folder under \Mosart
Medialab\Mosart server\ConfigurationFiles\CamboticsConfiguration.xml.
The following configurations are available:

Heartbeat: (keep connection alive) interval: Default 2000 ms.
Connection timeout: Default 1500 ms.

ConnectionAttempts: Default 5 tries.

ConnectionDelay: Default 60000 ms.

& Note: To integrate with Cambotics (Ross Cambot) Camera Robotics, you must also
configure it in Camera Robotics. Select the router protocol CAMBOTICS, set the IP

address of the camera controller, and the Port number (default is set to 2050 ).

& Note: For more information on setting up templates for Cambotics, see the section
on Robotic Camera Control in the Viz Mosart User Guide.

15.1.5 Cinneo Configuration File

Cinneo configuration is contained within the general device configuration file DeviceConfig.xml.

<item name="cinneoSceneFileTimeout" value="30000" />

cinneoSceneFileTimeout: The value is given in milliseconds.

15.1.6 Technodolly Configuration File

The Technodolly configuration file is named TechnodollyConfig.xml.

<DeviceConfig name="TechnodollyConfiguration" connectionString="1localhost">

<Properties>
<!-- Connection parameters, may be overridden -->

<item name="Port" value="15243" />
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<item name="HeartbeatInterval" value="20" />
<item name="MaxQueuelLength" value="2" />
<item name="ProtectInPreview" value="cut,move" />
<item name="ProtectInProgram" value="-" />
</Properties>
</DeviceConfig>

Port: Contains the default value, it is not used.

HeartbeatInterval: Defines how often Viz Mosart should check if the connection to
Technodolly is OK. The value is given in seconds.

MaxQueuelength: Restricts queuing of commands to Technodolly. A value of 1 means only

one prepare or one run. A value of 2 means one prepare and/or one run. A value greater

than 2 means no queuing restrictions.

ProtectinPreview: Defines which commands should not be sent to Technodolly in preview
when a mixer cross-point is protected. Valid values are "-" for none, "cut" for prepare, "move"
for run, and "cut,move" for both prepare and run.

ProtectinProgram: Defines which commands should not be sent to Technodolly in program
when a mixer cross-point is protected. The values have the same meaning as for
ProtectinPreview.

15.1.7 Panasonic (serial) Configuration File

The Panasonic configuration file (used for PANASONIC and PANASONICNEW) is named
PanasonicConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PanasonicConfiguration">
<Properties>
<!-- Connection parameters, may be overridden -->
<item name="HeartbeatInterval" value="2000" />
<item name="DisableHeartbeat" value="false" />
</Properties>
</DeviceConfig>

Heartbeatinterval: Time between heartbeats, in milliseconds. Integer >= 0. Default = 2.

DisableHeartbeat: If false, heartbeats are sent. This checks the connection and sends a keep
alive message to the controller. If true, no heartbeats are sent. Default = False.

15.1.8 Panasonic TCP Configuration File

The Panasonic TCP configuration file is named PanasonicTcpConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PanasonicConfiguration" connectionString="localhost">
<Properties>
<!-- Connection parameters, may be overridden -->

Copyright © 2023 Vizrt Page 476



Viz Mosart Administrator Guide - 5.3

<!--Whether to disable pings. If true, pings are still sent if no response is
received for a request.-->
<item name="DisablePing" value="false" />

<!--The path component of the Request-URI. Do not change.-->
<item name="Path" value="cgi-bin/aw_cam" />

<!--Time between pings in ms-->
<item name="PingInterval" value="2000" />

<!--In case of connection loss, a ping will be sent after this many ms-->
<jitem name="ReconnectInterval" value="1000" />

<!--The number of ms to wait for a response for a Ping command-->
<item name="TimeoutPing" value="500"/>

<!--The number of ms to wait for a response for a SelectPort command-->
<item name="TimeoutSelectPort" value="10"/>

<!--The number of ms to wait for a response for a PlayPreset command-->
<item name="TimeoutPlayPreset" value="10"/>
</Properties>
</DeviceConfig>

DisablePing: Whether to disable pings. If true, pings are still sent if no response is received
for a request.

Path: The path component of the Request-URI. Do not change.

Pinginterval: Time between pings in ms.

Reconnectinterval: In case of connection loss, a ping will be sent after this many ms.
TimeoutPing: The number of ms to wait for a response for a Ping command.
TimeoutSelectPort: The number of ms to wait for a response for a SelectPort command.
TimeoutPlayPreset: The number of ms to wait for a response for a PlayPreset command.

15.1.9 Electric Friends Configuration File

The configuration file for Electric Friends should be saved as ElectricFriendsConfiguration.xml
normally stored in C:\ChannelTemplates

& Note: For more information on setting up templates in AV Automation, see the section on
Robotic Camera Control in the Viz Mosart User Guide.

Example configuration:

{{
<?xml version="1.0" encoding="UTF\-8"?>}}{{
<DeviceConfig name="ElectricFriendsConfiguration" connectionString="1localhost">}} {{
<Properties>1}} {{
<!\-- Connection parameters, may be overridden \-->}1} {{
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<item name="HeartbeatInterval" value="2000" />}} {{
<I\-- Time between heartbeats in ms \-->}1} {{
<item name="PollDataInterval" value="10000" />}} {{

<!\-- Time between renewing list of shows, cameras and shots, in ms \-->}} {{

<item name="UseJsonWorkaround" value="true" />}} {{

<I\-- Early development. Timed move command needs a workaround for correct

response to server. Please let the value remain true \-->}} {{
<item name="PollRunningStatus" value="200" />}} {{

<I\-- Time between polls in ms. This will check to see if camera movement is

finished before starting a new move \-->3}3} {{
<item name="PollTimeout" value="5000" />}} {{

<!\-- Time the poll 1is allowed to run before dignoring the play command, in ms

\-—>}1 {{
<item name="DefaultPort" value="9000" />}} {{

<I\-- If no port 1is set, use this value. The ElectricFriends default port is

9000 \-->}} {{
</Properties>}}{{
</DeviceConfig>}}

15.2 Graphics Configuration Files

This section contains the graphics type:

Pixel Power Control Center (PPCC) Configuration File
Pixel Power (Clarity) Configuration File

Vizrt Graphics Configuration File

Vizrt Media Sequencer VDom Logic Macros

Chyron Configuration File

Deko, Orad, Xpression Configuration File

15.2.1 Pixel Power Control Center (PPCC) Configuration File

The PPCC configuration file is called PPCCConfiguration.xml|

<?xml version="1.0" encoding="utf-8" ?>

<DeviceConfig name="PixelPowerConfiguration" connectionString="1localhost:0">

<Properties>
<!-- Default channel nubmer to use -->
<item name="SystemNumber" value="1"/>
<item name="ClientApplication" value="Overlay Graphics"/>
<item name="ClientName" value="Vizrt Mosart"/>
<item name="DefaultOverlaysTriggerCount" value="2"/>
<item name="EnableOutputBlackOnTakeOut" value="true"/>
<item name="PreventPreloadOverlayIfItemsAreOnAir" value="true"/>
<item name="RundownPrefix" value=""/>
<item name="ConvertStoryIdToDecimal" value="false"/>
<item name="ConnectedWhenIdle" value="false" />
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<item name="ConnectedWhenInStandBy" value="false" />
</Properties>
</DeviceConfig>

Properties

DefaultOverlaysTriggerCount: Number of triggers used for take-in and take-out from PPCC in
overlays.

EnableOutputBlackOnTakeOut: True if OutputBlack should be sent when continue points still
exist on item.

PreventPreloadOverlaylfltemsAreOnAir: Will prevent selecte page of next overlay if the
engine currently has items on air (only overlays).

RundownPrefix: The prefix to be used in the rold of the commands. (The same as set in the
mosconfig.xml file in the Avid MOS Gateway.

ConvertStoryldToDecimal: Specifies whether the story id should be converted from Hex to
Decimal value.

ConnectedWhenldle: This value determines if the connection to the graphic devices are
maintained while Viz Mosart Server is in Idle mode.

True = Maintain connection to graphic devices while in Idle mode. This setting will also
initialize a connection to devices if Viz Mosart Server is started in Idle.

False = Do not start/maintain connection while in ldle mode.

ConnectedWhenlInStandBy: This value determines if the connection to the graphic devices are
maintained while Mosart is in Standby mode.

True = Maintain connection to graphic devices while in Standby mode. This setting will also
initialize a connection to devices if Mosart is started inStandby.

False = Do not start/maintain connection while in Standby mode.

A Note:
- You can specify Channel on the PPCC for each PPCC engine in AV Automation and

Overlay Graphics.

This channel will only be used for OutputBlack messages (clearing an engine).

It's possible to define multiple channels using both comma and semicolon as

separator.

Be aware that the channel will be cleared on the PPCC regardless of the connection

information.

For example, clearing channel 1 clears all graphics on this channel.

15.2.2 Pixel Power (Clarity) Configuration File

The Pixel Power (Clarity) configuration file is named PixelPowerConfiguration.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="PixelPowerConfiguration" connectionString="1localhost:0">
<Properties>
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<!-- Connection parameters, may be overridden -->

<item name="Server" value="localhost" /> <!-- Not in use -->

<item name="Port" value="10220" /> <!-- Not in use -->

<item name="DefaultTakeOutPage" value=""/> <!-- Not in use -->

<item name="OQutputBlack" value="false"/> <!-- Not in use -->

<item name="JobPath" value="c:\Pixel_Power\Jobs\"/> <!-- Not in use -->
<item name="Extension" value=".pjz"/>

<item name="LowPageRange" value="1-999"/> <!-- Not in use -->

<item name="FullScreenPageRange" value="1000-1999"/>
<item name="CgPageRange" value="2000-9999"/>
<item name="ClarityProtocolVersion" value="1.0"/>
<item name="UseAsUpdateJob" value="false"/>
<item name="CreatePageMode" value="true"/>
<item name="WaitHandle" value='"2000"/>
<item name="HeartbeatInterval" value="10"/>
<item name="PathCriteria" value=":"/>
<item name="DisableAVAutomationLoadJob" value="true"/>
<item name="DefaultOverlayPage" value="999" />
<item name="UseDefaultPageChannel" value="true" />
<item name="WaitForStories" value="3000"/>
<item name="AskPageInfo" value="false"/>
<item name="AskPageImage" value="false"/>
<item name="AskFieldInfo" value="false"/>
<item name="ConnectedWhenIdle" value="false" />
<item name="ConnectedWhenInStandBy" value="false" />
</Properties>
</DeviceConfig>

& Note: Items that are no longer supported for Viz Mosart’s Pixel Power implementation are
noted with <!-- Not in use -->.

Properties

Extension: The file extension for the Pixel Power job to be loaded.

FullScreenPageRange: Defines the range of Pixel Power page numbers used by Viz Mosart for
full screen pages.

CgPageRange: Defines the range of Pixel Power page numbers used by Viz Mosart for CG
(lower third) pages.

UseAsUpdateJob: Set if Pixel Power is to treat the loaded job as an update job.
CreatePageMode: Informs Pixel Power to create the page from Viz Mosart or not.
WaitHandle: Defines how long Viz Mosart should wait before removing a layer from the cued
page after sending a trigger animation char command to Pixel Power.

Heartbeatinterval: Defines how often Viz Mosart should check if the connection to Pixel
Power is valid. The value is given in seconds.

PathCriteria: Defines criteria that must be met (if any) for a job path to be valid.
DisableAVAutomationLoadJob: If this value is set to true, only Overlay Graphics will load jobs
on Pixel Power. Note that the current implementation will not handle other job/page logic
from AV Automation (such as delete pages). This value is expected to be true.
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DefaultOverlayPage: Defines the overlay page to use as default on which to add layers to.
This is the CG page that will be transferred on taking overlay graphics.
UseDefaultPageChannel: Lets the pages created use the default page channel defined in
Pixel Power. If set to false, the pages created will use the channel defined in engine settings.
WaitForStories: Defines how many seconds Viz Mosart should wait for a story before deleting
old/non-existing pages (handles shortcut keys from Viz Mosart GUI).

ConnectedWhenldle: This value determines if the connection to the graphic devices are
maintained while Mosart is in Idle mode.

True = Maintain connection to graphic devices while in Idle mode. This setting will also
initialize a connection to devices if Mosart is started in Idle.

False = Do not start/maintain connection while in ldle mode.

ConnectedWheninStandBy: This value determines if the connection to the graphic devices are
maintained while Viz Mosart is in Standby mode.

True = Maintain connection to graphic devices while in Standby mode. This setting will also
initialize a connection to devices if Viz Mosart is started in Standby.

False = Do not start/maintain connection while in Standby mode.

AskPagelnfo: Defines whether Viz Mosart requests Pixel Power for page info when creating a
page.

AskPagelmage: Defines whether Viz Mosart requests Pixel Power for page image when
creating a page.

AskFieldInfo: Defines whether Viz Mosart requests Pixel Power for a pages field info when
creating a page.

A Note: It is not necessary to ask for the last three items when creating a page.

15.2.3 Vizrt Graphics Configuration File

The Vizrt Graphics Configuration file is named VizrtGraphicsConfiguration.xml.

<?xml version="1.0" encoding="utf-8" ?>
<DeviceConfig name="VizrtGraphicsConfiguration">
<Properties>

<item name="default_effect_dsk" value=""/>
<item name="default_effect_wall" value=""/>
<item name="default_effect_fulll" value=""/>
<item name="allowUpdateOfOnAirItems" value="true"/>
<item name="RemoveUnusedChannelsOutputs" value="true"/>
<item name="SetConceptOnOutputChannel" value="true"/>

<item name="TakeInCommand" value="" />
<item name="TakeOutCommand" value=""/>
</Properties>
</DeviceConfig>
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Properties

& Note: For a complete list of available properties, refer to the comments in
VizrtGraphicsConfiguration.xml. This file is usually located under folder C:
\channeltemplates.

default_effect_dsk: Default effect to be used on the dsk handler (must be lower case)
default_effect_wall: Default effect to be used on the wall handler (must be lower case)
default_effect_full1: Default effect to be used on the fullscreen graphics engine 1 (must be
lower case)
allowUpdateOfOnAiritems: Allows an item to be updated even if it is onair (default = true)
RemoveUnusedChannelsOQutputs: When enabled, MSE Mosart Profile will synchronize to the
Overlay Graphics Configuration, i.e. all outputs that are not used in Viz Mosart will be
deleted. (default = true)
SetConceptOnOutputChannel: Current Concept Override functionality sets a context
environment variable named "alternative_concept"” when scheduling an operation to the MSE.
This variable will override any Concepts defined for an Output in the VCP/Trio profile editor.
In a setup where there are multiple outputs assigned to a Channel where each output has
Concepts assigned except the first, all outputs will run with the main concept. The following
setting will set the Concept of all outputs under Mosart control in the Profile to the currently
selected Concept and this will be the default behavior. The old way of sending the value in
the environment for ScheduleElement can still be used by setting the property
SetConceptOnOutputChannel to false. (default = true)
The following Viz Trio properties are used when connecting to Viz Trio. They were originally
stored in VizTrioConfig.xml. Viz Trio connections must use port 6200.

- TakelnCommand: Used to override take in commands. Use this if you require something
other than page:take

- TakeOutCommand: Used to override take out commands if you require something other
than page:takeout

15.2.4 Vizrt Media Sequencer VDom Logic Macros

It is possible to send custom commands to the Media Sequencer. This can be done by VDom logic
which can run on the Media Sequencer as macros from Viz Mosart.

An optional VizrtUserMacros.xml file should be created and placed in the config files folder
with the following format:

Macro file format:

<macros>
<macro name='"myMacroName">
<!-- Place a single VDom element here, for instance <env /> -->
</macro>

<macro name="StartScene">
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<env>
<viz>RENDERER*STAGE START</viz>
</env>
</macro>
</macros>

The macros are executed with the following variables:

Variable Value Comment
profile /config/profiles/MOSART
viz The viz handler for the engine

targeted in the MACRO call

channel The profile channel name for the Only send if channel names are
engine targeted in the MACRO call applied to elements

15.2.5 Chyron Configuration File

The Chyron configuration file is named ChyronConfig.xml.

The configurable parameters are documented with self-explanatory values in the code below.

<DeviceConfig name="DeviceConfig">
<Properties>
<!-- Macro for taking out graphics on Chyron channel x -->
<item name="TakeOutMacrol" value="BREAKOUT_A" />
<item name="TakeOutMacro2" value="BREAKOUT_B" />

<!-- Configure settings for taking out with transition graphics on Chyron channel
x for Intelligent Interface Rules Engine (IIRE).

Specify the transition to be used to effect out the graphic. In the examples
below, 2 take out commands have been defined for port 1 and 2

with tranistion "animate". {GraphicID} is a placeholder and must be given 1in the
specified format. -->

<item name="IIRETakeOutMacrol" value="L\{GraphicID}\animate" />

<item name="IIRETakeOutMacro2" value="L\{GraphicID}\animate" />

<l--
Encoding: Default encoding utf-16
Page containing valid .Net encodings:
http://blogs.msdn.com/b/shawnste/archive/2009/08/18/alternate-encoding-
names-recognized-by-net-ie.aspx
-—>
<item name="Encoding" value="utf-16"/>
<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->
<item name="ConnectedWhenIdle" value="false" />
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<!-- If true the connection to the graphics devices are maintained while Mosart
is in standby or idle modes -->
<item name="ConnectedWhenInStandBy" value="false" />

<!--Whether to send the NEW Check Existence command. (Requires Lyric build 2021
or higher. Use Help / About Lyric to find out.)-->
<jtem name="ShouldCheckExistence" value="false"/>

<!--Timeout for the NEW Check Existence command-->
<item name="TimeoutCheckExistence" value="1000"/>

<l--
Enable the PreviewOnOutput to keep the old behavior of cueing and taking an
item for preview.
Leave as false for previewing on the local preview output of the Chyron. Note
that when the below
setting is enabled, preview of CGs will be taken directly to air and is a
misconfiguration of the system.
-—>
<item name="PreviewOnOutput" value="false"/>
</Properties>
</DeviceConfig>

15.2.6 Deko, Orad, Xpression Configuration File

Several graphics drivers use variants of the common config file
IntelligentInterfaceConfiguration.xml . These include

Deko
Orad
Xpression

Their respective parameters are documented with self-explanatory values in the code below.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="IntelligentInterfaceConfiguration">
<Properties>
<!-- Config file for all Intelligent Interface Graphics Devices -->
<item name="IgnoreCreateCommandInStandby" value="false" />
<item name="LoadInBackground" value="false"/>

<!-- Encoding to be used for communication. Typical values: "utf-16", "utf-8" -->
<item name="Encoding" value="utf-16"/>
<!-- The name of the Xml attribute containing the graphics id used when

communicating with the graphics devices -->

<item name="GraphicsIdAttribute" value="graphics_id" />

<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->

<item name="ConnectedWhenIdle" value="false" />
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<!-- If true the connection to the graphics devices are maintained while Mosart
is in idle mode -->
<item name="ConnectedWhenInStandBy" value="false" />

<!-- DEKO -->

<item name="UseEffectsAttachedToTemplates" value="true"/>
<item name="TakeInWithCueAndTransferKeyCodes" value="false"/>
<item name="IgnoreKeyCodesOnTakeIn" value="false"/>

<item name="ClearScene" value=""/>

<I--<item name="TakeInPrefixFileName" value="\xF7"/>

<item name="TakeInPostfixFileName" value="\xF8\xF7"/>-->

<!-- XPRESSION -->

<item name="XpressionResumeBeforeTakeOffline" value="false" />
<!--true/false-->

<item name="XpressionTakeOfflineDelay" value="2000" />
<!I--milliseconds (req. XpressionResumeBeforeTakeOffline to be true)-->
<item name="XpressionSuppressAlfanumericTemplates" value="false" />
<!--true/false-->

<item name="XpressionRetryIndexGenerator" value="10" />
<!--true/false-->

<item name="XpressionOverlayIndexLimit" value="100000" />
<!--true/false-->

<!-- GRAPHICS : ORAD -->

<!-- Activates preload in preview for given destinations.

Syntax: comma separeted list of destinations: Example "DSK,WALL" -->
<item name="OradPreloadDestinations" value="" />
<!-- Either [1,2]. The number of response message expected after a preload

command V\5\13. Default 1-->
<item name="OradPreloadNumResponses" value="1" />
<!-- Orad Heartbeat 1interval in seconds. Set to 0 to disable -->
<item name="OradPollInterval" value="60" />
<l--seconds-->
<!== Minimum time to wait after take command before sending new commands to Orad

<item name="OradTakeBlocks" value="10" />
<!--milliseconds-->
<!-== Minimum time to wait after cue command before sending new commands to Orad

<item name="OradMaxWaitTillCued" value="6000" />

<!--milliseconds-->

<!-- Obsolete: Use general Encoding property instead -->

<!--<item name="OradEncoding" value="unicode" />-->

<item name="OradSkipRecue" value="never" />

<!-- Either [last,loaded,never]. Controls when to skip recue-->

<!-- If set, responses from last preview operation will be stored. Corresponding
play will not take place if cue is not verified -->

<item name="OradEnableCueVerification" value="false" />

<I-- If set, a Select Output command is sent as part of preview. Complient with
Orad/CII protocol, section 4.13-->

<item name="OradEnableSelectOutput" value="false" />

</Properties>
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</DeviceConfig>

15.3 Subtitling Configuration Files

15.3.1 ScreenLL Configuration File

The ScreenlLL configuration file is named ClipServerScreenLL.xml.

<?xml version="1.0" encoding="utf-8" ?>
<MediaServerConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="
http://www.w3.0rg/2001/XMLSchema'">
<Properties>

<!-- Language code to look for to decide clip availability -->
<item name="AvailabilitylLanguageCode" value="OPN" />

<!== First Incue Time code that 1indicates dinvalidated clip -->
<item name="InvalidatedFirstIncueTime" value="--:--:--:-=-" />

</Properties>
</MediaServerConfig>

Properties

- AvailabilityLanguageCode: Specifies which language code must be present in order for a clip
to be marked as available. The language code is a three letter text string, which relates to a
list of language codes found in the file PoliSTLServerLangs.Ist, which must be present on the
ScreenLL subtitle file server.

InvalidatedFirstincueTime: Specifies the First Incue Time value that will indicate that a
subtitle clip has been invalidated (is not available even if it matches the
AvailabilityLanguageCode).

Other configuration items are customer-specific or for Vizrt internal use only.

15.4 Video Router Configuration Files

Miranda NVision Configuration File
EvertzQuartz

15.4.1 Miranda NVision Configuration File

The integration between Viz Mosart and Miranda NVision video routers supports setting cross
points on the router.

- Viz Mosart will interface directly with the NVISION 5128 Router.
Router Control is handled by AV Automaton.
- Testing can be done using the Viz Mosart TestRouterControl application.
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The config file is called VideoRouterMirandaNV9000.xml, located at \\Mosart Medialab\Mosart
Server\ConfigurationFiles

<?xml version="1.0" encoding="utf-8" ?>
<DeviceConfig name="MirandaNVv9000Config">
<Properties>
<!--The amount of time (in ms) to wait before reconnection after unsuccessful
connect or lost connection-->
<item name="ReconnectInterval" value="10000"/>

<!--The Take mode parameter to the Take commands. Refer to the NV9000O spec pp. 8-9
for details. The default value 1is Automatic take mode.-->
<item name="TakeMode" value="0x00000001"/>

<!--Not used-->
<item name="TimeoutSetCrossPoint" value="1000"/>

<!--The User ID. Available in the NV9000® DB. Alternatively the client IP address
as a network byte order (big-endian) 32 bit word. E.g., the (hex) IP address
FE.DC.BA.98 should be written

OXFEDCBA98.-->

<item name="UserID" value="OxFEDCBA98"/>

<!--Whether (True/False) to use the Take Source To Destination command. If False,
use the Take Input To Output command instead. Default True.-->
<item name="UseTakeSourceToDestination" value="True"/>
</Properties>
</DeviceConfig>

Protocol Details

For details on the NV9000 protocol, refer to the GrassValley product documentation (https://
community.grassvalley.com/support/s/).

File Location

The Miranda Nvision configuration file is located in the program-folder under \Mosart

Medialab\Mosart server\ConfigurationFiles\VideoRouterMirandaNV9000.xml .

Properties

Reconnectinterval: The amount of time (in milliseconds) to wait before reconnection after
unsuccessful connect or lost connection. Default: 10000 .
TakeMode: The Take mode parameter to the Take commands. Default: 0x00000001

(Automatic take mode).
UserlID: The User ID. This can be fetched from the NV9000 database, or can be created by
converting the client IP address to a network byte order (big-endian) 32 bit word. Default:
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OXFEDCBASS .
For example, the (hex) IP address FE.DC.BA.98 should be written OXFEDCBA98.
UseTakeSourceToDestination: This value determines which protocol commands to use for

setting a crosspoint:
- True = 0x0000 3000 Take Source To Destination (default).
False = 0x0000 3001 Take Input To Output.

A Note:
- To integrate with Miranda NVision video routers, you must also

configure it in Router.
Select the router protocol MIRANDA NV9000.

Set the IP address of the router, and the Port number (use 9193).

15.4.2 EvertzQuartz

The config file is called VideoRouterEvertzQuartz.xml, located at \\Mosart Medialab\Mosart
Server\ConfigurationFiles

15.5 Audio Mixer Configuration Files

These config files are initially located in the Viz Mosart Server installation folder in a sub folder,

Configuration Files.
For operations, you copy the file to "%ProgramData%/

Calrec TCP/IP Configuration File

SSL Configuration File

Lawo Ember+ Configuration File
- Ardour Configuration File

MidiMixer Configuration File

See also Audio.

15.5.1 Calrec TCP/IP Configuration File

The Calrec TCP/IP configuration file is named AudioMixerCalrec.xml.

<?xml version="1.0" encoding="utf-8" 7>
<DeviceConfig name="AudioMixerCalrec">

<Properties>
<I-- If set to true, controller stays connected when 1in idle. Note that in a

redundancy setup,on both main and backup Viz Mosart servers this option must be set

to false. -->
<item name="ConnectedWhenIdle" value="false"/>
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<!-- If set to true, AvAutomation waits for Ack after sending command to the
driver.

Note that this configuration will overwrite the general configuration with same
name from AvAutomation settings (Ctrl+Shift+S).

If commented, the general configuration from AvAutomation will be taken 1into
consideration.-->

<item name="AudioWaitForAck" value="true"/>

<!-- Max wait time for receiving Ack -->
<item name="AckTime" value="199"/>

<!-- Wait time before trying to reconnect -->
<item name="ConWait" value="1000"/>

<!-- Interval to set fader levels on the audio driver. If set to 0, the
operation will not be re-scheduled.

Note that this configuration will overwrite the general configuration with same
name from AvAutomation settings (Ctrl+Shift+S).

If commented, the genral configuration from AvAutomation will be taken into
consideration.-->

<jitem name="AudioPollInterval" value="0"/>

<!-- Interval to send an heartbeat to the driver (number of counts until next
heartbeat will be sent). Set this to -1 to disable sending the heartbeat.
In this case, AvAutomation will not be able to detect when audio driver

connection goes down, for example. -->
<item name="HeartbeatInterval" value="1000"/>
</Properties>
</DeviceConfig>

15.5.2 SSL Configuration File

The SSL configuration file is the same as used for Calrec TCP/IP Configuration File.

15.5.3 Lawo Ember+ Configuration File
The Lawo Ember+ configuration file is named AudioMixerLawoEmberPlus.xml.

Please see the file for the available settings and their documentation.

15.5.4 Ardour Configuration File
The Ardour configuration file is named AudioMixerArdour.xml.

Please see the file for the available settings and their documentation.

15.5.5 MidiMixer Configuration File

The MidiMixer configuration file is named AudioMixerMidiMixer.xml.

Please see the file for the available settings and their documentation.
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15.6 Vision Mixer Configuration Files

The configuration files for the following vision mixers (switchers) are listed here for convenience.
See the inline commenting for parameter explanation.

A Note: Only changes to commented values, where indicated as variables, are supported!

ClipServerVizEngine.xml
GvgVideoSwitcherConfig.xml
GrassValleyCPLVideoSwitcherConfig.xml
RossVideoSwitcherConfig.xml
SonyVideoSwitcherConfig.xml
VizEngineSwitcherConfig.xml
VizrtlpSystemsVideoSwitcherConfig.xml

15.6.1 ClipServerVizEngine.xml

Settings for the video server configuration file and in addition, for Viz Engine as a video server.
Only commented values may be changed.

<DeviceConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="http:/
/www.w3.0rg/2001/XMLSchema"> <Properties>

<item name="KeepCache" value="False" />

<item name="RefreshOnUpdate" value="True" />

<!-- The layer a switching scene is located in on. Only used for video servers,
for Engine Switcher (Viz Engine) this value is always "MIDDLE". Default: Back -->

<item name="ControlScenelLayer" value="MIDDLE" />

<!-- Shall always be true, do not change. Default: true -->

<item name="UseScriptCommands" value="true" />

<!-- The path prefix of the clips. Default: <clip_root> -->

<item name="ClipNamePrefix" value="" />

<!-- Clip extension (if not set, all types can be played, but needs to be
specified in the NRCS). Default: empty -->

<item name="ClipNamePostfix" value="" />
<item name="AssetToMediaMap" value="UseTitleAsSlug" />
<!-- The version of the Switcher Scene. Used by Mosart to check the channel

status when connecting to a port. For versions after 1, it does not need Mosart to
check the status. It is dynamic. Default: 1 -->
<item name="SwitcherSceneVersion" value="2" />
</Properties>

& Note: For Engine Switcher Mode configurations in the Viz Engine, see Engine Switcher
Configuration.
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15.6.2 GvgVideoSwitcherConfig.xml

<DeviceConfig name="GvgVideoSwitcherConfig">
<Properties>
<item name="SendBreak" value="true" />
<item name="EnableHeartbeat" value="true" />
</Properties>
</DeviceConfig>
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SendBreak: All GVG 4000 protocol switchers requires a break before connecting (but there
are switchers which do not need this).
EnableHeartbeat: When no commands are issued, a heartbeat is sent to the vision mixer with

an interval equal to the configured heartbeat interval.

15.6.3 GrassValleyCPLVideoSwitcherConfig.xml

<DeviceConfig name="GrassValleyVideSwithcerConfig">

<Properties>
<!-- Interval in seconds when to test for a valid connection when not connected
-—>
<item name="ConnectionCheckIntervalInSecondsNotConnected" value="5" />
<!-- Interval in seconds when to test for a valid connection when connected -->
<item name="ConnectionCheckIntervalInSecondsConnected" value="10" />
</Properties>
</DeviceConfig>

15.6.4 RossVideoSwitcherConfig.xml

& Note: This config replaces CarboniteVideoSwitcherConfig.xml.

<DeviceConfig name="CarboniteVideoSwitcherConfig">

<Properties>

<!-- The properties below is the virtual cross point mapping for internal Ross
Carbonite sources. Alias can be anything. Value is the virtual assigned crosspoint to
be set in AV Config XML. Name is the RossTalk command for the -item.

-—>

<item alias="MediaStorel" value="1001" name="MS:1" />

<item alias="MediaStore2" value="1002" name="MS:2" />

<item alias="MediaStore3" value="1003" name="MS:3" />

<item alias="MediaStore4" value="1004" name="MS:4" />

<item alias="Black" value="1008" name="BK" />

<item alias="MatteColor" value="1009" name="BG" />

<item alias="ME1" value="1011" name="ME:1" />

Copyright © 2023 Vizrt

Page 491
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<item
<item
<item
<item
<item
<item
</Prope
</DeviceC

alias="ME2" value="1012" name="ME:2" />

value="1021" name="MME:1"
value="1022" name="MME:2"
value="1023" name="MME:3"
value="1024" name="MME:4"
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/>
/>
/>
/>

alias="MuliScreenl" value="1031" name="MSC:1" />
alias="MuliScreen2" value="1032" name="MSC:2" />

alias="MiniME1"
alias="MiniME2"
alias="MiniME3"
alias="MiniME4"
rties>
onfig>

15.6.5 SonyVideoSwitcherConfig.xml

<DeviceConfig name="SonySwitcherConfig">

<Properties>

<!-- Truns the heartbeat mechanism on/off. -->

<!-- djtem name="EnableHeartbeat" value="false" / -->

<!-- The number of milliseconds before a time-out occurs when a read operation
does not finish.

If set less than zero the time-out will be infinite -->

<!-- jtem name="ReadTimeout" value="100" / -->

<!-- ComPort2 is used for the SonySerialTallyDriver in split mode, using the
second serialport for the SCU connection -->

<!-- <item name="ComPort2" value="COM23" /> -->

<!-- The properties below routes the different commands sets to either the

standard or the extra COM port

-=>
<l==
<item
<item
<item
<item
<item
<item
<item
<item
<item
-=>

</Prope

None: always com

port 1,

Partial: com port 1 if the crosspoint range or mix effect range is supported
by com port 2, otherwise com port 2

Full: always com

port 2

name="AutoTransComPort2" value="None" />
name="SetCrossPointComPort2" value="Full" />
name="SetCrossPointComPort2" value="Full" />
name="SetAuxCrossPointComPort2" value="Full" />
name="SetKeyFillCrossPointComPort2" value="Full" />
name="SetKeyerComPort2" value="Full" />
name="SetDskComPort2" value="Partial" />
name="SetTransTypeComPort2" value="Full" />
name="RecallRegionComPort2" value="None" />

rties>

</DeviceConfig>
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15.6.6 VizEngineSwitcherConfig.xml

This config is employed when controlling video switching directly from a Vizrt Viz Engine, as
presented in section Viz Engine as a Switcher.

<DeviceConfig xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xmlns:xsd="http:/

/www.w3.0rg/2001/XMLSchema'">

<Properties>
<item name="ControlScenePath" value="Vizrt/VizMosart/ControlScenes/switcher" />

<item name="NumberOfKeyBuses'" value="8"/> <!-- Number of key buses in template
editor (default value is 4, only other valid option 1is 8) -->
</Properties>
</DeviceConfig>

A Note: Configurations are also required on the Viz Engine server. See Engine Switcher
Configuration.

15.6.7 VizrtlpSystemsVideoSwitcherConfig.xml

<DeviceConfig name="VizrtIpSystemsVideoSwitcherConfig">

<Properties>
<!-- The path where EMEMs are stored —-->
<item name="PathToEmem" value='"D:\Sessions\SessionName\emem\" />

<!-- Set this to true if the crosspoint names should be sent in the command to
the driver instead of the physical {inputs for the NDI Outputs. Default: true.-->
<item name="UseOutputCrosspointNames" value="true" />

</Properties>
</DeviceConfig>

15.7 Engine Switcher Configuration

For setup and configurations that use these settings, please refer to section Viz Engine as a
Switcher.

switcher_config.cfg
ClipServerVizEngine.xml

15.7.1 switcher_config.cfg

A Note: These configurations are performed on the Viz Engine (not Viz Mosart) machine.
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File Location

The Switcher Scene can be configured from its configuration file, switcher_config.cfg located
in C:\ProgramData\vizrt\VizEngine.

Configurable Parameters

#scene path for preview engine
<switcher_scene>Vizrt\Engine-Switcher\switcher</switcher_scene>

#scene path for openers if static_paths = 0 or 2
<opener_path>Vizrt\Engine-Switcher\openers\</opener_path>

##scene path for effects if static_paths = 0 or 2
<effect_path>Vizrt\Engine-Switcher\effects\</effect_path>

#type of paths: 0 = absolute path i.e. ALL/MyPath/openers, 1 = openers/effects underneath
switcher scene, 2 = relative path underneath switcher scene i.e. myeffects
<static_paths>2</static_paths>

#amount of effect scenes for preloading
<effects>10</effects>

#content transition effect number to begin with
<content_effect_start>90</content_effect_start>

#external transition effect number to begin with, end at content_effect_start
<ext_effect_start>50</ext_effect_start>

#external opener/trans within GFX channels
<gfx_channel_support>1</gfx_channel_support>

#activating external transition effect engine - not recommended due to possible network delays
<ext_trans_active>0</ext_trans_active>

#transition engine ip
<transition_host>127.0.0.1</transition_host>

#transition engine port
<transition_port>6100</transition_port>

#activating external top layer engine
<ext_top_scene_active>0</ext_top_scene_active>

#external top layer engine ip
<ext_top_scene_host>127.0.0.1</ext_top_scene_host>

#external top layer engine port
<ext_top_scene_port>6100</ext_top_scene_port>

#activating external preview
<ext_prev_active>0</ext_prev_active>

#external preview hostname
<ext_prev_host>127.0.0.1</ext_prev_host>

#external preview port
<ext_prev_port>6100</ext_prev_port>
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#show commands (log level)
<show_commands>2</show_commands>

#delaying the actual take in fields coming via external gfx scenes - this is used for having more
time to load ip sources in preview
<external_take_delay>0</external_take_delay>

#i am peview
<i_am_preview>0</i_am_preview>

#activating dynamic ip workflow (Probel source request)
<dynamic_ip_workflow>0</dynamic_ip_workflow>

#shared memory map name used for status signaling
<dynamic_ip_status>pgmstatus_prv</dynamic_ip_status>

#shared memory map name used for Probel status callbacks - mandatory for using Probel
communication!
<dynamic_ip_callback>probelstatus-machinename</dynamic_ip_callback>

#shared memory map name used for indicating a toggle (might be used in other gfx scenes)
<toggle_status>toggle_mapname</toggle_status>

#time waiting for the release of "old" sources after the toggle of new ones
<release_delay>10</release_delay>

#Source Prefix
<source_prefix>LIVE</source_prefix>

#size of the maximum number of active preview sources
<preview_queue_size>5</preview_queue_size>

#viz one in use (needed for setting clip prefix)
<viz_one>0</viz_one>

#clip prefix
<clip_prefix>V:\</clip_prefix>

#defines how the status overlay scene gets loaded - 1 = direct load to frontlayer - 2 = dynamic
scene container in fl scene
<status_overlay_mode>1</status_overlay_mode>

#path to status overlay scene in GH
<status_overlay>Default\statusoverlay_new</status_overlay>

#start playing clip on preview machines
<play_clip_on_preview>0</play_clip_on_preview>

#trigger tally lights
<tally_active>0</tally_active>

#tally server name
<tally_name>tally_pcr_main</tally_name>

#tally back